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＜お客様へのお願い！＞＜お客様へのお願い！＞＜お客様へのお願い！＞＜お客様へのお願い！＞＜お客様へのお願い！＞
MR-8mkIIをお買い上げいただき、ありがとうございま
した。本機をご使用いただく前には、17ページから記
載されている「準備編」を必ずお読みいただき、MR-
8mkIIを使用するための準備を行ってください。
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ここでは、本機をご使用いただく上での安全に関する項目を記載しています。
あなたや他の人々へ与える危害や、財産などへの損害を未然に防止するため、ここに記載されている
事項をお守りいただくものです。本機をご使用になる前には、必ずお読みください。

この表示の欄に記載されている事項を無視して、
誤った取り扱いをすると、人が死亡または重傷を
負う可能性が想定される内容を示しています。

この表示の欄に記載されている事項を無視して、
誤った取り扱いをすると、人が障害を負ったり、物
的損害の発生が想定される内容を示しています。

絵表示について絵表示について絵表示について絵表示について絵表示について
本書、および製品の表示には、あなたや他の人々へ与える危害や財産の損害を未然に防ぎ、本機を安
全にご使用いただくために、警告または注意を促す絵表示を使用しています。これら絵表示の意味を
よく理解して、本書をお読みください。

△記号は、注意しなければなら
ない内容（警告も含む）を示して
います。具体的な注意事項は、△
の中や近くに絵や文章で示して
います。上記例は「感電注意」を
示しています。

●記号は、強制内容（必ずする
こと）を示しています。具体的
な強制事項は、●の中や近くに
絵や文章で示しています。上記
例は「電源プラグをコンセント
から抜く」を示しています。

異常が発生した場合異常が発生した場合異常が発生した場合異常が発生した場合異常が発生した場合

●万一、煙が出ている、変な匂いや音がするな
どの異常のまま使用すると、火災・感電の原因
になります。すぐに機器本体の電源を切り、必
ずACアダプタをコンセントから抜いてくださ
い。異常が無くなったことを確認して、販売店
または当社営業窓口へ修理を依頼してくださ
い。お客様ご自身での修理は大変危険ですの
で、絶対にお止めください。

●万一、機器内部に水や異物が入った場合に
は、すぐに機器本体の電源を切り、必ずACア
ダプタをコンセントから抜いて、販売店または
当社営業窓口へ修理を依頼してください。その
まま使用すると、火災・感電の原因となります。

●万一、機器を落としたり、カバーを破損した
場合には、すぐに機器本体の電源を切り、必ず
ACアダプタをコンセントから抜いて、販売店
または当社営業窓口へ修理を依頼してくださ
い。そのまま使用すると、火災・感電の原因と
なります。

設置する場合設置する場合設置する場合設置する場合設置する場合

●機器本体に直接水のかかる場所には置かない
でください。火災・感電の原因となります。特
に屋外での使用（雨天、降雪時、海岸、水辺）は
ご注意ください。

●雷が鳴り出したら、ACアダプタのプラグに
は絶対手を触れないでください。感電の原因と
なります。

●製品本体の上に、花瓶、コップや水などの
入った容器、または小さな金属物類を置かない
でください。何らかの理由で水がこぼれたり、
本機の中に金属物が入ったりした場合、火災・
感電の原因となります。●ACアダプタのケーブルの断線、芯線の露出

などケーブルが傷んだ場合には、販売店または
当社営業窓口へ修理を依頼してください。その
まま使用すると、火災・感電の原因となります。

警告警告警告警告警告 注意注意注意注意注意

警告

◯記号は、禁止内容（してはいけ
ないこと）を示しています。具体
的な禁止事項は、◯の中や近く
に絵や文章で示しています。上
記例は「分解禁止」を示していま
す。

安全上のご注意安全上のご注意安全上のご注意安全上のご注意安全上のご注意
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使用する場合使用する場合使用する場合使用する場合使用する場合

●本機の分解／修理／改造は、絶対にしないで
ください。また、本体カバーは絶対に外したり
しないでください。火災・感電の原因となりま
す。

●ACアダプタのケーブルを傷つけたり、加工
したり、ねじったり、引っ張ったり、あるい加
熱しないでください。ケーブルが破損して、火
災・感電の原因となります。

●機器本体、または取扱説明書に表記されてい
る電源電圧以外では、使用しないでください。
なお、ACアダプタは家庭用100ボルトのコン
セントに確実に差し込んでください。火災・感
電の原因となります。

●ACアダプタのケーブル上に重い物を載せた
り、ケーブルが本機の下敷きにならないように
してください。ケーブルが傷ついて、火災・感
電の原因となります。

設置する場合設置する場合設置する場合設置する場合設置する場合

●油煙や湯気の当たるような場所、あるいは湿
気やホコリの多い所へ置かないでください。火
災・感電の原因となることがあります。

●ACアダプタのケーブルを熱器具に近付けな
いでください。ケーブルの被覆が溶けて、火災・
感電の原因となることがあります。

●本機をぐらついた台の上や傾いた所など、不
安定な場所に置かないでください。落ちたり倒
れたりして、けがの原因となることがあります。

●窓を閉め切った車の中や、直射日光が長時間
当たる場所など、異常に温度が高くなる場所に
放置しないでください。火災の原因となること
があります。

●ACアダプタがコンセントに接続されたまま
電源スイッチを切っても、機器は電源から完全
に断路状態になっていません。長期間使用しな
いときは、ACアダプタをコンセントから抜い
てください。火災・感電の原因となることがあ
ります。

製品をお手入れする場合製品をお手入れする場合製品をお手入れする場合製品をお手入れする場合製品をお手入れする場合
●本機をお手入れする場合は、安全のためAC
アダプタをコンセントから抜いてください。AC
アダプタを差し込んだまま行うと、感電の原因
となることがあります。

使用する場合使用する場合使用する場合使用する場合使用する場合

その他のご注意その他のご注意その他のご注意その他のご注意その他のご注意

●この製品は精密な部品でできています。製品
を運ぶときなどは、慎重に行ってください。

●本機に他のオーディオ機器を接続する場合に
は、必ず本機および接続する機器の電源を切り、
接続する機器の説明書をよく読んで、説明に
従って正しく接続してください。また、接続に
使用するケーブルなどは、指定された製品を使
用してください。

●5年に1度位は機器内部の清掃が必要です。
販売店または当社営業窓口へご相談ください。
長期間掃除しないと内部にホコリがたまり、そ
のまま使用すると火災・感電の原因となること
があります。特に湿気の多くなる梅雨時期の前
に行うと、より効果的です。

●濡れた手でACアダプタを抜き差ししないで
ください。感電の原因となることがあります。

●本機の近くで携帯電話を使用すると、機器にノイズが入
ることがあります。携帯電話は、本機から離れた場所でご
使用ください。

●この製品をラジオやテレビの近くで使用すると、ノイズ
や雑音が生じることがあります。このような場合には、本
機をラジオやテレビから離してご使用ください。

●電源が入った状態で、本機を布や布団で被っ
たりしないでください。熱がこもり、火災の原
因となることがあります。

●大きなモニター音を長時間ヘッドホンでモニ
ターするのはお止めください。聴力障害の原因
となることがあります。

●本機の電源を入れる前には、音量（ボリュー
ムなど）を最小にしてください。突然大きな音
が出て、聴力障害の原因となることがあります。

●本機を移動する場合には必ず電源を切り、AC
アダプタをコンセントから抜いて、接続されて
いる外部機器の接続ケーブルも外してください。
ケーブルが傷つき、火災・感電の原因となるこ
とがあります。

注意
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ここでは、MR-8mkIIをご使用になる前の注意、MR-8mkIIの特徴や基礎知
識について記載しています。

MR-8mkIIの特徴／機能をご理解いただくために、ご使用いただく前にお読
みください。



MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII　取扱説明書　取扱説明書　取扱説明書　取扱説明書　取扱説明書（（（（（最最最最最初初初初初にににににおおおおお読読読読読みみみみみくくくくくだだだだださささささいいいいい）））））

10

●自照式の操作キーを採用し、直感的な感覚で
操作が可能。

●コンデンサー・タイプのマイクロホンにも対
応する、「ファントム電源」の供給が可能。

●録音ガイドに性能を発揮する「リズム・ガイ
ド機能」を搭載。簡単な拍子／テンポを設定
したり、コンダクター・マップを作成して、リ
ズム・ガイド音を鳴らすことが可能。

● MR-8mkIIでマスタリング処理したソング・
データ（トラック7、8のモノWAVファイ
ル）を、簡単な操作でステレオWAVファイ
ルに変換が可能。
変換したステレオWAVファイルは、 [USB]
ポートを介してCD-R搭載のコンピュータに
取り込んでオーディオCDの作成が可能。

● [USB HOST] ポートを介して接続する外部
CD-R/RWドライブを使って、オーディオCD
の作成が可能（注注注注注：：：：：NormalNormalNormalNormalNormalモードのソングモードのソングモードのソングモードのソングモードのソング・・・・・
データのみが作成可能データのみが作成可能データのみが作成可能データのみが作成可能データのみが作成可能）。

●トラック・データのコピー・ペースト、ムー
ブ、入れ替え、またはイレースなど、任意の
トラックまたはパートで編集が可能。

●  [MIDI OUT] 端子を装備し、MTCまたはCLK
による外部MIDI機器（MIDIシーケンサーな
ど）との同期が可能。

このたびはフォステクス デジタル・マルチトラッカーMR-8mkIIをお買い上げいただき、誠にありが
とうございます。MR-8mkIIは、記録メディアにコンパクトフラッシュ・カード（以下CFカード）を
内蔵し、44.1kHz/16bit（または22.05kHz/16bit）で8トラックの録音（最大2トラック同時録音）
／再生が可能な、デジタル・マルチトラッカーです。

8チャンネルのデジタル・ミキサー、ディレイ／リバーブなどのデジタル・エフェクト、シミュレー
ションを可能にするインサート・エフェクトに加え、マスタリング・エフェクトも搭載していますの
で、オーバーダビング、バウンス（ピンポン）、エフェクト処理からミックスダウン、さらにはマスタ
リングという音楽制作に必要な全ての過程を、信号を劣化させることなくフル・デジタルの処理が行
なえます。

●コンパクトフラッシュ・カードを記録メディ
アに使用し、音質劣化のない高品質なデジタ
ル録音／編集が可能で、最大99のソングを
作成可能。

● AC電源（専用ACアダプタ使用）とDC電源
（アルカリ電池使用）の2電源方式を採用。

● 2系統（[INPUT A]／[INPUT B]）のアナログ
入力を装備し、最大2トラックの同時録音が
可能。

●トラック1～4をトラック5/6へバウンス、
トラック1～6をトラック7/8へバウンス、
さらには、フルトラック（8トラック）を再
生して、自動的にNewソングの7/8トラッ
クへバウンスするなど、多彩なバウンス機能
を搭載。

●フォステクスが独自に開発した新アルゴリズ
ムのASPデジタル・エフェクト（ディレイ／
リバーブ）を内蔵し、バウンス時にトラック
1～4の再生音にエフェクト処理が可能。
さらには、アンプ・シミュレート／マイク・
シミュレートを可能にするインサート・エフ
ェクトを内蔵し、多彩な音作りをしながら録
音が可能。

●ステレオ・バス専用のマスタリング・エフェ
クトを搭載し、バウンスあるいはミックスダ
ウンするソングにエフェクト処理が可能。

はじめにはじめにはじめにはじめにはじめに

MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII の特徴の特徴の特徴の特徴の特徴
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● 本機は、付属のACアダプタ（Model AD-12A）あ
るいは市販のアルカリ電池（単三6本）で駆動し
ます。ACアダプタは、交流100ボルト以外のコ
ンセントには接続しないでください。なお、マン
ガン電池は使用しないでください。

● 雑音の発生する外部機器（大型モーター、調光器
など）、あるいは大量に電力を消費する機器（エ
アコン、大型電熱器など）と同じ回路のコンセン
トには接続しないでください。

● 電源電圧の異なる地域で本機をご使用になる場合
は、お買い上げいただいた販売店、もしくは当社
営業窓口までご相談ください。
電源周波数はいずれの地域でも50Hz/60Hz切り
替えなしでご使用になれます。

● ACアダプタをコンセントに接続したままの状態
では、電源スイッチをオフにしても本機は電源か
ら完全に断路状態にはなりません。長期間ご使用
にならないときは、必ずACアダプタをコンセン
トから抜くようにしてください。

● ACアダプタのケーブル被覆が切れたり、こすれ
たりして傷んだまま使用すると大変危です。
もしケーブルが傷んでしまった場合にはすぐに使
用を中止し、修理を依頼してください。

電源に関するご注意電源に関するご注意電源に関するご注意電源に関するご注意電源に関するご注意

＜重要＞＜重要＞＜重要＞＜重要＞＜重要＞
本機の機種名、電気定格、およびシリアル・ナン
バーなどは、製品の底部に表示されています。

MODEL MR-8MK2
DIGITAL MULTITRACKER

FOSTEX CO.
INPUT : 12VDC

SERIAL NO.

MADE IN CHINA

設置に関するご注意設置に関するご注意設置に関するご注意設置に関するご注意設置に関するご注意

● 本機をつぎのような場所で使用するのはお止めく
ださい。

・ 極端な高温／低温など、温度差の激しい所
・ 湿気やホコリの多い所
・ 電源電圧の変動が激しい所
・ 震度や揺れの激しい不安定な所
・ 強い磁気を発している所（テレビ、スピーカーの
近くなど）

修理依頼に関するご注意修理依頼に関するご注意修理依頼に関するご注意修理依頼に関するご注意修理依頼に関するご注意

● 本機には、お客様が簡単に修理できる部品を使用
していません。修理を依頼するには、お買い上げ
いただいた販売店、当社営業窓口、または当社
サービス部門へご連絡ください。

● 修理依頼で本機を持ち込んだり返送する場合に
は、必ず専用の梱包箱を使用してください。
万一梱包箱がないときは、衝撃吸収材などを使っ
て、完全梱包するようにしてください。輸送中ま
たは梱包の不備による故障などについては、当社
では責任を負えませんのでご注意ください。

● 本機は民生用機器であるため、基本的に修理を行
う際の代替え機の提供、および出張修理などは行
なえません。あらかじめご承知置きください。

著作権に関するご注意著作権に関するご注意著作権に関するご注意著作権に関するご注意著作権に関するご注意

● 本機を使用して、第三者が著作権を保有している
CDソフト、ビデオ・ソフトなどを無断で録音し
たものは、あなたご自身が楽しむ以外、営利を目
的とした公演、放送、販売、配布などに使用する
ことは法律で禁止されています。

損害賠償に関するご注意損害賠償に関するご注意損害賠償に関するご注意損害賠償に関するご注意損害賠償に関するご注意

● 本機を使用して生じる「直接的損害」・「間接的損
害」については、当社では一切の責任を負えませ
んので、あらかじめご承知置きください。

音飛びに関するご注意音飛びに関するご注意音飛びに関するご注意音飛びに関するご注意音飛びに関するご注意

● 本機で過度な編集や録音作業を行うと、フラグメ
ンテーションにより音飛びが発生する可能性があ
ります。これは、仕様上の制限によるもので故障
ではありませんが、あらかじめご承知置きくださ
い。

USBUSBUSBUSBUSB接続に関するご注意接続に関するご注意接続に関するご注意接続に関するご注意接続に関するご注意

● MR-8mkIIをMacintoshのパソコンと接続してご
使用なる場合は、“OS X”以上のパソコンのみに
対応しています。“OS X”以前のOSを搭載して
いるパソコンに接続すると、MR-8mkIIのソング・
データが破壊される恐れがありますので、ご注意
ください。

ご使用になる前の注意ご使用になる前の注意ご使用になる前の注意ご使用になる前の注意ご使用になる前の注意
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ここでは、ぜひ覚えておいてほしいMR-8mkIIの基礎知識について説明します。
操作に入る前によくお読みいただき、MR-8mkII独自の特徴を理解するようにしてください。

記録方式記録方式記録方式記録方式記録方式

MR-8mkIIの記録メディアには、市販のコンパクトフラッシュ・カード（以下CFカード）を使用しま
す。そのため、CFカードに作成するソング（次項を参照）には、0m 00s 000msから99m 59s 999ms
までのABS時間が刻まれていきます。

また、テープ式のレコーダーでは使用するテープの長さによって録音可能な時間が決まってきますが、
MR-8mkIIでは未記録の部分はCFカードを消費しないため、効率的な録音が可能です（もちろん無限
ではありません・・・）。

コンパクトフラッシュ・カード

このABS時間はCFカード上における「絶対時間」を示しており、ソング内の0m 00s 000msから
99m 59s 999msの範囲であれば、どこの位置からでも録音することができます。

MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII の基礎知識の基礎知識の基礎知識の基礎知識の基礎知識
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リメインリメインリメインリメインリメイン（（（（（記記記記記録録録録録可可可可可能能能能能ななななな残残残残残容容容容容量量量量量）））））

リメインとは、使用しているCFカードにあとどのくらい録音できるかという、“残り”を表すのも
のです。
MR-8mkIIは0m 00s 000ms～99m 59s 999msの時間が刻まれたソングで管理されていますが、実
際にはCFカードの残りの容量によって、録音可能な時間が変ってきます。リメイン表示は、MR-8mkII
が録音状態（または録音スタンバイ）になっているとき表示され、下図の位置に録音可能なモノ・ト
ラック換算の時間が表示されます。

モノ・トラックとは「１つのトラック」という意味です。つまり、表示されている時間は１つのト
ラックだけに録音した場合の録音可能な時間を表しています。そのため、複数トラックに録音する場
合の録音可能な時間は、表示されているリメインを録音するトラック数で割ると算出できます。ただ
し、算出する時間はあくまでも「大まかな時間」としてご利用ください。

ソングソングソングソングソング

ソングとは、下の図のように独立した部屋を想像してください。MR-8mkIIでは、この独立したソン
グをCFカード上に最大99個作成することができます（注意：ただし、CFカードの記録可能な残容
量によって、作成可能なソング数は制限されます）。

このソングは、CFカード上で個々に独立していますので、他のソングに影響を与えることなく、それ
ぞれのソングにおいて録音／再生／編集が行なえます。
なお、ソングには名前（ソング・ネーム）を自由に付けることが可能ですから、録音した楽曲の管理
などに便利です（☞23／91ページ）。

また、本機ではトラック7/8に録音したモノWAVファイル（LとR）を、ステレオWAVファイルに
変換することができます（☞115ページ）。

変換したステレオWAVファイルは、USB接続でパソコンへ取り込み、パソコンの音楽ソフトを利用
してオリジナルのオーディオCDを作成したり、USB HOST接続で外部CD-R/RWドライブを使って
オーディオCDが作成できます（☞115、123ページ）。

Song01

Song02

Song03

Song04

Song05

Song99

Song98 Song01

Track 1 Track 2 Track 8

WAVファイル

録音したトラック・データは、下の図のようにモノのWAV
ファイルとしてソングに収納されます。

リメイン表示
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インプットモニターとリプロモニターインプットモニターとリプロモニターインプットモニターとリプロモニターインプットモニターとリプロモニターインプットモニターとリプロモニター

MR-8mkIIのレコーダーでは、各トラックの信号を出力する際に“インプットモニター”と“リプロ
モニター”があります。

インプットモニターとは、そのトラックへ入力された信号（録音しようとする音）を、そのままト
ラックの出力へ送ることを示しています。
インプットモニターは、録音する音の録音レベルを確認する際に使用します。したがって、インプッ
トモニターできるのは、 [REC SELECT] キーを押して録音トラックが選択されている状態で、
[RECORD] キーのみを押して“READY（録音待機状態）”になっているか、あるいは実際に録音し
ているトラックのみということになります。

リプロモニターとは、トラックの出力が「再生音」であることを示しています。既に、そのトラッ
クに録音されている再生音を聞く場合など、通常の再生はリプロモニターで行います。

タイムベースタイムベースタイムベースタイムベースタイムベース

本文中に「タイムベース」という言葉が出てきます。
このタイムベースとは、レコーダーの走行位置を表す際に利用します。MR-8mkIIで使用するタイム
ベース表示には、ABS時間で表示する「タイム表示」と、Bar/Beat/Clk（小節／拍子／クロック）で
表示する「Bar Beat表示」があり、 [TIME BASE SELECT] キーで交互に切り替えることができま
す。下記画面は、タイム表示およびBar/Beat表示における、ソングの先頭を示しています。

Bar/Beat/Clk

0m00s000ms 
(ABS ZERO) 0m03s000ms 0m06s000ms

 1bar 1    000clk  3bar 1   000clk-2bar 1    000clk

タイム表示とは、CFカード上に刻まれる“絶対時間” (Absolute Time)であり、0m 00s 000ms（ABS
ZEROと呼び、ソングの先頭を示しています）から99m 59s 999msまでの時間が、ソングを作成し
た時点で刻まれています。また、Bar Beatは、タイム表示0m 00s 000msの位置を“-2小節”と
して初期設定されています（これを本機では“Barオフセット”と呼んでいます）。MR-8mkIIは、こ
の位置を基準にしてそれ以降の小節を設定する、拍子とテンポにしたがって走行位置を決定していま
す。Barオフセット（-2小節）は、MENUモードにおいて0bar～ -8barの範囲で任意に設定するこ
とが可能です（☞81ページ）。下の図は、2つのタイムベースの関係を表したものです。

＜タイム表示＞＜タイム表示＞＜タイム表示＞＜タイム表示＞＜タイム表示＞ ＜＜＜＜＜Bar/BeatBar/BeatBar/BeatBar/BeatBar/Beat表示＞表示＞表示＞表示＞表示＞
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トリムトリムトリムトリムトリム [TRIM] [TRIM] [TRIM] [TRIM] [TRIM]

MR-8mkIIで録音する際にもっとも注意してほしいのは、入力端子に入力したアナログ信号を、デジタ
ル信号に変換（A/D変換と呼んでいます）するときです。
これを調整するのがトリム（[TRIM]）であり、監視するのがピーク（[PEAK]）LEDです。

MR-8mkIIの [INPUT A] / [INPUT B]に入力したアナログ信号に対して、トリムのゲインが大きすぎ
る状態（[PEAK] LEDが点灯する状態）では、入力信号が歪んだ信号としてデジタル信号に変換され、
ノイズのように聞こえてしまいます。

この音は取り除くことができないため、入力された信号が最大音量になる部分で [PEAK] LEDが点灯
しない位置にトリムを調整することが大切です。

[TRIM] つまみ

PEAK LED
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MR-8mkII 　取扱説明書（準備編）

準　備　編準　備　編準　備　編準　備　編準　備　編
ここでは、MR-8mkIIを使って録音／再生／編集などを行うための、「記録メ
ディアの準備」・「電源の準備」・「Newソングの作成」について記載していま
す。はじめてMR-8mkIIをご使用になる場合には、必ずこの「準備編」をお読
みいただき、事前準備を行ってください。
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MR-8mkII 　取扱説明書（準備編）

MR-8mkIIは2電源方式を採用しており、本機付属のACアダプタ（Model AD-12A）またはアルカリ電池（別
売）を使用します。電源の準備を行うには、MR-8mkIIの [POWER] スイッチがOFFになっていることを確認
してください。

電池の収納場所は、MR-8mkII 本体の底部にありま
す。下記手順に従い、正しく電池を入れてください。

＜注意！＞＜注意！＞＜注意！＞＜注意！＞＜注意！＞：：：：：電池は付属しておりません。市販の単3ア
ルカリ電池（6本）を別途お買い求めください。
なお、マンガン電池は使用しないでください。

11111））））） 柔らかい布などを敷いて、柔らかい布などを敷いて、柔らかい布などを敷いて、柔らかい布などを敷いて、柔らかい布などを敷いて、MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIの底部をの底部をの底部をの底部をの底部を
上面にして置きます。上面にして置きます。上面にして置きます。上面にして置きます。上面にして置きます。

22222））））） 底部にある電池収納カバーのツメを矢印方向底部にある電池収納カバーのツメを矢印方向底部にある電池収納カバーのツメを矢印方向底部にある電池収納カバーのツメを矢印方向底部にある電池収納カバーのツメを矢印方向
へ押しながら持ち上げ、へ押しながら持ち上げ、へ押しながら持ち上げ、へ押しながら持ち上げ、へ押しながら持ち上げ、カバーを外します。カバーを外します。カバーを外します。カバーを外します。カバーを外します。

＜電池交換時の注意＞＜電池交換時の注意＞＜電池交換時の注意＞＜電池交換時の注意＞＜電池交換時の注意＞
●使えなくなった電池は、すぐに本体から取り出してくだ
さい。そのまま放置しておくと、電池が液漏れしたり故
障の原因となります。また、新しい電池と交換しても、長
期間ご使用にならない場合には、電池を取り出しておき
ましょう。

●古い電池と新しい電池を、混ぜて使用しないでください。

33333））））） 用意した乾電池を、用意した乾電池を、用意した乾電池を、用意した乾電池を、用意した乾電池を、下図の要領で収納します。下図の要領で収納します。下図の要領で収納します。下図の要領で収納します。下図の要領で収納します。
極性（プラス／マイナス）を間違えないよう、正し
く収納してください。

44444））））） 収納部カバーを元の位置に固定します。収納部カバーを元の位置に固定します。収納部カバーを元の位置に固定します。収納部カバーを元の位置に固定します。収納部カバーを元の位置に固定します。

OPEN

Model AD-12A

[DC IN] 端子

＜注意！＞＜注意！＞＜注意！＞＜注意！＞＜注意！＞：：：：：電池が既に収納されている状態でACア
ダプタを接続したときは、ACアダプタが優先します。
なお、ACアダプタを外すとMR-8mkIIは電池で駆動
します。

電源の準備電源の準備電源の準備電源の準備電源の準備

ACACACACACアダプタを使う場合アダプタを使う場合アダプタを使う場合アダプタを使う場合アダプタを使う場合 電池を使う場合電池を使う場合電池を使う場合電池を使う場合電池を使う場合

＜注意！＞＜注意！＞＜注意！＞＜注意！＞＜注意！＞：：：：：ACアダプタは、必ず本機に付属している製
品をご使用ください。他の電圧やプラグの極性が異なる
ACアダプタは、絶対に使用しないでください。

下の図を参照し、付属のAC アダプタのプラグを
[DC IN] 端子にしっかり接続します。

[DC IN] 端子にプラグを接続した後、アダプタ本体
をコンセントに接続します（注意：家庭用100Vの
コンセント以外には接続しないでください）。

コンセント
POWER USB FOOT SW

ONDC IN
LIGHTOFF

12V

DC IN

12V

アルカリ電池での連続使
用可能な時間は、およそ
4時間です。なお、連続
使用可能な時間は、使用
環境や電池の種類などに
よって異なります。あく
までも目安としてご理解
ください。

本機付属のModel AD-12Aは、内側プラス／外側マイ
ナスの極性になっています。
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MR-8mkII 　取扱説明書（準備編）

MR-8mkIIで録音するには2種類のソング・モードが
あり、用途に合わせてソング・モードを設定するこ
とができます。

ソング・モードには、「ノーマル・モード」と「LPモー
ド」があり、「音質」を優先にするか、「録音時間」を
優先にするか選択できます（☞下記表を参照）。

ソング・モードは個々のソングに設定でき、CFカー
ドに新たなソングを作成する際に設定できます（本
機に付属しているCFカードでは、あらかじめ「ノー
マル・モード」のソングが一つ作成されています）。

なお、新規購入された未フォーマットのCFカードを
ご使用いただく場合は、CFカードをフォーマットす
る際に設定できます（☞23ページを参照）。

MR-8mkIIでは、記録メディアにコンパクトフラッシュ・カード（以下CFカード）を使用します（下記図を参
照）。お買い求めいただいた製品には、あらかじめフォーマット済みのCFカード（128MB）が付属されていま
すので、付属のCFカードをMR-8mkIIのサイド・パネルにあるカード・スロットにセットしてご使用ください。
なお、新たなCFカードを購入する際は、付属のCFカードと同等品を購入するか、もしくは下記いずれかの方
法で使用可能なCFカード情報をご確認の上、お買い求めください。

COMPACTFLASH    CARD

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：CFカードは、必ず当社で動作確認されたカードをお買い求めください。動作確認されていな
いCFカードを使用すると、MR-8mkIIが正常に動作しないことがありますのでご注意ください。

ソングソングソングソングソング・・・・・モードについてモードについてモードについてモードについてモードについて

モノ

128MB

256MB

512MB

24 (48）

48 (96)

96 (193)

＜イメージ図＞

容量 2track

12 (24）

24 (48)

48 (96)

4track

6 (12）

12 (24)

24 (48)

6track

4 (8）

8 (16)

16 (32)

8track

3 (6）

6 (12)

12 (24)

*上記数値は、おおよその記録時間です（単位=分）。
*（　）内はLPモードの記録時間です。

記録メディアの準備記録メディアの準備記録メディアの準備記録メディアの準備記録メディアの準備

FOSTEXFOSTEXFOSTEXFOSTEXFOSTEXホームホームホームホームホーム・・・・・ページページページページページ：：：：：http://www.fostex.co.jphttp://www.fostex.co.jphttp://www.fostex.co.jphttp://www.fostex.co.jphttp://www.fostex.co.jp

営業窓口営業窓口営業窓口営業窓口営業窓口：：：：：TEL: 042-546-6355TEL: 042-546-6355TEL: 042-546-6355TEL: 042-546-6355TEL: 042-546-6355 FAX: 042-546-6067FAX: 042-546-6067FAX: 042-546-6067FAX: 042-546-6067FAX: 042-546-6067
（（（（（土土土土土・・・・・日日日日日・・・・・祝祭日祝祭日祝祭日祝祭日祝祭日・・・・・当社の指定休日を除く当社の指定休日を除く当社の指定休日を除く当社の指定休日を除く当社の指定休日を除くAM10:00AM10:00AM10:00AM10:00AM10:00～～～～～12:0012:0012:0012:0012:00、、、、、PM1:00PM1:00PM1:00PM1:00PM1:00～～～～～5:005:005:005:005:00）））））

記録可能な時間は、ご使用いただくCFカードの容量
と、Newソングの作成時に選択するソング・モード
によって異なります。

下記表は、「ノーマル・モード」、または「LPモード」
で記録する場合の、おおよその記録時間を記載して
います。

表中（　）内の値は、「LPモード」における時間を
表しています。CFカードをご用意いただく際の目安
にご利用ください。

なお、MR-8mkII でご使用いただくCFカードには、
記録容量が128MB以上の製品をお勧めします。

記録可能な時間について記録可能な時間について記録可能な時間について記録可能な時間について記録可能な時間について

ノーマル
モード

LPモード

音質を優先するモードで、FS 44.1kHz
／16bitで高音質の8トラック録音／再
生ができます。通常は、ノーマル・モー
ドで録音します。

録音時間を優先するモードで、F S
22.05kHz／16bitで8トラック録音／再
生ができます。ノーマル・モードより録
音時間が長く確保できます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：LPモードで記録したソング・
データは、外部CD-R/RW ドライブを
使ってオーディオCDが作成できません。

＜記録可能な＜記録可能な＜記録可能な＜記録可能な＜記録可能なCFCFCFCFCFカードの情報を確認するには＞カードの情報を確認するには＞カードの情報を確認するには＞カードの情報を確認するには＞カードの情報を確認するには＞
MR-8mkIIで使用可能なCFカードの最新情報は、当社ホーム・ページをご覧いただくか、当社営業
窓口へお電話でお問い合わせください。
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MR-8mkII 　取扱説明書（準備編）

＜注意！＞＜注意！＞＜注意！＞＜注意！＞＜注意！＞：：：：：CFカードを抜き差しするときは、MR-
8mkIIの電源をOFFにしてください。電源が入ったま
まカードを抜き差しすると、カードを破損したり、記
録されているデータが損失することがありますので、
ご注意ください。

＜注意！＞＜注意！＞＜注意！＞＜注意！＞＜注意！＞：：：：：差し込む向きを間違えたり、過度な
力を加えて押し込まないでください。

用意したCFカードを、MR-8mkIIの右サイドにある
カード・スロットへ差し込みます。

カード・スロット

●●●●●CFCFCFCFCFカードを取り出す場合カードを取り出す場合カードを取り出す場合カードを取り出す場合カードを取り出す場合：：：：：
CFカードの裏側にある凸部に指をかけて、静かに
カードを引き抜きます。

●●●●●CFCFCFCFCFカードをセットする場合カードをセットする場合カードをセットする場合カードをセットする場合カードをセットする場合：：：：：
CFカードの表面を上にして、ゆっくりスロットの奥
まで差し込みます。

＜＜＜＜＜CFCFCFCFCFカードの保管＞カードの保管＞カードの保管＞カードの保管＞カードの保管＞
● 取り出したり、使用しないCFカードは、次の
ような所を避けて保管してください。

11111）））））湿気やほこりの多いところや、湿気やほこりの多いところや、湿気やほこりの多いところや、湿気やほこりの多いところや、湿気やほこりの多いところや、カビの発生カビの発生カビの発生カビの発生カビの発生
しやすい所しやすい所しやすい所しやすい所しやすい所

22222）））））直射日光が直接当たる所や、直射日光が直接当たる所や、直射日光が直接当たる所や、直射日光が直接当たる所や、直射日光が直接当たる所や、暖房器具の近暖房器具の近暖房器具の近暖房器具の近暖房器具の近
くくくくく

33333）））））夏の閉め切った自動車の中夏の閉め切った自動車の中夏の閉め切った自動車の中夏の閉め切った自動車の中夏の閉め切った自動車の中
44444）））））強い磁気の発生している所強い磁気の発生している所強い磁気の発生している所強い磁気の発生している所強い磁気の発生している所

● CFカードを落としたり、強い衝撃を与えない
でください。

● CFカードを踏み付けたり、重いものを乗せな
いでください。

CFCFCFCFCFカードの取り扱い方法カードの取り扱い方法カードの取り扱い方法カードの取り扱い方法カードの取り扱い方法

MIDI OUTUSB HOSTCOMPACTFLASH CARDCOMPACTFLASH CARD

＜注意！＞＜注意！＞＜注意！＞＜注意！＞＜注意！＞：：：：：CFカードをスロットに差し込むとき
は、必ずカードの裏面が下になるよう差し込んで
ください。
CFカードの裏面には、下記図の矢印部分に指が
引っ掛かる程度の凸部があります。無理やり逆に
差し込むと破損の原因となりますので、ご注意く
ださい。

裏面裏面裏面裏面裏面

差し込む方向

凸部
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電源をオンする電源をオンする電源をオンする電源をオンする電源をオンする

電源（ACアダプタ、または電池）の準備ができたら、
MR-8mkII 本体の後面にある、 [POWER] スイッチを
“ON”位置にセットして、電源を入れます。

下記操作は、フォーマット済み（または未フォーマッ
ト）のCFカードが、スロットにセットされていること
を前提にしています。

POWER USB FOOT SW

ONDC IN
LIGHTOFF

12V INPUT A SELECT

INT MIC
GUITAR

MIC/LINE

ON
LIGHTOFF

フォーマット済み（または未フォーマット）のCFカー
ドをセットした状態で電源を入れると、MR-8mkIIが起
動を開始してそれぞれつぎの画面に変ります。

ソング・ネームは初期設定で仮ネームの “Song01”に
設定されていますが、後で任意に変更が可能です（☞
91ページ）。また、CFカードには最大99個のソング
が作成できます（☞23ページ）。

＜周辺機器が接続されている場合の注意＞＜周辺機器が接続されている場合の注意＞＜周辺機器が接続されている場合の注意＞＜周辺機器が接続されている場合の注意＞＜周辺機器が接続されている場合の注意＞
MR-8mkIIに周辺機器が接続されているときは、下記の
順で電源を入れてください。

●MR-8mkIIの [MASTER] フェーダーを下げる。
⬇

●外部入力機器の電源をオンにする。
⬇

●MR-8mkIIの電源をオンにする。
⬇

●外部モニター機器（アンプ内蔵SPなど）の電源をオ
ンにする。

“ON”ポジション

この画面が表示された場合は、画面の指示に従って
[RECORD] キーを押しながら [MENU/ENTER] キーを
押してください。カードのフォーマットが実行され、終
了と同時に MENUモードの“Song”メニューへ進み、
Newソング（Song01）を作成する画面に変ります。

●未フォーマットの●未フォーマットの●未フォーマットの●未フォーマットの●未フォーマットのCFCFCFCFCFカードを使用時カードを使用時カードを使用時カードを使用時カードを使用時：：：：：
未フォーマットのCFカードをセットして電源を入れた
場合は、“Illegal Format! E01”を表示した後、下記画
面で立ち上がります。これは、セットしているCFカー
ドが「未フォーマット」であることを認識し、自動的に
MENUモードの “System”メニューにある“Card
Format”に入ったことを示しています。

＜注意！＞＜注意！＞＜注意！＞＜注意！＞＜注意！＞：：：：：CFカードがスロットに挿入されていない
状態で電源をオンしたときは、下記ワーニングが表示
されます。この場合、画面の指示に従って [MENU/
ENTER] キーを押してください。次のようなHome画
面に変り、スロットにカードがセットされていないこ
とを示します。

一旦電源をオフにしてからCFカードをセットして、再
度電源をオンにしてください。

この画面では、ソング・モードとソング・ネームを設定
して、Newソングを作成することができます。

「ソング・モード」と、「ソング・ネーム」の設定につい
ては、この後23ページに記載されている「Newソング
を作成」の操作-5～9を参照してください。

点滅

点滅

●フォーマット済みの●フォーマット済みの●フォーマット済みの●フォーマット済みの●フォーマット済みのCFCFCFCFCFカードを使用時カードを使用時カードを使用時カードを使用時カードを使用時：：：：：
フォーマット済みのCFカードをセットして電源を入れ
た場合は、下記Home画面で立ち上がります。フォー
マット済みのCFカードでは、あらかじめ“Normalモー
ド”のソングが一つ作成されており、この画面が表示さ
れている状態であれば、MR-8mkIIを使ってすぐに録音
作業へ入ることができます（☞35ページ）。
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電源をオフするときは、MR-8mkIIが停止しているこ
とを確認してください。
周辺機器が接続されている場合には、電源をオンし
た時と逆の手順で電源を切ってください。

＜注意！＞＜注意！＞＜注意！＞＜注意！＞＜注意！＞：：：：：CFカードがアクセスしているときに
電源を切ると、録音されているソング、あるいはCF
カード自体が破損する危険があります。

なお、MR-8mkIIでは電源をオフする前にシャット・
ダウンの操作は必要ありません。電源をオフする前
まで録音していたデータは残っていますので、安心
して電源を切ることができます。

電源をオフする電源をオフする電源をオフする電源をオフする電源をオフする

＜周辺機器が接続されている場合の注意＞＜周辺機器が接続されている場合の注意＞＜周辺機器が接続されている場合の注意＞＜周辺機器が接続されている場合の注意＞＜周辺機器が接続されている場合の注意＞
MR-8mkIIに周辺機器が接続されているときは、下記の
順で電源を切ってください。

●外部モニター機器（アンプ内蔵SPなど）の電源をオ
フにする。

⬇

●MR-8mkIIの電源をオフにする。
⬇

●外部入力機器の電源をオフにする。

MR-8mkIIを電池で駆動しているとき、電池が消耗し
てくると“Low Battery! ”がソング・ネーム表示部
に点滅するようになります。
これは、電池の交換を警告していますので、作業を
中断して、電池を入れ替えてください。

＜注意！＞＜注意！＞＜注意！＞＜注意！＞＜注意！＞：“Low Battery! ”が点滅したまま作業を続
けると電池がなくなり、下記のようなワーニング・メッ
セージを表示したまま、いかなる操作も受け付けなく
なります。電池の交換は早めに行ってください。

点 滅

電池の不足表示電池の不足表示電池の不足表示電池の不足表示電池の不足表示

MR-8mkII には、バックライト機能を搭載していま
す。暗い場所でディスプレイが見づらいときは、
[POWER] スイッチを“LIGHT”に切り替えてくださ
い。ディスプレイのバックライトが点灯します。

＜注意！＞＜注意！＞＜注意！＞＜注意！＞＜注意！＞：：：：：MR-8mkIIを電池で駆動しているときは、
必要以外にバックライトを点灯しないでください。
電池が消耗し、MR-8mkIIの動作時間が短くなります。

バックライトの点灯バックライトの点灯バックライトの点灯バックライトの点灯バックライトの点灯

POWER USB FOOT SW

ONDC IN
LIGHTOFF

12V INPUT A SELECT

INT MIC
GUITAR

MIC/LINE

ON
LIGHTOFF

“LIGHT”ポジション

また、本機にはディスプレイのコントラストを調整
する機能も備えています。詳細はこの後32ページを
お読みください。

“OFF”ポジション

POWER USB FOOT SW

ONDC IN
LIGHTOFF

12V INPUT A SELECT

INT MIC
GUITAR

MIC/LINE

ON
LIGHTOFF
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44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを     “““““---: (New---: (New---: (New---: (New---: (New
Song)Song)Song)Song)Song)”””””に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押キーを押キーを押キーを押キーを押
します。します。します。します。します。
Newソングのソング・モードと、ソング・ネームを
設定する画面に変ります。初期設定のソング・モー
ドは“Normal”で、ソング・ネームが“Song02”に
なっています（フォーマット直後は“Song01”）。

Normal
モード

LP
モード

FS 44.1kHz 16bitで音質を優先したモー
ドです。

FS 22.05kHz 16bitで録音時間を優先し
たモードで、Normalモードより長い録音
時間が確保できます。
＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：LPLPLPLPLPモードで録音したソングモードで録音したソングモードで録音したソングモードで録音したソングモードで録音したソング・・・・・
データは、データは、データは、データは、データは、後述の外部後述の外部後述の外部後述の外部後述の外部CD-R/RWCD-R/RWCD-R/RWCD-R/RWCD-R/RWドライドライドライドライドライ
ブを使ってオーディオブを使ってオーディオブを使ってオーディオブを使ってオーディオブを使ってオーディオCDCDCDCDCDを作成できまを作成できまを作成できまを作成できまを作成できま
せんせんせんせんせん

点滅

NewNewNewNewNewソングの作成ソングの作成ソングの作成ソングの作成ソングの作成
CFカード上に、ソング1（Song01）以外の新たなソングを作成します。下記操作は、MR-8mkIIがソング1
（Song01）の先頭で立ち上がっていることを前提にしています。なお、未フォーマットのCFカードにNewソ
ングを作成するには、前述21ページの要領でフォーマットを実行した後、＜操作-5＞～＜操作-9＞で「ソン
グ・モード」と「ソング・ネーム」を設定してください。

11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
MENUモードのメニュー選択画面に変ります。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルで“““““SongSongSongSongSong”””””にカーソルを移動にカーソルを移動にカーソルを移動にカーソルを移動にカーソルを移動
して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Songメニューの選択画面に変ります。

33333））））） “““““Select SongSelect SongSelect SongSelect SongSelect Song”””””が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、 [MENU/ [MENU/ [MENU/ [MENU/ [MENU/
ENTER] ENTER] ENTER] ENTER] ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ソングを選択する画面に変ります。
下記画面は、現在CFカード上にソング・ネーム
Song 01のソングが一つ作成されていることを示し
ています。“---: (New Song)”は、新たなソングを作
成するときに使用します。

55555））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでソングダイヤルでソングダイヤルでソングダイヤルでソングダイヤルでソング・・・・・モードを選択して、モードを選択して、モードを選択して、モードを選択して、モードを選択して、
[MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押キーを押キーを押キーを押キーを押します。します。します。します。します。
[MENU/ENTER] キーを押すと、続いてNewソン
グの「ソング・ネーム」が入力可能になります。

ソング・モードは通常“Normal”に設定しますが、
用途に応じて“LP”も選択できます。

＜注意！＞＜注意！＞＜注意！＞＜注意！＞＜注意！＞：：：：：ソング・ネームは初期設定（仮ネー
ム）のまま（上記例では“Song02”）でも構いま
せん。仮ネームのままソングを作成しても、後で
任意に編集できます（91ページ）。初期設定のま
まソングを作成するには、ソング・モードを選択
した後 [MENU/ENTER] キーを三度続けて押して
ください（次ページ＜操作-9＞を参照）。

点滅

点滅
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77777））））） 文字入力キーで希望のソング文字入力キーで希望のソング文字入力キーで希望のソング文字入力キーで希望のソング文字入力キーで希望のソング・・・・・ネームを入力ネームを入力ネームを入力ネームを入力ネームを入力
します。します。します。します。します。
下記「ネームの入力例」を参照して、希望のソング・
ネームを入力します。文字／数字は最大16文字ま
で入力できます。

＜文字入力キー＞＜文字入力キー＞＜文字入力キー＞＜文字入力キー＞＜文字入力キー＞
MENUモードで機能する文字入
力キーとは、 左記 [PLAY MODE]
キーのように、キーの下に
“STU7”の文字／数字が表示さ
れているキーを指しています。ち
なみに [PLAY MODE] キーでは、
大文字の“S, T, U”、小文字の“s,
t, u”そして数字の“7”が入力で
きます。

STU7

PLAY MODE

＜文字入力キーの使用例＞＜文字入力キーの使用例＞＜文字入力キーの使用例＞＜文字入力キーの使用例＞＜文字入力キーの使用例＞
例として“Memory”というソング・ネームを入力
するには、下記の順でキーを押していきます。

1.1.1.1.1. [MNO5] [MNO5] [MNO5] [MNO5] [MNO5] キーキーキーキーキー →→→→→ “““““MMMMM”””””を入力を入力を入力を入力を入力
⬇

22222..... [[[[[DDDDDEEEEEFFFFF22222]]]]]     キキキキキーーーーー →→→→→ “““““eeeee”””””ををををを入入入入入力力力力力
⬇

33333..... [[[[[MMMMMNNNNNOOOOO55555]]]]]     キキキキキーーーーー →→→→→ “““““mmmmm”””””ををををを入入入入入力力力力力
⬇

44444..... ジジジジジョョョョョグググググ・・・・・ダダダダダイイイイイヤヤヤヤヤルルルルル →→→→→ カカカカカーーーーーソソソソソルルルルルををををを移移移移移動動動動動
⬇

55555..... [[[[[MMMMMNNNNNOOOOO55555]]]]]     キキキキキーーーーー →→→→→ “““““ooooo”””””ををををを入入入入入力力力力力
⬇

66666..... [[[[[PPPPPQQQQQRRRRR66666]]]]]     キキキキキーーーーー →→→→→ “““““rrrrr”””””ををををを入入入入入力力力力力
⬇

77777..... [[[[[YYYYYZZZZZ99999]]]]]     キキキキキーーーーー →→→→→ “““““yyyyy”””””ををををを入入入入入力力力力力

ネームの入力例ネームの入力例ネームの入力例ネームの入力例ネームの入力例

＜注意！＞＜注意！＞＜注意！＞＜注意！＞＜注意！＞：：：：：上記例のように、１つのキーで入力
できる文字が連続するときは、一文字入力ごとに
ジョグ・ダイヤルでカーソルを移動してくださ
い。入力するキーが異なる場合は、キーを押すと
自動的にカーソルが移動します。

なお、ソング・ネームを8文字以下で設定する場
合、ネームに“+”記号は使用できません（例：
AAA+BBB）。ただし、8文字以上のネームをつけ
るときは“+”記号を使うことが可能です（例：
AAA+BBBBB）。

88888））））） ネームを入力した後、ネームを入力した後、ネームを入力した後、ネームを入力した後、ネームを入力した後、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーをキーをキーをキーをキーを
押します。押します。押します。押します。押します。
入力したネームに設定され、カーソルが画面下の
“[ENTER]”に移動します。

＜注意！＞＜注意！＞＜注意！＞＜注意！＞＜注意！＞：：：：：既に存在するソング・ネームと同
じネームを設定しようとすると、 “Illegal Song
Name!”を表示して警告し、入力画面に変りま
す。そのような場合には、再度ネームを入力し
直してください。

99999））））） “““““[ENTER][ENTER][ENTER][ENTER][ENTER]”””””が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、 [MENU/ [MENU/ [MENU/ [MENU/ [MENU/
ENTER] ENTER] ENTER] ENTER] ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
2つめのソング（ソング・ネーム：Memory）が作
成されると同時にMENUモードから抜け出し、新
たに作成したソング02のHome画面に変ります。
下記Home画面は、初期設定のソング・モード
（Normal)で作成した場合の例です。

このように、録音を始める前に複数のソングを作成
することができます。
なお、カード上に複数のソングを作成した場合は、
録音／編集などの作業を行う前に、希望のソングに
切り替えることが必要です。

希望のソングを選択するには、90ページ「希望の希望の希望の希望の希望の
ソングを選択するソングを選択するソングを選択するソングを選択するソングを選択する」を参照してください。

＜注意！＞＜注意！＞＜注意！＞＜注意！＞＜注意！＞：：：：：ソング・モードを“LPモード”に
設定して作成されたソングは、下記例のように
Home画面上に“ ”アイコンが点灯します。
「ノーマル・モード」と「LPモード」が容易に
区別できます。

66666））））） [UNDO/REDO] / [DELETE]  [UNDO/REDO] / [DELETE]  [UNDO/REDO] / [DELETE]  [UNDO/REDO] / [DELETE]  [UNDO/REDO] / [DELETE]  キーを押していき、キーを押していき、キーを押していき、キーを押していき、キーを押していき、
現在表示されている仮ネームを削除します。現在表示されている仮ネームを削除します。現在表示されている仮ネームを削除します。現在表示されている仮ネームを削除します。現在表示されている仮ネームを削除します。
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各部の名称と働き各部の名称と働き各部の名称と働き各部の名称と働き各部の名称と働き
ここでは、MR-8mkIIのトップ・パネル／リア・パネル／サイド・パネルなど
の各部の名称と機能、およびディスプレイ部の詳細について記載しています。
「この操作キーはどんな役目をするのかな？・・・・」と、疑問に思ったとき
にお読みください。
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3. [STEREO OUT L, R] 端子（PHONEジャック）
ステレオ・バス（L, R）の信号を出力します。
外部モニター機器やマスターレコーダーと接続しま
す（☞44ページ）。出力レベルは [MASTER] フェー
ダーでコントロールします。

4. [PHONES] 端子（STEREO PHONEジャック）
ヘッドホンを接続します。2台のヘッドホンが同時
に使用できます。

5. [PHONES VOL] つまみ
ヘッドホンの音量を調整します。

6. [REVERB / DELAY TIME] つまみ
リバーブ・タイムまたはディレイ・タイムを調整す
るときに使用します。
エフェクト・タイプに“ROOM”、“HALL”または
“PLATE”が選択されているときはリバーブ・タイ
ムが調整でき、“DELAY”が選択されているときは
ディレイ・タイムが調整できます（☞62ページ）。

7. [EFFECT (ROOM/HALL/PLATE/DELAY)] キー
リバーブまたはディレイの、エフェクト・タイプを
選択するとき使用します。
エフェクト・タイプには3つのリバーブ（“ROOM”、
“HALL”、“PLATE”）と、1つのディレイ（“DELAY”）
から選択でき、選択されたキーのランプが点灯しま
す（☞61ページ）。

1. [INPUT A] 端子（XLRコネクタ/PHONEジャック）
ギター、マイク、キーボードなどの外部出力を接続
します（ギターの出力は [UNBAL/GUITAR] 端子へ
接続します）。
[INPUT A] にはバランス入力端子（XLRコネクタ）
とアンバランス入力端子（PHONEジャック）があ
り、接続する音源に合わせて選択できます。ただし、
XLRとPHONEを同時に接続した場合は、PHONE
が優先となります。
[INPUT A] 端子を使うときは、リアパネルにある
[INPUT A SELECT] スイッチを“MIC/LINE”また
は “GUITAR”に切り替えます（“INT MIC”に切
り換えたときは使用できません（☞ 36ページ）。
モノ・トラックへ録音するときは、 [INPUT A] 端子
のみが使用でき、ステレオ・トラックに録音すると
きは [INPUT A] および [INPUT B] 端子が使用でき
ます。

2. [INPUT B] 端子（XLRコネクタ/PHONEジャック）
マイク、キーボードなどの外部出力を接続します。
[INPUT B] にはバランス入力端子（XLRコネクタ）
とアンバランス入力端子（PHONEジャック）があ
り、接続する音源に合わせて選択できます（☞36
ページ）。ただし、XLRとPHONEを同時に接続し
た場合は、PHONEが優先となります。
[INPUT B] 端子は、ステレオ・トラックへ録音する
ときのみ使用でき、モノ・トラックの録音時には使
用できません。

トップトップトップトップトップ・・・・・パネルパネルパネルパネルパネル11111
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8. [MASTER] フェーダー
ステレオ・バス（L, R）の出力レベルを調整します
（☞38～44ページ）。

9. トラック・フェーダー
トラック1～8の再生レベルを調整します。
トラック5/6および7/8は、１つのフェーダーで2
つのトラックが調整できます（☞38～44ページ）。

10. [REC SELECT] キー
録音トラックを選択するとき押します。
同時録音可能なトラック数は2つで、キーを押すご
とにON/OFFが交互に切り替わります。トラック
5/6と7/8は、１つのセレクト・キーで2つのトラッ
クが選択できます（☞37～44ページ）。

11. [PAN] つまみ
トラック再生音（1～4）の定位（L/Rバランス）
を設定します。

12. [EFFECT SEND] つまみ
トラック1～4の再生音に内蔵エフェクト（リバー
ブまたはディレイ）をかけるとき、各トラックのド
ライ音を内蔵エフェクト（リバーブ／ディレイ）に
送る量を調整します（☞62ページ）。

13. インサート・エフェクト選択キー
[INPUT A] の入力信号に、インサート・エフェクト
（マイク・シミュレート／アンプ・シミュレート）を
かけるとき使用します。リアパネルにある [INPUT
A SELECT] スイッチを“MIC/LINE”に設定したと
きは、マイクのシミュレートが可能で、“GUITAR”
に設定したときはギターアンプのシミュレートが可
能になります（☞60ページ）。

14. 内蔵マイク
内蔵マイクで録音するときは、リアパネルにある
[INPUT A SELECT] スイッチを“INT MIC”に切
り換えます（☞36ページ）。なお、内蔵マイクを使
用するときは、インサート・エフェクトは機能しま
せん。

15. [DISTORTION] つまみ
[INPUT A SELECT] スイッチを"GUITAR"に設定し
たときのみ有効で、 [INPUT A] 端子に入力する、ギ
ター演奏の「ひずみ具合」が調整できます（☞36、
38ページ）。

16. [TRIM] つまみ／[PEAK] LED
[INPUT A] および [INPUT B] の、各入力ゲインを
調整します（☞36～44ページ）。
[INPUT A] および [INPUT B] の入力ゲインがオー
バーしているとき、 [PEAK] LEDが点滅（点灯）し
ます（☞15ページ）。LEDが点滅（点灯）しないよ
う、 [TRIM] つまみで入力ゲインを調整します。

トップトップトップトップトップ・・・・・パネルパネルパネルパネルパネル22222
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17. [RHYTHM GUIDE] キー
リズム・ガイドのオン／オフを切り換えます（☞76
ページ）。キーを押すごとにオン／オフが交互に切
り替ります。また、キーを押し続けるとリズム・ガ
イドのパラメータを設定するリズムガイド・メニュ
ーへ進みます（☞76ページ）。

18. [1-4 > 5/6, 1-6 > 7/8] / [A B C 1] キー
トラック1～4をトラック5/6にバウンスする“1-
4>5/6”モード、あるいはトラック1～6をトラッ
ク7/8にバウンスする“1-6>7/8”モードを選択す
るとき使用します（☞68ページ）。キーを押すごと
に、“1-4>5/6”モード→“1-6>7/8”モード→“OFF”
を交互に切り換えできます。また、MENUモードに
おいては“A、 B、C、a、b、c、1”の入力キーとし
て機能します。

19. [TIME BASE SELECT] キー
ディスプレイのタイム・ベース表示（タイム表示と
Bar Beat表示）を切り換えます（☞ 32ページ）。
キーを押すごとに、タイム・ベース表示が切り替り
ます。

20. [1-8 > NEW SONG] / [D E F 2] キー
トラック1～8に録音した演奏を、Newソングのト
ラック7/8にバウンスするとき使用します（☞73
ページ）。また、MENUモードにおいては“D、E、
F、d、e、f、2”の入力キーとして機能します。

21. [CONTRAST] キー
このキーを押しながらジョグ・ダイヤルを回すと、
ディスプレイのコントラストが調整できます（☞
32ページ）。

22. [7/8>STEREO WAV FILE] / [G H I 3] キー
トラック7/8に録音したモノWAVファイルを、ス
テレオWAVファイルに変換するとき使用します
（☞116ページ）。変換されたステレオWAVファイ
ルは、USB接続でパソコンへ取り込むことができま
す（☞118ページ）。また、MENUモードにおいて
は“G、H、I、g、h、i、3”の入力キーとして機能
します。

23. LCDディスプレイ
132×64ドットのLCDで、各種情報を表示します
（☞31ページ）。

24. ジョグ・ダイヤル
MENUモードにおけるカーソルの移動や、設定項目
の選択時に使用します。

25. [MASTERING] キー
バウンスまたはミックスダウンするときの、マスタ
リング・エフェクトを選択するとき使用します。
マスタリン・エフェクトのタイプは3つあり、希望
のキーを押して選択します（☞63ページ）。また、
[POWERFUL] キーと [NATURAL] キーは、MENU
モードにおいて“J、K、L、j、k、l、4”および“M、
N、O、m、n、o、5”の入力キーとして機能します。

26. [MENU/ENTER] キー
MENUモードへ入るとき押します。
また、MENUモードにおいては、設定を確定すると
きの [ENTER] キーとして機能します。

27. [STORE] / [+ - _ 0] キー
現在のレコーダ位置（タイム・データ）を、LOCATE
A/INポイントまたはLOCATE B/OUTポイントと
して登録するとき使用します（☞51、56ページ）。
また、MENUモードにおいては“+、-、_、0”の入
力キーとしても機能します。

28. [UNDO/REDO] / [DELETE] キー
録音や編集をやり直したいときに使用します（☞
39、41、43、95、103ページ）。キーを押すごと
にアンドウ／リドウを繰り返します。
また、MENUモードにおいては、文字／記号などの
削除キーとしても機能します（☞23、91ページ）。

29. [LOCATE B/OUT] / [G H I 3] キー
LOCATE Bポイント（またはパンチアウト・ポイント）
を登録するとき、 [STORE] キーを押しながらこのキー
を押します（☞51、56ページ）。ダイレクトにこの
キーを押すと、Locate Bポイントへロケートしま
す。また、MENUモードにおいては“G、H、I、g、h、
i、3”の入力キーとしても機能します。

30. トランスポート・キー

[PLAY] キー
レコーダーを再生するとき押します。
[RECORD] キーを押しながらこのキーを押すと、
READYトラックの録音が始まります。録音中にこ
のキーを押すと、録音は解除されます。

[STOP] キー
レコーダーを停止させるとき押します。
このキーを押しながら、 [PLAY] キー、 [REWIND]
キー、あるいは [F FWD] キーを押すと、それぞれ
下記の動作を実行します。

●●●●● [STOP] + [PLAY] (A - B PLAY) [STOP] + [PLAY] (A - B PLAY) [STOP] + [PLAY] (A - B PLAY) [STOP] + [PLAY] (A - B PLAY) [STOP] + [PLAY] (A - B PLAY)
LOCATE AポイントとLOCATE Bポイント間を再
生します（☞46ページ）。

●●●●● [STOP] + [REWIND] (LOCATE ABS ZERO) [STOP] + [REWIND] (LOCATE ABS ZERO) [STOP] + [REWIND] (LOCATE ABS ZERO) [STOP] + [REWIND] (LOCATE ABS ZERO) [STOP] + [REWIND] (LOCATE ABS ZERO)
現在立ち上がっているソングの先頭 (ABS ZERO) に
ロケートします（☞50ページ）。

●●●●● [STOP] + [F FWD] (LOCATE REC END) [STOP] + [F FWD] (LOCATE REC END) [STOP] + [F FWD] (LOCATE REC END) [STOP] + [F FWD] (LOCATE REC END) [STOP] + [F FWD] (LOCATE REC END)
現在立ち上がっているソングの最終録音位置（REC
END）へロケートします（☞ 50ページ）。

[RECORD] [RECORD] [RECORD] [RECORD] [RECORD] キーキーキーキーキー
[RECORD] キーを押しながら [PLAY] キーを押す
と、READYトラックの録音が始まります。
また、いずれかのトラックが録音トラックに選択さ
れている状態でこのキーのみを押すと、選択されて
いるトラックがインプットモニターになります（☞
38～43ページ）。
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[F FWD] キー
[F FWD] キーを押すと、早送りになります。
再生中にこのキーを押すと、フォワード方向へ3倍
速のキューイングができます（☞46ページ）。
[STOP] キーを押しながらこのキーを押 すと、ソン
グの最終録音位置（REC END）へロケートします
（☞50ページ）。

[REWIND] キー
[REWIND] キーを押すと、逆戻しになります。
再生中にこのキーを押すと、リワインド方向へ3倍
速のキューイングができます（☞46ページ）。
[STOP] キーを押しながらこのキーを押すと、ソン
グの先頭 (ABS ZERO) へロケートします（☞50
ページ）。
また、MENUモードの階層画面が表示されていると
き、 [REWIND] キーを押すごとに一つ前の階層画面
に戻ることができます。

31. [LOCATE A/IN] / [V W X 8]  キー
LOCATE Aポイント（またはパンチイン・ポイント）
を登録するとき、 [STORE] キーを押しながらこの
キーを押します（☞51、56ページ）。ダイレクトに
このキーを押すと、Locate Aポイントへロケートし
ます。また、MENUモードにおいては“V 、W、 X、
v、w、x、8”の入力キーとしても機能します。

32. [AUTO PUNCH] ／ [P Q R 6] キー
オート・パンチ・モードのON/OFFを切り替えます
（☞57ページ）。また、MENUモードにおいては“P、
Q、R、p、q、r、6”の入力キーとしても機能しま
す。

33. [PLAY MODE] / [S T U 7] キー
プレイ・モード（ノーマル／オート・プレイ／オー
ト・リターン／ループ）を切り替えます（☞47ペー
ジ）。また、MENUモードにおいては“S、T、U、s、
t、u、7”の入力キーとしても機能します。

リアリアリアリアリア・・・・・パネルパネルパネルパネルパネル

1. [DC IN] 端子
付属のACアダプタを接続します（☞20ページ）。

4. [FOOT SW] 接続端子（TRS PHONEジャック）
アンラッチ・タイプのフットスイッチを接続します
（☞55ページ）。

2. [POWER] スイッチ
本機の電源をオン／オフします（☞21ページ）。
電源をオンした後、 “LIGHT”ポジションにすると、
ディスプレイのバックライトが点灯します。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：長期間使用しない場合は、ACアダプタ
をコンセントから抜くようにしてください。

3. [USB] 端子（USB Bタイプ）
USBケーブル（別売）を使ってパソコンと接続し、
MR-8mkIIとPC間でソング・ファイルのやり取りが
行なえます（☞115ページ）。

POWER USB FOOT SW

ONDC IN
LIGHTOFF

12V INPUT A SELECT

INT MIC
GUITAR

MIC/LINE

1 2 3 4 5

XLR-3-31コネクタとPHONEジャック
のいずれかの端子が使用できます（注
意：PHONEジャックが優先）。
[TRIM] つまみで入力レベルを調整しま
す。このポジションに設定したときは、
マイク・シミュレートのインサート・エ
フェクトが使用できます。

MIC/LINE

GUITAR

INT MIC

XLR-3-31コネクタとPHONEジャック
のいずれかの端子が使用できます（注
意：PHONEジャックが優先）。  [TRIM]
つ ま みで入力レベルを調整し、
[DISTORTION] つまみで歪みの調整が
できます。このポジションに設定した
ときは、アンプ・シミュレートのイン
サート・エフェクトが使用できます。

内蔵マイクのみが有効となり、 [TRIM] つ
まみで入力レベルを調整します。このポ
ジションでは [INPUT A] 端子、および
インサート・エフェクトは機能しませ
ん。

5. [INPUT A SELECT] スイッチ
[INPUT A] 端子の入力を切り替えます（☞36ペー
ジ）。
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3. [MIDI OUT] 端子（DIN 5ピンコネクタ）
外部MIDI機器（MIDIシーケンサーなど）のMIDI IN
端子と接続します（☞ 86ページ）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：　　　　　[USB HOST] 端子には、パソコンを
接続しないでください

サイドサイドサイドサイドサイド・・・・・パネルパネルパネルパネルパネル（（（（（右右右右右）））））

1. カード・スロット
コンパクトフラッシュ・カードを差し込みます（☞
20ページ）。

2. [USB HOST] 端子（USB Aタイプ）
外部CD-R/RWドライブを接続し、MR-8mkIIで録
音した曲のオーディオCD（CD-DAフォーマット）
が作成できます（☞123ページ）。

MIDI OUTUSB HOSTCOMPACTFLASH CARD

21 3

ボトムボトムボトムボトムボトム・・・・・パネルパネルパネルパネルパネル

1. 電池収納部
MR-8mkIIを電池で駆動する場合、市販のアルカリ
電池（単3×6本）を収納します（☞18ページ）。

OPEN

1

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：　　　　　MR-8mkIIを長期間使用しないときは、
電池を取り出すようにしてください。長期間入れた
ままにしておくと、液漏れなどの原因となります。
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MR-8mkIIの電源をオンにすると、起動ディスプレイ（MR-8mkIIを立ち上げる過程を示す表示）を表示した後、前回
電源をオフしたときのタイムベース（タイム表示、またはBar/Beat表示）で立ち上がり、ソングの先頭を表示しま
す。MR-8mkIIでは、電源投入後のLCD表示を「Home画面」と呼び、各エリアにはつぎの情報が表示されます。

LCDディスプレイの主な表示内容、およびその操作について説明します。

① タイムタイムタイムタイムタイム・・・・・カウンター表示部カウンター表示部カウンター表示部カウンター表示部カウンター表示部
時間情報（レコーダーの位置）を、タイム（ABS）、
またはBar/Beatのいずれかのタイムベースで表示
します（初期設定ではBar/Beatを表示します）。
タイムベースは、 [TIME BASE SELECT] キーで交
互に切り替えできます。
また、停止以外でトランスポート部が何らかの動作
状態（再生、停止など）にあるときは、その動作状
況を示すアイコン（再生=●、停止=■など）も表
示します。さらに、カードがアクセス中は“ ACC ”
アイコンも点灯します。

⑥ ソングソングソングソングソング・・・・・ナンバー表示部ナンバー表示部ナンバー表示部ナンバー表示部ナンバー表示部
現在立ち上がっているソングのソング・ナンバーを
表示します。また、ファントム電源の供給がONに

なっているときは、“ ”アイコンが点灯します
（☞137ページ）。

④ ステレオステレオステレオステレオステレオ・・・・・バスバスバスバスバスL, RL, RL, RL, RL, Rレベル表示部レベル表示部レベル表示部レベル表示部レベル表示部
録音／再生時、ステレオ・バスL, Rのレベルを表示
します。

⑤ ソングソングソングソングソング・・・・・ステータス表示部ステータス表示部ステータス表示部ステータス表示部ステータス表示部
インプット・モニターやオート・パンチ・モードな
ど、ソングが現在どのモードの状態になっているか
を、下記例のようなアイコンを点灯して表示しま
す。

ソングの任意のトラックが、イン
プット・モニターになっていると
き点灯します（☞39、41、43ペー
ジ）。

ソングのオート・パンチ・モードが
オンのとき点灯します（☞57ペー
ジ）。

ソングのオート・リターン・モード
がオンのとき点灯します（☞ 47
ページ）。

③ トラックトラックトラックトラックトラック11111～～～～～88888レベル表示部レベル表示部レベル表示部レベル表示部レベル表示部
トラック1～8の録音／再生レベルを表示します。

このリメインは、モノ・トラックであと何分何秒録
音できるかという、コンパクト・フラッシュカード
の録音可能な残時間を表しています。

② キャラクター表示部キャラクター表示部キャラクター表示部キャラクター表示部キャラクター表示部
通常は、現在立ち上がっているソングの、ソング・
ネームを表示します（最大16文字までを表示）。
また、バウンスなどのモード名（例：“BOUNCE 1-
6->7/8”など）や、軽度のワーニング・メッセージ
を表示します。さらには、いずれかのトラックが録
音トラックに選択（[REC SELECT] キーをONにし
たとき）されると、下記例のようなリメインを表示
します。

ソングのループ・モードがオンの
とき点灯します（☞47ページ）。

HomeHomeHomeHomeHome画面画面画面画面画面

ソングのオートプレイ・モードが
オンのとき点灯します（☞47ペー
ジ）。

1

2

3 4

5

6

LCDLCDLCDLCDLCDディスプレイディスプレイディスプレイディスプレイディスプレイ
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Home画面の状態で [TIME BASE SELECT] キーを押すごとに、タイムベースが交互に切り替えできます。

タイム表示のHome画面

Bar/Beat表示のHome画面

ディスプレイのコントラストは、 [CONTRAST] キーを押しながら、ジョグ・ダイヤルを回して調整します。
ジョグ・ダイヤルを時計方向へ回していくとコントラストが強くなり、反時計方向へ回していくと弱くなります。

ジョグ・ダイヤル

[CONTRAST] キー

[TIME BASE SELECT] キー

コントラスト強

コントラスト弱

タイムベース表示の切り換えタイムベース表示の切り換えタイムベース表示の切り換えタイムベース表示の切り換えタイムベース表示の切り換え

ディスプレイのコントラスト調整ディスプレイのコントラスト調整ディスプレイのコントラスト調整ディスプレイのコントラスト調整ディスプレイのコントラスト調整

[CONTRAST] キーを押している間、ディスプレイには
“CONTRAST -> DIAL”が表示されます。

LOCATE

MNO5JKL4

BRIGHTNATURALPOWERFUL MENU/ENTER

MASTERING

GHI3DEF2ABC1

7/8 WAV FILE
STEREO1-4

1-6
NEW
SONG1-8

GUIDE
RHYTHM CONTRASTTIME BASE

SELECT

BOUNCE

5/6
7/8

LOCATE

MNO5JKL4

BRIGHTNATURALPOWERFUL MENU/ENTER

MASTERING

GHI3DEF2ABC1

7/8 WAV FILE
STEREO1-4

1-6
NEW
SONG1-8

GUIDE
RHYTHM CONTRASTTIME BASE

SELECT

BOUNCE

5/6
7/8
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MR-8mkII を操作中、問題性の高いワーニングが発生したときに表示します。この表示は、一部を除き [MENU/
ENTER] キーが押されるまで表示されます。なお、軽度のワーニングが発生したときは下記以外にポップアップ表示
される項目もあります。

停止状態で [MENU/ENTER] キーを押すと、各種設定や編集を実行するためのMENU画面に変り、用途に応じた設
定や編集が実行できます。MENU選択画面は2ページで構成され、 ジョグ・ダイヤルで希望の設定MENUを選択し
ます。

[MENU/ENTER] キー

1ページめのMENU選択画面

プロテクトのかかって
いるソングを削除しよ
うとしたときに警告し
ます。

操作中、何らかの理由
でCFカードが不良に
なったときに警告しま
す。

トラックの編集やパー
トの編集などを実行し
ようとしたとき、CF
カードにアンドウする
ための空き容量がない
ことを警告します。

録音時、CFカードに記
録できる空き容量がな
くなったときに警告し
ます。

録音時や編集時、ソン
グにプロテクトがか
かっているときに警告
します。

Newソングの作成時、
CFカード上に既に99
個のソングが存在して
いるときに警告しま
す。

2ページめのMENU選択画面

MENUMENUMENUMENUMENUモード画面モード画面モード画面モード画面モード画面

ワーニング表示ワーニング表示ワーニング表示ワーニング表示ワーニング表示

LOCATE

MNO5JKL4

BRIGHTNATURALPOWERFUL MENU/ENTER

MASTERING

GHI3DEF2ABC1

7/8 WAV FILE
STEREO1-4

1-6
NEW
SONG1-8

GUIDE
RHYTHM CONTRASTTIME BASE

SELECT

BOUNCE

5/6
7/8

ジョグ・ダイヤル

電池で駆動していると
き、電池が消耗してき
たとき警告します。
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基本的な録音操作基本的な録音操作基本的な録音操作基本的な録音操作基本的な録音操作
ここでは、「MR-8mkIIを使った基本的な多重録音の方法」について記載してい
ます。

はじめてマルチトラッカーをお使いになる方はこの「基本的な録音操作」をお
読みいただき、MR-8mkIIの基本的な操作方法に慣れた後、他の操作方法へお
進みください。
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BRIT STACK US METAL 60'S COMBO
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TUBECONDENSERDYNAMIC
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/GUITAR
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TRIM TRIM

BAL

INPUT A INPUT B

PHONES VOL

L
ST OUT

R

2
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MIN MAX

EFFECT
REVERB/DELAY TIME

INPUT A SELECT

AMP SIMULATION

MIC SIMULATION

PEAK

音源の接続音源の接続音源の接続音源の接続音源の接続
MR-8mkIIには、 [INPUT A] と [INPUT B] の2つの入力端子を装備しており、録音する音源やトラックに合わ
せて、使い分けます。また、 [INPUT A] では2つの入力端子以外に「内蔵マイク」も使用できます。コンデン
サ・マイクを使うときはバランス（XLR）コネクタを使用し、ファントム電源を供給することが可能です（☞
128ページ）。

[INPUT A][INPUT A][INPUT A][INPUT A][INPUT A]
XLR-3-31タイプのコネクタ（バランス）
またはPHONEジャック（アンバランス）
が使用できます（同時に接続した場合は
PHONEがジャックが優先となります）。
ギターの出力はPHONEジャックに接続
し、入力する音源に合わせて、 [INPUT A
SELECT] スイッチを切り換えます（次
ページ参照）。

[INPUT B][INPUT B][INPUT B][INPUT B][INPUT B]
XLR-3-31タイプのコネクタ（バランス）
またはPHONEジャック（アンバランス）
が使用できます（同時に接続した場合は
PHONEジャックが優先となります）。
入力する音源に合わせて、いずれかの入
力端子を使用します。

[TRIM] [TRIM] [TRIM] [TRIM] [TRIM] つまみつまみつまみつまみつまみ
[INPUT A] の入力レベル（録音レベル）
を調整します（内蔵マイク使用時も含
む）。PEAK LEDが点滅（または点灯）し
ないポジションが、最適なレベルです
（15ページ）。

[TRIM] [TRIM] [TRIM] [TRIM] [TRIM] つまみつまみつまみつまみつまみ
[INPUT B] の入力レ
ベル（録音レベル）を
調整します。
PEAK LEDが点滅（ま
たは点灯）しないポジ
ションが、最適なレベ
ルです（15ページ）。

[DISTORTION] [DISTORTION] [DISTORTION] [DISTORTION] [DISTORTION] つまみつまみつまみつまみつまみ
[INPUT A] 使用時（[INPUT A SELECT]
スイッチ：GUITAR）、ディストーション
（歪み）のかかり具合を調整できます。
例えば、 [PHONE] ジャックにギターを接
続して、ギター演奏に適度なディストー
ションをかけながら録音できます。

内蔵マイク内蔵マイク内蔵マイク内蔵マイク内蔵マイク
[INPUT A SELECT] ス
イッチを“INT MIC”に
切り替えると、 [INPUT
A] の音源に内蔵マイ
クが使用できます。
内蔵マイクを使うとき
は、 [INPUT A] の入力
コネクタは機能しませ
ん。

接続可能なコネクタの形状接続可能なコネクタの形状接続可能なコネクタの形状接続可能なコネクタの形状接続可能なコネクタの形状

PHONEプラグ

XLR-3-12Cタイプ

BRIT STACK US METAL 60'S COMBO

MIC

TUBECONDENSERDYNAMIC

INPUT A

LINE MIC MIN MAX LINE MIC

DISTORTION
GUITAR

UNBAL

BAL

UNBAL
/GUITAR

PEAK
TRIM TRIM

BAL

INPUT A INPUT B

PHONES VOL

L
ST OUT

R

2
PHONES

1

MIN MAX

EFFECT
REVERB/DELAY TIME

INPUT A SELECT

AMP SIMULATION

MIC SIMULATION

PEAK

モニター用のヘッドホンやアンプ内蔵のモニター・スピーカは、下の図のように [PHONES] ジャッ
ク（同時に2つのヘッドホンが使用できます）、および [STEREO OUT] ジャックへ接続してご使
用いただけます。

ヘッドホン

アンプ内蔵モニター
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[INPUT A] （または内蔵マイク）を使用するときは、用途に合わせて[INPUT A SELECT] スイッチを 切り換
えます。

“MIC/LINE”ポジション “GUITAR”ポジション “INT MIC”ポジション

外部マイクまたはライン・レベルの音源
を録音するとき“MIC/LINE”ポジション
に切り換えます。このポジションでは、マ
イク・シミュレーションのインサート・エ
フェクトが使用できます（☞60ページ）。

本機内蔵のディストーションをかけて録
音したいとき“GUITAR”ポジションに
切り換えます。このポジションでは、ア
ンプ・シミュレーションのインサート・エ
フェクトも使用できます（☞60ページ）。

内蔵マイクで録音するときは“INT MIC”ポ
ジションに切り換えます。
このポジションでは、 [INPUT A] の入力端
子（XLR/PHONE）は機能しません。また、
インサート・エフェクトも機能しません。

[INPUT A SELECT] [INPUT A SELECT] [INPUT A SELECT] [INPUT A SELECT] [INPUT A SELECT] スイッチの使い方スイッチの使い方スイッチの使い方スイッチの使い方スイッチの使い方

録音トラックの選択録音トラックの選択録音トラックの選択録音トラックの選択録音トラックの選択

POWER USB FOOT SW

ONDC IN
LIGHTOFF

12V INPUT A SELECT

INT MIC
GUITAR

MIC/LINE INPUT A SELECT

INT MIC
GUITAR

MIC/LINE

録音トラックは、 [REC SELECT] キーでモノ・トラックまたは同時に最大2つのトラックが選択できます。ト
ラック1～4はモノ録音に使用し、5-6（または7-8）はステレオ音源を録音するときに使用します。また、選
択するトラックによって、 [INPUT A] / [INPUT B] の入力端子がトラックに振り分けられます。

MAX MAX

REC SELECT

1 2 3 4 5/6 7/8 MASTER

[REC SELECT] [REC SELECT] [REC SELECT] [REC SELECT] [REC SELECT] キーキーキーキーキー

REC SELECT

1 2 3 4 5/6 7/8

REC SELECT

1 2 3 4 5/6 7/8

REC SELECT

1 2 3 4 5/6 7/8

REC SELECT

1 2 3 4 5/6 7/8

REC SELECT

1 2 3 4 5/6 7/8

REC SELECT

1 2 3 4 5/6 7/8

REC SELECT

1 2 3 4 5/6 7/8

REC SELECT

1 2 3 4 5/6 7/8

REC SELECT

1 2 3 4 5/6 7/8

REC SELECT

1 2 3 4 5/6 7/8

REC SELECT

1 2 3 4 5/6 7/8

REC SELECT

1 2 3 4 5/6 7/8

＜選択可能なモノ＜選択可能なモノ＜選択可能なモノ＜選択可能なモノ＜選択可能なモノ・・・・・トラック＞トラック＞トラック＞トラック＞トラック＞

＜同時に選択可能な＜同時に選択可能な＜同時に選択可能な＜同時に選択可能な＜同時に選択可能な22222トラック＞トラック＞トラック＞トラック＞トラック＞

トラック1 トラック2

トラック3 トラック4

トラック1と2

トラック1と3

トラック1と4

トラック2と3

●モノ・トラックへ録音するときは、
[INPUT A] （内蔵マイク含む）のみ
が使用可能で、 [INPUT B] は使用で
きません。

トラック2と4

トラック3と4

トラック5と6（１つのキーで選択できます）

トラック7と8（１つのキーで選択できます）

●2つのトラックへ同時に録音する
ときは、選択したトラックの若い順
に [INPUT A] および [INPUT B] が
振り分けられ、使用できます。
例えば、録音トラックをトラック5/
6に選択した場合、 インプット端子は
以下のように振り分けられます。

[INPUT A] [INPUT A] [INPUT A] [INPUT A] [INPUT A] ➡トトトトトラララララッッッッッククククク55555
[[[[[IIIIINNNNNPPPPPUUUUUTTTTT     BBBBB]]]]]     ➡トトトトトラララララッッッッッククククク66666
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＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：トラック1のフェーダーは、モニ
ター・レベルの調整に使用します。トラック1
の録音レベルを調整するには、 [INPUT A] の
[TRIM] つまみを使用します。

44444））））） トラックトラックトラックトラックトラック11111のフェーダーとのフェーダーとのフェーダーとのフェーダーとのフェーダーと [MASTER]  [MASTER]  [MASTER]  [MASTER]  [MASTER] フェーダーフェーダーフェーダーフェーダーフェーダー
を、を、を、を、を、“““““ ”””””位置まで上げておきます。位置まで上げておきます。位置まで上げておきます。位置まで上げておきます。位置まで上げておきます。
これは、トラック1のモニター音を出力するための
準備です。トラック・フェーダーと [MASTER]
フェーダーが上がっていないと、ヘッドホンからは
音が聴こえません。

ここでは例として、エレクトリック・ギターの演奏をトラック1へ録音してみましょう（他のトラックへも同
じ要領で行ってください）。下記操作は、CFカードがスロットに差し込まれ、録音するためのソング（Song01）
が立ち上がっていることを前提にしています。

11111））））） [INPUT A] [INPUT A] [INPUT A] [INPUT A] [INPUT A] 端子の端子の端子の端子の端子の [PHONE]  [PHONE]  [PHONE]  [PHONE]  [PHONE] ジャックに、ジャックに、ジャックに、ジャックに、ジャックに、ギターギターギターギターギター
の出力を接続します。の出力を接続します。の出力を接続します。の出力を接続します。の出力を接続します。

22222））））） [INPUT A SELECT] [INPUT A SELECT] [INPUT A SELECT] [INPUT A SELECT] [INPUT A SELECT] スイッチをスイッチをスイッチをスイッチをスイッチを“““““GUITARGUITARGUITARGUITARGUITAR”””””に切に切に切に切に切
り換えます。り換えます。り換えます。り換えます。り換えます。
“GUITAR”ポジションで使用するときは、内蔵ディ
ストーションで適度な歪みを加えたり、インサー
ト・エフェクト（アンプ・シミュレーション）をか
けて録音することができます（☞60ページ）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： キーボードなどのライン出力や、外
部マイクで録音するときは、 [INPUT A SELECT]
スイッチを“MIC/LINE”ポジションに切り換
え、内蔵マイクで録音するときは“INT MIC”ポ
ジションに切り換えます。“MIC/LINE”ポジ
ションに切り換えたときは、マイク・シミュ
レーションのインサート・エフェクトが使用で
きます（☞60ページ）。

これは、トラック1に [INPUT A] がアサインされ、
[INPUT A] の音源が録音可能になっていることを
示しています。

録音の準備録音の準備録音の準備録音の準備録音の準備

11111つのトラックに録音つのトラックに録音つのトラックに録音つのトラックに録音つのトラックに録音
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33333））））） トラックトラックトラックトラックトラック11111ののののの [REC SELECT]  [REC SELECT]  [REC SELECT]  [REC SELECT]  [REC SELECT] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
[REC SELECT] キーのランプが点滅するとともに
Home画面にはリメインが表示され、トラック表示
“1”が“A”に変わります。
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66666））））） この状態でギターを演奏しながら、この状態でギターを演奏しながら、この状態でギターを演奏しながら、この状態でギターを演奏しながら、この状態でギターを演奏しながら、 [TRIM]  [TRIM]  [TRIM]  [TRIM]  [TRIM] つまみつまみつまみつまみつまみ
で適正なゲインで適正なゲインで適正なゲインで適正なゲインで適正なゲイン（（（（（録録録録録音音音音音レレレレレベベベベベルルルルル）））））を調整します。を調整します。を調整します。を調整します。を調整します。
PEAK LEDが点灯しないよう [TRIM] つまみを調
整します。
[PHONES VOL] つまみを上げていくと、ヘッドホ
ンからモニター音が聴こえてきます。

Home画面のレベル・メータには、トラック1の入
力レベルとステレオ・アウトL、R（ステレオ・バ
スの出力）が、共に振れていきます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：トラック1のゲイン（録音レベル）
は、ギター演奏の音が最大のとき [PEAK] LED
が点灯しないよう設定してください。
[PEAK] LEDが点灯するときは入力オーバーを
示し、音が歪んだりノイズが多くなってしまい
ます。

＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞：：：：： [TRIM] つまみの調整は、ライ
ン入力の録音時に“LINE”ポジション側へ回す
と適正なゲインが得られ、マイクロホンでの録
音時では“MIC”ポジション側へ回すと適正な
ゲインが得られます。

77777））））） [RECORD] [RECORD] [RECORD] [RECORD] [RECORD] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [PLAY]  [PLAY]  [PLAY]  [PLAY]  [PLAY] キーを押しキーを押しキーを押しキーを押しキーを押し
て録音を開始します。て録音を開始します。て録音を開始します。て録音を開始します。て録音を開始します。
ギター演奏を録音していきます。

88888））））） 録音が終了したら、録音が終了したら、録音が終了したら、録音が終了したら、録音が終了したら、 [STOP]  [STOP]  [STOP]  [STOP]  [STOP] キーを押してキーを押してキーを押してキーを押してキーを押してMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII
を停止させます。を停止させます。を停止させます。を停止させます。を停止させます。

＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞：：：：： 録音終了後は、トラック1の
[REC SELECT] キーを押してREC READYを
解除しておきましょう。

録音の開始録音の開始録音の開始録音の開始録音の開始

99999））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [REWIND]  [REWIND]  [REWIND]  [REWIND]  [REWIND] キーを押しキーを押しキーを押しキーを押しキーを押し
て、て、て、て、て、ソングの先頭に戻します。ソングの先頭に戻します。ソングの先頭に戻します。ソングの先頭に戻します。ソングの先頭に戻します。

1010101010））））） [PLAY] [PLAY] [PLAY] [PLAY] [PLAY] キーを押して再生を開始します。キーを押して再生を開始します。キーを押して再生を開始します。キーを押して再生を開始します。キーを押して再生を開始します。
トラック1のフェーダーで再生レベルを調整し、録
音した演奏を聴いてみましょう。

録音したトラックの確認録音したトラックの確認録音したトラックの確認録音したトラックの確認録音したトラックの確認（（（（（再再再再再生生生生生）））））

＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞：：：：： もし、納得のゆく録音ができ
なかったときは、下記の「アンドウ／リドウ機
能」を使って、最初からやり直してください。

録音のやり直し録音のやり直し録音のやり直し録音のやり直し録音のやり直し（（（（（アアアアアンンンンンドドドドドウウウウウ／／／／／リリリリリドドドドドウウウウウ）））））

55555））））） [RECORD] [RECORD] [RECORD] [RECORD] [RECORD] キーを一度押しますキーを一度押しますキーを一度押しますキーを一度押しますキーを一度押します（（（（（キキキキキーーーーーのののののララララランンンンンプププププががががが
点点点点点滅滅滅滅滅）））））。。。。。
REC READYになっているトラック1がインプッ
ト・モニターになったことを示す“ ”
が、Home画面上に点灯します。

録音終了後 [UNDO/REDO] キーを押すと、録音する前
の状態に戻す（アンドウ）ことができ、最初から録音を
やり直すことが可能になります。
また、アンドウした後再度 [UNDO/REDO] キーを押す
と、録音した後の状態へ戻すこともできます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：アンドウ／リドウは、全ての録音に対して
有効ですが、録音終了後下記操作を行うと、アンドウ
／リドウできなくなりますので、ご注意ください。

● 新たな録音を行ったとき
● トラック編集やパート編集を行ったとき
● 電源をオフしたとき
● 他のソングをセレクトしたり、ソング・ネームをエ
ディットしたとき

[UNDO/REDO] キー

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：ディストーションをかけないとき
は、必ず [DISTORTION] つまみを反時計方向に
絞っておきましょう。
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＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：トラック3と4のフェーダーは、モ
ニター・レベルの調整に使用し、録音レベルを
変えるには [INPUT A] / [INPUT B] の [TRIM]
つまみで調整してください。

MR-8mkIIでは、最大2つのトラックを同時に録音することができます。録音トラックは、前述37ページに記
載されている組み合わせが可能です。ここでは例として、トラック3と4に異なった音源を同時に録音します
（他の組み合わせでも、同じ要領で行うことができます）。

11111））））） [INPUT A] [INPUT A] [INPUT A] [INPUT A] [INPUT A] ののののの PHONE PHONE PHONE PHONE PHONEジャック、ジャック、ジャック、ジャック、ジャック、およびおよびおよびおよびおよび [INPUT [INPUT [INPUT [INPUT [INPUT
B] B] B] B] B] のののののXLRXLRXLRXLRXLRコネクタに、コネクタに、コネクタに、コネクタに、コネクタに、下記例の音源を接続しま下記例の音源を接続しま下記例の音源を接続しま下記例の音源を接続しま下記例の音源を接続しま
す。す。す。す。す。

[INPUT A] [INPUT A] [INPUT A] [INPUT A] [INPUT A] →→→→→エレクトリックエレクトリックエレクトリックエレクトリックエレクトリック・・・・・ギターギターギターギターギター
[INPUT B] [INPUT B] [INPUT B] [INPUT B] [INPUT B] →→→→→マイクロホンマイクロホンマイクロホンマイクロホンマイクロホン

録音の準備録音の準備録音の準備録音の準備録音の準備

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： “GUITAR”ポジションで使用する
ときは、インサート・エフェクトのアンプ・シ
ミュレーションが使えます（☞60ページ）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： [INPUT B] でコンデンサ・マイク
を使うときは、バランス（XLR）入力端子を使
います。ファントム電源が供給できます（☞
137ページ）。

22222））））） [INPUT A SELECT] [INPUT A SELECT] [INPUT A SELECT] [INPUT A SELECT] [INPUT A SELECT] スイッチをスイッチをスイッチをスイッチをスイッチを“““““GUITARGUITARGUITARGUITARGUITAR”””””に切に切に切に切に切
り換えます。り換えます。り換えます。り換えます。り換えます。
E. ギターに内蔵ディストーションがかけられます。

Home画面下のトラック表示“3”が“A”、“4”が
“B”に変わり、各インプットが録音するトラック
にアサインされたことを示します。また、ディスプ
レイにはコンパクトフラッシュ・カードのリメイ
ン値が表示されます。

44444））））） トラックトラックトラックトラックトラック33333ととととと44444のフェーダーとのフェーダーとのフェーダーとのフェーダーとのフェーダーと [MASTER]  [MASTER]  [MASTER]  [MASTER]  [MASTER] フェーフェーフェーフェーフェー
ダーをダーをダーをダーをダーを“““““ ”””””位置まで上げておきます。位置まで上げておきます。位置まで上げておきます。位置まで上げておきます。位置まで上げておきます。
これは、トラック3と4のモニター音を出力するた
めの準備です。3つの各フェーダーが上がっていな
いと、ヘッドホンからは音が聴こえません。

22222つのトラックに同時録音つのトラックに同時録音つのトラックに同時録音つのトラックに同時録音つのトラックに同時録音
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33333））））） トラックトラックトラックトラックトラック33333ととととと44444ののののの [REC SELECT]  [REC SELECT]  [REC SELECT]  [REC SELECT]  [REC SELECT] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
[REC SELECT] キーのランプが点滅するとともに、
トラック3と4がREADYトラックに選択されます。
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66666））））） この状態で各楽器を演奏しながら、この状態で各楽器を演奏しながら、この状態で各楽器を演奏しながら、この状態で各楽器を演奏しながら、この状態で各楽器を演奏しながら、 [TRIM]  [TRIM]  [TRIM]  [TRIM]  [TRIM] つまみつまみつまみつまみつまみ
で適正なゲインで適正なゲインで適正なゲインで適正なゲインで適正なゲイン（（（（（録録録録録音音音音音レレレレレベベベベベルルルルル）））））を調整します。を調整します。を調整します。を調整します。を調整します。
PEAK LEDが点灯しないよう [TRIM] つまみを調
整します。
[PHONES VOL] つまみを上げていくと、ヘッドホ
ンからモニター音が聴こえてきます。

Home画面のレベル・メータには、トラック3と4
の入力レベルとステレオ・アウトL、R（ステレオ・
バスの出力）が、共に振れていきます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：トラック3と4のゲイン（録音レベ
ル）は、各演奏の音が最大のとき [PEAK] LED
が点灯しないよう設定してください。

＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞：：：：： [TRIM] つまみの調整は、ライ
ン入力の録音時に“LINE”ポジション側へ回す
と適正なゲインが得られ、マイクロホンでの録
音時では“MIC”ポジション側へ回すと適正な
ゲインが得られます。

77777））））） [RECORD] [RECORD] [RECORD] [RECORD] [RECORD] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [PLAY]  [PLAY]  [PLAY]  [PLAY]  [PLAY] キーを押しキーを押しキーを押しキーを押しキーを押し
て録音を開始します。て録音を開始します。て録音を開始します。て録音を開始します。て録音を開始します。
各楽器の演奏を記録していきます。

88888））））） 録音が終了したら、録音が終了したら、録音が終了したら、録音が終了したら、録音が終了したら、 [STOP]  [STOP]  [STOP]  [STOP]  [STOP] キーを押してキーを押してキーを押してキーを押してキーを押してMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII
を停止させます。を停止させます。を停止させます。を停止させます。を停止させます。

＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞：：：：： 録音終了後は、トラック3と
4の [REC SELECT] キーを押してREC READY
を解除しておきましょう。

録音の開始録音の開始録音の開始録音の開始録音の開始

99999））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [REWIND]  [REWIND]  [REWIND]  [REWIND]  [REWIND] キーを押しキーを押しキーを押しキーを押しキーを押し
て、て、て、て、て、ソングの先頭に戻します。ソングの先頭に戻します。ソングの先頭に戻します。ソングの先頭に戻します。ソングの先頭に戻します。

1010101010））））） [PLAY] [PLAY] [PLAY] [PLAY] [PLAY] キーを押して再生を開始します。キーを押して再生を開始します。キーを押して再生を開始します。キーを押して再生を開始します。キーを押して再生を開始します。
トラック3と4のフェーダーで再生レベルを調整
し、録音した演奏を聴いてみましょう。

録音したトラックの確認録音したトラックの確認録音したトラックの確認録音したトラックの確認録音したトラックの確認（（（（（再再再再再生生生生生）））））

＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞：：：：： もし、納得のゆく録音ができ
なかったときは、下記の「アンドウ／リドウ機
能」を使って、最初からやり直してください。

録音のやり直し録音のやり直し録音のやり直し録音のやり直し録音のやり直し（（（（（アアアアアンンンンンドドドドドウウウウウ／／／／／リリリリリドドドドドウウウウウ）））））

55555））））） [RECORD] [RECORD] [RECORD] [RECORD] [RECORD] キーを一度押しますキーを一度押しますキーを一度押しますキーを一度押しますキーを一度押します（（（（（キキキキキーーーーーのののののララララランンンンンプププププががががが
点点点点点滅滅滅滅滅）））））。。。。。
REC READYになっているトラック3と4がイン
プット・モニターになったことを示す“ ”
が、Home画面上に点灯します。

録音終了後 [UNDO/REDO] キーを押すと、録音する前
の状態に戻す（アンドウ）ことができ、最初から録音を
やり直すことが可能になります。
また、アンドウした後再度 [UNDO/REDO] キーを押す
と、録音した後の状態へ戻すこともできます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：アンドウ／リドウは、全ての録音に対して
有効ですが、録音終了後下記操作を行うと、アンドウ
／リドウできなくなりますので、ご注意ください。

● 新たな録音を行ったとき
● トラック編集やパート編集を行ったとき
● 電源をオフしたとき
● 他のソングをセレクトしたり、ソング・ネームをエ
ディットしたとき

＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞：：：：： [INPUT A] のE. ギターには、
ディストーションをかけることができます。
[DISTORTION] つまみを調整して、好みの音作
りにチャレンジしてください。
ディストーションをかけるときは、 [TRIM] つま
みでレベル調整を再調整してください。

[UNDO/REDO] キー
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55555））））） [RECORD] [RECORD] [RECORD] [RECORD] [RECORD] キーを一度押しますキーを一度押しますキーを一度押しますキーを一度押しますキーを一度押します（（（（（キキキキキーーーーーのののののララララランンンンンプププププががががが
点点点点点滅滅滅滅滅）））））。。。。。
REC READYになっているトラック7/8がインプ
ット・モニターになったことを示す“ ”
が、Home画面上に点灯します。

オーバーダビングとは、先に録音したトラックの音を聞きながら（モニターしながら）、他のトラックへ録音す
ることを言い、多重録音では大切な録音方法の一つです。ここでは例として、前述の「1つのトラックに録音」
でトラック1に録音したギター演奏をモニターしながら、トラック7-8にステレオ出力のキーボードを録音し
ます。下記操作は、トラック1に録音済みのソングが立ち上がっていることを前提にしています（他のトラッ
クにおいても、同じ要領で行なえます）。

11111））））） [INPUT A] [INPUT A] [INPUT A] [INPUT A] [INPUT A] およびおよびおよびおよびおよび [INPUT B]  [INPUT B]  [INPUT B]  [INPUT B]  [INPUT B] 端子に、端子に、端子に、端子に、端子に、キーボードキーボードキーボードキーボードキーボード
の出力の出力の出力の出力の出力（（（（（LLLLL、、、、、RRRRR）））））を接続します。を接続します。を接続します。を接続します。を接続します。
L ch出力を [INPUT A] に、R ch出力を [INPUT
B] に接続します。

22222））））） [INPUT A SEL] [INPUT A SEL] [INPUT A SEL] [INPUT A SEL] [INPUT A SEL] スイッチをスイッチをスイッチをスイッチをスイッチを“““““MIC/LINEMIC/LINEMIC/LINEMIC/LINEMIC/LINE”””””に切り換に切り換に切り換に切り換に切り換
えます。えます。えます。えます。えます。

33333））））） トラックトラックトラックトラックトラック7/87/87/87/87/8ののののの [REC SELECT]  [REC SELECT]  [REC SELECT]  [REC SELECT]  [REC SELECT] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
[REC SELECT] キーのランプが点滅するとともに
リメインが表示され、トラック表示“7”が“A”、
“8”が“B”に変わります。

録音の準備録音の準備録音の準備録音の準備録音の準備 44444））））） トラックトラックトラックトラックトラック11111およびおよびおよびおよびおよび7/87/87/87/87/8のフェーダーとのフェーダーとのフェーダーとのフェーダーとのフェーダーと [MASTER] [MASTER] [MASTER] [MASTER] [MASTER]
フェーフェーフェーフェーフェーダーをダーをダーをダーをダーを“““““ ”””””位置まで上げておきます。位置まで上げておきます。位置まで上げておきます。位置まで上げておきます。位置まで上げておきます。
これは、トラック1および7/8のモニター音を出力
するための準備です。3つのフェーダーが上がって
いないと、ヘッドホンからは音が聴こえません。

これは、トラック7に [INPUT A] がアサインされ、
トラック8に [INPUT B] にアサインされ、 [INPUT
A] と [INPUT B] の音源が録音可能になっている
ことを示しています。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：トラック1および7/8のフェーダー
は、モニター・レベルの調整に使用し、録音レ
ベルをかえるには [INPUT A] および [INPUT B]
の [TRIM] つまみで調整してください。

基本的なオーバーダビング基本的なオーバーダビング基本的なオーバーダビング基本的なオーバーダビング基本的なオーバーダビング
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99999））））） [RECORD] [RECORD] [RECORD] [RECORD] [RECORD] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [PLAY]  [PLAY]  [PLAY]  [PLAY]  [PLAY] キーを押しキーを押しキーを押しキーを押しキーを押し
て録音を開始します。て録音を開始します。て録音を開始します。て録音を開始します。て録音を開始します。
トラック1の演奏を聞きながら、キーボード演奏を
録音していきます。

＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞：：：：： 録音終了後は、トラック7/8
の [REC SELECT] キーを押してREC READY
を解除しておきましょう。

録音の開始録音の開始録音の開始録音の開始録音の開始

1111111111））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [REWIND]  [REWIND]  [REWIND]  [REWIND]  [REWIND] キーを押しキーを押しキーを押しキーを押しキーを押し
て、て、て、て、て、ソングの先頭に戻します。ソングの先頭に戻します。ソングの先頭に戻します。ソングの先頭に戻します。ソングの先頭に戻します。

1212121212））））） [PLAY] [PLAY] [PLAY] [PLAY] [PLAY] キーを押して再生を開始します。キーを押して再生を開始します。キーを押して再生を開始します。キーを押して再生を開始します。キーを押して再生を開始します。
トラック7/8のフェーダーで再生レベルを調整し、
録音した演奏を聴いてみましょう。

録音したトラックの確認録音したトラックの確認録音したトラックの確認録音したトラックの確認録音したトラックの確認（（（（（再再再再再生生生生生）））））

＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞：：：：： もし、納得のゆく録音ができ
なかったときは、下記の「アンドウ／リドウ機
能」を使って、最初からやり直してください。

録音のやり直し録音のやり直し録音のやり直し録音のやり直し録音のやり直し（（（（（アアアアアンンンンンドドドドドウウウウウ／／／／／リリリリリドドドドドウウウウウ）））））

録音終了後 [UNDO/REDO] キーを押すと、録音する前
の状態に戻す（アンドウ）ことができ、最初から録音を
やり直すことが可能になります。
また、アンドウした後再度 [UNDO/REDO] キーを押す
と、録音した後の状態へ戻すこともできます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：アンドウ／リドウは、全ての録音に対して
有効ですが、録音終了後下記操作を行うと、アンドウ
／リドウできなくなりますので、ご注意ください。

● 新たな録音を行ったとき
● トラック編集やパート編集を行ったとき
● 電源をオフしたとき
● 他のソングをセレクトしたり、ソング・ネームをエ
ディットしたとき

77777））））） この状態でキーボードを演奏しながら、この状態でキーボードを演奏しながら、この状態でキーボードを演奏しながら、この状態でキーボードを演奏しながら、この状態でキーボードを演奏しながら、 [TRIM]  [TRIM]  [TRIM]  [TRIM]  [TRIM] つつつつつ
まみで適正なゲインまみで適正なゲインまみで適正なゲインまみで適正なゲインまみで適正なゲイン（（（（（録録録録録音音音音音レレレレレベベベベベルルルルル）））））を調整します。を調整します。を調整します。を調整します。を調整します。
PEAK LEDが点灯しないよう [TRIM] つまみを調
整します。

Home画面のレベル・メータには、トラック1の再
生レベルおよびトラック7/8の入力レベルと、ステ
レオ・アウトL、R（ステレオ・バスの出力）が、共
に振れていきます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：トラック7/8のゲイン（録音レベル）
は、キーボード演奏の音が最大のとき [PEAK]
LEDが点灯しないよう設定してください。

＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞：：：：： [TRIM] つまみの調整は、ライ
ン入力の録音時に“LINE”ポジション側へ回す
と適正なゲインが得られ、マイクロホンでの録
音時では“MIC”ポジション側へ回すと適正な
ゲインが得られます。

トラックトラックトラックトラックトラック11111を聞きながらレベル調整を聞きながらレベル調整を聞きながらレベル調整を聞きながらレベル調整を聞きながらレベル調整

66666））））） [PLAY] [PLAY] [PLAY] [PLAY] [PLAY] キーを押してソングの先頭から再生します。キーを押してソングの先頭から再生します。キーを押してソングの先頭から再生します。キーを押してソングの先頭から再生します。キーを押してソングの先頭から再生します。
インプットモニターの状態ですが、先に録音してい
るトラック1のレベルが振れ、 [PHONES VOL] つ
まみを上げていくと、ヘッドホンからトラック1の
ギター演奏が聴こえてきます。

88888））））） レベルの調整が終了後、レベルの調整が終了後、レベルの調整が終了後、レベルの調整が終了後、レベルの調整が終了後、 [STOP]  [STOP]  [STOP]  [STOP]  [STOP] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら
[REWIND] [REWIND] [REWIND] [REWIND] [REWIND] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、ソングの先頭に戻しまソングの先頭に戻しまソングの先頭に戻しまソングの先頭に戻しまソングの先頭に戻しま
す。す。す。す。す。

1010101010））））） 録音が終了したら、録音が終了したら、録音が終了したら、録音が終了したら、録音が終了したら、 [STOP]  [STOP]  [STOP]  [STOP]  [STOP] キーを押してキーを押してキーを押してキーを押してキーを押してMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII
を停止させます。を停止させます。を停止させます。を停止させます。を停止させます。

[UNDO/REDO] キー
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＜ポイント！＞＜ポイント！＞＜ポイント！＞＜ポイント！＞＜ポイント！＞：：：：： MR-8mkII の [MASTER]
フェーダーを操作することで、フェード・イン
（徐々に音量が上がっていく）、またはフェー
ド・アウト（徐々に音量が下がっていく）させ
ながら録音できます。

33333））））） ミックスダウンのリハーサルをしながら、ミックスダウンのリハーサルをしながら、ミックスダウンのリハーサルをしながら、ミックスダウンのリハーサルをしながら、ミックスダウンのリハーサルをしながら、マスターマスターマスターマスターマスター
レコーダーの録音レベルを調整します。レコーダーの録音レベルを調整します。レコーダーの録音レベルを調整します。レコーダーの録音レベルを調整します。レコーダーの録音レベルを調整します。
マスターレコーダーの取扱説明書を参照して、最適
な録音レベルに調整してください。

44444））））） リハーサル／録音レベルの調整が終ったらリハーサル／録音レベルの調整が終ったらリハーサル／録音レベルの調整が終ったらリハーサル／録音レベルの調整が終ったらリハーサル／録音レベルの調整が終ったらMR-MR-MR-MR-MR-
8mkII8mkII8mkII8mkII8mkIIを停止させ、を停止させ、を停止させ、を停止させ、を停止させ、 [STOP]  [STOP]  [STOP]  [STOP]  [STOP] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら
[REWIND] [REWIND] [REWIND] [REWIND] [REWIND] キーを押してソングの先頭に戻します。キーを押してソングの先頭に戻します。キーを押してソングの先頭に戻します。キーを押してソングの先頭に戻します。キーを押してソングの先頭に戻します。

55555））））） マスターレコーダーの録音を開始させた後、マスターレコーダーの録音を開始させた後、マスターレコーダーの録音を開始させた後、マスターレコーダーの録音を開始させた後、マスターレコーダーの録音を開始させた後、MR-MR-MR-MR-MR-
8mkII8mkII8mkII8mkII8mkII を再生させます。を再生させます。を再生させます。を再生させます。を再生させます。

66666））））） 録音が終了したら、録音が終了したら、録音が終了したら、録音が終了したら、録音が終了したら、双方の機器を停止させます。双方の機器を停止させます。双方の機器を停止させます。双方の機器を停止させます。双方の機器を停止させます。

11111））））） MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIののののの [STEREO OUT L, R]  [STEREO OUT L, R]  [STEREO OUT L, R]  [STEREO OUT L, R]  [STEREO OUT L, R] 端子と、端子と、端子と、端子と、端子と、アナロアナロアナロアナロアナロ
グググググ・・・・・マスターレコーダーの入力端子を接続します。マスターレコーダーの入力端子を接続します。マスターレコーダーの入力端子を接続します。マスターレコーダーの入力端子を接続します。マスターレコーダーの入力端子を接続します。

22222））））） MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIを再生しながら、を再生しながら、を再生しながら、を再生しながら、を再生しながら、各トラックの音量／バ各トラックの音量／バ各トラックの音量／バ各トラックの音量／バ各トラックの音量／バ
ランスを調整し、ランスを調整し、ランスを調整し、ランスを調整し、ランスを調整し、必要に応じてトラック必要に応じてトラック必要に応じてトラック必要に応じてトラック必要に応じてトラック11111～～～～～44444ににににに
エフェクトをかけたり、エフェクトをかけたり、エフェクトをかけたり、エフェクトをかけたり、エフェクトをかけたり、マスタリングマスタリングマスタリングマスタリングマスタリング・・・・・エフェクトエフェクトエフェクトエフェクトエフェクト
をかけて、をかけて、をかけて、をかけて、をかけて、ミックスダウンのリハーサルを行ないミックスダウンのリハーサルを行ないミックスダウンのリハーサルを行ないミックスダウンのリハーサルを行ないミックスダウンのリハーサルを行ない
ます。ます。ます。ます。ます。
[STEREO OUT L, R] 端子からの出力レベルは、
[MASTER] フェーダーで調整します。
ディスプレイのL, Rレベル・メーターが振り切れ
ないように調整してください。

ディレイ／リバーブの処理、およびマスタリング・
エフェクトについては、59ページの「エフェクトエフェクトエフェクトエフェクトエフェクト
機能機能機能機能機能」を参照してください。

アナログ・マスターレコーダー

MR-8mkII

ここでは、多重録音の最終作業といえる基本的なミックスダウンについて説明します。ミックスダウンとは、下
の図のようにトラック1～8（8トラック）に録音した演奏を、ステレオL/R（2トラック）の曲に完成させる
作業です。全トラックを再生しながら、トラック1～4にエフェクトをかけたり、L/Rの定位などを調整して、
2ミックスした信号にマスタリング・エフェクトをかけて外部マスター・レコーダーへ出力します。

なお、なお、なお、なお、なお、MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIでは後述のでは後述のでは後述のでは後述のでは後述の「「「「「バババババウウウウウンンンンンススススス機機機機機能能能能能」」」」」を使うことで、を使うことで、を使うことで、を使うことで、を使うことで、トラック１～トラック１～トラック１～トラック１～トラック１～88888をミックスダウンしたソングををミックスダウンしたソングををミックスダウンしたソングををミックスダウンしたソングををミックスダウンしたソングをMR-MR-MR-MR-MR-
8mkII8mkII8mkII8mkII8mkII内部の内部の内部の内部の内部のNewNewNewNewNewソングに記録することができ、ソングに記録することができ、ソングに記録することができ、ソングに記録することができ、ソングに記録することができ、外部マスター外部マスター外部マスター外部マスター外部マスター・・・・・レコーダーを使わずミックスダウンが可能でレコーダーを使わずミックスダウンが可能でレコーダーを使わずミックスダウンが可能でレコーダーを使わずミックスダウンが可能でレコーダーを使わずミックスダウンが可能で
す。す。す。す。す。詳細は後述詳細は後述詳細は後述詳細は後述詳細は後述「「「「「バババババウウウウウンンンンンススススス機機機機機能能能能能」」」」」を参照してくださいを参照してくださいを参照してくださいを参照してくださいを参照してください（（（（（☞ 6666655555ペペペペペーーーーージジジジジ）））））。。。。。

[STEREO OUT L, R]

基本的なミックスダウン基本的なミックスダウン基本的なミックスダウン基本的なミックスダウン基本的なミックスダウン

Track 4
Track 3
Track 2
Track 1

Track 5

Track 6

Track 7

Track 8

STEREO OUT (R)

STEREO OUT (L)
D/A
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色々な再生とロケート色々な再生とロケート色々な再生とロケート色々な再生とロケート色々な再生とロケート
ここでは、キューイングによる再生、LOCATE A/B間の再生、およびプレイ・
モードによる再生など、MR-8mkIIの多彩な再生方法と、ソング内で移動する
ロケート機能について説明します。
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***** 再生中に再生中に再生中に再生中に再生中に [F FWD]  [F FWD]  [F FWD]  [F FWD]  [F FWD] キーを押すと、キーを押すと、キーを押すと、キーを押すと、キーを押すと、フォワード方向へフォワード方向へフォワード方向へフォワード方向へフォワード方向へ33333倍速の倍速の倍速の倍速の倍速の
キューイングができます。キューイングができます。キューイングができます。キューイングができます。キューイングができます。
キューイング動作中は、ディスプレイに“>>”アイコンが表
示されます。

***** 再生中に再生中に再生中に再生中に再生中に [REWIND]  [REWIND]  [REWIND]  [REWIND]  [REWIND] キーを押すと、キーを押すと、キーを押すと、キーを押すと、キーを押すと、リワインド方向へリワインド方向へリワインド方向へリワインド方向へリワインド方向へ33333倍速倍速倍速倍速倍速
のキューイングができます。のキューイングができます。のキューイングができます。のキューイングができます。のキューイングができます。
キューイング動作中は、ディスプレイに“<<”アイコンが表
示されます。

あらかじめソングに登録されている、LOCATE AポイントとLOCATE Bポイント間を再生します。
この機能は、この後説明する「プレイ・モード」の設定に関わらず、LOCATE A - LOCATE B間の音声デー
タを一度だけ再生します。この機能は、後述の「パート・データの編集」で説明するコピー・ペースト、イレー
ス、ムーブやパートの入れ替えなどにおける、編集範囲（LOCATE A-Bポイント間）を確認するときに便利で
す。

再生中に [F FWD] キーまたは [REWIND] キーを押すことで、3倍速のキューイング（音を聞きながら早送り
／逆戻し）ができます。頭出しなどにご利用ください。

***** 停止状態で停止状態で停止状態で停止状態で停止状態で [STOP]  [STOP]  [STOP]  [STOP]  [STOP] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [PLAY]  [PLAY]  [PLAY]  [PLAY]  [PLAY] キーをキーをキーをキーをキーを
押すと、押すと、押すと、押すと、押すと、LOCATE ALOCATE ALOCATE ALOCATE ALOCATE AポイントとポイントとポイントとポイントとポイントとLOCATE BLOCATE BLOCATE BLOCATE BLOCATE Bポイントポイントポイントポイントポイント
間の音声データを、間の音声データを、間の音声データを、間の音声データを、間の音声データを、一度だけ再生して停止します。一度だけ再生して停止します。一度だけ再生して停止します。一度だけ再生して停止します。一度だけ再生して停止します。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： LOCATE AポイントとLOCATE Bポ
イントが、B＜Aで登録されている状態で操作を行う
と、LOCATE AポイントからREC ENDまで再生し
てREC ENDで停止します。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： この操作は、あらかじめLOCATE Aポ
イントと、LOCATE Bポイントが登録されている状
態で行なえます。LOCATE A/Bポイントの登録につ
いては51ページをご覧ください。

再生中、 [MASTER] フェーダーと再生したいトラッ
クのフェーダー、 および [PHONES VOL] つまみを上
げていくと、希望のトラックのみがモニターできます。

LOCATE AポイントとLOCATE Bポイント間を再
生中は、ディスプレイにA-B間を再生している状態
を示すアイコンが表示されます。

 [REWIND] キー  [F FWD] キー

 [STOP] キー  [PLAY] キー

33333倍速でのキューイング再生倍速でのキューイング再生倍速でのキューイング再生倍速でのキューイング再生倍速でのキューイング再生

LOCATE A/BLOCATE A/BLOCATE A/BLOCATE A/BLOCATE A/Bポイント間の再生ポイント間の再生ポイント間の再生ポイント間の再生ポイント間の再生

LOCATE REC END

A-B PLAY
LOCATE ABS ZERO

DELETE+-_0YZ9VWX8STU7

PLAYSTOPRECORD REWIND F FWD

PQR6

UNDO/REDOPLAY MODE STOREA / IN B / OUT
LOCATE

MNO5JKL4

BRIGHTNATURALPOWERFUL MENU/ENTER

MASTERING

AUTO PUNCH

LOCATE REC END

A-B PLAY
LOCATE ABS ZERO

DELETE+-_0YZ9VWX8STU7

PLAYSTOPRECORD REWIND F FWD

PQR6

UNDO/REDOPLAY MODE STOREA / IN B / OUT
LOCATE

MNO5JKL4

BRIGHTNATURALPOWERFUL MENU/ENTER

MASTERING

AUTO PUNCH
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[PLAY MODE] キーを押すごとに“Off”→“AUTO PLAY”→“AUTO RTN”→“LOOP”→“Off”の順に、
プレイ・モードが切り替わります。
各モードに切り替えると、ディスプレイにはそれぞれのモードを示すアイコンが点灯します（“Off”のとき
はなにも点灯しません）。

本機のプレイ・モードには、通常の再生モード以外に、AUTO PLAY（オート・プレイ）モード、AUTO RTN
（オート・リターン）モード、そしてLOOP（ループ）モードがあります。

プレイプレイプレイプレイプレイ・・・・・モードの切り替えモードの切り替えモードの切り替えモードの切り替えモードの切り替え

＜プレイ＜プレイ＜プレイ＜プレイ＜プレイ・・・・・モードモードモードモードモードOffOffOffOffOff ＞＞＞＞＞ ＜＜＜＜＜AUTO PLAYAUTO PLAYAUTO PLAYAUTO PLAYAUTO PLAYモード＞モード＞モード＞モード＞モード＞

＜＜＜＜＜AUTO RTNAUTO RTNAUTO RTNAUTO RTNAUTO RTNモード＞モード＞モード＞モード＞モード＞＜＜＜＜＜LOOPLOOPLOOPLOOPLOOPモード＞モード＞モード＞モード＞モード＞

点灯

点灯点灯

プレイプレイプレイプレイプレイ・・・・・モードによる再生モードによる再生モードによる再生モードによる再生モードによる再生

MAX

MIN

MAX

MIN

REC SELECT

1 2 3 4 5/6 7/8 MASTER

RL PANL R L R L R

0 10 EFFECT SEND100 100 100

BRIT STACK US METAL 60'S COMBO

MIC

TUBECONDENSERDYNAMIC

INPUT A

LINE MIC MIN MAX LINE MIC

DISTORTION
GUITAR

UNBAL

BAL

UNBAL
/GUITAR

PEAK
TRIM TRIM

BAL

INPUT A INPUT B

PHONES VOL

L
ST OUT

R

2
PHONES

1

MIN MAX

EFFECT
REVERB/DELAY TIME

MIN MAX
HALLROOM

PLATE DELAY

LOCATE REC END

A-B PLAY
LOCATE ABS ZERO

DELETE+-_0YZ9VWX8STU7

PLAYSTOPRECORD REWIND F FWD

PQR6

UNDO/REDOPLAY MODE STOREA / IN B / OUT
LOCATE

MNO5JKL4

BRIGHTNATURALPOWERFUL MENU/ENTER

MASTERING

GHI3DEF2ABC1

7/8 WAV FILE
STEREO1-4

1-6
NEW
SONG1-8

GUIDE
RHYTHM CONTRASTTIME BASE

SELECT

BOUNCE

INPUT A SELECT

AUTO PUNCH

5/6
7/8

AMP SIMULATION

MIC SIMULATION

PEAK

STU7

PLAY MODE

停止状態で停止状態で停止状態で停止状態で停止状態で [PLAY [PLAY [PLAY [PLAY [PLAY
MODE] MODE] MODE] MODE] MODE] キーを押してキーを押してキーを押してキーを押してキーを押して
いくと、いくと、いくと、いくと、いくと、希望のプレ希望のプレ希望のプレ希望のプレ希望のプレ
イイイイイ・・・・・モードが選択できモードが選択できモードが選択できモードが選択できモードが選択でき
ます。ます。ます。ます。ます。
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AUTO PLAYモードでは、ABS ZERO、REC END、またはLOCATE A/Bポイントへのロケート動作を実行
したとき、ロケートしたポイントから自動的に再生を開始させることができます（下記図は、LOCATE Aポイ
ントへロケートした例です。ロケートについてはこの後50ページを参照）。

AUTO RTNモードは、事前にLOCATE AポイントとLOCATE Bポイントが登録されているときに有効です。
このモードでは、下図のように再生中LOCATE Bポイントに達すると、自動的にLOCATE Aポイントへロケー
トして停止します。

LOOPモードは、AUTO RTNモードと同様、事前にLOCATE AポイントとLOCATE Bポイントが登録され
ているときに有効です。
このモードでは、下図のように再生中LOCATE Bポイントに達すると、自動的にLOCATE Aポイントへロケー
トして、再びLOCATE Aポイントから再生します。強制的に停止させるまでこの動作を繰り返します。このモー
ドは、オート・パンチイン／アウトと併用すると便利です（次ページ参照）。

     “““““AUTO PLAYAUTO PLAYAUTO PLAYAUTO PLAYAUTO PLAY”””””モードを利用した再生モードを利用した再生モードを利用した再生モードを利用した再生モードを利用した再生

     “““““AUTO RTNAUTO RTNAUTO RTNAUTO RTNAUTO RTN”””””モードを利用した再生モードを利用した再生モードを利用した再生モードを利用した再生モードを利用した再生

     “““““LOOPLOOPLOOPLOOPLOOP”””””モードを利用した再生モードを利用した再生モードを利用した再生モードを利用した再生モードを利用した再生
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MR-8mkII MR-8mkII MR-8mkII MR-8mkII MR-8mkII 　取扱説明書　取扱説明書　取扱説明書　取扱説明書　取扱説明書（（（（（色色色色色々々々々々ななななな再再再再再生生生生生とととととロロロロロケケケケケーーーーートトトトト）））））

オートオートオートオートオート・・・・・パンチイン／アウト時における、パンチイン／アウト時における、パンチイン／アウト時における、パンチイン／アウト時における、パンチイン／アウト時における、LOOPLOOPLOOPLOOPLOOPモードの併用モードの併用モードの併用モードの併用モードの併用
通常、LOOPモードやオート・パンチイン／アウトを実行するために登録するLOCATE Aポイントと
LOCATE Bポイントは、単独で実行するときは、LOCATE AポイントがLoop Startポイントまたはパ
ンチイン・ポイントとなり、LOCATE BポイントがLoop Endポイントまたはパンチアウト・ポイント
として利用されます。

しかし、プレイ・モードに「LOOPモード」が選択されている状態でオート・パンチ・モードをONにす
ると、LOCATE AポイントとLOCATE Bポイントには、下の図のようにそれぞれプリロール時間（初
期設定：4秒）とポストロール時間（初期設定：1秒）が自動的に設定されます。つまり、LOCATE A/
Bポイントはオート・パンチイン／アウト・ポイントとして機能し、LOCATE Aポイントより4秒手前
がLoop Startポイント、LOCATE Bポイントより1秒後がLoop Endポイントとして機能するように
なります。

この機能を活用することで、下の図のようにオート・パンチイン／アウトのリハーサルを繰り返して行う
ときや本番を実行するとき、無駄なキー操作を省いてパンチイン／アウトの演奏に集中することができま
す。

プリロール時間とポストロール時間の初期設定値はMENUモードで変更することができ、0.1s～10.0s
の範囲を0.1sステップで任意に設定できます（☞134ページ）。

パンチイン／アウトの範囲

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： LOCATE AポイントとLOCATE Bポイントを、ソングの先頭（ABS ZERO）およ
び最終記録位置（REC END）に登録しているときは、LOOPモードが設定されている状態でオー
トパンチ・モードをONにしても、プリロール／ポストロール時間は設定されません。
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ここでは、ソング内の任意の位置へ移動する、各種ロケートの方法について説明します。

タイムタイムタイムタイムタイム・・・・・ロケートロケートロケートロケートロケート

レコーダーの現在位置がどこにいても、ABSタイムにおけるソングの先頭（ABS ZERO）、または最終録音位
置（REC END）へ移動できます。

MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIが停止状態で、が停止状態で、が停止状態で、が停止状態で、が停止状態で、 [STOP]  [STOP]  [STOP]  [STOP]  [STOP] キーを押しながキーを押しながキーを押しながキーを押しながキーを押しなが
ららららら [REWIND]  [REWIND]  [REWIND]  [REWIND]  [REWIND] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
MR-8mkIIは、速やかにソングの先頭（ABS ZERO
と呼びます）へロケートして停止します。

■ソングの先頭■ソングの先頭■ソングの先頭■ソングの先頭■ソングの先頭（（（（（ABS ZEROABS ZEROABS ZEROABS ZEROABS ZERO）））））へロケートへロケートへロケートへロケートへロケート：：：：：

MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIが停止状態で、が停止状態で、が停止状態で、が停止状態で、が停止状態で、 [STOP]  [STOP]  [STOP]  [STOP]  [STOP] キーを押しながキーを押しながキーを押しながキーを押しながキーを押しなが
ららららら [F FWD] [F FWD] [F FWD] [F FWD] [F FWD] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
MR-8mkII は、速やかにソングの最終録音位置
（REC ENDと呼びます）へロケートして停止しま
す。

■ソングの最終録音位置■ソングの最終録音位置■ソングの最終録音位置■ソングの最終録音位置■ソングの最終録音位置（（（（（REC ENDREC ENDREC ENDREC ENDREC END）））））へロケートへロケートへロケートへロケートへロケート：：：：：

[STOP] キーを押しながら
[REWIND] キーを押す

ロケートロケートロケートロケートロケート（（（（（ソソソソソンンンンングググググ内内内内内ののののの移移移移移動動動動動）））））

LOCATE REC END

A-B PLAY
LOCATE ABS ZERO

DELETE+-_0YZ9VWX8STU7

PLAYSTOPRECORD REWIND F FWD

PQR6

UNDO/REDOPLAY MODE STOREA / IN B / OUT
LOCATE

MNO5JKL4

BRIGHTNATURALPOWERFUL MENU/ENTER

MASTERING

AUTO PUNCH

LOCATE REC END

A-B PLAY
LOCATE ABS ZERO

DELETE+-_0YZ9VWX8STU7

PLAYSTOPRECORD REWIND F FWD

PQR6

UNDO/REDOPLAY MODE STOREA / IN B / OUT
LOCATE

MNO5JKL4

BRIGHTNATURALPOWERFUL MENU/ENTER

MASTERING

AUTO PUNCH

[STOP] キーを押しながら
[F FWD] キーを押す
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LOCATE A/BLOCATE A/BLOCATE A/BLOCATE A/BLOCATE A/Bポイントへのロケートポイントへのロケートポイントへのロケートポイントへのロケートポイントへのロケート
本機では、レコーダーの任意の位置（時刻）を、 [LOCATE A/IN] キーと [LOCATE B/OUT] キーに登録する
ことができます。これらのキーに登録されるタイム・データは、ここで説明するLOCATE A/Bポイントへのロ
ケート以外に、オート・パンチイン／アウト、プレイ・モードにおける再生、さらにはパート・データの編集
などにも利用されます。

■■■■■LOCATE A/BLOCATE A/BLOCATE A/BLOCATE A/BLOCATE A/Bポイントの登録ポイントの登録ポイントの登録ポイントの登録ポイントの登録：：：：：
LOCATE A/Bポイントの登録は、タイム表示またはBar/Beat表示でも行なえ、レコーダーが再生中ま
たは登録したい位置で停止しているとき、リアルタイムに登録できます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： オート・パンチイン／アウトやループ機能を正常に動作させるためには、登録する
LOCATE AポイントとLOCATE Bポイントは、必ず“LOCATE A＜LOCATE B”となるように登録し
てください。

＜覚えておきましょう！＞＜覚えておきましょう！＞＜覚えておきましょう！＞＜覚えておきましょう！＞＜覚えておきましょう！＞：：：：： ディスプレイ表示がBar/Beatの状態でLOCATE A/Bポイントを登録
する際、MENUモードにある “Beatリゾリューション”メニューをONに設定しておくと、自動的に
リゾリューション（分解能）を拍精度に変換して登録することができます。つまり、Bar/Beat/ClkのClk
（クロック）の桁を切り捨てまたは切り上げて、常にClkの値が“000”になるように登録できます。

“Beatリゾリューション”の設定については136ページをご覧ください。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： プロテクトのかかっているソングでは、LOCATE A/Bポイントを登録することはできませ
ん。登録しようとすると、“This song is Protected! ”という警告メッセージを表示します。プロテクト
のかかっているソングにLOCATE A/Bポイントを登録するには、あらかじめソングのプロテクトを解除
してください（☞93ページ）。

●●●●● LOCATE BLOCATE BLOCATE BLOCATE BLOCATE Bポイントの登録方法ポイントの登録方法ポイントの登録方法ポイントの登録方法ポイントの登録方法：：：：：

MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII が再生中が再生中が再生中が再生中が再生中（（（（（まままままたたたたたははははは停停停停停止止止止止中中中中中）））））、、、、、
LOCATE BLOCATE BLOCATE BLOCATE BLOCATE Bポイントを登録したい位置でポイントを登録したい位置でポイントを登録したい位置でポイントを登録したい位置でポイントを登録したい位置で
[STORE] [STORE] [STORE] [STORE] [STORE] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [LOCATE B/ [LOCATE B/ [LOCATE B/ [LOCATE B/ [LOCATE B/
OUT] OUT] OUT] OUT] OUT] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ディスプレイのキャラクタ表示部に一瞬“Store
LOCATE B”を表示して、 [LOCATE B/OUT]
キーを押した時点のタイム表示（タイムまたは
Bar/Beat表示）が、LOCATE Bポイントとし
て登録されます。

●●●●● LOCATE ALOCATE ALOCATE ALOCATE ALOCATE Aポイントの登録方法ポイントの登録方法ポイントの登録方法ポイントの登録方法ポイントの登録方法：：：：：

MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII が再生中が再生中が再生中が再生中が再生中（（（（（まままままたたたたたははははは停停停停停止止止止止中中中中中）））））、、、、、
LOCATE ALOCATE ALOCATE ALOCATE ALOCATE Aポイントを登録したい位置でポイントを登録したい位置でポイントを登録したい位置でポイントを登録したい位置でポイントを登録したい位置で
[STORE] [STORE] [STORE] [STORE] [STORE] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [LOCATE A/ [LOCATE A/ [LOCATE A/ [LOCATE A/ [LOCATE A/
IN] IN] IN] IN] IN] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ディスプレイのキャラクタ表示部に一瞬
“Store LOCATE A ”を表示して、 [LOCATE A/
IN] キーを押した時点のタイム表示（タイムまた
はBar/Beat表示）が、LOCATE Aポイントと
して登録されます。

LOCATE REC END

A-B PLAY
LOCATE ABS ZERO

DELETE+-_0YZ9VWX8STU7

PLAYSTOPRECORD REWIND F FWD

PQR6

UNDO/REDOPLAY MODE STOREA / IN B / OUT
LOCATE

MNO5JKL4

BRIGHTNATURALPOWERFUL MENU/ENTER

MASTERING

AUTO PUNCH

LOCATE REC END

A-B PLAY
LOCATE ABS ZERO

DELETE+-_0YZ9VWX8STU7

PLAYSTOPRECORD REWIND F FWD

PQR6

UNDO/REDOPLAY MODE STOREA / IN B / OUT
LOCATE

MNO5JKL4

BRIGHTNATURALPOWERFUL MENU/ENTER

MASTERING

AUTO PUNCH

[STORE] キーを押しながら
[LOCATE A/IN] キーを押す

[STORE] キーを押しながら
[LOCATE B/OUT] キーを押す
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■ロケートの実行■ロケートの実行■ロケートの実行■ロケートの実行■ロケートの実行：：：：：

停止状態で、停止状態で、停止状態で、停止状態で、停止状態で、 [LOCATE A/IN]  [LOCATE A/IN]  [LOCATE A/IN]  [LOCATE A/IN]  [LOCATE A/IN] キーキーキーキーキー（（（（（まままままたたたたたははははは [LOCATE B/OUT]  [LOCATE B/OUT]  [LOCATE B/OUT]  [LOCATE B/OUT]  [LOCATE B/OUT] キー）キー）キー）キー）キー）をダイレクトに押します。をダイレクトに押します。をダイレクトに押します。をダイレクトに押します。をダイレクトに押します。
各キーに登録されているポイント（タイム／Bar Beat）へ、速やかにロケートします。

＜覚えておきましょう！＞＜覚えておきましょう！＞＜覚えておきましょう！＞＜覚えておきましょう！＞＜覚えておきましょう！＞
前述の「プレイ・モード」を“AUTO PLAY”に設定しておくと、LOCATE Aポイント（また
はLOCATE Bポイント）へロケートした後、ロケートした位置から自動的に再生させることが
できます。

● 現在位置がLOCATE AポイントとLOCATE Bポイントの間にある場合

● 現在位置がLOCATE AポイントとLOCATE Bポイントより手前の場合

● 現在位置がLOCATE AポイントとLOCATE Bポイントより後方の場合
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パンチイン／アウト機能パンチイン／アウト機能パンチイン／アウト機能パンチイン／アウト機能パンチイン／アウト機能
MR-8mkIIのパンチイン／アウト機能を使って、録音したトラックの一部分だ
けを録音し直すことができます。パンチインとは再生状態から録音に切り替え
ること、そしてパンチアウトとはその逆で、録音状態から再生に切り替えるこ
とを言い、MR-8mkIIで行なうパンチイン／アウトは、つぎの3つの方法があ
ります。

11111））））） 本体キーの操作による、本体キーの操作による、本体キーの操作による、本体キーの操作による、本体キーの操作による、手動でのパンチイン／アウト手動でのパンチイン／アウト手動でのパンチイン／アウト手動でのパンチイン／アウト手動でのパンチイン／アウト
22222））））） フットスイッチの操作による、フットスイッチの操作による、フットスイッチの操作による、フットスイッチの操作による、フットスイッチの操作による、パンチイン／アウトパンチイン／アウトパンチイン／アウトパンチイン／アウトパンチイン／アウト
33333））））） パンチイン／アウトパンチイン／アウトパンチイン／アウトパンチイン／アウトパンチイン／アウト・・・・・ポイントを登録して行う、ポイントを登録して行う、ポイントを登録して行う、ポイントを登録して行う、ポイントを登録して行う、オートオートオートオートオート・・・・・パンチインパンチインパンチインパンチインパンチイン

／アウト／アウト／アウト／アウト／アウト

ここからの説明は、パンチイン／アウトする任意のソングが立ち上がり、録音
の準備ができていることを前提にしています。
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11111））））） パンチイン／アウトしたいトラックのパンチイン／アウトしたいトラックのパンチイン／アウトしたいトラックのパンチイン／アウトしたいトラックのパンチイン／アウトしたいトラックの [REC [REC [REC [REC [REC
SELECT] SELECT] SELECT] SELECT] SELECT] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、録音スタンバイにします。録音スタンバイにします。録音スタンバイにします。録音スタンバイにします。録音スタンバイにします。

22222））））） [PLAY] [PLAY] [PLAY] [PLAY] [PLAY] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、パンチインを開始する手前パンチインを開始する手前パンチインを開始する手前パンチインを開始する手前パンチインを開始する手前
から再生します。から再生します。から再生します。から再生します。から再生します。
再生音に合わせて、やり直しする楽器を演奏してい
きます。

33333））））） パンチインする位置に来たら、パンチインする位置に来たら、パンチインする位置に来たら、パンチインする位置に来たら、パンチインする位置に来たら、 [PLAY]  [PLAY]  [PLAY]  [PLAY]  [PLAY] キーを押しキーを押しキーを押しキーを押しキーを押し
ながらながらながらながらながら [RECORD]  [RECORD]  [RECORD]  [RECORD]  [RECORD] キーを押しますキーを押しますキーを押しますキーを押しますキーを押します（（（（（注注注注注意意意意意！！！！！）））））。。。。。
パンチイン／アウトするトラックのみが、再生状態
から録音に切り替わります。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： 本体キーでのパンチイン／アウトは、キー操作に気が取られて演奏に集中できないこと
があります。そんなときはバンドの仲間に手伝ってもらいましょう。一人でパンチイン／アウトするに
は後述2つのいずれかの方法をお勧めします。

MR-8mkII本体の [RECORD] キーおよび [PLAY] キーを使って、手動でパンチイン／アウトします。

44444））））） パンチアウトする位置に来たら、パンチアウトする位置に来たら、パンチアウトする位置に来たら、パンチアウトする位置に来たら、パンチアウトする位置に来たら、 [PLAY]  [PLAY]  [PLAY]  [PLAY]  [PLAY] キーのみキーのみキーのみキーのみキーのみ
を押します。を押します。を押します。を押します。を押します。
録音が解除されて、再生状態に切り替わります。

55555））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して停止させ、キーを押して停止させ、キーを押して停止させ、キーを押して停止させ、キーを押して停止させ、パンチインを開始パンチインを開始パンチインを開始パンチインを開始パンチインを開始
させた位置に戻します。させた位置に戻します。させた位置に戻します。させた位置に戻します。させた位置に戻します。

66666））））） パンチイン／アウトした部分を再生して、パンチイン／アウトした部分を再生して、パンチイン／アウトした部分を再生して、パンチイン／アウトした部分を再生して、パンチイン／アウトした部分を再生して、結果を確結果を確結果を確結果を確結果を確
認します。認します。認します。認します。認します。
思うようにやり直しができなかったときは、アンド
ウ機能を使って、速やかに録音する前に戻して、同
じ要領で再度やり直しましょう。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： パンチインするときは、必ず
[PLAY] キーを押しながら [RECORD] キーを
押してください。

本体キーでのパンチイン／アウト本体キーでのパンチイン／アウト本体キーでのパンチイン／アウト本体キーでのパンチイン／アウト本体キーでのパンチイン／アウト
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22222））））） パンチイン／アウトするトラックのパンチイン／アウトするトラックのパンチイン／アウトするトラックのパンチイン／アウトするトラックのパンチイン／アウトするトラックの [REC [REC [REC [REC [REC
SELECT] SELECT] SELECT] SELECT] SELECT] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、録音スタンバイにします。録音スタンバイにします。録音スタンバイにします。録音スタンバイにします。録音スタンバイにします。

33333））））） [PLAY] [PLAY] [PLAY] [PLAY] [PLAY] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、パンチインを開始する手前パンチインを開始する手前パンチインを開始する手前パンチインを開始する手前パンチインを開始する手前
から再生します。から再生します。から再生します。から再生します。から再生します。
再生に合わせて、演奏を始めます。

アンラッチ・タイプのフットスイッチを使って、パンチイン／アウトします。

77777））））） パンチイン／アウトした部分を再生して、パンチイン／アウトした部分を再生して、パンチイン／アウトした部分を再生して、パンチイン／アウトした部分を再生して、パンチイン／アウトした部分を再生して、録音結果録音結果録音結果録音結果録音結果
を確認します。を確認します。を確認します。を確認します。を確認します。
思うようにやり直しができなかったときは、アンド
ウ機能を使って速やかに録音する前に戻して、再度
やり直しましょう。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： 他のポイントで、連続してパン
チイン／アウトすることはできません。

再度パンチイン／アウトするには、一旦MR-
8mkIIを停止させてから同様の操作を行ってく
ださい。

[FOOT SW] ジャック

66666））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押してキーを押してキーを押してキーを押してキーを押してMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIを停止させ、を停止させ、を停止させ、を停止させ、を停止させ、パンパンパンパンパン
チインを開始した位置に戻します。チインを開始した位置に戻します。チインを開始した位置に戻します。チインを開始した位置に戻します。チインを開始した位置に戻します。

フットスイッチでのパンチイン／アウトフットスイッチでのパンチイン／アウトフットスイッチでのパンチイン／アウトフットスイッチでのパンチイン／アウトフットスイッチでのパンチイン／アウト

POWER USB FOOT SW

ONDC IN
LIGHTOFF

12V

11111））））） アンラッチアンラッチアンラッチアンラッチアンラッチ・・・・・タイプのフットスイッチを、タイプのフットスイッチを、タイプのフットスイッチを、タイプのフットスイッチを、タイプのフットスイッチを、
MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII ののののの [FOOT SW]  [FOOT SW]  [FOOT SW]  [FOOT SW]  [FOOT SW] ジャックへ接続します。ジャックへ接続します。ジャックへ接続します。ジャックへ接続します。ジャックへ接続します。

55555））））） パンチアウトする位置まで来たら、パンチアウトする位置まで来たら、パンチアウトする位置まで来たら、パンチアウトする位置まで来たら、パンチアウトする位置まで来たら、     再度フットス再度フットス再度フットス再度フットス再度フットス
イッチを踏みます。イッチを踏みます。イッチを踏みます。イッチを踏みます。イッチを踏みます。
録音が解除されて、再生状態に切り替ります（パン
チアウト）。
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MIC SIMULATION

PEAK

2 4,5

3,76

44444））））） パンチインする位置まで来たら、パンチインする位置まで来たら、パンチインする位置まで来たら、パンチインする位置まで来たら、パンチインする位置まで来たら、フットスイッチをフットスイッチをフットスイッチをフットスイッチをフットスイッチを
一度踏みます。一度踏みます。一度踏みます。一度踏みます。一度踏みます。
パンチイン／アウトするトラックのみが、再生状態
から録音に切り替ります（パンチイン）。
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あらかじめ、パンチイン／アウトしたい位置に“パンチイン・ポイント”と“パンチアウト・ポイント”を設
定して、自動でパンチイン／アウトします。オート・パンチイン／アウトではリハーサルすることが可能です
から、納得いくまで何度もリハーサルしてから本番に望むことができます。

パンチイン／アウトパンチイン／アウトパンチイン／アウトパンチイン／アウトパンチイン／アウト・・・・・ポイントの登録ポイントの登録ポイントの登録ポイントの登録ポイントの登録

33333））））） 引き続き、引き続き、引き続き、引き続き、引き続き、パンチアウトパンチアウトパンチアウトパンチアウトパンチアウト・・・・・ポイントを登録したい位ポイントを登録したい位ポイントを登録したい位ポイントを登録したい位ポイントを登録したい位
置まで来たら、置まで来たら、置まで来たら、置まで来たら、置まで来たら、同じ要領で同じ要領で同じ要領で同じ要領で同じ要領で [STORE]  [STORE]  [STORE]  [STORE]  [STORE] キーを押しなキーを押しなキーを押しなキーを押しなキーを押しな
がらがらがらがらがら [LOCATE B/OUT]  [LOCATE B/OUT]  [LOCATE B/OUT]  [LOCATE B/OUT]  [LOCATE B/OUT] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
同様に、ディスプレイには一瞬“Store LOCATE B ”
を表示して、 [LOCATE B/OUT] キーを押したとき
の時刻がパンチアウト・ポイントとして登録されま
す。

44444））））） パンチイン／アウトパンチイン／アウトパンチイン／アウトパンチイン／アウトパンチイン／アウト・・・・・ポイントの登録が済んだら、ポイントの登録が済んだら、ポイントの登録が済んだら、ポイントの登録が済んだら、ポイントの登録が済んだら、
レコーダーを停止させ、レコーダーを停止させ、レコーダーを停止させ、レコーダーを停止させ、レコーダーを停止させ、ソングの先頭ソングの先頭ソングの先頭ソングの先頭ソングの先頭（（（（（まままままたたたたたはははははパパパパパンンンンン
チインしたい位置より手前）チインしたい位置より手前）チインしたい位置より手前）チインしたい位置より手前）チインしたい位置より手前）へ戻しておきます。へ戻しておきます。へ戻しておきます。へ戻しておきます。へ戻しておきます。

＜覚えておきましょう！＞＜覚えておきましょう！＞＜覚えておきましょう！＞＜覚えておきましょう！＞＜覚えておきましょう！＞
登録したパンチイン／アウト・ポイントのデー
タは、ソング内でのロケートやプレイ・モード
による再生（☞47ページ）、さらにはパート・
データの編集などにも利用できます（☞ 103
ページ）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： 登録に失敗したときは、最初から
やり直しましょう。

11111））））） [PLAY] [PLAY] [PLAY] [PLAY] [PLAY] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、ソングの先頭ソングの先頭ソングの先頭ソングの先頭ソングの先頭（（（（（まままままたたたたたはははははパパパパパンンンンンチチチチチ
インしたいポイントより手前）インしたいポイントより手前）インしたいポイントより手前）インしたいポイントより手前）インしたいポイントより手前）から再生します。から再生します。から再生します。から再生します。から再生します。

22222））））） パンチインパンチインパンチインパンチインパンチイン・・・・・ポイントを登録したい位置まで来たら、ポイントを登録したい位置まで来たら、ポイントを登録したい位置まで来たら、ポイントを登録したい位置まで来たら、ポイントを登録したい位置まで来たら、
速やかに速やかに速やかに速やかに速やかに [STORE]  [STORE]  [STORE]  [STORE]  [STORE] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [LOCATE A/ [LOCATE A/ [LOCATE A/ [LOCATE A/ [LOCATE A/
IN] IN] IN] IN] IN] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ディスプレイには一瞬“Store LOCATE A ”を表示
して、 [LOCATE A/IN] キーを押したときの時刻が
パンチイン・ポイントとして登録されます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： プロテクトのかかっているソングでは、
パンチイン／アウト・ポイントは登録できません。
あらかじめソングのプロテクトを解除してください
（☞93ページ）。

パンチイン・ポイント パンチアウト・ポイント

パンチイン／アウトする範囲

＜覚えておきましょう！＞＜覚えておきましょう！＞＜覚えておきましょう！＞＜覚えておきましょう！＞＜覚えておきましょう！＞
パンチアウト・ポイントの登録後ソングの先頭
へ戻すには、 [STOP]  キーを押しながら
[REWIND] キーを押してください。

また、パンチイン・ポイントを登録した位置よ
り手前に移動するには、次の操作を行ってくだ
さい。

（（（（（11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [LOCATE A/IN]  [LOCATE A/IN]  [LOCATE A/IN]  [LOCATE A/IN]  [LOCATE A/IN] キーを押す。キーを押す。キーを押す。キーを押す。キーを押す。
速やかにパンチイン・ポイントを登録し
た位置へロケートして停止します。

（（（（（22222））））） [REWIND] [REWIND] [REWIND] [REWIND] [REWIND] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、パンチインパンチインパンチインパンチインパンチイン・・・・・
ポイント手前に移動して停止させます。ポイント手前に移動して停止させます。ポイント手前に移動して停止させます。ポイント手前に移動して停止させます。ポイント手前に移動して停止させます。

パンチイン・ポイントとパンチアウト・ポイントは、レコーダーを再生しながらリアルタイムに登録します（または、
登録したい位置で停止している状態でも可能です）。

オートオートオートオートオート・・・・・パンチイン／アウトパンチイン／アウトパンチイン／アウトパンチイン／アウトパンチイン／アウト

LOCATE REC END

A-B PLAY
LOCATE ABS ZERO

DELETE+-_0YZ9VWX8STU7

PLAYSTOPRECORD REWIND F FWD

PQR6

UNDO/REDOPLAY MODE STOREA / IN B / OUT
LOCATE

MNO5JKL4

AUTO PUNCH

LOCATE REC END

A-B PLAY
LOCATE ABS ZERO

DELETE+-_0YZ9VWX8STU7

PLAYSTOPRECORD REWIND F FWD

PQR6

UNDO/REDOPLAY MODE STOREA / IN B / OUT
LOCATE

MNO5JKL4

AUTO PUNCH
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MAX

MIN

MAX

MIN

REC SELECT

1 2 3 4 5/6 7/8 MASTER

RL PANL R L R L R

0 10 EFFECT SEND100 100 100

BRIT STACK US METAL 60'S COMBO

MIC

TUBECONDENSERDYNAMIC

INPUT A

LINE MIC MIN MAX LINE MIC

DISTORTION
GUITAR

UNBAL

BAL

UNBAL
/GUITAR

PEAK
TRIM TRIM

BAL

INPUT A INPUT B

PHONES VOL

L
ST OUT

R

2
PHONES

1

MIN MAX

EFFECT
REVERB/DELAY TIME

MIN MAX
HALLROOM

PLATE DELAY

LOCATE REC END

A-B PLAY
LOCATE ABS ZERO

DELETE+-_0YZ9VWX8STU7

PLAYSTOPRECORD REWIND F FWD

PQR6

UNDO/REDOPLAY MODE STOREA / IN B / OUT
LOCATE

MNO5JKL4

BRIGHTNATURALPOWERFUL MENU/ENTER

MASTERING

GHI3DEF2ABC1

7/8 WAV FILE
STEREO1-4

1-6
NEW
SONG1-8

GUIDE
RHYTHM CONTRASTTIME BASE

SELECT

BOUNCE

INPUT A SELECT

AUTO PUNCH

5/6
7/8

AMP SIMULATION

MIC SIMULATION

PEAK

PQR6

AUTO PUNCH

パンチイン／アウト・ポイントが正しく登録できたら、オート・パンチイン／アウトのリハーサルを実行します。

＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞
[LOCATE A/IN] キーを押すと、レコーダーは現
在の位置から速やかにパンチイン・ポイントま
でロケートします。その後、 [REWIND] キーを
押して、パンチイン・ポイントの手前に移動さ
せます。

11111））））） レコーダーの位置を、レコーダーの位置を、レコーダーの位置を、レコーダーの位置を、レコーダーの位置を、登録したパンチイン登録したパンチイン登録したパンチイン登録したパンチイン登録したパンチイン・・・・・ポインポインポインポインポイン
トの手前トの手前トの手前トの手前トの手前（（（（（まままままたたたたたはははははソソソソソンンンンングググググののののの先先先先先頭頭頭頭頭）））））に移動させておきに移動させておきに移動させておきに移動させておきに移動させておき
ます。ます。ます。ます。ます。

33333））））） [AUTO PUNCH] [AUTO PUNCH] [AUTO PUNCH] [AUTO PUNCH] [AUTO PUNCH] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、オートパンチオートパンチオートパンチオートパンチオートパンチ・・・・・
モードをモードをモードをモードをモードを“““““OnOnOnOnOn”””””に設定します。に設定します。に設定します。に設定します。に設定します。
ディスプレイに“ ”アイコンが点灯しま
す。

44444））））） [PLAY] [PLAY] [PLAY] [PLAY] [PLAY] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、ソングを再生します。ソングを再生します。ソングを再生します。ソングを再生します。ソングを再生します。
[PLAY] キーを押すと、“ ”アイコンが
“ ”（REHEARSAL)に変わり、オート・パ
ンチイン／アウトのリハーサル・モードに入ったこ
とを表します。

22222））））） オートオートオートオートオート・・・・・パンチイン／アウトするトラックのパンチイン／アウトするトラックのパンチイン／アウトするトラックのパンチイン／アウトするトラックのパンチイン／アウトするトラックの [REC [REC [REC [REC [REC
SELECT] SELECT] SELECT] SELECT] SELECT] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、そのトラックを録音スタそのトラックを録音スタそのトラックを録音スタそのトラックを録音スタそのトラックを録音スタ
ンバイにします。ンバイにします。ンバイにします。ンバイにします。ンバイにします。

点灯

＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞
オート・パンチイン／アウトのリハーサルを実
行する際、本機の「ループ機能」を併用するこ
とで、煩わしいキーの操作などを省くことがで
き、演奏に集中することができます。
詳細については、49ページをご覧ください。

55555））））） リハーサルが終了したら停止させ、リハーサルが終了したら停止させ、リハーサルが終了したら停止させ、リハーサルが終了したら停止させ、リハーサルが終了したら停止させ、レコーダーのレコーダーのレコーダーのレコーダーのレコーダーの
位置を元に戻します。位置を元に戻します。位置を元に戻します。位置を元に戻します。位置を元に戻します。

リハーサルでは、上の図のようにパンチイン・ポ
イントまで再生すると、自動的にREC READYに
なっているトラックがインプットモニターになる
だけで、実際には録音されません（[RECORD]キー
が点滅し、ディスプレイには“ ”が点灯
します）。

この操作を繰り返すことで、オート・パンチイン／
アウトの練習を納得のいくまで行なえます。

オートパンチモードの
ON/OFF は、 [AUTO
PUNCH] キーで切り替え
ます。

キーを押すごとにON（ラ
ンプ点灯）/OFF（ランプ
消灯）が切り替ります。

＜オート＜オート＜オート＜オート＜オート・・・・・パンチモードのパンチモードのパンチモードのパンチモードのパンチモードのON/OFFON/OFFON/OFFON/OFFON/OFF＞＞＞＞＞

オートオートオートオートオート・・・・・パンチイン／アウトのリハーサルパンチイン／アウトのリハーサルパンチイン／アウトのリハーサルパンチイン／アウトのリハーサルパンチイン／アウトのリハーサル
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十分なリハーサルを行った後、オート・パンチイン／アウトのテイクを実行します。

11111））））） レコーダーの位置を、レコーダーの位置を、レコーダーの位置を、レコーダーの位置を、レコーダーの位置を、登録したパンチイン登録したパンチイン登録したパンチイン登録したパンチイン登録したパンチイン・・・・・ポインポインポインポインポイン
トの手前に移動させます。トの手前に移動させます。トの手前に移動させます。トの手前に移動させます。トの手前に移動させます。

22222））））） オートオートオートオートオート・・・・・パンチパンチパンチパンチパンチ・・・・・モードがモードがモードがモードがモードが“““““OnOnOnOnOn”””””になっているこになっているこになっているこになっているこになっているこ
とを確認します。とを確認します。とを確認します。とを確認します。とを確認します。
Onになっていないときは、 [AUTO PUNCH] キー
を押して、ディスプレイに  を点灯させ
ます。

33333））））） [PLAY] [PLAY] [PLAY] [PLAY] [PLAY] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [RECORD]  [RECORD]  [RECORD]  [RECORD]  [RECORD] キーを押しキーを押しキーを押しキーを押しキーを押し
ます。ます。ます。ます。ます。

＜オート＜オート＜オート＜オート＜オート・・・・・パンチイン／アウトのやり直し＞パンチイン／アウトのやり直し＞パンチイン／アウトのやり直し＞パンチイン／アウトのやり直し＞パンチイン／アウトのやり直し＞
テイクを失敗したときは、オート・パンチイン
／アウトの終了後、速やかに [UNDO/REDO]
キーを押して、アンドウした後最初からやり直
しができます。

＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞＜ポイント＞
本機では、パンチイン／アウトのような部分的なや
り直し以外に、つぎのような各種編集機能を搭載し
ています。

● 任意のトラック・データ全てを削除する（Erase
Trackメニュー：☞96ページ）。

● 任意のトラック・データ全てを他のトラックへコ
ピー・ペーストする（Copy Paste Trackメニ
ュー：☞97ページ）。

● 任意のトラック・データを他のトラックへムーブ
（移動）する（Move Trackメニュー：☞99ペー
ジ）。

● 異なったトラック間でデータ全てを入れ替える
（Change Trackメニュー：☞101ページ）。

● 任意のパートだけを削除する（Erase Partメニ
ュー：☞105ページ））。

● 任意のパートだけを他のトラックへペーストす
る（Copy-Paste Partメニュー：☞106ページ、
Copy Partメニュー／Paste Partメニュー：☞
108ページ）。

● 任意のパートを他のトラックへムーブ（移動）す
る（Move Partメニュー：☞111ページ）。

● トラック間でパートを入れ替える（Change Part
メニュー：☞113ページ）。

＜パートとは＞＜パートとは＞＜パートとは＞＜パートとは＞＜パートとは＞
本機で言う「パート」とは、あらかじめ登録され
た“LOCATE Aポイント”と“LOCATE Bポイ
ント”間の音声データを指しています。

そのため、後述のパートの編集を実行するには
“LOCATE Aポイント”と“LOCATE Bポイント”
が登録されていることが必要です。

オート・パンチイン／アウトを実行するために登
録したパンチイン／アウト・ポイントは、
“LOCATE Aポイント”および“LOCATE Bポイ
ント”としても利用されます。

[PLAY] キーを押しながら [RECORD] キーを押す
と、ディスプレイの“ ”アイコンが
“ ”（TAKE)に変わり、オート・パンチイ
ン／アウトのテイクに入ったことを表します。

テイクでは前述のリハーサルと異なり、パンチイ
ン・ポイントで自動的に録音モードに入り、差し換
える部分の演奏が録音されていきます。
そして、パンチアウト・ポイントまで達すると、自
動的に録音モードとオートパンチ・モードが解除さ
れます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： リハーサルのときは [PLAY] キー
のみを押しましたが、テイクでは必ず [PLAY]
キーを押しながら [RECORD] キーを押してくだ
さい。

オートオートオートオートオート・・・・・パンチイン／アウトのテイクパンチイン／アウトのテイクパンチイン／アウトのテイクパンチイン／アウトのテイクパンチイン／アウトのテイク（（（（（本本本本本番番番番番）））））
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エフェクト機能エフェクト機能エフェクト機能エフェクト機能エフェクト機能
MR-8mkIIには、録音時に有効なインサート・エフェクト（2タイプのシミュ
レーション）、バウンス／ミックスダウン時など、録音したトラックを再生し
ながらエフェクト処理するディレイ／リバーブ（トラック1～4のみ）に加
え、L/Rにミックスするときに有効なマスタリング・エフェクトを搭載してい
ます。
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インサート・エフェクトは [INPUT A] にのみ有効で、2タイプのインサート・エフェクトを搭載しています。
１つはマイク・シミュレーション、もう１つはアンプ・シミュレーションで、録音するときに有効です。

これには、代表的なマイクやギター・アンプをシミュレートしたアルゴリズムが、あらかじめプリセットされ
ています。例えば、アコースティック・ギターをオン・マイクで録音したり、エレクトリック・ギターを録音
したりするとき、このインサート・エフェクトを利用すると、あたかも著名なマイクやギターあたかも著名なマイクやギターあたかも著名なマイクやギターあたかも著名なマイクやギターあたかも著名なマイクやギター・・・・・アンプを使っアンプを使っアンプを使っアンプを使っアンプを使っ
たかのような音質たかのような音質たかのような音質たかのような音質たかのような音質で録音することが可能になります（もちろんシミュレートですから、本物ソックリという訳
にはいきませんが・・・！）。

MR-8mkIIのリア・パネルにある [INPUT A SEL] スイッチを“MIC/LINE”ポジションで使用すると、マイク・シミュレー
ションが機能します。

マイク・シミュレーションが機能するときのインサート・
エフェクトは、“DYNAMIC” 、“CONDENSER” または
“TUBE” のいずれか１つをセレクトできます（セレクトし
たキーのランプが点灯します）。

●●●●●マイクマイクマイクマイクマイク・・・・・シミュレーションの詳細シミュレーションの詳細シミュレーションの詳細シミュレーションの詳細シミュレーションの詳細

DYNAMIC

CONDENSER

TUBE

ダイナミック・マイクのサウンドをシ
ミュレートします。

プロ用コンデンサー・マイクのサウン
ドをシミュレートします。

プロ用チューブ・マイクのサウンドを
シミュレートします。

“MIC/LINE”ポジション

“DYNAMIC”“CONDENSER” “TUBE”

マイクマイクマイクマイクマイク・・・・・シミュレーションを使うシミュレーションを使うシミュレーションを使うシミュレーションを使うシミュレーションを使う

アンプアンプアンプアンプアンプ・・・・・シミュレーションを使うシミュレーションを使うシミュレーションを使うシミュレーションを使うシミュレーションを使う

アンプ・シミュレーションが機能するときのインサート・
エフェクトは、“BRIT STACK” 、“US METAL” または“60’s
COMBO” のいずれか1つをセレクトできます（セレクト
したキーのランプが点灯します）。

●●●●●アンプアンプアンプアンプアンプ・・・・・シミュレーションの詳細シミュレーションの詳細シミュレーションの詳細シミュレーションの詳細シミュレーションの詳細

BRIT STACK

US METAL

60’s COMBO

イギリス製800系真空管アンプヘッド
をシミュレートします。
ハイゲイン・アンプシリーズのアンプ
ヘッドをシミュレートします。

真空管コンボ・アンプをシミュレート
します。

“GUITAR”ポジション

“BRIT STACK” “US METAL” “60”s COMBO”

MR-8mkIIのリア・パネルにある [INPUT A SEL] スイッチを“GUITAR”ポジションで使用するとき、アンプ・シミュレー
ションが機能します。なお、“GUITAR”ポジションでは、インサート・エフェクトに加え、ディストーション（歪み）を効
かせることが可能です（[DISTORTION] つまみで調整）。

インサートインサートインサートインサートインサート・・・・・エフェクトをかけるエフェクトをかけるエフェクトをかけるエフェクトをかけるエフェクトをかける

INPUT A SELECT

INT MIC
GUITAR

MIC/LINE

INPUT A SELECT

INT MIC
GUITAR

MIC/LINE

BRIT STACK US METAL 60'S COMBO

MIC

TUBECONDENSERDYNAMIC

INPUT A

AMP SIMULATION

MIC SIMULATION

BRIT STACK US METAL 60'S COMBO

MIC

TUBECONDENSERDYNAMIC

INPUT A

AMP SIMULATION

MIC SIMULATION

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：     [INPUT A SELECT] スイッチを“INT MIC”
ポジションにして内蔵マイクを使用するときは、イン
サート・エフェクトは機能しません。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：     [INPUT A SELECT] スイッチを“INT MIC”
ポジションにして内蔵マイクを使用するときは、イン
サート・エフェクトは機能しません。
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エフェクトエフェクトエフェクトエフェクトエフェクト・・・・・タイプのセレクトタイプのセレクトタイプのセレクトタイプのセレクトタイプのセレクト

トラック1～4の再生音には、新アルゴリズムで構成されたリバーブ（またはディレイ）をかけることができ
ます。後述の「バウンス」あるいは「ミックスダウン」を実行する際、トラック1～4の再生音にリバーブ（ま
たはディレイ）をかけながらバウンスやミキシングができます。

エフェクトエフェクトエフェクトエフェクトエフェクト・・・・・タイプの詳細タイプの詳細タイプの詳細タイプの詳細タイプの詳細

ROOM

HALL

PLATE

DELAY

程よい空間をイメージする、ルーム・リバー
ブ効果が得られます。“ROOM”を選択した
ときは、 [REVERB/DELAY TIME] つまみで
リバーブ・タイムを調整できます。

適度なPre Delayを持った一般的なホール・
リバーブ効果が得られます。“HALL”を選
択したときは、 [REVERB/DELAY TIME] つ
まみでリバーブ・タイムが調整できます。

帯域の広い、プレート・リバーブ効果が得
られます。“PLATE”を選択したときは、
[REVERB/DELAY TIME] つまみでリバー
ブ・タイムが調整できます。

“DELAY”を選択したときは、MENU モー
ドのSystem 設定の中にある、“De lay
Type”で好みのディレイ・タイプを選択し
て使用できます （ [DELAY] キーを長押し
することでも、“Delay Type”の設定画面に
進むことができます）。

ディレイ・タイプにはMonoディレイ／L-
Rディレイ／Diffディレイの3つのタイプ
があり、好みのディレイ効果が得られます。
初期設定ではL-Rディレイになっています
ので、次項を参照して好みのディレイ・タ
イプを選択してください。
“DELAY”を選択したときは、 [REVERB
TIME] つまみでディレイ・タイムが調整で
きます。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““SystemSystemSystemSystemSystem”””””に移動に移動に移動に移動に移動
して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Systemメニューを選択する1ページめの画面に変
り、同様に“<< Back”が反転します。

エフェクト・タイプには、3つのリバーブ（ROOM/
HALL/PLATE）と1つのディレイ（DELAY）があり、
下図の [EFFECT] キーでセレクトします（セレクトし
たキーのランプが点灯します）。 11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU

モードモードモードモードモードへ入ります。へ入ります。へ入ります。へ入ります。へ入ります。
MENUを選択する画面に変り、初期設定では
“<< Back”が反転します。

ディレイを使うときは、下記の操作でディレイ・タイプ
が選択できます。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Delay TypeDelay TypeDelay TypeDelay TypeDelay Type”””””ににににに
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在設定されているディレイ・タイプが点滅し、希
望のタイプが選択できるようになります。初期設定
では“L-R”が点滅します。

ディレイディレイディレイディレイディレイ・・・・・タイプのセレクトタイプのセレクトタイプのセレクトタイプのセレクトタイプのセレクト

リバーブ／ディレイをかけるリバーブ／ディレイをかけるリバーブ／ディレイをかけるリバーブ／ディレイをかけるリバーブ／ディレイをかける

EFFECT
REVERB/DELAY TIME

MIN MAX
HALLROOM

PLATE DELAY

[ROOM] キー

[PLATE] キー

[HALL] キー

[DELAY] キー

点滅
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エフェクト処理される信号は、外観からはどのような
経路でどこへ送られているか見ることができませんが、
下記シグナル・フローチャートにその流れを記載して
います。

下記シグナル・フローチャートにあるように、1～4そ
れぞれのトラック・フェーダーで調整された再生音（ド
ライ音）が、 [EFFECT SEND] つまみを上げていくこ
とでそのドライ音が内蔵エフェクトへ送られていきま
す。そして、エフェクト処理された信号が、ステレオ・
バスL, Rへと送られていきます。

そのため、ステレオ・バスL, Rにはドライ音（エフェ
クト処理されない信号）とエフェクト処理された音が、
同時に送られていることになります。

なお、下の図からわかるように、エフェクトをかけるに
は、1～4のトラック・フェーダーが上がっている状態
で [EFFECT SEND] つまみを調整することが大切です。
つまり、エフェクトへ送られるドライ音は常にトラッ
ク・フェーダーの影響を受けているため、この信号を
「ポスト・フェーダー」と呼んでいます（ちなみに、ト
ラック・フェーダーの影響を受けない信号を、プリ・
フェーダーと呼んでいます）。

[REVERB / DELAY TIME] つまみ

HALL

ROOM

PLATE

DELAY

1.0s～6.0sの範囲でリバーブ・タイムが調整
可能（センター：3.0s）

0.1s～2.0sの範囲でリバーブ・タイムが調整
可能（センター：1.0s）

0.5s～4.0sの範囲でリバーブ・タイムが調整
可能（センター：2.0s）

100ms～1000msの範囲でディレイ・タイム
が調整可能（センター：300ms）

＜エフェクトへ送られる信号の流れ＜エフェクトへ送られる信号の流れ＜エフェクトへ送られる信号の流れ＜エフェクトへ送られる信号の流れ＜エフェクトへ送られる信号の流れ（（（（（トトトトトラララララッッッッッククククク11111～～～～～44444のみ）のみ）のみ）のみ）のみ）＞＞＞＞＞

ドライ・サウンド

エフェクト・サウンド

再生

トラックの
再生レベルを調整

エフェクトへ送る
信号量を調整

トラック1～4の再生音にディレイまたはリバーブを
かけるには、下図の [EFFECT SEND] つまみを調整し
てトラック再生音を内蔵エフェクトへ送り込みます
（エフェクト・センドと呼んでいます）。

下の図は、トラック1と2にエフェクトをかけるため、
[EFFECT SEND] つまみ1と2を上げた例です。

選択するエフェクト・タイプ（リバーブまたはディレ
イ）によって、 [REVERB / DELAY TIME] つまみを回
すと、リバーブ・タイム、またはディレイ・タイムが調
整できます。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで希望のディレイダイヤルで希望のディレイダイヤルで希望のディレイダイヤルで希望のディレイダイヤルで希望のディレイ・・・・・タイプを選択タイプを選択タイプを選択タイプを選択タイプを選択
して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択したディレイ・タイプに設定され、一つ前の画
面に変ります。

55555））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

ディレイ・タイプは下記3種類から選択できます。

L - R

Mono

Diff

L-R (ステレオ)ディレイ（初期設定）

Mono（モノ）ディレイ

Diffusion（拡散）ディレイ

Track 1

1

0 10

Delay
or

Reverb

L R

EFFECT SEND

PAN

STEREO BUSS

L R

リバーブ／ディレイリバーブ／ディレイリバーブ／ディレイリバーブ／ディレイリバーブ／ディレイ・・・・・タイムの調整タイムの調整タイムの調整タイムの調整タイムの調整

エフェクトエフェクトエフェクトエフェクトエフェクト・・・・・センドの調整センドの調整センドの調整センドの調整センドの調整

EFFECT
REVERB/DELAY TIME

MIN MAX
HALLROOM

PLATE DELAY

0 10 EFFECT SEND100 100 100
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本機には、ステレオ・バスL, R専用のマスタリング・エフェクトを搭載しています。マスタリング・エフェク
トは、下の図のように複数トラックをバウンスして2つのトラックにまとめるときや、トラック1～8をミッ
クスダウンして、外部マスターレコーダーへ録音するときなどに有効です。

POWERFUL

NATURAL

BRIGHT

＜トラック＜トラック＜トラック＜トラック＜トラック11111～～～～～44444ををををを5/65/65/65/65/6へバウンス＞へバウンス＞へバウンス＞へバウンス＞へバウンス＞ ＜トラック＜トラック＜トラック＜トラック＜トラック11111～～～～～66666ををををを7/87/87/87/87/8へバウンス＞へバウンス＞へバウンス＞へバウンス＞へバウンス＞

＜トラック＜トラック＜トラック＜トラック＜トラック11111～～～～～88888をミックスダウン＞をミックスダウン＞をミックスダウン＞をミックスダウン＞をミックスダウン＞

Track 4

Track 3

Track 2

Track 1

Track 7
Track 8

Track 5
Track 6

STEREO OUT (L, R)

Track 4

Track 3

Track 2

Track 1

Track 5
Track 6

Track 7
Track 8

STEREO OUT (L, R)

Track 4
Track 3
Track 2
Track 1

Track 5

Track 6

Track 7

Track 8

D/A

複数トラックをまとめる「バウンス」については65ページ、
「ミックスダウン」については44ページをお読みください。

マスタリング・エフェクト マスタリング・エフェクト

マスタリング・エフェクト

[STEREO OUT L, R]

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： マスタリング・エフェクトをオンする
と、出力レベルが上がります。そのため、外部レコー
ダーの録音レベル調整や、ヘッドホンやモニター・ス
ピーカでモニターしているときなど、音量の変化にご
注意ください。

Track 4

Track 3

Track 2

Track 1

Track 5
Track 6

Track 7
Track 8

STEREO OUT (L, R)

Track 7
Track 8

＜トラック＜トラック＜トラック＜トラック＜トラック11111～～～～～88888をををををNewNewNewNewNewソングへバウンス＞ソングへバウンス＞ソングへバウンス＞ソングへバウンス＞ソングへバウンス＞

マスタリング・エフェクト

音圧が上がり、迫力のある音になります。
ロック系の曲に向いています。

音の変化が少なく、適度な音圧上げを行う
ため、アコースティック系の曲に向いてい
ます。

抜けの良い音になります。ミックスの仕上
がりがこもっているときに向いています。

各エフェクト・タイプには右記のような特長がありま
す。好みに合わせてご利用ください。

マスタリング・エフェクトには3つのタイプが用意さ
れ、下図の [MASTERING] キー（POWERFUL,
NATURAL, BRIGHT）でセレクトします（セレクトし
たキーのランプが点灯します）。

マスタリングマスタリングマスタリングマスタリングマスタリング・・・・・エフェクトのタイプをセレクトエフェクトのタイプをセレクトエフェクトのタイプをセレクトエフェクトのタイプをセレクトエフェクトのタイプをセレクト

マスタリングマスタリングマスタリングマスタリングマスタリング・・・・・エフェクトをかけるエフェクトをかけるエフェクトをかけるエフェクトをかけるエフェクトをかける

MNO5JKL4

BRIGHTNATURALPOWERFUL

MASTERING



64

MR-8mkII MR-8mkII MR-8mkII MR-8mkII MR-8mkII 　取扱説明書　取扱説明書　取扱説明書　取扱説明書　取扱説明書（（（（（エエエエエフフフフフェェェェェクククククトトトトト機機機機機能能能能能）））））



65

MR-8mkII MR-8mkII MR-8mkII MR-8mkII MR-8mkII 　取扱説明書　取扱説明書　取扱説明書　取扱説明書　取扱説明書（（（（（バババババウウウウウンンンンンススススス機機機機機能能能能能）））））

バウンス機能バウンス機能バウンス機能バウンス機能バウンス機能
ここでは、曲を完成させる過程で重要な、バウンス機能について記載していま
す。
バウンスとは、複数トラックに録音した音を2つのトラックにまとめる（以前
はピンポン録音とも呼んでいました）作業です、
マルチトラッカーではこのバウンス機能を使い、録音トラックを有効に活用す
ることで、より多くの音源が録音可能になります。MR-8mkIIでは、下記3種
類のバウンス方法があります。

（（（（（11111））））） トラックトラックトラックトラックトラック11111～～～～～44444を、を、を、を、を、トラックトラックトラックトラックトラック5/65/65/65/65/6にバウンスするにバウンスするにバウンスするにバウンスするにバウンスする

（（（（（22222））））） トラックトラックトラックトラックトラック11111～～～～～66666を、を、を、を、を、トラックトラックトラックトラックトラック7/87/87/87/87/8にバウンスするにバウンスするにバウンスするにバウンスするにバウンスする

（（（（（33333））））） トラックトラックトラックトラックトラック11111～～～～～88888を、を、を、を、を、NewNewNewNewNewソングのトラックソングのトラックソングのトラックソングのトラックソングのトラック7/87/87/87/87/8にバウンスするにバウンスするにバウンスするにバウンスするにバウンスする

いずれのバウンス時においても、トラック1～4にはリバーブまたはディレイ
をかけることができ、ミックスしたステレオ・バスL, R信号にはマスタリン
グ・エフェクトをかけることもできます。
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バウンス・モードを活用すると録音トラックが有効に使え、下記例のようにより多くの音源を多重録音するこ
とができます。

＜手順＜手順＜手順＜手順＜手順-1-1-1-1-1＞＞＞＞＞
トラック1～6へ録音。

＜手順＜手順＜手順＜手順＜手順 -2-2-2-2-2＞＞＞＞＞
トラック1～6をトラック7/8へバウンス。

＜手順＜手順＜手順＜手順＜手順-3-3-3-3-3＞＞＞＞＞
トラック1～6を削除。

＜手順＜手順＜手順＜手順＜手順 -4-4-4-4-4＞＞＞＞＞
トラック1～4へ新たな音源
をオーバーダビング。

＜手順＜手順＜手順＜手順＜手順 -5-5-5-5-5＞＞＞＞＞
トラック1～4をトラック5/6へバウンス。

Track 4
Track 3
Track 2
Track 1

Track 5

Track 6

Track 7

Track 8

Track 4
Track 3
Track 2
Track 1

Track 5

Track 6

Track 7

Track 8

Track 4
Track 3
Track 2
Track 1

Track 5

Track 6

Track 7

Track 8

Track 4
Track 3
Track 2
Track 1

Track 5

Track 6

Track 7

Track 8

Track 4
Track 3
Track 2
Track 1

Track 5

Track 6

Track 7

Track 8

Track 4
Track 3
Track 2
Track 1

Track 5

Track 6

Track 7

Track 8

Track 4
Track 3
Track 2
Track 1

Track 5

Track 6

Track 7

Track 8

＜手順＜手順＜手順＜手順＜手順 -6-6-6-6-6＞＞＞＞＞
トラック1～4を削除。

＜手順＜手順＜手順＜手順＜手順-7-7-7-7-7＞＞＞＞＞
トラック1～4へ新たな音源
をオーバーダビング。

ここでは、先にバウンスしたト
ラック7/8の再生音を聞きながら
バウンスできます（☞68ページ）。

バウンスを始める前に、下記「バウンス・モードの活用例」と次ページの「バウンス・モードの信号の流れ」を
お読みください。

バウンスバウンスバウンスバウンスバウンス・・・・・モードの活用例モードの活用例モードの活用例モードの活用例モードの活用例

初めにお読みください初めにお読みください初めにお読みください初めにお読みください初めにお読みください
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●●●●●“““““1-61-61-61-61-6＞＞＞＞＞7/87/87/87/87/8”””””モードモードモードモードモード（☞70ページ）
“1-6＞7/8”モードでは、トラック1～6を再生し
ながらミキシング（L, R）して、トラック7/8にバ
ウンスします。
このとき、好みに応じてトラック1～4にはエフェ
クト（ディレイまたはリバーブ）をかけたり、最終
的にミキシングした信号（L, R）にマスタリング・
エフェクトをかけることもできます。

バウンス実行時、ヘッドホン（またはモニター・ス
ピーカー）からはトラック7/8に録音している音
（ミックス信号）が聴こえてきます。

●●●●●“““““1-41-41-41-41-4＞＞＞＞＞5/65/65/65/65/6”””””モードモードモードモードモード（☞68ページ）
“1-4＞5/6”モードでは、トラック1～4を再生し
ながらミキシング（L, R）して、トラック5/6にバ
ウンスします。
このとき、好みに応じてトラック1～4にはエフェ
クト（ディレイまたはリバーブ）をかけたり、最終
的にミキシングした信号（L, R）にマスタリング・
エフェクトをかけることができます。

バウンス実行時、ヘッドホン（またはモニター・ス
ピーカー）からはトラック5/6に録音している音
と、トラック7/8の再生音が一緒に聴こえてきま
す。

●●●●●“““““1-81-81-81-81-8＞＞＞＞＞NEW SONGNEW SONGNEW SONGNEW SONGNEW SONG”””””モードモードモードモードモード（☞72ページ）
“1-8＞NEW SONG”モードでは、トラック1～8
を再生しながらミキシング（L, R）して、自動的に
作成されるNewソングのトラック7/8にバウンス
します。つまり、“1-8 > NEW SONG”モードを使
うことで、外部マスター・レコーダーを使うことな
く、本機自身でマスター・ソングを完成させること
ができます。

ことのき、好みに応じてトラック1～4にはエフェ
クト（ディレイまたはリバーブ）をかけたり、最終
的にミキシングした信号（L, R）にマスタリング・
エフェクトをかけることができます。

バウンス実行時、ヘッドホン（またはモニター・ス
ピーカー）からはNewソングのトラック7/8に録
音している音が聴こえてきます。

Track 4

Track 3

Track 2

Track 1

Track 7
Track 8

Track 5
Track 6

STEREO OUT (L, R)

Track 4

Track 3

Track 2

Track 1

Track 5
Track 6

Track 7
Track 8

STEREO OUT (L, R)

Track 4

Track 3

Track 2

Track 1

Track 5
Track 6

Track 7
Track 8

STEREO OUT (L, R)

Track 7
Track 8

バウンスバウンスバウンスバウンスバウンス・・・・・モードの信号の流れモードの信号の流れモードの信号の流れモードの信号の流れモードの信号の流れ

バウンス・モードにはつぎの3つのモードがあり、それぞれ下図のように信号が送られていきます。
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本番を実行する前に、ソングを再生しながら各トラックの再生レベル／定位を調整したり、トラック1～4にはディ
レイ（またはリバーブ）をかけていきます。また、ミックスしたL、R信号にはマスタリング・エフェクトをかける
ことができますので、好みの音でバウンスできるよう十分なリハーサルを行います。

下記操作は、あらかじめバウンスしたいソングが立ち上がっていることを前提にしています。

11111））））） [1-4>5/6, 1-6>7/8] [1-4>5/6, 1-6>7/8] [1-4>5/6, 1-6>7/8] [1-4>5/6, 1-6>7/8] [1-4>5/6, 1-6>7/8] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、     バウンスバウンスバウンスバウンスバウンス・・・・・モーモーモーモーモー
ドをドをドをドをドを“““““1-4 > 5/61-4 > 5/61-4 > 5/61-4 > 5/61-4 > 5/6”””””に切り替えます。に切り替えます。に切り替えます。に切り替えます。に切り替えます。
バウンス・モード“1-4>5/6”がONになると、自
動的にトラック5/6がREADYトラックに設定さ
れ、5/6がインプットモニターになります。
ディスプレイは、下記例のように表示されます。

点灯

点滅

22222））））） トラックトラックトラックトラックトラック5/65/65/65/65/6のフェーダーとのフェーダーとのフェーダーとのフェーダーとのフェーダーと [MASTER]  [MASTER]  [MASTER]  [MASTER]  [MASTER] フェーダフェーダフェーダフェーダフェーダ
ーをーをーをーをーを“““““ ”””””位置まで上げ、位置まで上げ、位置まで上げ、位置まで上げ、位置まで上げ、 他のトラック他のトラック他のトラック他のトラック他のトラック・・・・・フェーフェーフェーフェーフェー
ダーは全てダーは全てダーは全てダーは全てダーは全て“““““MINMINMINMINMIN”””””位置に下げておきます。位置に下げておきます。位置に下げておきます。位置に下げておきます。位置に下げておきます。

トラック1～4の録音ミックスを
調整します。

44444））））） 再生しながら、再生しながら、再生しながら、再生しながら、再生しながら、トラックトラックトラックトラックトラック11111～～～～～44444のフェーダーで各トのフェーダーで各トのフェーダーで各トのフェーダーで各トのフェーダーで各ト
ラックの再生レベルを調整します。ラックの再生レベルを調整します。ラックの再生レベルを調整します。ラックの再生レベルを調整します。ラックの再生レベルを調整します。
トラックトラックトラックトラックトラック11111～～～～～44444のののののPANPANPANPANPANを調整したり、を調整したり、を調整したり、を調整したり、を調整したり、ディレイやディレイやディレイやディレイやディレイや
リバーブをかけ、リバーブをかけ、リバーブをかけ、リバーブをかけ、リバーブをかけ、好みに合わせてミックスしたサウ好みに合わせてミックスしたサウ好みに合わせてミックスしたサウ好みに合わせてミックスしたサウ好みに合わせてミックスしたサウ
ンドにマスタリングンドにマスタリングンドにマスタリングンドにマスタリングンドにマスタリング・・・・・エフェクトをかけます。エフェクトをかけます。エフェクトをかけます。エフェクトをかけます。エフェクトをかけます。
トラック5/6へバウンスする際のリハーサルおよ
び本番中は、各トラック・フェーダーや [MASTER]
フェーダーは、つぎの役目を果たします。

フェーダーフェーダーフェーダーフェーダーフェーダー
11111～～～～～44444点灯

バウンスのリハーサルバウンスのリハーサルバウンスのリハーサルバウンスのリハーサルバウンスのリハーサル

トラック1～4に録音した演奏をミックスして、トラック5/6へバウンスします。
バウンスを実行する前には十分なリハーサルを重ねて、本番へ進むことができます。

33333））））） [PLAY] [PLAY] [PLAY] [PLAY] [PLAY] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、ソングの先頭から再生しまソングの先頭から再生しまソングの先頭から再生しまソングの先頭から再生しまソングの先頭から再生しま
す。す。す。す。す。

[MASTER][MASTER][MASTER][MASTER][MASTER]
フェーダーフェーダーフェーダーフェーダーフェーダー

フェーダーフェーダーフェーダーフェーダーフェーダー
5/65/65/65/65/6

トラック5/6の録音レベルを調整
します。

トラック5/6の再生レベル（モニ
ター・レベル）を調整します。

トラックトラックトラックトラックトラック11111～～～～～44444ををををを5/65/65/65/65/6にバウンスにバウンスにバウンスにバウンスにバウンス
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55555））））） リハーサルが終ったらリハーサルが終ったらリハーサルが終ったらリハーサルが終ったらリハーサルが終ったら [STOP]  [STOP]  [STOP]  [STOP]  [STOP] キーを押して停止キーを押して停止キーを押して停止キーを押して停止キーを押して停止
させ、させ、させ、させ、させ、ソングの先頭へ戻します。ソングの先頭へ戻します。ソングの先頭へ戻します。ソングの先頭へ戻します。ソングの先頭へ戻します。
リハーサルで設定した各つまみやフェーダーのポジ
ションは、そのままにしておきましょう。

11111））））） 本番に入る前に、本番に入る前に、本番に入る前に、本番に入る前に、本番に入る前に、バウンスバウンスバウンスバウンスバウンス・・・・・モードモードモードモードモード（（（（（1-4>5/61-4>5/61-4>5/61-4>5/61-4>5/6）））））ががががが
ONONONONONになっていることを確認してください。になっていることを確認してください。になっていることを確認してください。になっていることを確認してください。になっていることを確認してください。

22222））））） [RECORD] [RECORD] [RECORD] [RECORD] [RECORD] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [PLAY]  [PLAY]  [PLAY]  [PLAY]  [PLAY] キーを押しキーを押しキーを押しキーを押しキーを押し
ます。ます。ます。ます。ます。
リハーサルで設定したレベル／音質でバウンスが始
まり、トラック5/6へ録音されていきます。

33333））））） バウンスが終了したら、バウンスが終了したら、バウンスが終了したら、バウンスが終了したら、バウンスが終了したら、 [STOP]  [STOP]  [STOP]  [STOP]  [STOP] キーを押してキーを押してキーを押してキーを押してキーを押してMR-MR-MR-MR-MR-
8mkII8mkII8mkII8mkII8mkII を停止させます。を停止させます。を停止させます。を停止させます。を停止させます。
MR-8mkIIを停止させると、トラック5/6のイン
プットモニターは自動的に解除され、“INPUT
MONI”アイコンが消えます。
終了と同時にディスプレイがつぎの画面に変りま
す。これはバウンスしたトラック5/6を再生して、
確認することを促しています。

11111））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [REWIND]  [REWIND]  [REWIND]  [REWIND]  [REWIND] キーを押しキーを押しキーを押しキーを押しキーを押し
て、て、て、て、て、ソングの先頭へ戻します。ソングの先頭へ戻します。ソングの先頭へ戻します。ソングの先頭へ戻します。ソングの先頭へ戻します。

22222））））） インプットモニターが解除されていることを確認しインプットモニターが解除されていることを確認しインプットモニターが解除されていることを確認しインプットモニターが解除されていることを確認しインプットモニターが解除されていることを確認し
ます。ます。ます。ます。ます。

33333））））） [PLAY] [PLAY] [PLAY] [PLAY] [PLAY] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、ソングの先頭から再生しまソングの先頭から再生しまソングの先頭から再生しまソングの先頭から再生しまソングの先頭から再生しま
す。す。す。す。す。

44444））））） トラックトラックトラックトラックトラック5/65/65/65/65/6のフェーダーで、のフェーダーで、のフェーダーで、のフェーダーで、のフェーダーで、バウンスしたトラッバウンスしたトラッバウンスしたトラッバウンスしたトラッバウンスしたトラッ
クの再生レベルを調整します。クの再生レベルを調整します。クの再生レベルを調整します。クの再生レベルを調整します。クの再生レベルを調整します。
バウンス・モードがONになっている状態でソング
を再生すると、トラック5/6のみがモニターされま
す。
このときトラック1～4のフェーダーを上げても
トラック1～6の再生音は聴こえません。

トラック5/6の音を確認した後、バウンスをやり直
したいときは、「アンドウ機能」を使って一旦バウ
ンスする前に戻し、再度リハーサルを行ってから本
番に挑戦しましょう。

十分なリハーサルが終了したら、本番を実行しましょ
う。ソングの先頭に戻っていることを確認してくださ
い。

＜＜＜＜＜PANPANPANPANPANの調整について＞の調整について＞の調整について＞の調整について＞の調整について＞
トラック1～4のPAN調整に、決まりはありま
せん。ギター演奏は左、ボーカルはセンター・・・
というように、好みに合わせて調整してくださ
い。

[PHONES VOL] つまみを回していくと、ヘッドホ
ンからはトラック5/6にバウンスされている音が
聴こえてきます。

トラック5/6のフェーダーでモニターの出力レベ
ルを調整し、 [MASTER] フェーダーで、バウンス
する最終録音レベルを調整します。
レベル・メータの5/6を見ながら、最適な録音レ
ベルを調整してください。

好みに応じて、トラック1～4にはディレイ（また
はリバーブ）をかけ、ミックスしたL/R信号にマ
スタリング・エフェクトをかけていきます。
エフェクトの詳細については、69ページ記載の「エ
フェクト機能」を参照してください。

トラック1～4のトラック・レベ
ルを表示します。

メーターメーターメーターメーターメーター
11111～～～～～44444

バウンスしたトラックの確認は、バウンス・モードが
ONの状態で行ないます。

L, RL, RL, RL, RL, R
メーターメーターメーターメーターメーター

メーターメーターメーターメーターメーター
5/65/65/65/65/6

モニター出力レベル（STEREO
OUT L/R）を表示します。

トラック5/6の録音レベルを表示
します。

また、ディスプレイの各レベル・メータはそれぞれ
つぎのレベルを表示します。

バウンスのテイクバウンスのテイクバウンスのテイクバウンスのテイクバウンスのテイク（（（（（本本本本本番番番番番）））））

バウンスしたトラックバウンスしたトラックバウンスしたトラックバウンスしたトラックバウンスしたトラック5/65/65/65/65/6の確認の確認の確認の確認の確認

＜バウンスのパンチイン／アウト！＞＜バウンスのパンチイン／アウト！＞＜バウンスのパンチイン／アウト！＞＜バウンスのパンチイン／アウト！＞＜バウンスのパンチイン／アウト！＞
オート・パンチイン／アウトを利用して、任意の範囲
（パンチイン・ポイントとパンチアウト・ポイント間）
のみをバウンスすることもできます（☞74ページ）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞
バウンスが終了したら、 [1-4 > 5/6, 1-6 > 7/8]
キーを押して、バウンス・モードを解除してお
きましょう。
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トラック1～6に録音した演奏をミックスして、トラック7/8へバウンスします。前述の「トラック1～4を
5/6にバウンス」と同様、納得のいくまでリハーサルしてから本番へ進むことができます。

本番を実行する前に、ソングを再生しながら各トラックの再生レベル／定位を調整したり、トラック1～4にはディ
レイ（またはリバーブ）をかけていきます。また、ミックスしたL, R信号にはマスタリング・エフェクトをかける
ことができますので、好みの音でバウンスできるよう十分なリハーサルを行います。下記操作は、あらかじめバウン
スしたいソングが立ち上がっていることを前提にしています。

バウンスのリハーサルバウンスのリハーサルバウンスのリハーサルバウンスのリハーサルバウンスのリハーサル

11111））））） [1-4>5/6, 1-6>7/8] [1-4>5/6, 1-6>7/8] [1-4>5/6, 1-6>7/8] [1-4>5/6, 1-6>7/8] [1-4>5/6, 1-6>7/8] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、     バウンスバウンスバウンスバウンスバウンス・・・・・モーモーモーモーモー
ドをドをドをドをドを“““““1-6> 7/81-6> 7/81-6> 7/81-6> 7/81-6> 7/8”””””に切り替えます。に切り替えます。に切り替えます。に切り替えます。に切り替えます。
バウンス・モード“1-6>7/8”がONになると、自
動的にトラック7/8がREADYトラックに設定さ
れ、7/8がインプットモニターになります。
ディスプレイは、下記例のように表示されます。

点灯

点滅

22222））））） トラックトラックトラックトラックトラック7/87/87/87/87/8のフェーダーとのフェーダーとのフェーダーとのフェーダーとのフェーダーと [MASTER]  [MASTER]  [MASTER]  [MASTER]  [MASTER] フェーダフェーダフェーダフェーダフェーダ
ーをーをーをーをーを“““““ ”””””位置まで上げ、位置まで上げ、位置まで上げ、位置まで上げ、位置まで上げ、 他のトラック他のトラック他のトラック他のトラック他のトラック・・・・・フェーフェーフェーフェーフェー
ダーは全てダーは全てダーは全てダーは全てダーは全て“““““MINMINMINMINMIN”””””位置に下げておきます。位置に下げておきます。位置に下げておきます。位置に下げておきます。位置に下げておきます。

44444））））） 再生しながら、再生しながら、再生しながら、再生しながら、再生しながら、トラックトラックトラックトラックトラック11111～～～～～66666のフェーダーで各トのフェーダーで各トのフェーダーで各トのフェーダーで各トのフェーダーで各ト
ラックの再生レベルを調整します。ラックの再生レベルを調整します。ラックの再生レベルを調整します。ラックの再生レベルを調整します。ラックの再生レベルを調整します。
さらに、さらに、さらに、さらに、さらに、トラックトラックトラックトラックトラック11111～～～～～44444のののののPANPANPANPANPANを調整したり、を調整したり、を調整したり、を調整したり、を調整したり、ディディディディディ
レイやリバーブをかけ、レイやリバーブをかけ、レイやリバーブをかけ、レイやリバーブをかけ、レイやリバーブをかけ、好みに合わせてミックスし好みに合わせてミックスし好みに合わせてミックスし好みに合わせてミックスし好みに合わせてミックスし
たサウンドにマスタリングたサウンドにマスタリングたサウンドにマスタリングたサウンドにマスタリングたサウンドにマスタリング・・・・・エフェクトをかけまエフェクトをかけまエフェクトをかけまエフェクトをかけまエフェクトをかけま
す。す。す。す。す。
トラック7/8へバウンスする際のリハーサルおよ
び本番中は、各トラック・フェーダーや [MASTER]
フェーダーは、つぎの役目を果たします。

点灯

33333））））） [PLAY] [PLAY] [PLAY] [PLAY] [PLAY] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、ソングの先頭から再生しまソングの先頭から再生しまソングの先頭から再生しまソングの先頭から再生しまソングの先頭から再生しま
す。す。す。す。す。

トラック1～4の録音ミックスを
調整します。

フェーダーフェーダーフェーダーフェーダーフェーダー
11111～～～～～44444

[MASTER][MASTER][MASTER][MASTER][MASTER]
フェーダーフェーダーフェーダーフェーダーフェーダー

フェーダーフェーダーフェーダーフェーダーフェーダー
7/87/87/87/87/8

フェーダーフェーダーフェーダーフェーダーフェーダー
5/65/65/65/65/6

トラック7/8の録音レベルを調整
します。

トラック7/8の再生レベル（モニ
ター・レベル）を調整します。

トラック5/6の録音ミックスを調
整します。

トラックトラックトラックトラックトラック11111～～～～～66666ををををを7/87/87/87/87/8にバウンスにバウンスにバウンスにバウンスにバウンス
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55555））））） リハーサルが終ったらリハーサルが終ったらリハーサルが終ったらリハーサルが終ったらリハーサルが終ったら [STOP]  [STOP]  [STOP]  [STOP]  [STOP] キーを押して停止キーを押して停止キーを押して停止キーを押して停止キーを押して停止
させ、させ、させ、させ、させ、ソングの先頭へ戻します。ソングの先頭へ戻します。ソングの先頭へ戻します。ソングの先頭へ戻します。ソングの先頭へ戻します。
リハーサルで設定した各つまみやフェーダーのポジ
ションは、そのままにしておきましょう。

11111））））） 本番に入る前に、本番に入る前に、本番に入る前に、本番に入る前に、本番に入る前に、バウンスバウンスバウンスバウンスバウンス・・・・・モードモードモードモードモード（（（（（1-6>7/81-6>7/81-6>7/81-6>7/81-6>7/8）））））ががががが
ONONONONONになっていることを確認してください。になっていることを確認してください。になっていることを確認してください。になっていることを確認してください。になっていることを確認してください。

22222））））） [RECORD] [RECORD] [RECORD] [RECORD] [RECORD] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [PLAY]  [PLAY]  [PLAY]  [PLAY]  [PLAY] キーを押しキーを押しキーを押しキーを押しキーを押し
ます。ます。ます。ます。ます。
リハーサルで設定したレベル／音質でバウンスが始
まり、トラック7/8へ録音されていきます。

33333））））） バウンスが終了したら、バウンスが終了したら、バウンスが終了したら、バウンスが終了したら、バウンスが終了したら、 [STOP]  [STOP]  [STOP]  [STOP]  [STOP] キーを押してキーを押してキーを押してキーを押してキーを押してMR-MR-MR-MR-MR-
8mkII8mkII8mkII8mkII8mkII を停止させます。を停止させます。を停止させます。を停止させます。を停止させます。
MR-8mkIIを停止させると、トラック7/8のイン
プットモニターは自動的に解除され、“INPUT
MONI”アイコンが消えます。
終了と同時にディスプレイがつぎの画面に変りま
す。これはバウンスしたトラック7/8を再生して、
確認することを促しています。

11111））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [REWIND]  [REWIND]  [REWIND]  [REWIND]  [REWIND] キーを押しキーを押しキーを押しキーを押しキーを押し
て、て、て、て、て、ソングの先頭へ戻します。ソングの先頭へ戻します。ソングの先頭へ戻します。ソングの先頭へ戻します。ソングの先頭へ戻します。

22222））））） インプットモニターが解除されていることを確認しインプットモニターが解除されていることを確認しインプットモニターが解除されていることを確認しインプットモニターが解除されていることを確認しインプットモニターが解除されていることを確認し
ます。ます。ます。ます。ます。

33333））））） [PLAY] [PLAY] [PLAY] [PLAY] [PLAY] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、ソングの先頭から再生しまソングの先頭から再生しまソングの先頭から再生しまソングの先頭から再生しまソングの先頭から再生しま
す。す。す。す。す。

44444））））） トラックトラックトラックトラックトラック7/87/87/87/87/8のフェーダーで、のフェーダーで、のフェーダーで、のフェーダーで、のフェーダーで、バウンスしたトラッバウンスしたトラッバウンスしたトラッバウンスしたトラッバウンスしたトラッ
クの再生レベルを調整します。クの再生レベルを調整します。クの再生レベルを調整します。クの再生レベルを調整します。クの再生レベルを調整します。
バウンス・モードがONになっている状態でソング
を再生すると、トラック7/8のみがモニターされま
す。
このとき、トラック1～4のフェーダーを上げて
もトラック1～6の再生音は聴こえません。

トラック7/8の音を確認した後、バウンスをやり直
したいときは、「アンドウ機能」を使って一旦バウ
ンスする前に戻し、再度リハーサルを行ってから本
番に挑戦しましょう。

十分なリハーサルが終了したら、本番を実行しましょ
う。

＜＜＜＜＜PANPANPANPANPANの調整について＞の調整について＞の調整について＞の調整について＞の調整について＞
トラック1～4のPAN調整に、決まりはありま
せん。ギター演奏は左、ボーカルはセンター・・・
というように、好みに合わせて調整してくださ
い。

[PHONES VOL] つまみを回していくと、ヘッドホ
ンからはトラック7/8にバウンスされている音が
聴こえてきます。

トラック7/8のフェーダーでモニターの出力レベ
ルを調整し、 [MASTER] フェーダーで、バウンス
する最終録音レベルを調整します。
レベル・メータの7/8を見ながら、最適な録音レ
ベルを調整してください。

好みに応じて、トラック1～4にはディレイ（また
はリバーブ）をかけ、ミックスしたL/R信号にマ
スタリング・エフェクトをかけていきます。
エフェクトの詳細については、59ページ記載の「エ
フェクト機能」を参照してください。

バウンスしたトラックの確認は、バウンス・モードが
ONの状態で行ないます。

また、ディスプレイの各レベル・メータはそれぞれ
つぎのレベルを表示します。

バウンスのテイクバウンスのテイクバウンスのテイクバウンスのテイクバウンスのテイク（（（（（本本本本本番番番番番）））））

バウンスしたトラックバウンスしたトラックバウンスしたトラックバウンスしたトラックバウンスしたトラック7/87/87/87/87/8の確認の確認の確認の確認の確認

トラック1～4のトラック・レベ
ルを表示します。

メーターメーターメーターメーターメーター
11111～～～～～44444

L, RL, RL, RL, RL, R
メーターメーターメーターメーターメーター

メーターメーターメーターメーターメーター
7/87/87/87/87/8

メーターメーターメーターメーターメーター
5/65/65/65/65/6

モニター出力レベル（STEREO
OUT L/R）を表示します。

トラック7/8の録音レベルを表示
します。

トラック5/6のトラック・レベル
を表示します。

＜バウンスしたデータを＜バウンスしたデータを＜バウンスしたデータを＜バウンスしたデータを＜バウンスしたデータをPCPCPCPCPCへ取り込む＞へ取り込む＞へ取り込む＞へ取り込む＞へ取り込む＞
トラック7/8にバウンスしたソング・データは、パソ
コンへ取り込むことができます。
パソコンに取り込んだデータは、パソコンに接続され
ているCD-RWなどを使ってオリジナルのオーディオ
CDを作成したり、音楽ソフトで使用することができま
す。なお、トラック7/8のソング・データをパソコン
に取り込むためには、トラック7/8のモノWAVファイ
ルをステレオWAVファイルに変換することが必要です
（☞115ページ）。

＜バウンスのパンチイン／アウト！＞＜バウンスのパンチイン／アウト！＞＜バウンスのパンチイン／アウト！＞＜バウンスのパンチイン／アウト！＞＜バウンスのパンチイン／アウト！＞
オート・パンチイン／アウトを利用して、任意の範囲
（パンチイン・ポイントとパンチアウト・ポイント間）の
みをバウンスすることもできます（☞74ページ）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞
バウンスが終了したら、 [1-4 > 5/6, 1-6 > 7/8]
キーを押して、バウンス・モードを解除してお
きましょう。

＜外部＜外部＜外部＜外部＜外部CD-R/RWCD-R/RWCD-R/RWCD-R/RWCD-R/RWドライブでオーディオドライブでオーディオドライブでオーディオドライブでオーディオドライブでオーディオCDCDCDCDCDを作成＞を作成＞を作成＞を作成＞を作成＞
[USB HOST] 端子に外部CD-R/RWドライブを接続
し、トラック7/8にバウンスした曲のオーディオCD
が作成できます（☞123ページ）。
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ここでは、トラック1～8に録音した演奏をミックスして、新たに作成するソングのトラック7/8へバウンス
します。Newソングは、バウンス実行と同時に自動的に作成されます（＜注意！＞＜注意！＞＜注意！＞＜注意！＞＜注意！＞：：：：：“1-8 > NEW SONG”モー
ドでは、オート・パンチイン／アウトを併用した部分的なバウンスは実行できません）。

本番を実行する前に、ソングを再生しながらトラック1～8の再生レベル／定位を調整したり、トラック1～4には
ディレイ（またはリバーブ）をかけていきます。また、ミックスしたL, R信号にはマスタリング・エフェクトをか
けることができますので、好みの音でバウンスできるよう十分なリハーサルを行います。下記操作は、バウンスする
ソングが立ち上がっていることを前提にしています。

また、ディスプレイの各レベル・メータはそれぞれ
つぎのレベルを表示します。

11111））））） [MASTER] [MASTER] [MASTER] [MASTER] [MASTER] フェーダフェーダフェーダフェーダフェーダーをーをーをーをーを“““““ ”””””位置まで上げ、位置まで上げ、位置まで上げ、位置まで上げ、位置まで上げ、他他他他他
のトラックのトラックのトラックのトラックのトラック・・・・・フェーダーは全てフェーダーは全てフェーダーは全てフェーダーは全てフェーダーは全て“““““MINMINMINMINMIN”””””位置に下げ位置に下げ位置に下げ位置に下げ位置に下げ
ておきます。ておきます。ておきます。ておきます。ておきます。

22222））））） [PLAY] [PLAY] [PLAY] [PLAY] [PLAY] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、ソングの先頭から再生しまソングの先頭から再生しまソングの先頭から再生しまソングの先頭から再生しまソングの先頭から再生しま
す。す。す。す。す。

33333））））） 再生しながら、再生しながら、再生しながら、再生しながら、再生しながら、トラックトラックトラックトラックトラック11111～～～～～88888のフェーダーで各トのフェーダーで各トのフェーダーで各トのフェーダーで各トのフェーダーで各ト
ラックの再生レベルを調整します。ラックの再生レベルを調整します。ラックの再生レベルを調整します。ラックの再生レベルを調整します。ラックの再生レベルを調整します。
さらに、さらに、さらに、さらに、さらに、トラックトラックトラックトラックトラック11111～～～～～44444はははははPANPANPANPANPANを調整したり、を調整したり、を調整したり、を調整したり、を調整したり、ディディディディディ
レイやリバーブをかけ、レイやリバーブをかけ、レイやリバーブをかけ、レイやリバーブをかけ、レイやリバーブをかけ、好みに合わせてミックスし好みに合わせてミックスし好みに合わせてミックスし好みに合わせてミックスし好みに合わせてミックスし
たサウたサウたサウたサウたサウンドにマスタリングンドにマスタリングンドにマスタリングンドにマスタリングンドにマスタリング・・・・・エフェクトをかけまエフェクトをかけまエフェクトをかけまエフェクトをかけまエフェクトをかけま
す。す。す。す。す。
リハーサルや本番におけるトラック1～8のフェー
ダーや [MASTER] フェーダーは、つぎの役目を果
たします。

トラック1～8の録音ミックスを
調整します。

フェーダーフェーダーフェーダーフェーダーフェーダー
11111～～～～～88888

[MASTER][MASTER][MASTER][MASTER][MASTER]
フェーダーフェーダーフェーダーフェーダーフェーダー

バウンスの録音マスター・レベル
を調整します。

トラック1～8のトラック・レベ
ルを調整します。

メーターメーターメーターメーターメーター
11111～～～～～88888

メーターメーターメーターメーターメーター
LLLLL、、、、、RRRRR

バウンスの録音レベルを表示しま
す。

44444））））） リハーサルが終ったらリハーサルが終ったらリハーサルが終ったらリハーサルが終ったらリハーサルが終ったら [STOP]  [STOP]  [STOP]  [STOP]  [STOP] キーを押して停止キーを押して停止キーを押して停止キーを押して停止キーを押して停止
させ、させ、させ、させ、させ、ソングの先頭へ戻します。ソングの先頭へ戻します。ソングの先頭へ戻します。ソングの先頭へ戻します。ソングの先頭へ戻します。
リハーサルで設定した各つまみやフェーダーのポジ
ションは、そのままにしておきましょう。

[PHONES VOL] つまみを回していくと、ヘッドホ
ンからはトラック7/8にバウンスされる音が聴こ
えてきます。

トラック1～8のフェーダーで各トラックの出力レ
ベルを調整し、 [MASTER] フェーダーで、バウン
スする最終録音レベルを調整します。
レベル・メータのL、Rを見ながら、最適な録音レ
ベルを調整してください。

エフェクトの詳細については、59ページ記載の「エ
フェクト機能」を参照してください。

バウンスのリハーサルバウンスのリハーサルバウンスのリハーサルバウンスのリハーサルバウンスのリハーサル

トラックトラックトラックトラックトラック11111～～～～～88888をををををNewNewNewNewNewソングへバウンスソングへバウンスソングへバウンスソングへバウンスソングへバウンス
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リハーサルで、バウンスするトラック1～8のバランス／音質が決定したら、早速本番へ進みます。

11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [1-8 > NEW SONG]  [1-8 > NEW SONG]  [1-8 > NEW SONG]  [1-8 > NEW SONG]  [1-8 > NEW SONG] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
[1-8 > NEW SONG] キーを押すとキーのランプが
点灯し、つぎの画面に変ります。
この画面は、バウンスを開始するかを訪ねる表示
で、バウンスを実行するには [RECORD] キーを押
しながら [MENU/ENTER] キーを押し、キャンセ
ルするには [STOP] キーを押すことを示していま
す。

22222））））） [RECORD] [RECORD] [RECORD] [RECORD] [RECORD] キーを押しながら、キーを押しながら、キーを押しながら、キーを押しながら、キーを押しながら、 [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER]
キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
バウンスが開始され、Newソングのトラック7/8
へ記録されていきます。下記例は、ソング・ネーム
“Moonlit”のソング02を、Newソング04にバウ
ンス実行中の画面で、レベル・メータの1～8には
トラック1～8の再生レベルが表示され、L、Rメー
タにはバウンスしているトラック7/8の録音レベ
ルが表示されます。

バウンスのテイクバウンスのテイクバウンスのテイクバウンスのテイクバウンスのテイク（（（（（本本本本本番番番番番）））））

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： バウンスを中止したいときは、
[STOP] キーを押してください。実行中のバウン
スがキャンセルされると同時にバウンス・モー
ドは解除されます。ただし、途中で中止した場
合には、作りかけのNewソングは自動的に削除
され、カード上には残りません。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： コンパクト・フラッシュカード
に、Newソングを作成してバウンスするための
記録領域が無い場合や、ソング数が99を超えて
しまう場合には、ワーニング・メッセージを表
示して作業はキャンセルされます。

＜バウンスしたデータを＜バウンスしたデータを＜バウンスしたデータを＜バウンスしたデータを＜バウンスしたデータをPCPCPCPCPCへ取り込む＞へ取り込む＞へ取り込む＞へ取り込む＞へ取り込む＞
New ソングのトラック7/8 にバウンスしたソング・
データは、パソコンへ取り込むことができます。
パソコンに取り込んだデータは、パソコンに接続され
ているCD-RWなどを使ってオリジナルのオーディオ
CDを作成したり、音楽ソフトで使用することができま
す（☞115ページ）。

Newソングへのバウンスでは、バウンスが終了す
ると同時に自動的に停止し、バウンスしたNewソ
ングのHome画面で立ち上がります。
バウンスしたNewソングのソング・ネームは、下
記例のように自動的にバウンス元のネームの後に
“-**” (**=番号）が付加されます。

前述71ページの「バウンスしたトラック7/8の確
認」を参照して、バウンスしたNewソングを再生
して確認してください。
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＜外部＜外部＜外部＜外部＜外部CD-R/RWCD-R/RWCD-R/RWCD-R/RWCD-R/RWドライブでオーディオドライブでオーディオドライブでオーディオドライブでオーディオドライブでオーディオCDCDCDCDCDを作成＞を作成＞を作成＞を作成＞を作成＞
[USB HOST] 端子に外部CD-R/RWドライブを接続
し、Newソングのトラック7/8にバウンスした曲の
オーディオCDが作成できます（☞123ページ）。
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通常バウンスは、図-1のようにソングの先頭から最終記録位置までのデータを対象に実行しますが、図-2のよ
うにパンチイン・ポイントとパンチアウト・ポイント間のデータのみを、バウンスすることが可能です。これ
は、「バウンス機能」と「オート・パンチイン／アウト機能」を組み合わせて、任意の範囲のみをバウンスする
方法です。下記操作は、バウンスしたいソングが立ち上がり、前述のリハーサルが済んでいることを前提にし
ています。例として、“Bounce 1-6 > 7/8”モードとオート・パンチイン／アウトを組み合わせて、トラック
7-8にバウンスします（注意注意注意注意注意：：：：：“““““1-8 > NEW SONG1-8 > NEW SONG1-8 > NEW SONG1-8 > NEW SONG1-8 > NEW SONG”””””モードでは、モードでは、モードでは、モードでは、モードでは、オートオートオートオートオート・・・・・パンチイン／アウトを併用したバパンチイン／アウトを併用したバパンチイン／アウトを併用したバパンチイン／アウトを併用したバパンチイン／アウトを併用したバ
ウンスは実行できませんウンスは実行できませんウンスは実行できませんウンスは実行できませんウンスは実行できません）。

11111））））） あらかじめパンチインあらかじめパンチインあらかじめパンチインあらかじめパンチインあらかじめパンチイン・・・・・ポイントとパンチアウトポイントとパンチアウトポイントとパンチアウトポイントとパンチアウトポイントとパンチアウト・・・・・
ポイントを登録しておきますポイントを登録しておきますポイントを登録しておきますポイントを登録しておきますポイントを登録しておきます（（（（（☞ 5555566666ペペペペペーーーーージジジジジ）））））。。。。。
[STOP] キーを押しながら [PLAY] キーを押すと、
パンチイン・ポイントとパンチアウト・ポイント間
の再生ができます（☞46ページ）。

22222））））） レレレレレコココココーーーーーダダダダダーーーーーののののの位位位位位置置置置置ををををを、、、、、パパパパパンンンンンチチチチチイイイイインンンンン・・・・・ポポポポポイイイイインンンンントトトトトよよよよよりりりりり手手手手手
前前前前前ににににに移移移移移動動動動動しししししててててておおおおおきききききままままますすすすす。。。。。

33333））））） [[[[[11111-----44444>>>>>55555/////66666,,,,,11111-----66666>>>>>77777/////88888]]]]]     キキキキキーーーーーををををを押押押押押しししししててててて、、、、、バババババウウウウウンンンンンススススス・・・・・モモモモモーーーーー
ドドドドドををををを“““““11111-----66666>>>>>77777/////88888”””””モモモモモーーーーードドドドドににににに切切切切切りりりりり換換換換換えええええままままますすすすす。。。。。
バウンス・モードを“1-6>7/8”に切り替ると、自
動的にトラック7/8がインプットモニターになり、
Home画面上に“ ”アイコンが点灯しま
す。

TRK 1
TRK 2
TRK 3
TRK 4
TRK 5
TRK 6

TRK 7
TRK 8

ABS ZERO REC END

M
ixing

パンチイン・ポイント
（=LOCATE Aポイント）

パンチアウト・ポイント
（=LOCATE Bポイント）

TRK 1
TRK 2
TRK 3
TRK 4
TRK 5
TRK 6

TRK 7
TRK 8

M
ixing

＜図＜図＜図＜図＜図 -1-1-1-1-1＞＞＞＞＞：：：：：通常のバウンス通常のバウンス通常のバウンス通常のバウンス通常のバウンス ＜図＜図＜図＜図＜図 -2-2-2-2-2＞＞＞＞＞：：：：：オートオートオートオートオート・・・・・パンチイン／アウトを併用したバウンスパンチイン／アウトを併用したバウンスパンチイン／アウトを併用したバウンスパンチイン／アウトを併用したバウンスパンチイン／アウトを併用したバウンス

点灯

点滅

点灯

44444））））） 引き続き引き続き引き続き引き続き引き続き [AUTO PUNCH]  [AUTO PUNCH]  [AUTO PUNCH]  [AUTO PUNCH]  [AUTO PUNCH] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、オートオートオートオートオート・・・・・
パンチパンチパンチパンチパンチ・・・・・モードをモードをモードをモードをモードをONONONONONにします。にします。にします。にします。にします。
オート・パンチ・モードがONになると、Home画
面上に“ ”アイコンが点灯します。

点灯

55555））））） [PLAY] [PLAY] [PLAY] [PLAY] [PLAY] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [RECORD]  [RECORD]  [RECORD]  [RECORD]  [RECORD] キーを押しキーを押しキーを押しキーを押しキーを押し
ます。ます。ます。ます。ます。
“ ”アイコンのみが点灯して再生を開始
し、パンチイン・ポイントで録音モードに入り、バ
ウンスが実行されます。

パンチイン・ポイント
（=LOCATE Aポイント）

パンチアウト・ポイント
（=LOCATE Bポイント）

TRK 1
TRK 2
TRK 3
TRK 4
TRK 5
TRK 6

TRK 7
TRK 8

再　生
（インプットモニター）

録　音
（バウンスを実行）

再　生

その後パンチアウト・ポイントで録音（バウンス）
が解除され、通常の再生に変ります。同時にオー
ト・パンチ・モードが解除され、“ ”アイ
コンが消灯します。

66666））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、レコーダーを停止させまレコーダーを停止させまレコーダーを停止させまレコーダーを停止させまレコーダーを停止させま
す。す。す。す。す。
前述のバウンス同様、バウンスしたトラックを再生
して確認してください。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： パンチアウト後は、モニター音は
聴こえてきません。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： 思うようなバウンスができなかっ
た場合は、速やかに [UNDO/REDO] キーを押し
た後、最初からやり直してください。

任意の範囲をバウンス任意の範囲をバウンス任意の範囲をバウンス任意の範囲をバウンス任意の範囲をバウンス
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リズムガイド機能リズムガイド機能リズムガイド機能リズムガイド機能リズムガイド機能
MR-8mkIIにはリズムガイド機能を搭載していて、録音時のガイドとなるリズ
ムガイド音を出力することができます。

ここでは、リズムガイドを出力する方法と、出力するために必要な拍子および
テンポの設定、さらにはコンダクター・マップの作成方法について記載してい
ます。
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MR-8mkIIにはメトロノーム機能を搭載していて、録音時のガイドとなるリズムガイド音を出力することができ
ます。リズムガイド音は、操作パネルにある [RHYTHM GUIDE] キーをONするだけで、録音（または再生）
時 [STEREO OUT L/R] に出力されます。また、リズムガイドは曲の頭から最後まで同じ拍子／テンポで出力
する方法と、任意の小節における拍のテンポを変えて出力する、2つの方法があります。

任意の拍子とテンポの設定任意の拍子とテンポの設定任意の拍子とテンポの設定任意の拍子とテンポの設定任意の拍子とテンポの設定

リズムガイドを出力するには、
[RHYTHM GUIDE] キーをON
（ランプ点灯）にします。リズム
ガイドをONすると、初期設定で
は、4/4拍子でテンポ120のリ
ズムガイド音が出力されます。

このリズムガイド音は、用途に
合わせて任意の拍子／テンポを
設定して出力したり、あらかじ
め作成するコンダクター・マッ
プに基づいたリズムガイド音を
出力することができます。

リズムガイドの初期設定（4/4拍子でテンポ120）や出力レベルなどは、MENUモードの“Rhythm Guide”メニュー
で設定します。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Rhythm GuideRhythm GuideRhythm GuideRhythm GuideRhythm Guide”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
リズムガイドの設定を行う画面に変り、初期設定で
は“<< Back”が反転します。

11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードモードモードモードモードに入ります。に入ります。に入ります。に入ります。に入ります。
MENU選択の1ページめの画面に変り、初期設定
では“<< Back”が反転します（“<< Back”は一つ
前の画面に戻ること示しています）。

＜ヒント！＞＜ヒント！＞＜ヒント！＞＜ヒント！＞＜ヒント！＞：：：：： Home画面が表示されて停止
している状態で、 [RHYTHM GUIDE] キーを長
押しすると、リズムガイドの設定を行う画面に
直接進むことができます。

リズムガイド音は、 [RHYTHM GUIDE] キーをON（ランプ点灯）にしている状態で、録音（または再
生）を開始すると同時に、現在設定されているクリック・レベル（初期設定：80）の音量でSTEREO
OUT L/Rに出力されます（注意：バウンス・モード実行時は出力しません）。また、リズムガイドの出
力レベルは、レベル・メータL/Rに表示されます。
なお、リズムガイド音はヘッドホンやモニター・スピーカーでモニターできるだけで、録音されること
はありません。ガイド音が不要のときは [RHYTHM GUIDE] キーをOFFにしてください。

リズムガイドを鳴らすにはリズムガイドを鳴らすにはリズムガイドを鳴らすにはリズムガイドを鳴らすにはリズムガイドを鳴らすには
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Rhythm Guide = Off

Conductor Map = Off

リズムガイドリズムガイドリズムガイドリズムガイドリズムガイド

出力無し出力無し出力無し出力無し出力無し

Bar/BeatBar/BeatBar/BeatBar/BeatBar/Beat表示表示表示表示表示

ここで設定す
るTempoおよ
び Signature
の値が有効。

Rhythm Guide = Off

Conductor Map = On
出力無し出力無し出力無し出力無し出力無し

コンダクター・
マップで設定
した値が有効。

Rhythm Guide = On

Conductor Map = Off

出力有り出力有り出力有り出力有り出力有り：：：：：
ここで設定す
るTempoおよ
び Signature
の値が有効。

ここで設定す
るTempoおよ
び Signature
の値が有効。

Rhythm Guide = On

Conductor Map = On

出力有り出力有り出力有り出力有り出力有り：：：：：
コンダクター・
マップで設定
した値が有効。

コンダクター・
マップで設定
した値が有効。

On/OffOn/OffOn/OffOn/OffOn/Off 設定状況設定状況設定状況設定状況設定状況

なお、画面中の“Rhythm Guide”設定と“Conductor Map”
設定との関係は、以下のようになります。

① リリリリリズズズズズムムムムムガガガガガイイイイイドドドドドのののののOOOOONNNNN/////OOOOOFFFFFFFFFFををををを設設設設設定定定定定
設定状態は、操作パネルの [RHYTHM
GUIDE] キーに反映され、Onに設定したと
きはランプが点灯し、Offでは消灯します。
また、 [RHYTHM GUIDE] キーでOn/Offし
た場合も、リアルタイムに反映されます。
詳細は、右表を参照してください。

② コココココンンンンンダダダダダクククククタタタタターーーーー・・・・・マママママッッッッップププププのののののOOOOONNNNN/////OOOOOFFFFFFFFFFををををを設設設設設定定定定定
後述の「コンダクター・マップの作成」で作
成するコンダクター・マップを有効にする
かしないかを設定します（初期設定はOff）。
詳細は、右表を参照してください。

③ 拍拍拍拍拍子子子子子ををををを設設設設設定定定定定
初期設定は“4/4”で、1/4～5/4および
1/8～8/8の範囲から任意に設定できます。
ここで設定した値は、ソングの最初から最
後まで同じ拍子となります。
なお、Conductor MapをOnに設定したと
きは、ここで設定する値は無効になります。
詳細は、右表を参照してください。

他の項目も、同じ要領で設定します。

なお、リズムガイドの設定画面では、以下の設定が
行えます。

MENUモードから抜け出すには、 [STOP] キーを押すか、
“<< Back”を選択して [MENU/ENTER] キーを押す操作
を繰り返していきます。

コンダクター・マップの設定は、次ページを参照して
ください。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルを希望の項目に移動しダイヤルでカーソルを希望の項目に移動しダイヤルでカーソルを希望の項目に移動しダイヤルでカーソルを希望の項目に移動しダイヤルでカーソルを希望の項目に移動し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在の設定が点滅する画面に変ります。
下記画面は “Rhythm Guide”を選択して [MENU/
ENTER] キーを押した例です。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで設定を変更して、ダイヤルで設定を変更して、ダイヤルで設定を変更して、ダイヤルで設定を変更して、ダイヤルで設定を変更して、 [MENU/ [MENU/ [MENU/ [MENU/ [MENU/
ENTER] ENTER] ENTER] ENTER] ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
変更した項目（OnまたはOff）が設定され、一つ前
の画面に変ります。

④ テテテテテンンンンンポポポポポををををを設設設設設定定定定定
初期設定は“120”で、30～250の範囲で
任意に設定できます。ここで設定した値は、
ソングの最初から最後まで同じテンポとな
ります。
なお、Conductor MapをOnに設定したと
きは、ここで設定する値は無効になります。
詳細は、下記表を参照してください。

⑤ 内内内内内蔵蔵蔵蔵蔵クククククリリリリリッッッッックククククののののの出出出出出力力力力力レレレレレベベベベベルルルルルををををを設設設設設定定定定定
初期設定はレベル80で、0～99の範囲で
任意に設定できます。

1
2

3

4

5

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：Conductor Mapを“On”に設定したとき
は、下記画面のようにSignatureおよびTempoの設定
値が“- - -”になります。これは、出力するリズムガ
イド音がコンダクター・マップで設定した値が有効に
なっていることを示しています。

点滅
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最初に、内蔵のプログラマブル・テンポマップ上の、任意の小節における「拍子」を設定します。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““SongSongSongSongSong”””””に移動しに移動しに移動しに移動しに移動し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ソング編集のメニューを選択する1ページめの画
面に変り、初期設定では“<< Back”が反転します。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを22222ページめのページめのページめのページめのページめの
“““““Signature MapSignature MapSignature MapSignature MapSignature Map”””””に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER]
キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在設定されているイベント（小節と拍子）を表示
します。
初期設定では“1Bar -> 4/4”と“---Bar -> ---”が
表示されます。“1Bar -> 4/4”は、１小節から最後
の小節まで4/4拍子になっていることを示し、
“---Bar -> ---”は新たなイベントを設定するときに
使用します。

ここでは例として、初期設定の“1bar -> 4/4”はそ
のままで、つぎのようなイベントを設定していきま
す。

11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードに入ります。モードに入ります。モードに入ります。モードに入ります。モードに入ります。
MENU選択の1ページめの画面に変り、初期設定
では“<< Back”が反転します（“<< Back”は一つ
前の画面に戻ること示しています）。

拍子拍子拍子拍子拍子（（（（（Signature MapSignature MapSignature MapSignature MapSignature Map）））））の設定の設定の設定の設定の設定

コンダクター・マップとは、録音時などに本機内蔵のプログラマブル・テンポマップに基づいたリズム・ガイ
ド音を鳴らしたり、外部MIDIシーケンサなどに対してMIDIクロック＆ソング・ポジション・ポインター（CLK）
を [MIDI OUT] 端子から出力することを可能にします。
コンダクター・マップは任意に作成でき、本機内蔵のプログラマブル・テンポマップ上の、任意の小節におけ
る拍子と、任意のポイントにおけるテンポを設定して作成します。
例えば、「ソングの１小節目は4/4拍子で、3小節目からは2/4拍子・・・・」というようにソングの拍子を設
定し、「4小節めの3拍めのテンポを120、12小節めの2拍めのテンポを90・・・」というように、任意ポイ
ントにおけるテンポを設定して、ソングのコンダクター・マップを作成します。

4
4

4
3

120 180

90 120

[REWIND] キーを押していくことでも、一つ前
の画面に戻ることができます。

コンダクターコンダクターコンダクターコンダクターコンダクター・・・・・マップを作成マップを作成マップを作成マップを作成マップを作成
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44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““---Bar ->---Bar ->---Bar ->---Bar ->---Bar -> ---------------”””””ににににに
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
新たなイベントを設定する画面に変り、“<< Back”
が反転します。

1小節～3小節 ➡4/4拍子
4小節～7小節 ➡3/4拍子
8小節～11小節 ➡4/4拍子
12小節～15小節 ➡5/8拍子
16小節～最後の小節 ➡3/4拍子

55555））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Bar = 2BarBar = 2BarBar = 2BarBar = 2BarBar = 2Bar”””””ににににに
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
新たな小節を設定する画面に変り、“2Bar”が反転
します。

66666））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで希望の小節を入力し、ダイヤルで希望の小節を入力し、ダイヤルで希望の小節を入力し、ダイヤルで希望の小節を入力し、ダイヤルで希望の小節を入力し、 [MENU/ [MENU/ [MENU/ [MENU/ [MENU/
ENTER] ENTER] ENTER] ENTER] ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
入力した小節に設定され、一つ前の画面に変りま
す。前述の設定例に基づいて“4Bar”を入力します。

77777））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Sig. = 4/4Sig. = 4/4Sig. = 4/4Sig. = 4/4Sig. = 4/4”””””に移に移に移に移に移
動して、動して、動して、動して、動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
新たな拍子を設定する画面に変り、“4/4”が反転し
ます。

88888））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで希望の拍子を入力し、ダイヤルで希望の拍子を入力し、ダイヤルで希望の拍子を入力し、ダイヤルで希望の拍子を入力し、ダイヤルで希望の拍子を入力し、 [MENU/ [MENU/ [MENU/ [MENU/ [MENU/
ENTER] ENTER] ENTER] ENTER] ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
入力した拍子に設定され、一つ前の画面に変りま
す。前述の設定例に基づいて“3/4”を入力します。

99999））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルを一番下にあるダイヤルでカーソルを一番下にあるダイヤルでカーソルを一番下にあるダイヤルでカーソルを一番下にあるダイヤルでカーソルを一番下にある
“““““[ENTER][ENTER][ENTER][ENTER][ENTER]”””””へ移動して、へ移動して、へ移動して、へ移動して、へ移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーをキーをキーをキーをキーを
押します。押します。押します。押します。押します。
入力した小節と拍子が設定され、以下のような画面
に変ります。これは、1小節～3小節までは4/4拍
子、4小節以降は3/4拍子に設定されたことを示し
ています。

操作手順（5）～（9）と同じ要領で、前述の設定
例に基づいて、他のイベントを設定していきます。

点滅

点滅

点滅

点滅
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●不要なイベントを削除するには●不要なイベントを削除するには●不要なイベントを削除するには●不要なイベントを削除するには●不要なイベントを削除するには

不要なイベントを選択して削除します。

11111））））） イベントの一覧が表示されている画面で、イベントの一覧が表示されている画面で、イベントの一覧が表示されている画面で、イベントの一覧が表示されている画面で、イベントの一覧が表示されている画面で、削除した削除した削除した削除した削除した
いイベントにジョグいイベントにジョグいイベントにジョグいイベントにジョグいイベントにジョグ・・・・・ダイヤルでカーソルを移動ダイヤルでカーソルを移動ダイヤルでカーソルを移動ダイヤルでカーソルを移動ダイヤルでカーソルを移動
して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
前述と同様、小節が入力可能な画面に変ります。
例として、前述例に基づいて設定したイベントの中
の、“8Bar -> 4/4”を選択します。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にある
“““““[DELETE][DELETE][DELETE][DELETE][DELETE]”””””へ移動して、へ移動して、へ移動して、へ移動して、へ移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーをキーをキーをキーをキーを
押します。押します。押します。押します。押します。
速やかに選択したイベントがリストから削除される
と同時に、イベントの一覧画面に変ります。

●任意のイベントを変更するには●任意のイベントを変更するには●任意のイベントを変更するには●任意のイベントを変更するには●任意のイベントを変更するには

任意のイベントを選択して変更します。

11111））））） イベントの一覧が表示されている画面で、イベントの一覧が表示されている画面で、イベントの一覧が表示されている画面で、イベントの一覧が表示されている画面で、イベントの一覧が表示されている画面で、変更した変更した変更した変更した変更した
いイベントにジョグいイベントにジョグいイベントにジョグいイベントにジョグいイベントにジョグ・・・・・ダイヤルでカーソルを移動ダイヤルでカーソルを移動ダイヤルでカーソルを移動ダイヤルでカーソルを移動ダイヤルでカーソルを移動
して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
前述と同様、小節が入力可能な画面に変ります。
例として、前述例に基づいて設定したイベントの中
の、“8Bar -> 4/4”を選択します。

22222））））） 小節を変更するには小節を変更するには小節を変更するには小節を変更するには小節を変更するには“““““Bar = 8BarBar = 8BarBar = 8BarBar = 8BarBar = 8Bar”””””にカーソルをにカーソルをにカーソルをにカーソルをにカーソルを
移動して移動して移動して移動して移動して [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押し、キーを押し、キーを押し、キーを押し、キーを押し、拍子を変拍子を変拍子を変拍子を変拍子を変
更するには更するには更するには更するには更するには“““““Sig. = 4/4Sig. = 4/4Sig. = 4/4Sig. = 4/4Sig. = 4/4”””””にカーソルを移動してにカーソルを移動してにカーソルを移動してにカーソルを移動してにカーソルを移動して
[MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
前述の設定方法と同様、新たな小節（または拍子）
が入力可能な画面に変ります。

33333））））） 小節小節小節小節小節（（（（（まままままたたたたたははははは拍拍拍拍拍子子子子子）））））を入力してを入力してを入力してを入力してを入力して [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER]
キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
例として、小節のみを10小節に変更します。

44444））））） 変更終了後、変更終了後、変更終了後、変更終了後、変更終了後、カーソルを画面下のカーソルを画面下のカーソルを画面下のカーソルを画面下のカーソルを画面下の“““““[ENTER][ENTER][ENTER][ENTER][ENTER]”””””へ移へ移へ移へ移へ移
動して動して動して動して動して [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
変更したイベントが設定され、前述と同様イベント
の一覧画面に変ります。

＜変更前のイベント一覧画面＞＜変更前のイベント一覧画面＞＜変更前のイベント一覧画面＞＜変更前のイベント一覧画面＞＜変更前のイベント一覧画面＞

＜変更後のイベント一覧画面＞＜変更後のイベント一覧画面＞＜変更後のイベント一覧画面＞＜変更後のイベント一覧画面＞＜変更後のイベント一覧画面＞

＜削除前のイベント一覧画面＞＜削除前のイベント一覧画面＞＜削除前のイベント一覧画面＞＜削除前のイベント一覧画面＞＜削除前のイベント一覧画面＞

＜削除後のイベント一覧画面＞＜削除後のイベント一覧画面＞＜削除後のイベント一覧画面＞＜削除後のイベント一覧画面＞＜削除後のイベント一覧画面＞

MENUモードから抜け出すには、 [STOP] キーを押
してください（または、“<< Back”を選択して
[MENU/ENTER] キーを押す操作を繰り返すか、
[REWIND] キーを押してください）。

MENUモードから抜け出すには、 [STOP] キーを押
してください（または、“<< Back”を選択して
[MENU/ENTER] キーを押す操作を繰り返すか、
[REWIND] キーを押してください）。
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レコーダーの現在位置がABS ZERO（ソングの先頭）のとき、Bar/Beatの初期設定は“-2bar 1beat”になっていま
す。つまり、ABS ZEROの位置はBar/Beatで表すと-2-2-2-2-2小節の小節の小節の小節の小節の11111拍目拍目拍目拍目拍目にいることを示しています。

このようにABS ZEROにおけるBar/Beatの位置を“BarBarBarBarBarオフセットオフセットオフセットオフセットオフセット”と呼びます。このBarオフセットは、 用途に
合わせて変更することができます。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで希望のオフセット値を入力しダイヤルで希望のオフセット値を入力しダイヤルで希望のオフセット値を入力しダイヤルで希望のオフセット値を入力しダイヤルで希望のオフセット値を入力し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
入力したオフセット値に設定され、一つ前の画面に
変ります。

表示
-8Bar

-7Bar

-6Bar
-5Bar

-4Bar

-3Bar

-2Bar

-1Bar
0Bar

ABS ZERO=-8Bar

ABS ZERO=-7Bar
ABS ZERO=-6Bar
ABS ZERO=-5Bar
ABS ZERO=-4Bar

ABS ZERO=-3Bar

ABS ZERO=-2Bar
ABS ZERO=-1Bar
ABS ZERO=1Bar

表示内容 内容

下記のオフセット値が選択できます。

33333））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

設定した“Barオフセット値”は、ソングの先頭（ABS
ZERO）を示すHome画面上に反映されます。
下記Home画面は、“Barオフセット値”を初期設定の
“-2Bar”から“-4Bar”に設定した場合の例です。

11111））））） 前述のソング編集のメニューを選択する前述のソング編集のメニューを選択する前述のソング編集のメニューを選択する前述のソング編集のメニューを選択する前述のソング編集のメニューを選択する22222ページページページページページ
めにあるめにあるめにあるめにあるめにある“““““Bar Offset ”””””にカーソルを移動して、にカーソルを移動して、にカーソルを移動して、にカーソルを移動して、にカーソルを移動して、
[MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在設定されているオフセット値が点滅する画面に
変ります（初期設定では“-2Bar”が点滅します）。

BarBarBarBarBarオフセットの設定オフセットの設定オフセットの設定オフセットの設定オフセットの設定

初期設定初期設定初期設定初期設定初期設定（（（（（“““““-2Bar-2Bar-2Bar-2Bar-2Bar”””””）））））のののののHomeHomeHomeHomeHome画面画面画面画面画面

“““““-4Bar-4Bar-4Bar-4Bar-4Bar”””””に設定時のに設定時のに設定時のに設定時のに設定時のHomeHomeHomeHomeHome画面画面画面画面画面

点滅

点滅
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1小節の１拍目 ➡ テンポ120
4小節の2拍目 ➡ テンポ180
8小節の3拍目 ➡ テンポ90
12小節の1拍目 ➡ テンポ120
16小節の4拍目 ➡ テンポ250

続いて、前述の「拍子の設定」で構成されたソングの、任意のポイントにおけるテンポを設定します。
例えば、「4小節の３拍目のテンポを120」、「12小節の2拍目のテンポを90」・・・・というような設定ができます。

テンポテンポテンポテンポテンポ（（（（（Tempo MapTempo MapTempo MapTempo MapTempo Map）））））の設定の設定の設定の設定の設定

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““SongSongSongSongSong”””””に移動しに移動しに移動しに移動しに移動し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ソング編集のメニューを選択する1ページめの画
面に変り、初期設定では“<< Back”が反転します。

11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードモードモードモードモードに入ります。に入ります。に入ります。に入ります。に入ります。
MENU選択の1ページめの画面に変り、初期設定
では“<< Back”が反転します（“<< Back”は一つ
前の画面に戻ること示しています）。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを22222ページめのページめのページめのページめのページめの
“““““Tempo MapTempo MapTempo MapTempo MapTempo Map”””””に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーキーキーキーキー
を押します。を押します。を押します。を押します。を押します。
現在設定されているイベントを表示します。
初期設定では“1Bar 1  -> 120bpm”と“---Bar -
-> ---bpm”が表示されます。“1Bar 1  -> 120bpm”
は、１小節の1拍めのテンポが120で、他には何
もテンポが設定されていないことを示しています。
“---Bar -  -> ---bpm”は新たなテンポを設定すると
きに使用します。

ここでは例として、前述設定した小節／拍子に基づ
いて、下記のようにテンポを設定します。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““- - - Bar -- - - Bar -- - - Bar -- - - Bar -- - - Bar -  -> - - - -> - - - -> - - - -> - - - -> - - -
bpmbpmbpmbpmbpm”””””に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押しまキーを押しまキーを押しまキーを押しまキーを押しま
す。す。す。す。す。
小節/拍/テンポを設定する画面に変り、“<< Back”
が反転します。

55555））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Bar = 2 BarBar = 2 BarBar = 2 BarBar = 2 BarBar = 2 Bar”””””ににににに
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
小節を入力する画面に変り、“2Bar”が反転します。

1～999の小節が入力可能です。

66666））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで希望の小節を入力し、ダイヤルで希望の小節を入力し、ダイヤルで希望の小節を入力し、ダイヤルで希望の小節を入力し、ダイヤルで希望の小節を入力し、 [MENU/ [MENU/ [MENU/ [MENU/ [MENU/
ENTER] ENTER] ENTER] ENTER] ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
入力した小節が設定され、一つ前の画面に変りま
す。
前述の設定例に基づいて“4Bar”を入力します。

点滅
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77777））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Beat = 1 Beat = 1 Beat = 1 Beat = 1 Beat = 1 ”””””ににににに
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
拍を設定する画面に変り、“1 ”が反転します。

1～8の拍が入力可能です。

88888））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで希望の拍を入力し、ダイヤルで希望の拍を入力し、ダイヤルで希望の拍を入力し、ダイヤルで希望の拍を入力し、ダイヤルで希望の拍を入力し、 [MENU/ [MENU/ [MENU/ [MENU/ [MENU/
ENTER] ENTER] ENTER] ENTER] ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
入力した拍が設定され、一つ前の画面に変ります。

前述の設定例に基づいて“2 ”を入力します。

1111111111））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルを一番下にあるダイヤルでカーソルを一番下にあるダイヤルでカーソルを一番下にあるダイヤルでカーソルを一番下にあるダイヤルでカーソルを一番下にある
“““““[ENTER][ENTER][ENTER][ENTER][ENTER]”””””へ移動して、へ移動して、へ移動して、へ移動して、へ移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーをキーをキーをキーをキーを
押します。押します。押します。押します。押します。
入力したイベントが設定され、一覧画面に変りま
す。これは、1小節の1拍めのテンポが120、4小
節の2拍めのテンポが180に設定されたことを示
しています。

操作手順（4）～（11）と同じ要領で、前述の設定
例に基づいて、他のイベントを設定していきます。

99999））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Tempo = 120Tempo = 120Tempo = 120Tempo = 120Tempo = 120
bpmbpmbpmbpmbpm”””””に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押しまキーを押しまキーを押しまキーを押しまキーを押しま
す。す。す。す。す。
テンポを設定する画面に変り、“120 bpm”が反転
します。

30～250のテンポが入力可能です。

1010101010））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで希望のテンポを入力して、ダイヤルで希望のテンポを入力して、ダイヤルで希望のテンポを入力して、ダイヤルで希望のテンポを入力して、ダイヤルで希望のテンポを入力して、
[MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
入力したテンポが設定され、一つ前の画面に変りま
す。

前述の設定例に基づいて“180bpm”を入力します。

点滅

点滅

点滅

点滅

点滅
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●不要なイベントを削除するには●不要なイベントを削除するには●不要なイベントを削除するには●不要なイベントを削除するには●不要なイベントを削除するには

不要なイベントを選択して削除します。

11111））））） イベントの一覧が表示されている画面で、イベントの一覧が表示されている画面で、イベントの一覧が表示されている画面で、イベントの一覧が表示されている画面で、イベントの一覧が表示されている画面で、ジョグジョグジョグジョグジョグ・・・・・
ダイヤルで変更したいイベントにカーソルを移動ダイヤルで変更したいイベントにカーソルを移動ダイヤルで変更したいイベントにカーソルを移動ダイヤルで変更したいイベントにカーソルを移動ダイヤルで変更したいイベントにカーソルを移動
して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
前述と同様、小節/拍/テンポが入力可能な画面に
変ります。
例として、前述例に基づいて設定したイベントの、
“12Bar 1* -> 120”を選択します。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にある
“““““[DELETE][DELETE][DELETE][DELETE][DELETE]”””””へ移動して、へ移動して、へ移動して、へ移動して、へ移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーをキーをキーをキーをキーを
押します。押します。押します。押します。押します。
速やかに選択したイベントがリストから削除される
と同時に、イベントの一覧画面に変ります。

●任意のイベントを変更するには●任意のイベントを変更するには●任意のイベントを変更するには●任意のイベントを変更するには●任意のイベントを変更するには

任意のイベントを選択して変更します。

11111））））） イベントの一覧が表示されている画面で、イベントの一覧が表示されている画面で、イベントの一覧が表示されている画面で、イベントの一覧が表示されている画面で、イベントの一覧が表示されている画面で、ジョグジョグジョグジョグジョグ・・・・・
ダイヤルで変更したいイベントにカーソルを移動ダイヤルで変更したいイベントにカーソルを移動ダイヤルで変更したいイベントにカーソルを移動ダイヤルで変更したいイベントにカーソルを移動ダイヤルで変更したいイベントにカーソルを移動
して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
前述と同様、小節/拍/テンポが入力可能な画面に
変ります。例として、前述例に基づいて設定したイ
ベントの、“12Bar 1  -> 120”を選択します。

22222））））） 小節を変更するには小節を変更するには小節を変更するには小節を変更するには小節を変更するには“““““Bar = 12BarBar = 12BarBar = 12BarBar = 12BarBar = 12Bar”””””にカーソルをにカーソルをにカーソルをにカーソルをにカーソルを
移動、移動、移動、移動、移動、拍を変更するには拍を変更するには拍を変更するには拍を変更するには拍を変更するには“““““Beat = 1Beat = 1Beat = 1Beat = 1Beat = 1 ”””””にカーソルにカーソルにカーソルにカーソルにカーソル
を移動、を移動、を移動、を移動、を移動、そしてテンポを変更するにはそしてテンポを変更するにはそしてテンポを変更するにはそしてテンポを変更するにはそしてテンポを変更するには“““““Tempo =Tempo =Tempo =Tempo =Tempo =
120bpm120bpm120bpm120bpm120bpm”””””にカーソルを移動してにカーソルを移動してにカーソルを移動してにカーソルを移動してにカーソルを移動して [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER]
キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
前述の設定方法と同様、新たな小節、拍、またはテ
ンポが入力可能な画面に変ります。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで小節、ダイヤルで小節、ダイヤルで小節、ダイヤルで小節、ダイヤルで小節、拍、拍、拍、拍、拍、またはテンポを入力またはテンポを入力またはテンポを入力またはテンポを入力またはテンポを入力
して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーキーキーキーキーを押します。を押します。を押します。を押します。を押します。
例として、小節のみを“10Bar”に変更します。

44444））））） 変更終了後、変更終了後、変更終了後、変更終了後、変更終了後、ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルを画面下ダイヤルでカーソルを画面下ダイヤルでカーソルを画面下ダイヤルでカーソルを画面下ダイヤルでカーソルを画面下
ののののの“““““[ENTER][ENTER][ENTER][ENTER][ENTER]”””””へ移動して、へ移動して、へ移動して、へ移動して、へ移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーキーキーキーキー
を押します。を押します。を押します。を押します。を押します。
変更したイベントに設定され、前述と同様イベント
の一覧画面に変ります。

＜変更前のイベント一覧画面＞＜変更前のイベント一覧画面＞＜変更前のイベント一覧画面＞＜変更前のイベント一覧画面＞＜変更前のイベント一覧画面＞

＜変更後のイベント一覧画面＞＜変更後のイベント一覧画面＞＜変更後のイベント一覧画面＞＜変更後のイベント一覧画面＞＜変更後のイベント一覧画面＞

MENUモードから抜け出すには、 [STOP] キーを押
してください（または、“<< Back”を選択して
[MENU/ENTER] キーを押す操作を繰り返すか、
[REWIND] キーを押してください）。

＜削除後のイベント一覧画面＞＜削除後のイベント一覧画面＞＜削除後のイベント一覧画面＞＜削除後のイベント一覧画面＞＜削除後のイベント一覧画面＞

MENUモードから抜け出すには、 [STOP] キーを押
してください（または、“<< Back”を選択して
[MENU/ENTER] キーを押す操作を繰り返すか、
[REWIND] キーを押してください）。
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MIDIMIDIMIDIMIDIMIDI 機器との同期機器との同期機器との同期機器との同期機器との同期
MR-8mkIIの [MIDI OUT] 端子と外部のMIDIシステム（シーケンサー、音源
モジュール、コンピュータなど）を接続することで、グレードの高いレコー
ディングが可能になります。

例えば、MR-8mkIIにはボーカルやギターなどを録音し、音源モジュールの音
はミックスダウンする際に、シーケンサーなどで再生して、MR-8mkIIと同期
させながら演奏させる・・・・という方法があります。

MR-8mkIIには [MIDI OUT] 端子を設けていますので、MR-8mkIIから外部MIDI
システムへMTC (MIDIタイムコード）または、CLK (MIDIクロック＆ソング・
ポジション・ポインタ）を出力することで、外部のMIDI機器と同期を取るこ
とができます。



86

MR-8mkII MR-8mkII MR-8mkII MR-8mkII MR-8mkII 　取扱説明書　取扱説明書　取扱説明書　取扱説明書　取扱説明書（（（（（MIDIMIDIMIDIMIDIMIDI 機器との同期）機器との同期）機器との同期）機器との同期）機器との同期）

MIDI OUTUSB HOSTCOMPACTFLASH CARD

MIDI IN

ここでは、MTC (MIDIタイムコード）に対応しているシーケンサーなどと同期させます。

MIDIケーブルを使って、MR-8mkIIの [MIDI OUT] 端子と外部MIDIシーケンサーの [MIDI IN] 端子を接続します。
接続用のMIDIケーブルはMR-8mkIIに付属しておりませんので、市販のMIDIケーブル（DIN 5ピン）をご用意くだ
さい。

11111））））） MENUMENUMENUMENUMENUモードのモードのモードのモードのモードのSystemSystemSystemSystemSystemメニューの中にあるメニューの中にあるメニューの中にあるメニューの中にあるメニューの中にある“““““MidiMidiMidiMidiMidi
Sync OutSync OutSync OutSync OutSync Out”””””ををををを“““““MTCMTCMTCMTCMTC”””””に設定し、に設定し、に設定し、に設定し、に設定し、“““““MTC FrameMTC FrameMTC FrameMTC FrameMTC Frame
RateRateRateRateRate”””””でででででMTC OUTMTC OUTMTC OUTMTC OUTMTC OUTのフレームのフレームのフレームのフレームのフレーム・・・・・レートを設定しレートを設定しレートを設定しレートを設定しレートを設定し
ます。ます。ます。ます。ます。
詳細は次項をご覧ください。

22222））））） 外部外部外部外部外部MIDIMIDIMIDIMIDIMIDIシーケンサーを、シーケンサーを、シーケンサーを、シーケンサーを、シーケンサーを、MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIからのからのからのからのからのMTCMTCMTCMTCMTC
に同期するよう設定します。に同期するよう設定します。に同期するよう設定します。に同期するよう設定します。に同期するよう設定します。
詳細は、シーケンサーの取扱説明書をご覧くださ
い。

33333））））） MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIののののの [PLAY]  [PLAY]  [PLAY]  [PLAY]  [PLAY] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、再生を開始しま再生を開始しま再生を開始しま再生を開始しま再生を開始しま
す。す。す。す。す。
MR-8mkIIの再生に同期して、シーケンサーが再生
を始めます。

MR-8mkIIが停止状態で、MIDI同期信号を“MTC”に
設定し、シーケンサーに合わせたMTCフレーム・レー
トを設定します。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““SystemSystemSystemSystemSystem”””””へ移動へ移動へ移動へ移動へ移動
して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Systemメニューを選択する1ページめの画面に変
り、初期設定では“<< Back”が反転します。

＜＜＜＜＜MTCMTCMTCMTCMTCのスタート時間＞のスタート時間＞のスタート時間＞のスタート時間＞のスタート時間＞
MR-8mkIIから出力されるMTCは、ABS ZERO （0m
00s 000ms）に1時間のオフセットが設定されていま
す（オフセット値は固定です）。
つまり、ソングの先頭（ABS ZERO）から再生すると、
MTC時間は01h 00m 00s 00fからスタートして出力
されることになります。

11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードに入ります。モードに入ります。モードに入ります。モードに入ります。モードに入ります。
MENU選択画面に変り、初期設定では“<< Back”が
反転します（“<< Back”は一つ前の画面に戻ること
を示しています）。

MIDIMIDIMIDIMIDIMIDIシーケンサーなどシーケンサーなどシーケンサーなどシーケンサーなどシーケンサーなど

外部外部外部外部外部MIDIMIDIMIDIMIDIMIDI 機器との接続機器との接続機器との接続機器との接続機器との接続

MR-8mkII / MIDIMR-8mkII / MIDIMR-8mkII / MIDIMR-8mkII / MIDIMR-8mkII / MIDIシーケンサーの設定シーケンサーの設定シーケンサーの設定シーケンサーの設定シーケンサーの設定

MIDIMIDIMIDIMIDIMIDI同期信号同期信号同期信号同期信号同期信号/MTC/MTC/MTC/MTC/MTCフレームフレームフレームフレームフレーム・・・・・レートの設定レートの設定レートの設定レートの設定レートの設定

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Midi Sync OutMidi Sync OutMidi Sync OutMidi Sync OutMidi Sync Out”””””
へ移動して、へ移動して、へ移動して、へ移動して、へ移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。

MTCMTCMTCMTCMTCを利用した同期を利用した同期を利用した同期を利用した同期を利用した同期
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MTC (MIDIタイムコード）に対応していないシーケンサーなどと同期させるには、CLK (MIDIクロック＆MIDI
ソング・ポジション・ポインタ）をMR-8mkIIから出力させます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞
● CLKを使って外部MIDI機器を同期させるには、必
ずテンポ・マップを作成してください。
CLKは、MR-8mkIIで作成されたテンポ・マップ
に基づいて出力されます。なお、録音を開始する
ときは、本機から出力するCLKにシーケンサーを
同期させてください。

● MIDIクロックとソング・ポジション・ポインタに
対応しているシーケンサーを使う場合は、ソング
の任意の位置から再生させることができます。
このとき、シーケンサーは現在のソング・ポジ
ションをロケートして同期走行します。しかし、
一部のシーケンサーによっては、同期しない場合
もありますので、ご注意ください。

66666））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで希望のフレームダイヤルで希望のフレームダイヤルで希望のフレームダイヤルで希望のフレームダイヤルで希望のフレーム・・・・・レートを選択レートを選択レートを選択レートを選択レートを選択
して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択したフレーム・レートに設定され、“MTC
Frame Rate = **”が反転する画面に変ります。

77777））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

55555））））） 引き続き、引き続き、引き続き、引き続き、引き続き、ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““MTCMTCMTCMTCMTC
FrameRateFrameRateFrameRateFrameRateFrameRate”””””へ移動して、へ移動して、へ移動して、へ移動して、へ移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーをキーをキーをキーをキーを
押します。押します。押します。押します。押します。
現在設定されているフレーム・レートが点滅する画
面に変ります（初期設定では“25”が点滅）。
フレーム・レートは“25”以外に、“24”、“30nd”、
または“30df”が選択できます。

11111））））） MENUMENUMENUMENUMENUモードのモードのモードのモードのモードのSystemSystemSystemSystemSystemメニューの中にあるメニューの中にあるメニューの中にあるメニューの中にあるメニューの中にある“““““MidiMidiMidiMidiMidi
Sync OutSync OutSync OutSync OutSync Out”””””を、を、を、を、を、“““““CLKCLKCLKCLKCLK”””””に設定します。に設定します。に設定します。に設定します。に設定します。
前項と同じ要領で設定します。

22222））））） MENUMENUMENUMENUMENUモードのモードのモードのモードのモードのSongSongSongSongSongメニューの中にあるメニューの中にあるメニューの中にあるメニューの中にあるメニューの中にある
“““““Signature MapSignature MapSignature MapSignature MapSignature Map”””””ととととと“““““Tempo MapTempo MapTempo MapTempo MapTempo Map”””””で、で、で、で、で、テンポテンポテンポテンポテンポ・・・・・
マップを設定します。マップを設定します。マップを設定します。マップを設定します。マップを設定します。
76ページの「リズム・ガイドを鳴らすには」を参
照してください。

33333））））） 外部外部外部外部外部MIDIMIDIMIDIMIDIMIDIシーケンサーを、シーケンサーを、シーケンサーを、シーケンサーを、シーケンサーを、MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIからのからのからのからのからのCLKCLKCLKCLKCLKににににに
同期するよう設定します。同期するよう設定します。同期するよう設定します。同期するよう設定します。同期するよう設定します。
詳細は、シーケンサーの取扱説明書を参照してくだ
さい。

44444））））） MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIののののの [PLAY]  [PLAY]  [PLAY]  [PLAY]  [PLAY] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、再生を開始し再生を開始し再生を開始し再生を開始し再生を開始し
ます。ます。ます。ます。ます。
MR-8mkIIの再生に同期して、シーケンサーが再生
を始めます。

現在の設定が点滅する画面に変ります（初期設定
では“Off”が点滅）。
MIDI同期信号は、“Off”以外に“CLK”または
“MTC”が選択できます。

Off

CLK

MTC

何も出力しません（初期設定）。
MIDIクロック＆MIDIソング・ポジショ
ン・ポインターを出力します。

MIDIタイムコードを出力します。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルで“““““MTCMTCMTCMTCMTC”””””を選択して、を選択して、を選択して、を選択して、を選択して、  [MENU/  [MENU/  [MENU/  [MENU/  [MENU/
ENTER] ENTER] ENTER] ENTER] ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
MIDI同期出力信号がMIDIタイムコードに設定さ
れ、“Midi Sync Out = MTC ”が反転する画面に変
ります。

外部外部外部外部外部MIDIMIDIMIDIMIDIMIDI 機器との接続機器との接続機器との接続機器との接続機器との接続

前述と同様、MIDIケーブルを使ってMR-8mkII の [MIDI
OUT] 端子と、外部MIDIシーケンサーの [MIDI IN] 端子
を接続します。

MR-8mkII / MIDIMR-8mkII / MIDIMR-8mkII / MIDIMR-8mkII / MIDIMR-8mkII / MIDIシーケンサーの設定シーケンサーの設定シーケンサーの設定シーケンサーの設定シーケンサーの設定

CLKCLKCLKCLKCLKを利用した同期を利用した同期を利用した同期を利用した同期を利用した同期

点滅

点滅
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ソングの管理ソングの管理ソングの管理ソングの管理ソングの管理
ここでは、記録／再生を行うためのソングを管理する、下記項目について記載
しています。

（（（（（11111）））））　　　　　希希希希希望望望望望のののののソソソソソンンンンングググググををををを選選選選選択択択択択すすすすするるるるる

（（（（（22222））））） ソングソングソングソングソング・・・・・ネームを編集して再登録するネームを編集して再登録するネームを編集して再登録するネームを編集して再登録するネームを編集して再登録する

（（（（（33333）））））　　　　　不不不不不要要要要要なななななソソソソソンンンンングググググををををを削削削削削除除除除除すすすすするるるるる

（（（（（44444）））））　　　　　ソソソソソンンンンングググググにににににプププププロロロロロテテテテテクククククトトトトトをををををかかかかかけけけけけるるるるる

（（（（（55555）））））　　　　　ソソソソソンンンンングググググ内内内内内ののののの不不不不不要要要要要なななななWAVWAVWAVWAVWAVファイルを削除ファイルを削除ファイルを削除ファイルを削除ファイルを削除

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞
MENUモードの階層画面が表示されている状態では、下記の操作をすることで一つ前
の階層画面に戻したり、ダイレクトにMENUモードから抜け出すことができます。

（（（（（１１１１１））））） MENUMENUMENUMENUMENU画面上にある画面上にある画面上にある画面上にある画面上にある“““““<<Back<<Back<<Back<<Back<<Back”””””を選択してを選択してを選択してを選択してを選択して [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押す。キーを押す。キーを押す。キーを押す。キーを押す。
現在表示されている階層画面の一つ前に戻り、同じ操作を繰り返すと最終的に
はMENUモードから抜け出します。

（（（（（２２２２２））））） [REWIND] [REWIND] [REWIND] [REWIND] [REWIND] キーを押す。キーを押す。キーを押す。キーを押す。キーを押す。
キーを押すごとに、現在表示されている階層画面の一つ前に戻り、最終的には
MENUモードから抜け出します。

（（（（（３３３３３））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押す。キーを押す。キーを押す。キーを押す。キーを押す。
一気にMENUモードから抜け出し、Home画面に変ります。
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コンパクトフラッシュ・カード上に複数のソングが作成されていることを前提に、希望のソングを選択します。
なお、この操作の過程では、新たなソングを作成することもできます（新たなソングの作成については「準備
編」の23ページを参照してください）。

11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。
MENU選択の1ページめの画面に変り、初期設定
では“<< Back”が反転します。“<< Back”は、一
つ前の画面に戻ることを示しています。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Song >Song >Song >Song >Song >”””””に移動に移動に移動に移動に移動
して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ソングの編集メニューを選択する画面に変り、
“<< Back”が反転します。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Select Song >Select Song >Select Song >Select Song >Select Song >”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在作成されているソングの一覧画面に変ります。

上記例は、現在4つのソングがカード上に作成され
ていることを示し、ソングの一覧が1ページで表示
されています。

多くのソングが作成されているときは複数ページに
なり、ジョグ・ダイヤルを回していくと、スクロー
ル表示できます。
画面最後の一番下にある“---: (New Song)”は、新
たなソングを作成するときに使用します。
新たなソングを作成する方法については、23ペー
ジの「Newソングの作成」を参照してください。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで希望のソングダイヤルで希望のソングダイヤルで希望のソングダイヤルで希望のソングダイヤルで希望のソング・・・・・ナンバー／ソンナンバー／ソンナンバー／ソンナンバー／ソンナンバー／ソン
グググググ・・・・・ネームを選択して、ネームを選択して、ネームを選択して、ネームを選択して、ネームを選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押キーを押キーを押キーを押キーを押
します。します。します。します。します。
“Select Song > ”が反転する画面に変ります。

55555））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。
選択したソングのHome画面に変ります。

希望のソングを選択する希望のソングを選択する希望のソングを選択する希望のソングを選択する希望のソングを選択する
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ソングに設定されているソング・ネームを編集し、再登録します。ソング・ネームの編集は、現在立ち上がっ
ているソングでのみ行なえます。

11111））））） あらかじめ、あらかじめ、あらかじめ、あらかじめ、あらかじめ、ネームを編集するソングを立ち上げネームを編集するソングを立ち上げネームを編集するソングを立ち上げネームを編集するソングを立ち上げネームを編集するソングを立ち上げ
ておきます。ておきます。ておきます。ておきます。ておきます。

22222））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。
MENU選択の1ページめの画面に変り、初期設定
では“<< Back”が反転します。“<< Back”は、一
つ前の画面に戻ることを示しています。

77777））））） 続けて続けて続けて続けて続けて [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ネームが再登録され、一つ前の画面に変ります。

8)8)8)8)8) [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出モードから抜け出モードから抜け出モードから抜け出モードから抜け出
します。します。します。します。します。
MENUモードから抜け出すとHome画面に変り、編
集したソング・ネームが表示されます。

＜文字入力キー＞＜文字入力キー＞＜文字入力キー＞＜文字入力キー＞＜文字入力キー＞
文字入力キーとは、左記 [PLAY
MODE] キーのように、キーの
下に “S T U 7”などのアルファ
ベット／数字が印刷されている
キーを指しています。 [PLAY
MODE] キーでは、大文字のS,

T, U／小文字のs, t, u ／数字の7が入力できま
す。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：既に存在するネームを入力したり、
何もネームを入力しないで登録しようとする
と、警告メッセージ（“Illegal Song Name! ”）
を表示して、元の入力可能な画面に戻ります。
また、8桁以下のソング・ネームを設定すると
きは、ネームに“+”記号は使用できません（例：
AAA+BBB）。なお、8桁以上のソング・ネー
ムを設定するときは“+”記号が使用可能です
（例：AAAA+BBBB）。ネームを入力する際に
はご注意ください。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Song >Song >Song >Song >Song >”””””に移動に移動に移動に移動に移動
して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ソングの編集メニューを選択する画面に変り、
“<< Back”が反転します。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Rename Song >Rename Song >Rename Song >Rename Song >Rename Song >”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在立ち上がっているソングのソング・ネームが編
集可能な画面に変り、ネームの右端が点滅します。

カーソルが点滅しているポイントで、文字入力キー
を使って文字／記号などを入力し、カーソルは
ジョグ・ダイヤルを回して移動します（異なった文
字入力キーを押してもカーソルが移動します）。

＜＜＜＜＜[UNDO/REDO] / [DELETE] [UNDO/REDO] / [DELETE] [UNDO/REDO] / [DELETE] [UNDO/REDO] / [DELETE] [UNDO/REDO] / [DELETE] キー＞キー＞キー＞キー＞キー＞
カーソルが点滅している状態で
[UNDO/REDO] / [DELETE]
キーを押していくと、文字が全
てデリートできます。

55555））））） 文字入力キーを使って、文字入力キーを使って、文字入力キーを使って、文字入力キーを使って、文字入力キーを使って、希望のソング希望のソング希望のソング希望のソング希望のソング・・・・・ネームを入ネームを入ネームを入ネームを入ネームを入
力します。力します。力します。力します。力します。

66666））））） ネームを入力した後ネームを入力した後ネームを入力した後ネームを入力した後ネームを入力した後 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押しキーを押しキーを押しキーを押しキーを押し
ます。ます。ます。ます。ます。
カーソルが画面下の“[ENTER]”に移動します。
中止するには、[MENU]ダイヤルで“[CANCEL]”を
選択して [ENTER] キーを押します。

ソングソングソングソングソング・・・・・ネームを編集するネームを編集するネームを編集するネームを編集するネームを編集する

STU7

PLAY MODE

DELETE

UNDO/REDO

点滅
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＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：プロテクトがOnになっているソングは、削除することができません。あらかじめ、削除し
たいソングのプロテクトを解除してください（次ページ参照）。

11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードモードモードモードモードへ入ります。へ入ります。へ入ります。へ入ります。へ入ります。
MENU選択の1ページめの画面に変り、初期設定
では“<< Back”が反転します。“<< Back”は、一
つ前の画面に戻ることを示しています。

55555））））） [RECORD] [RECORD] [RECORD] [RECORD] [RECORD] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER]
キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択したソングが削除され、ソング一覧の画面に変
ります。

カード上に作成されているソングの中から、不要になった任意のソングを削除します。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Song >Song >Song >Song >Song >”””””に移動に移動に移動に移動に移動
して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ソングの編集メニューを選択する画面に変り、
“<< Back”が反転します。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Delete Song >Delete Song >Delete Song >Delete Song >Delete Song >”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在カード上に作成されているソング一覧の画面に
変ります。下記例は現在4つのソングが作成されて
いる状態で、1ページで表示されいます（4つ以上
ソングがある場合は、複数ページで表示されます）。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで削除したいソングを選択して、ダイヤルで削除したいソングを選択して、ダイヤルで削除したいソングを選択して、ダイヤルで削除したいソングを選択して、ダイヤルで削除したいソングを選択して、
[MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択したソングの削除はアンドウできないことを警
告し、実行するかどうかを確認するための画面に
変ります。中止するときは [STOP] キーを押しま
す。

上記例のように、ソング3（S03）を削除するこ
とで、下にあったソング4（S04: DDDDDDDD）が
ソング3に入れ換わります。

66666））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。
MENUモードから抜け出すと、ソング3に繰り上
がったソングのHome画面に変ります（上記例で
は、削除する前のソング4が立ち上がります）。

不要なソングを削除する不要なソングを削除する不要なソングを削除する不要なソングを削除する不要なソングを削除する

同様の操作でカード上の全てのソングを削除したと
きは、“<< Back”のみが表示されます。この状態から
[STOP] キーを押してMENUモードから抜け出すと、
カード上には新たなソング（Song01）が自動的に作
成され、Song01のHome画面に変ります。

点滅
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録音済みのソングを誤って消去したりしないようソングにプロテクトをかけたり、プロテクトを解除します。大
切な楽曲を録音したソングを保存しておくには、プロテクトをかけておくことをお勧めします。プロテクトの
オン／オフは、現在立ち上がっているソングにのみ行なえます。

55555））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルで“““““OnOnOnOnOn”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ [MENU/ [MENU/ [MENU/ [MENU/
ENTER] ENTER] ENTER] ENTER] ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在立ち上がっているソングのプロテクトがOnに
設定され、一つ前の画面に変ります。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：プロテクトのかかったソングでは、
録音をはじめ各種編集などを実行することが
できなくなります。
録音や編集を実行したい場合は、作業に入る
前にプロテクトを解除してください。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：プロテクトをOnに設定すると、設
定する前に選択されている [REC SELECT]
キーまたはバウンス・モードなどの設定は、す
べて解除されます。

66666））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

プロテクトを解除するには、同じ要領で“Off”
を選択して [MENU/ENTER] キーを押してくだ
さい。

＜覚えておきましょう！＞＜覚えておきましょう！＞＜覚えておきましょう！＞＜覚えておきましょう！＞＜覚えておきましょう！＞
プロテクトが“On”に設定されたソングでは、
Home画面のソング・ネーム先頭に“ ”アイ
コンが点灯します。“ ”アイコンが点灯して
いるソングは、録音や編集を行うことができ
ません。

11111））））） あらかじめ、あらかじめ、あらかじめ、あらかじめ、あらかじめ、プロテクトをかけるソングを立ち上げプロテクトをかけるソングを立ち上げプロテクトをかけるソングを立ち上げプロテクトをかけるソングを立ち上げプロテクトをかけるソングを立ち上げ
ておきます。ておきます。ておきます。ておきます。ておきます。

22222））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。
MENU選択の1ページめの画面に変り、初期設定
では“<< Back”が反転します。“<< Back”は、一
つ前の画面に戻ることを示しています。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Song >Song >Song >Song >Song >”””””に移動に移動に移動に移動に移動
して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ソングの編集メニューを選択する画面に変り、
“<< Back”が反転します。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Protect = **Protect = **Protect = **Protect = **Protect = **”””””ににににに
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在設定されている項目（OnまたはOff）が点滅
し、設定可能な画面に変ります（初期設定では
“Off”が点滅します）。

ソングにプロテクトをかけるソングにプロテクトをかけるソングにプロテクトをかけるソングにプロテクトをかけるソングにプロテクトをかける

点滅

点滅
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ここで言う「不要なファイル」とは、使用することの無いアンドウ用のWAVファイルを指しています。通常、
任意のソング内で重ね録音やパンチン／アウト編集などを実行すると、アンドウ用のWAVファイルが残ったま
まになります。このアンドウ用WAVファイルは、編集前の状態に戻す（アンドウ）ためのファイルで、録音や
編集を繰り返すと、その都度アンドウ用のWAVファイルがソング内に増えていきます。しかし、アンドウ／リ
ドウを必要としないソングではその分カードの記録可能な領域を消費することになります。そのため、“Delete
Unused”でこれらの不要なファイルを削除することで、カードの記録領域を最大限確保することができます。

ソング内の不要なファイルを削除ソング内の不要なファイルを削除ソング内の不要なファイルを削除ソング内の不要なファイルを削除ソング内の不要なファイルを削除

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞
● プロテクトがOnになっているソングの不要なWAVファイルは、削除することができません。あらかじめ、
ソングのプロテクトを解除してください（前ページ参照）。

● 不要なWAVファイルの削除はアンドウ（やり直し）できませんので、メニューを実行する際にはご注意くだ
さい。

● 不要なWAVファイルを削除すると、その時点でアンドウ／リドウができなくなります。しかし、新たな録音
作業を行うことで、再びアンドウ用のWAVファイルが作成され、アンドウ／リドウが可能になります。

● MR-8mkIIが初期設定の状態では、ソング内でトラック・データ（またはパート・データ）の削除を実行する
と、“Delete Unused”を実行しなくても、自動的に不要なWAVファイルが削除されるようになっています
（135ページの“Auto Delete機能のON/OFF設定”をお読みください）。

11111））））） あらかじめ、あらかじめ、あらかじめ、あらかじめ、あらかじめ、希望のソングを立ち上げておきます。希望のソングを立ち上げておきます。希望のソングを立ち上げておきます。希望のソングを立ち上げておきます。希望のソングを立ち上げておきます。

22222））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。
MENU選択の1ページめの画面に変り、初期設定
では“<< Back”が反転します。“<< Back”は、一
つ前の画面に戻ることを示しています。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Song >Song >Song >Song >Song >”””””に移動に移動に移動に移動に移動
して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ソングの編集メニューを選択する画面に変り、
“<< Back”が反転します。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Delete UnusedDelete UnusedDelete UnusedDelete UnusedDelete Unused”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
アンドウ用ファイルの削除を確認する画面に変りま
す。

55555））））） [RECORD] [RECORD] [RECORD] [RECORD] [RECORD] キーを押しながら、キーを押しながら、キーを押しながら、キーを押しながら、キーを押しながら、 [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER]
キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ファイルの削除が実行され、処理が終了すると同時
に “Completed!”が点灯します。

66666））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：ファイルの削除を中止するには、
[STOP] キーを押してください。

点滅
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トラックトラックトラックトラックトラック・・・・・データの編集データの編集データの編集データの編集データの編集
ここでは、録音済みのソングにおける「トラック・データの編集」について記
載しています。本機で言う「トラック・データ」とは、ソングの先頭（ABS
0）から最終記録位置（REC END）までの全データを指しています。

＜編集のアンドウ／リドウ！＞＜編集のアンドウ／リドウ！＞＜編集のアンドウ／リドウ！＞＜編集のアンドウ／リドウ！＞＜編集のアンドウ／リドウ！＞
トラックの編集は、失敗してもやり直しが可能です。
トラック編集の終了後 [UNDO/REDO] キーを押すと、編集する前の状態に戻すこと
ができます。また、アンドウした後再度 [UNDO/REDO] キーを押すと、編集した後
の状態に戻すこともできます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：編集を終了した後下記の操作を行うと、アンドウはで
きなくなりますのでご注意ください。

1.1.1.1.1. 新たな録音を実行したとき。新たな録音を実行したとき。新たな録音を実行したとき。新たな録音を実行したとき。新たな録音を実行したとき。
2.2.2.2.2. 新たな編集を実行したとき。新たな編集を実行したとき。新たな編集を実行したとき。新たな編集を実行したとき。新たな編集を実行したとき。
3.3.3.3.3. 電源を電源を電源を電源を電源をOFFOFFOFFOFFOFFしたとき。したとき。したとき。したとき。したとき。
4.4.4.4.4. ソングのセレクトを実行したとき。ソングのセレクトを実行したとき。ソングのセレクトを実行したとき。ソングのセレクトを実行したとき。ソングのセレクトを実行したとき。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：MENUモードの階層画面が表示されている状態では、下記の操作をするこ
とで一つ前の階層画面に戻したり、ダイレクトにMENUモードから抜け出すことが
できます。

（（（（（11111））））） MENUMENUMENUMENUMENU画面上にある画面上にある画面上にある画面上にある画面上にある     “““““<<Back<<Back<<Back<<Back<<Back”””””を選択してを選択してを選択してを選択してを選択して [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押す。キーを押す。キーを押す。キーを押す。キーを押す。
現在表示されている階層画面の一つ前に戻り、同じ操作を繰り返すと最終的には
MENUモードから抜け出します。

（（（（（22222））））） [REWIND] [REWIND] [REWIND] [REWIND] [REWIND] キーを押す。キーを押す。キーを押す。キーを押す。キーを押す。
キーを押すごとに、現在表示されている階層画面の一つ前に戻り、最終的には
MENUモードから抜け出します。

（（（（（33333））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押す。キーを押す。キーを押す。キーを押す。キーを押す。
一気にMENUモードから抜け出し、Home画面に変ります。

 [UNDO/REDO] キー

DELETE

UNDO/REDO

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：MR-8mkIIが初期設定の状態では、トラック・データの削除を実行し
たときのみ、アンドウ／リドウができない設定になっています。
これは、カードの記録可能な領域を最大限確保するためで、削除後はカードのリ
メインが増加します。削除のアンドウ／リドウを可能にするには、作業を始める
前にMENUモードの“System”メニューにある “Auto Delete”を“Off”に
設定してください（☞135ページ）。ただし、アンドウ／リドウ可能な設定にし
た場合は、トラック・データを削除しても、カードのリメインが増加することは
ありません。
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55555））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Erase Track = 1Erase Track = 1Erase Track = 1Erase Track = 1Erase Track = 1”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在の設定が点滅し、選択可能になり、ジョグ・ダ
イヤルで下記トラックが選択できます。

●1～8のモノ・トラック。
●1/2、3/4、5/6、7/8のステレオ・トラック。

77777））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にある
“““““[ENTER][ENTER][ENTER][ENTER][ENTER]”””””へ移動して、へ移動して、へ移動して、へ移動して、へ移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーをキーをキーをキーをキーを
押します。押します。押します。押します。押します。
“Please Wait”を表示した後速やかに削除が終了し
た後、“Completed ”が点灯します。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：キャンセルするときは、“[CANCEL]”
を選択して [ENTER] キーを押してください。

66666））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで希望のトラックを選択して、ダイヤルで希望のトラックを選択して、ダイヤルで希望のトラックを選択して、ダイヤルで希望のトラックを選択して、ダイヤルで希望のトラックを選択して、
[MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Erase Track = **”が反転する画面に変ります。

任意のトラック・データ全て（ABS ZERO～REC END）を削除します。トラック・データの削除は、現在立
ち上がっているソングでのみ行なえます。

11111））））） あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。

22222））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。
MENU選択の1ページめの画面に変わり、初期設
定では“<< Back”が反転します。“<< Back”は、
一つ前の画面に戻ることを示しています。

TRK 1
TRK 2
TRK 3
TRK 4
TRK 5
TRK 6
TRK 7
TRK 8

Silent

ABS ZERO REC END

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Erase Track >Erase Track >Erase Track >Erase Track >Erase Track >”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
削除するトラックを選択する画面に変ります。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：プロテクトのかかっているソングでは、ト
ラック・データの削除は実行できません。あらかじめ
プロテクトを解除してください（☞93ページ）。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Track Edit >Track Edit >Track Edit >Track Edit >Track Edit >”””””ににににに
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
トラックの編集メニューを選択する画面に変り、
“<< Back”が反転します。

トラックトラックトラックトラックトラック・・・・・データの削除データの削除データの削除データの削除データの削除

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：初期設定の状態では、トラック・データの
削除はアンドウできません。アンドウを可能にするに
は、MENUモードの“System”メニューにある“Auto
Delete”を“Off”に設定し直してください（☞135ペー
ジ）。

点灯している“Can’t  Undo !”は、トラック・デー
タの削除はアンドウできないことを示しています。

点滅
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88888））））） [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Erase Track >”が反転する画面に変ります。

99999））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

任意のトラック・データ全て（ABS ZERO～REC END）をコピーして、他のトラックへペーストします。ペー
スト後もコピー元のトラック・データは残ったままになります。コピー・ペーストは、現在立ち上がっている
ソング内で行なえます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：プロテクトのかかっているソングでは、ト
ラック・データのコピー／ペーストは実行できません。
あらかじめソングのプロテクトを解除してください
（☞93ページ）。

TRK 1
TRK 2
TRK 3
TRK 4
TRK 5
TRK 6
TRK 7
TRK 8

ABS ZERO REC END

11111））））） あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。

22222））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードモードモードモードモードへ入ります。へ入ります。へ入ります。へ入ります。へ入ります。
MENU選択の1ページめの画面に変わり、初期設
定では“<< Back”が反転します。“<< Back”は、
一つ前の画面に戻ることを示しています。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Track Edit >Track Edit >Track Edit >Track Edit >Track Edit >”””””ににににに
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
トラックの編集メニューを選択する画面に変り、
“<< Back”が反転します。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Copy-PasteCopy-PasteCopy-PasteCopy-PasteCopy-Paste
Trk >Trk >Trk >Trk >Trk >”””””ににににに移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押しキーを押しキーを押しキーを押しキーを押し
ます。ます。ます。ます。ます。
コピー元のトラックと、ペースト先のトラック選択
画面に変わります。“Source Track ”はコピー元の
トラックを指し、“Dest. Track”はペースト先のト
ラックを指しています。

トラックトラックトラックトラックトラック・・・・・データのコピーデータのコピーデータのコピーデータのコピーデータのコピー・・・・・ペーストペーストペーストペーストペースト
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99999））））） [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Copy-Paste Trk > ”が反転する画面に変ります。

1010101010））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：既に記録済みトラックへコピー・
ペーストを実行すると、元のデータは書き換え
られてしまいます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：キャンセルするときは、“[CANCEL]”
を選択して [MENU/ENTER] キーを押してくだ
さい。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：思うような編集結果でなかったとき
は、 [UNDO/REDO] キーを押して、最初からや
り直ししてください（☞95ページ）。

66666））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでコピー元のトラックを選択しダイヤルでコピー元のトラックを選択しダイヤルでコピー元のトラックを選択しダイヤルでコピー元のトラックを選択しダイヤルでコピー元のトラックを選択し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ペースト先のトラックが選択可能になります。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：コピー元とコピー先のトラックは、同
じトラックを選択できません。

88888））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にある
“““““[ENTER][ENTER][ENTER][ENTER][ENTER]”””””に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーをキーをキーをキーをキーを
押します。押します。押します。押します。押します。
“Please Wait”を表示した後速やかにコピー・ペー
ストが終了して、“Completed ”が点灯します。

ペースト先のトラックには、コピー元のトラックに
選択したトラックと同じ組み合わせで選択できま
す。例えば、コピー元にモノ・トラックを選択した
ときはモノ・トラックのみ選択でき、コピー元にス
テレオ・トラックを選択したときは、ペースト先の
トラックもステレオ・トラックのみ選択できます。

77777））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでペースト先のトラックを選択しダイヤルでペースト先のトラックを選択しダイヤルでペースト先のトラックを選択しダイヤルでペースト先のトラックを選択しダイヤルでペースト先のトラックを選択し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Dest. Track = **”が反転する画面に変ります。

55555））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Source Track =Source Track =Source Track =Source Track =Source Track =
*****”””””に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
コピー元のトラックが選択可能になり、ジョグ・ダ
イヤルで下記トラックが選択できます。

●1～8のモノ・トラック。
●1/2、3/4、5/6、7/8のステレオ・トラック。

点滅

点滅

点滅

点滅
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TRK 1
TRK 2
TRK 3
TRK 4
TRK 5
TRK 6
TRK 7
TRK 8

ABS ZERO REC END

任意のトラック・データ（ABS ZERO～REC END）全てを、他のトラックへムーブ（移動）します。ムーブ
後は、ムーブ元のトラックは無音になります。なお、トラック・データのムーブは、現在立ち上がっているソ
ング内で行なえます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：プロテクトのかかっているソングでは、ト
ラック・データのムーブは実行できません。あらかじめ
ソングのプロテクトを解除してください（☞ 93ペー
ジ）。

11111））））） あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。

22222））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。
MENU選択の1ページめの画面に変わり、初期設
定では“<< Back”が反転します。“<< Back”は、
一つ前の画面に戻ることを示しています。

ムーブ元のトラックと、ムーブ先のトラック選択画
面に変わります。“Source Track ”はムーブ元のト
ラックを指し、“Dest. Track”はムーブ先のトラッ
クを指しています。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Track Edit >Track Edit >Track Edit >Track Edit >Track Edit >”””””ににににに
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
トラックの編集メニューを選択する画面に変り、
“<< Back”が反転します。

55555））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Source Track =Source Track =Source Track =Source Track =Source Track =
11111”””””に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ムーブ元のトラックが選択可能になり、ジョグ・ダ
イヤルで下記トラックが選択できます。

●1～8のモノ・トラック。
●1/2、3/4、5/6、7/8のステレオ・トラック。

66666））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでムーブ元のトラックを選択しダイヤルでムーブ元のトラックを選択しダイヤルでムーブ元のトラックを選択しダイヤルでムーブ元のトラックを選択しダイヤルでムーブ元のトラックを選択し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ムーブ先のトラックが選択可能になります。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Move Track >Move Track >Move Track >Move Track >Move Track >”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。

トラックトラックトラックトラックトラック・・・・・データのムーブデータのムーブデータのムーブデータのムーブデータのムーブ

点滅

点滅

点滅
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＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：キャンセルするときは、“[CANCEL]”
を選択して [MENU/ENTER] キーを押してくだ
さい。

99999））））） [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Move Track >”が反転する画面に変ります。

1010101010））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：既に記録済みのトラックへムーブす
ると、元のデータは書き換えられてしまいます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：思うような編集結果でなかったとき
は、 [UNDO/REDO] キーを押して、最初からや
り直ししてください（☞95ページ）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：ムーブ元とムーブ先のトラックは、同
じトラックを選択できません。

77777））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでムーブ先のトラックを選択しダイヤルでムーブ先のトラックを選択しダイヤルでムーブ先のトラックを選択しダイヤルでムーブ先のトラックを選択しダイヤルでムーブ先のトラックを選択し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Dest. Track = **”が反転する画面に変ります。

ムーブ先のトラックには、ムーブ元のトラックに選
択したトラックと同じ組み合わせで選択できます。
例えば、ムーブ元にモノ・トラックを選択したとき
はモノ・トラックのみ選択でき、ムーブ元にステレ
オ・トラックを選択したときは、ステレオ・トラッ
クのみ選択できます。

88888））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にある
“““““[ENTER][ENTER][ENTER][ENTER][ENTER]”””””に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーをキーをキーをキーをキーを
押します。押します。押します。押します。押します。
“Please Wait”を表示した後速やかにムーブが終了
して、“Completed ”が点灯します。

点滅
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44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Change Track >Change Track >Change Track >Change Track >Change Track >”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
入れ替え元のトラックと、入れ替え先のトラック選
択画面に変わります。“Source Track ”は入れ替え
元のトラックを指し、“Dest. Track”は入れ替え先
のトラックを指しています。

55555））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Source Track =Source Track =Source Track =Source Track =Source Track =
11111”””””に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
入れ替え元のトラックが選択可能になり、ジョグ・
ダイヤルで下記トラックが選択できます。

●1～8のモノ・トラック。
●1/2、3/4、5/6、7/8のステレオ・トラック。

66666））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで入れ替え元のトラックを選択しダイヤルで入れ替え元のトラックを選択しダイヤルで入れ替え元のトラックを選択しダイヤルで入れ替え元のトラックを選択しダイヤルで入れ替え元のトラックを選択し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
入れ替え先のトラックが選択可能になります。

任意のトラック間で、全データ（ABS ZERO～REC END）を入れ替えます。トラック・データの入れ替えは、
現在立ち上がっているソング内で行なえます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：プロテクトのかかっているソングでは、ト
ラック・データの入れ替えは実行できません。あらか
じめソングのプロテクトを解除してください（☞ 93
ページ）。

TRK 1
TRK 2
TRK 3
TRK 4
TRK 5
TRK 6
TRK 7
TRK 8

ABS ZERO REC END

11111））））） あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。

22222））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。
MENU選択の1ページめの画面に変わり、初期設
定では“<< Back”が反転します。“<< Back”は、
一つ前の画面に戻ることを示しています。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Track Edit >Track Edit >Track Edit >Track Edit >Track Edit >”””””ににににに
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
トラックの編集メニューを選択する画面に変り、
“<< Back”が反転します。

トラックトラックトラックトラックトラック・・・・・データの入れ替えデータの入れ替えデータの入れ替えデータの入れ替えデータの入れ替え

点滅

点滅

点滅
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99999））））） [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Change Track > ”が反転する画面に変ります。

1010101010））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：思うような編集結果でなかったとき
は、 [UNDO/REDO] キーを押して、最初からや
り直ししてください（☞95ページ）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：入れ替え元と入れ替え先のトラック
は、同じトラックを選択して実行できません。

88888））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にあるダイヤルでカーソルを画面下にある
“““““[ENTER][ENTER][ENTER][ENTER][ENTER]”””””に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーをキーをキーをキーをキーを
押します。押します。押します。押します。押します。
“Please Wait”を表示した後速やかにトラックの入
れ替えが終了して、“Completed ”が点灯します。

入れ替え先のトラックには、入れ替え元のトラック
に選択したトラックと同じ組み合わせで選択できま
す。例えば、入れ替え元にモノ・トラックを選択し
たときはモノ・トラックのみ選択でき、入れ替え元
にステレオ・トラックを選択したときは、ステレ
オ・トラックのみ選択できます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：キャンセルするときは、“[CANCEL]”
を選択して [MENU/ENTER] キーを押してくだ
さい。

77777））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで入れ替え先のトラックを選択しダイヤルで入れ替え先のトラックを選択しダイヤルで入れ替え先のトラックを選択しダイヤルで入れ替え先のトラックを選択しダイヤルで入れ替え先のトラックを選択し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Dest. Track = **”が反転する画面に変ります。

点滅
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パートパートパートパートパート・・・・・データの編集データの編集データの編集データの編集データの編集
ここでは、録音済みソングにおける「パート・データの編集」について記載し
ています。本機で言う「パート」は、あらかじめ登録された“LOCATE Aポ
イント”と“LOCATE Bポイント”間の音声データを指しています。

＜編集のアンドウ／リドウ！＞＜編集のアンドウ／リドウ！＞＜編集のアンドウ／リドウ！＞＜編集のアンドウ／リドウ！＞＜編集のアンドウ／リドウ！＞
パート・データの編集は、失敗してもやり直しが可能です。
パート編集の終了後 [UNDO/REDO] キーを押すと、編集する前の状態に戻すことが
できます。また、アンドウした後再度 [UNDO/REDO] キーを押すと、編集した後の
状態に戻すこともできます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：編集を終了した後下記の操作を行うと、アンドウはで
きなくなりますのでご注意ください。

1.1.1.1.1. 新たな録音を実行したとき。新たな録音を実行したとき。新たな録音を実行したとき。新たな録音を実行したとき。新たな録音を実行したとき。
2.2.2.2.2. 新たな編集を実行したとき。新たな編集を実行したとき。新たな編集を実行したとき。新たな編集を実行したとき。新たな編集を実行したとき。
3.3.3.3.3. 電源を電源を電源を電源を電源をOFFOFFOFFOFFOFFしたとき。したとき。したとき。したとき。したとき。
4.4.4.4.4. ソングのセレクトを実行したとき。ソングのセレクトを実行したとき。ソングのセレクトを実行したとき。ソングのセレクトを実行したとき。ソングのセレクトを実行したとき。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：MENUモードの階層画面が表示されている状態では、下記の操作をするこ
とで一つ前の階層画面に戻したり、ダイレクトにMENUモードから抜け出すことが
できます。

（（（（（11111））））） MENUMENUMENUMENUMENU画面上にある画面上にある画面上にある画面上にある画面上にある“““““<<Back<<Back<<Back<<Back<<Back”””””を選択してを選択してを選択してを選択してを選択して [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押す。キーを押す。キーを押す。キーを押す。キーを押す。
現在表示されている階層画面の一つ前に戻り、同じ操作を繰り返すと最終的には
MENUモードから抜け出します。

（（（（（22222））））） [REWIND] [REWIND] [REWIND] [REWIND] [REWIND] キーを押す。キーを押す。キーを押す。キーを押す。キーを押す。
キーを押すごとに、現在表示されている階層画面の一つ前に戻り、最終的には
MENUモードから抜け出します。

（（（（（33333））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押す。キーを押す。キーを押す。キーを押す。キーを押す。
一気にMENUモードから抜け出し、Home画面に変ります。

 [UNDO/REDO] キー

DELETE

UNDO/REDO

＜＜＜＜＜LOCATE ALOCATE ALOCATE ALOCATE ALOCATE AポイントとポイントとポイントとポイントとポイントとLOCATE BLOCATE BLOCATE BLOCATE BLOCATE Bポイント＞ポイント＞ポイント＞ポイント＞ポイント＞
“LOCATE Aポイント”と“LOCATE Bポイント”は、パートの各編集を実行するため
に必要で、あらかじめ登録しておく必要があります。登録の方法については、前述51ペー
ジを参照してください。なお、“LOCATE Aポイント”と“LOCATE Bポイント”は編
集モードに入った後でも登録することが可能です（詳細は次ページを参照してください）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：MR-8mkIIが初期設定の状態では、パート・データの削除を実行した
ときのみ、アンドウ／リドウができない設定になっています。
これは、カードの記録可能な領域を最大限確保するためで、削除後はカードのリ
メインが増加します。削除のアンドウ／リドウを可能にするには、作業を始める
前にMENUモードの“System”メニューにある“Auto Delete”を“Off”に設
定してください（☞135ページ）。ただし、アンドウ／リドウ可能な設定にした
場合は、パート・データを削除しても、カードのリメインが増加することはあり
ません。
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パート・データの編集を実行する前に、下記記載項目をよくお読みください。

ここに表示される時間は現在位置を示し、再生／早
送り／逆戻し／ロケートなどを行うと、リアル・タ
イムに変っていきます。
また、 [LOCATE A/IN] キー（または [LOCATE B/
OUT] キー）を押して、LOCATE AまたはBポイン
トへロケートを実行すると、下記例のように時間
（またはBar/Beat）表示の前に“LocA=”（または
“LocB=”）が点灯します。
これは、現在位置がLOCATE A ポイントまたは
LOCATE Bポイントにあることを示しています。

11111））））） 現在位置を任意の位置へ移動します。現在位置を任意の位置へ移動します。現在位置を任意の位置へ移動します。現在位置を任意の位置へ移動します。現在位置を任意の位置へ移動します。
[PLAY] キーを押して移動したり、 [REWIND]
キー／ [F FWD] キーを押して移動します。

22222））））） 変更したい位置で停止させた後、変更したい位置で停止させた後、変更したい位置で停止させた後、変更したい位置で停止させた後、変更したい位置で停止させた後、 [STORE] [STORE] [STORE] [STORE] [STORE]
キーを押した後キーを押した後キーを押した後キーを押した後キーを押した後 [LOCATE A/IN]  [LOCATE A/IN]  [LOCATE A/IN]  [LOCATE A/IN]  [LOCATE A/IN] キーキーキーキーキー（（（（（ままままま
たはたはたはたはたは [LOCATE B/OUT]  [LOCATE B/OUT]  [LOCATE B/OUT]  [LOCATE B/OUT]  [LOCATE B/OUT] キー）キー）キー）キー）キー）を押しまを押しまを押しまを押しまを押しま
す。す。す。す。す。
あらかじめ登録していた編集ポイントを変更
して再登録することができます。
なお、任意にLOCATE Aポイント（または
LOCATE Bポイント）を登録し直したとき
は、左記例のように時間（またはBar/Beat）
表示の前に“LocA=”（または“LocB=”）が
点灯します。

この後、パートの削除、コピー・ペースト、ムーブ、
または入れ替えするトラックを設定して実行する
と、登録し直したパート・データを編集することが
できます。

各編集メニューのトラックを選択する画面に入る
と、画面上部には現在位置を示す時間（Bar/Beat表
示またはタイム表示）が表示されます（下記例は、
“Erase Part”メニューでパートを削除するトラック
を選択する画面です）。

このように、パートの編集画面において現在位置の
タイムデータ（またはBar/Beat値）が表示されて
いる状態では、下記操作手順でリアルタイムに
LOCATE AポイントおよびLOCATE Bポイントを
変更することができます。

編集するパート （LOCATE A - LOCATE Bポイント間）の音声は、編集を実行する前に再生して確認するこ
とができます。LOCATE A/Bポイントを登録後下記の操作で確認し、各ポイントの修正などにご利用くださ
い。この操作は、MENUモードに入る前またはパートの編集画面になっているときでも可能です。

1.1.1.1.1. [STOP] [STOP] [STOP] [STOP] [STOP] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [PLAY]  [PLAY]  [PLAY]  [PLAY]  [PLAY] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
A - B PLAY動作に入り、LOCATE AポイントとLOCATE Bポイント間のみを再生します（☞46ページ）。

2.2.2.2.2. 再生しながら、再生しながら、再生しながら、再生しながら、再生しながら、編集トラックのフェーダーと編集トラックのフェーダーと編集トラックのフェーダーと編集トラックのフェーダーと編集トラックのフェーダーと [MASTER]  [MASTER]  [MASTER]  [MASTER]  [MASTER] フェーダーを上げていきます。フェーダーを上げていきます。フェーダーを上げていきます。フェーダーを上げていきます。フェーダーを上げていきます。
編集するパートの音声のみがモニターでき、編集範囲を確認することができます。

LOCATE AおよびLOCATE Bポイントは、編集モードに入る前に変更する以外に、編集作業の操作過程でもリア
ルタイムに変更可能です（詳細は、下記説明をお読みください）。

編集するパート編集するパート編集するパート編集するパート編集するパート（（（（（LOCATE A - LOCATE BLOCATE A - LOCATE BLOCATE A - LOCATE BLOCATE A - LOCATE BLOCATE A - LOCATE B間）間）間）間）間）の再生の再生の再生の再生の再生

編集作業の途中で編集ポイントを変更するには！編集作業の途中で編集ポイントを変更するには！編集作業の途中で編集ポイントを変更するには！編集作業の途中で編集ポイントを変更するには！編集作業の途中で編集ポイントを変更するには！



105

MR-8mkII MR-8mkII MR-8mkII MR-8mkII MR-8mkII 　取扱説明書　取扱説明書　取扱説明書　取扱説明書　取扱説明書（（（（（パパパパパーーーーートトトトト・・・・・データの編集）データの編集）データの編集）データの編集）データの編集）

TRK 1
TRK 2
TRK 3
TRK 4
TRK 5
TRK 6
TRK 7
TRK 8

Silent

LOCATE A
point

LOCATE B
point

REC ENDABS ZERO

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：プロテクトのかかっているソングではパー
トを削除できません。あらかじめプロテクトを解除し
てください（☞93ページ）。

11111））））） あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。

22222））））） 編集したいパートの編集したいパートの編集したいパートの編集したいパートの編集したいパートのLOCATE ALOCATE ALOCATE ALOCATE ALOCATE Aポイント、ポイント、ポイント、ポイント、ポイント、およびおよびおよびおよびおよび
LOCATE BLOCATE BLOCATE BLOCATE BLOCATE Bポイントを登録しますポイントを登録しますポイントを登録しますポイントを登録しますポイントを登録します（（（（（☞ 5555511111ペペペペペーーーーージジジジジ）））））。。。。。
必要に応じてLOCATE A - B間の音声を再生して、
編集範囲を確認します（☞46ページ）。

33333））））） 停停停停停止止止止止状状状状状態態態態態ででででで     [[[[[MMMMMEEEEENNNNNUUUUU/////EEEEENNNNNTTTTTEEEEERRRRR]]]]]     キキキキキーーーーーををををを押押押押押しししししててててて、、、、、MMMMMEEEEENNNNNUUUUU
モモモモモーーーーードドドドドへへへへへ入入入入入りりりりりままままますすすすす。。。。。
MENU選択の1ページめの画面に変わり、初期設定
では“<< Back”が反転します。“<< Back”は、一
つ前の画面に戻ることを示しています。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソル位置をダイヤルでカーソル位置をダイヤルでカーソル位置をダイヤルでカーソル位置をダイヤルでカーソル位置を“““““Part Edit >Part Edit >Part Edit >Part Edit >Part Edit >”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
パートの編集メニューを選択する画面に変り、
“<< Back”が反転します。

55555））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Erase Part >Erase Part >Erase Part >Erase Part >Erase Part >”””””へへへへへ
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
パートを削除するトラックを選択する画面に変り、
“<< Back”が反転します。点灯している“Can’t
Undo !”は、パート・データの削除がアンドウでき
ないことを示しています。

66666））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルでカーソルをカーソルをカーソルをカーソルをカーソルを“““““Erace Track = 1Erace Track = 1Erace Track = 1Erace Track = 1Erace Track = 1”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在表示されているトラックが点滅し、選択可能な
画面に変り、ジョグ・ダイヤルで下記トラックが選
択可能です。

●1～8のモノ・トラック
●1/2、3/4、5/6、7/8のステレオ・トラック

77777））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで希望のトラックを選択して、ダイヤルで希望のトラックを選択して、ダイヤルで希望のトラックを選択して、ダイヤルで希望のトラックを選択して、ダイヤルで希望のトラックを選択して、
[MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Erase Track = **”が反転する画面に変ります。

任意に選択したトラックの、パート・データを削除します。パート・データの削除は、現在立ち上がっている
ソング内でのみ行なえます。

パートパートパートパートパート・・・・・データの削除データの削除データの削除データの削除データの削除

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：初期設定の状態では、パート・データの削
除はアンドウできません。アンドウを可能にするには、
MENUモードの“System”メニューにある“Auto
Delete”を“Off”に設定し直してください（☞135ペー
ジ）。

点滅
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ここでは、任意に選択するトラックのパート・データを、他のトラックへコピー・ペーストします。パート・
データのコピー・ペーストは、現在立ち上がっているソング内でのみ行なえます。パート・データのコピー・
ペーストは、後述108ページの「パートをコピー・ペーストする（2）」でも行なえます。

TRK 1
TRK 2
TRK 3
TRK 4
TRK 5
TRK 6
TRK 7
TRK 8

LOCATE A
point

LOCATE B
point

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：プロテクトのかかっているソングではコ
ピー・ペーストできません。あらかじめプロテクトを
解除してください（☞93ページ）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：コピーしたパートをLOCATE A-LOCATE
B間以外の位置へペーストするには、後述108ページ
の「パート・データのコピー・ペースト（2）」を参照
してください。

99999））））） [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Erase Part >”が反転する画面に変ります。

1010101010））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

88888））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルでカーソルを画面下のカーソルを画面下のカーソルを画面下のカーソルを画面下のカーソルを画面下の
“““““[ENTER][ENTER][ENTER][ENTER][ENTER]”””””に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押キーを押キーを押キーを押キーを押
します。します。します。します。します。
“Please Wait”を表示した後速やかに削除が終了し
て、“Completed ”が点灯します。

パートの削除を中止するには“[CANCEL]”を選択
して、 [MENU/ENTER] キーを押してください。

33333））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードモードモードモードモードへ入ります。へ入ります。へ入ります。へ入ります。へ入ります。
MENU選択の1ページめの画面に変わり、初期設定
では“<< Back”が反転します。“<< Back”は、一
つ前の画面に戻ることを示しています。

パートパートパートパートパート・・・・・データのコピーデータのコピーデータのコピーデータのコピーデータのコピー・・・・・ペーストペーストペーストペーストペースト(1)(1)(1)(1)(1)

11111））））） あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。

22222））））） 編集したいパートの編集したいパートの編集したいパートの編集したいパートの編集したいパートのLOCATE ALOCATE ALOCATE ALOCATE ALOCATE Aポイント、ポイント、ポイント、ポイント、ポイント、およびおよびおよびおよびおよび
LOCATE BLOCATE BLOCATE BLOCATE BLOCATE Bポイントを登録しますポイントを登録しますポイントを登録しますポイントを登録しますポイントを登録します（（（（（☞ 5555511111ペペペペペーーーーージジジジジ）））））。。。。。
必要に応じてLOCATE A - B間の音声を再生して、
編集範囲を確認します（☞46ページ））。

点滅
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66666））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Source TrackSource TrackSource TrackSource TrackSource Track”””””へへへへへ
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
コピー元のトラックが選択可能な画面に変り、
ジョグ・ダイヤルで下記トラックが選択可能です。

●1～8のモノ・トラック
●1/2、3/4、5/6、7/8のステレオ・トラック

77777））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでコピー元のトラックを選択しダイヤルでコピー元のトラックを選択しダイヤルでコピー元のトラックを選択しダイヤルでコピー元のトラックを選択しダイヤルでコピー元のトラックを選択し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ペースト先のトラックが選択可能な画面に変り、
ジョグ・ダイヤルで下記トラックが選択可能です。

●1～8のモノ・トラック
●1/2、3/4、5/6、7/8のステレオ・トラック

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：コピー元とペースト先は、同じトラッ
クを選択できません。

99999））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルでカーソルを画面下のカーソルを画面下のカーソルを画面下のカーソルを画面下のカーソルを画面下の“““““[ENTER][ENTER][ENTER][ENTER][ENTER]”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Please Wait”を表示した後速やかにペーストが終了
して、“Completed”が点灯します。
コピー・ペーストを中止するときは、“[CANCEL]”
を選択して [MENU/ENTER] キーを押してくださ
い。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Part EditPart EditPart EditPart EditPart Edit”””””に移動に移動に移動に移動に移動
して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
パートの編集メニューを選択する画面に変り、
“<< Back”が反転します。

55555））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Copy-PastePartCopy-PastePartCopy-PastePartCopy-PastePartCopy-PastePart
>>>>>”””””へ移動して、へ移動して、へ移動して、へ移動して、へ移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
コピー元とペースト先のトラックを選択する画面に
変り、“<< Back”が反転します。
“Source Track ”がコピー元を示し、“Dest. Track”
がペースト先を示しています。 88888））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでペースト先のトラックを選択しダイヤルでペースト先のトラックを選択しダイヤルでペースト先のトラックを選択しダイヤルでペースト先のトラックを選択しダイヤルでペースト先のトラックを選択し

て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Dest. Track = **”が反転する画面に変ります。

点滅

点滅

点滅

点滅
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ここでは、任意に選択するトラックのLOCATE A-LOCATE B間のパートを、他のトラックの任意の位置へコ
ピー・ペーストします。前述の「パート・データのコピー・ペースト（1）」と異なり、下の図のように、任意
のパートを一旦クリップボード（バーチャル）へコピーした後、他のトラックのペーストする位置を指定して
からペーストします。なお、ここで行うコピー・ペーストは、同じソング内でのみ可能です。

11111））））） あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。

22222））））） 編集したいパートの編集したいパートの編集したいパートの編集したいパートの編集したいパートのLOCATE ALOCATE ALOCATE ALOCATE ALOCATE Aポイント、ポイント、ポイント、ポイント、ポイント、およびおよびおよびおよびおよび
LOCATE BLOCATE BLOCATE BLOCATE BLOCATE Bポイントを登録しますポイントを登録しますポイントを登録しますポイントを登録しますポイントを登録します（（（（（☞ 5555511111ペペペペペーーーーージジジジジ）））））。。。。。
必要に応じてLOCATE A - B間の音声を再生して、
編集範囲を確認します（☞46ページ））。

33333））））） 停停停停停止止止止止状状状状状態態態態態ででででで     [[[[[MMMMMEEEEENNNNNUUUUU/////EEEEENNNNNTTTTTEEEEERRRRR]]]]]     キキキキキーーーーーををををを押押押押押しししししててててて、、、、、MMMMMEEEEENNNNNUUUUU
モモモモモーーーーードドドドドへへへへへ入入入入入りりりりりままままますすすすす。。。。。
MENU選択の1ページめの画面に変わり、初期設定
では“<< Back”が反転します。“<< Back”は、一
つ前の画面に戻ることを示しています。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：プロテクトのかかっているソングではコ
ピー・ペーストできません。あらかじめプロテクトを
解除してください（☞93ページ）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：クリップボードにコピーした後MR-8mkIIの
電源をオフしてしまうと、クリップボード上のデータ
は無くなってしまいます。また、この操作はアンドウ
することはできませんので、ご注意ください。

TRK 1
TRK 2
TRK 3
TRK 4
TRK 5
TRK 6
TRK 7
TRK 8

LOCATE A
point

LOCATE B
point

Clipboard
(Virtual)

ABS ZERO REC END

TRK 1
TRK 2
TRK 3
TRK 4
TRK 5
TRK 6
TRK 7
TRK 8

LOCATE A
point

＜ポイント！＞＜ポイント！＞＜ポイント！＞＜ポイント！＞＜ポイント！＞：：：：：コピー元と同一のLOCATE Aポイン
トで他のトラックへペーストするには、前述106ペー
ジの「パート・データのコピー・ペースト（1）」が、速
やかに実行できます。

まず最初に、クリップ・ボードへ任意のパートをコピーしま
す。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：クリップ・ボードへのコピーは、アンドウ
／リドウすることができません。

パートをクリップパートをクリップパートをクリップパートをクリップパートをクリップ・・・・・ボードへコピーボードへコピーボードへコピーボードへコピーボードへコピー

パートパートパートパートパート・・・・・データのコピーデータのコピーデータのコピーデータのコピーデータのコピー・・・・・ペーストペーストペーストペーストペースト(2)(2)(2)(2)(2)

1010101010））））） [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Copy-Paste Part > ”が反転する画面に変ります。

1111111111））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：パートのコピー・ペーストが思うよ
うにいかなかったときは、 [UNDO/REDO] キー
を押して、最初からやり直ししてください（☞
103ページ）。
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99999））））） [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Copy Part >”が反転する画面に変ります。
ここでは例として、クリップ・ボードへコピーした
パート・データを、任意に指定するトラックの
LOCATE Aポイントへペーストします。

66666））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Copy Track = 1Copy Track = 1Copy Track = 1Copy Track = 1Copy Track = 1”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
コピー元のトラックが選択可能な画面に変り、
ジョグ・ダイヤルで下記トラックが選択可能です。

●1～8のモノ・トラック
●1/2、3/4、5/6、7/8のステレオ・トラック

88888））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルでカーソルを画面下のカーソルを画面下のカーソルを画面下のカーソルを画面下のカーソルを画面下の“““““[ENTER][ENTER][ENTER][ENTER][ENTER]”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Please Wait”を表示した後速やかにコピーが終了
して、“Completed ”が点灯します。
クリップボードへのコピーを中止するときは、
“[CANCEL]”を選択して [MENU/ENTER] キーを
押してください。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Part Edit >Part Edit >Part Edit >Part Edit >Part Edit >”””””ににににに
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
パートの編集メニューを選択する画面に変り、
“<< Back”が反転します。

55555））））） [MENU] [MENU] [MENU] [MENU] [MENU] ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Copy Part >Copy Part >Copy Part >Copy Part >Copy Part >”””””へへへへへ
移動して、移動して、移動して、移動して、移動して、 [ENTER]  [ENTER]  [ENTER]  [ENTER]  [ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
コピー元のトラックを選択する画面に変り、
“<< Back”が反転します。

77777））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでコピー元のトラックを選択しダイヤルでコピー元のトラックを選択しダイヤルでコピー元のトラックを選択しダイヤルでコピー元のトラックを選択しダイヤルでコピー元のトラックを選択し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Copy Track = ** ”が反転する画面に変ります。

点滅

点滅
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55555））））） [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Paste Part >”が反転する画面に変ります。

66666））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：クリップボードにコピーされたデー
タが無い状態では、ペーストすることができま
せん。“Clip board Empty! ”のエラー・メッセー
ジが表示されます。 [STOP] キーを押して
MENU モードから抜け出し、再度クリップ・
ボードへコピーしてからやり直してください。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：クリップ・ボードからのペーストが
思うようにいかなかったときは、 [UNDO/
REDO] キーを押して、最初からやり直ししてく
ださい（☞103ページ）。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでペースト先のトラックを選択しダイヤルでペースト先のトラックを選択しダイヤルでペースト先のトラックを選択しダイヤルでペースト先のトラックを選択しダイヤルでペースト先のトラックを選択し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
一つ前の画面に戻り、“Paste Track = *”が反転し
ます。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルでカーソルを画面下のカーソルを画面下のカーソルを画面下のカーソルを画面下のカーソルを画面下の“““““[ENTER][ENTER][ENTER][ENTER][ENTER]”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Please Wait”を表示した後速やかにペーストが終
了して、“Completed ”が点灯します。
パートのペーストを中止するときは、“[CANCEL]”
を選択して [MENU/ENTER] キーを押してくださ
い。11111））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Paste Part >Paste Part >Paste Part >Paste Part >Paste Part >”””””ににににに

移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ペースト先のトラックを選択する画面に変り、
“<< Back”が反転します。

クリップクリップクリップクリップクリップ・・・・・ボードのデータをペーストボードのデータをペーストボードのデータをペーストボードのデータをペーストボードのデータをペースト

ここからの操作は、あらかじめペーストするLOCATE Aポ
イントが登録されていることを前提にしています。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Paste Track = 1Paste Track = 1Paste Track = 1Paste Track = 1Paste Track = 1”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ペースト先のトラックが選択可能な画面に変り、
ジョグ・ダイヤルで下記トラックが選択可能です。

●1～8のモノ・トラック
●1/2、3/4、5/6、7/8のステレオ・トラック

点滅

点滅
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任意に選択したトラックのパート・データを、他のトラックへムーブ（移動）します。
パートのムーブは、現在立ち上がっているソング内でのみ行なえます。なお、ムーブした後は、ムーブ元の音
声データは無音になります。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：プロテクトのかかっているソングではムー
ブはできません。あらかじめプロテクトを解除してく
ださい（☞93ページ）。

TRK 1
TRK 2
TRK 3
TRK 4
TRK 5
TRK 6
TRK 7
TRK 8

LOCATE A
point

LOCATE B
point

11111））））） あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。

22222））））） 編集したいパートの編集したいパートの編集したいパートの編集したいパートの編集したいパートのLOCATE ALOCATE ALOCATE ALOCATE ALOCATE Aポイント、ポイント、ポイント、ポイント、ポイント、およびおよびおよびおよびおよび
LOCATE BLOCATE BLOCATE BLOCATE BLOCATE Bポイントを登録しますポイントを登録しますポイントを登録しますポイントを登録しますポイントを登録します（（（（（☞ 5555511111ペペペペペーーーーージジジジジ）））））。。。。。
必要に応じてLOCATE A - B間の音声を再生して、
編集範囲を確認します（☞46ページ））。

33333））））） 停停停停停止止止止止状状状状状態態態態態ででででで     [[[[[MMMMMEEEEENNNNNUUUUU/////EEEEENNNNNTTTTTEEEEERRRRR]]]]]     キキキキキーーーーーををををを押押押押押しししししててててて、、、、、MMMMMEEEEENNNNNUUUUU
モモモモモーーーーードドドドドへへへへへ入入入入入りりりりりままままますすすすす。。。。。
MENU選択の1ページめの画面に変わり、初期設定
では“<< Back”が反転します。“<< Back”は、一
つ前の画面に戻ることを示しています。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Part Edit >Part Edit >Part Edit >Part Edit >Part Edit >”””””ににににに
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
パートの編集メニューを選択する画面に変り、
“<< Back”が反転します。

55555））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Move Part >Move Part >Move Part >Move Part >Move Part >”””””へへへへへ
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ムーブ元とムーブ先のトラックを選択する画面に変
り、“<< Back”が反転します。
“Source Track ”がムーブ元を示し、“Dest. Track”
がムーブ先を示しています。

66666））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Source Track =Source Track =Source Track =Source Track =Source Track =
11111”””””へ移動して、へ移動して、へ移動して、へ移動して、へ移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ムーブ元のトラックが選択可能な画面に変り、
ジョグ・ダイヤルで下記トラックが選択可能です。

●1～8のモノ・トラック
●1/2、3/4、5/6、7/8のステレオ・トラック

ムーブ先のトラックが選択可能な画面に変り、
[MENU] ダイヤルで下記トラックが選択可能です。

●1～8のモノ・トラック
●1/2、3/4、5/6、7/8のステレオ・トラック

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：ムーブ元とムーブ先は、同じトラッ
クを選択できません。

77777））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでムーブ元のトラックを選択しダイヤルでムーブ元のトラックを選択しダイヤルでムーブ元のトラックを選択しダイヤルでムーブ元のトラックを選択しダイヤルでムーブ元のトラックを選択し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。

パートパートパートパートパート・・・・・データのムーブデータのムーブデータのムーブデータのムーブデータのムーブ

点滅
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MR-8mkII MR-8mkII MR-8mkII MR-8mkII MR-8mkII 　取扱説明書　取扱説明書　取扱説明書　取扱説明書　取扱説明書（（（（（パパパパパーーーーートトトトト・・・・・データの編集）データの編集）データの編集）データの編集）データの編集）

1010101010））））） [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Move Part”が反転する画面に変ります。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：パートのムーブが思うようにいかな
かったときは、 [UNDO/REDO] キーを押して、
最初からやり直ししてください（☞ 103 ペー
ジ）。

99999））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルでカーソルを画面下のカーソルを画面下のカーソルを画面下のカーソルを画面下のカーソルを画面下の“““““[ENTER][ENTER][ENTER][ENTER][ENTER]”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Please Wait”を表示した後速やかにムーブが終了し
て、“Completed”が点灯します。
パートのムーブを中止するときは、“[CANCEL]”を
選択して [MENU/ENTER] キーを押してください。

88888））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでムーブ先のトラックを選択しダイヤルでムーブ先のトラックを選択しダイヤルでムーブ先のトラックを選択しダイヤルでムーブ先のトラックを選択しダイヤルでムーブ先のトラックを選択し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Dest. Track = **”が反転する画面に変ります。

1111111111））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

点滅

点滅

点滅
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MR-8mkII MR-8mkII MR-8mkII MR-8mkII MR-8mkII 　取扱説明書　取扱説明書　取扱説明書　取扱説明書　取扱説明書（（（（（パパパパパーーーーートトトトト・・・・・データの編集）データの編集）データの編集）データの編集）データの編集）

77777））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで入れ替え元のトラックを選択しダイヤルで入れ替え元のトラックを選択しダイヤルで入れ替え元のトラックを選択しダイヤルで入れ替え元のトラックを選択しダイヤルで入れ替え元のトラックを選択し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
入れ替え先のトラックが選択可能な画面に変り、
ジョグ・ダイヤルで下記トラックが選択可能です。

●1～8のモノ・トラック
●1/2、3/4、5/6、7/8のステレオ・トラック

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：入れ替え元と入れ替先は、同じトラッ
クを選択できません。

任意に選択する異なったトラック間で、パート・データを入れ替えます。パートの入れ替えは、現在立ち上がっ
ているソング内でのみ行なえます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：プロテクトのかかっているソングでは、
パートの入れ替えは実行できません。あらかじめプロ
テクトを解除してください（☞93ページ）。

11111））））） あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。あらかじめ編集するソングを立ち上げておきます。

22222））））） 編集したいパートの編集したいパートの編集したいパートの編集したいパートの編集したいパートのLOCATE ALOCATE ALOCATE ALOCATE ALOCATE Aポイント、ポイント、ポイント、ポイント、ポイント、およびおよびおよびおよびおよび
LOCATE BLOCATE BLOCATE BLOCATE BLOCATE Bポイントを登録しますポイントを登録しますポイントを登録しますポイントを登録しますポイントを登録します（（（（（☞ 5555511111ペペペペペーーーーージジジジジ）））））。。。。。
必要に応じてLOCATE A - B間の音声を再生して、
編集範囲を確認します（☞ 46ページ））。

33333））））） 停停停停停止止止止止状状状状状態態態態態ででででで     [[[[[MMMMMEEEEENNNNNUUUUU/////EEEEENNNNNTTTTTEEEEERRRRR]]]]]     キキキキキーーーーーををををを押押押押押しししししててててて、、、、、MMMMMEEEEENNNNNUUUUU
モモモモモーーーーードドドドドへへへへへ入入入入入りりりりりままままますすすすす。。。。。
MENU選択の1ページめの画面に変わり、初期設定
では“<< Back”が反転します。“<< Back”は、一
つ前の画面に戻ることを示しています。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Part Edit >Part Edit >Part Edit >Part Edit >Part Edit >”””””ににににに
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
パートの編集メニューを選択する画面に変り、
“<< Back”が反転します。

入れ替え元のトラックが選択可能な画面に変り、
ジョグ・ダイヤルで下記トラックが選択可能です。

●1～8のモノ・トラック
●1/2、3/4、5/6、7/8のステレオ・トラック

パートパートパートパートパート・・・・・データの入れ替えデータの入れ替えデータの入れ替えデータの入れ替えデータの入れ替え

55555））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを22222ページめのページめのページめのページめのページめの
“““““Change Part >Change Part >Change Part >Change Part >Change Part >”””””へ移動して、へ移動して、へ移動して、へ移動して、へ移動して、 [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER]
キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
入れ替え元と入れ替え先のトラックを選択する画面
に変り、“<< Back”が反転します。
“Source Track ”が入れ替え元のトラックを示し、
“Dest.Track”が入れ替え先のトラックを示してい
ます。

66666））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Source TrackSource TrackSource TrackSource TrackSource Track”””””へへへへへ
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。

TRK 1
TRK 2
TRK 3
TRK 4
TRK 5
TRK 6
TRK 7
TRK 8

LOCATE A
point

LOCATE B
point

ABS ZERO REC END

点滅
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1010101010））））） [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Change Part >”が反転する画面に変ります。

1111111111））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

99999））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルでカーソルを画面下のカーソルを画面下のカーソルを画面下のカーソルを画面下のカーソルを画面下の“““““[ENTER][ENTER][ENTER][ENTER][ENTER]”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Please Wait”を表示した後速やかにペーストが終了
して、“Completed”が点灯します。

パートの入れ替えを中止するときは、“[CANCEL]”
を選択して [MENU/ENTER] キーを押してくださ
い。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：パートの入れ替えが思うようにいか
なかったときは、 [UNDO/REDO] キーを押して、
最初からやり直ししてください（☞ 103 ペー
ジ）。

88888））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで入れ替え先のトラックを選択しダイヤルで入れ替え先のトラックを選択しダイヤルで入れ替え先のトラックを選択しダイヤルで入れ替え先のトラックを選択しダイヤルで入れ替え先のトラックを選択し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Dest. Track = **”が反転する画面に変ります。

点滅

点滅

点滅
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MR-8mkII MR-8mkII MR-8mkII MR-8mkII MR-8mkII 　取扱説明書　取扱説明書　取扱説明書　取扱説明書　取扱説明書（（（（（パパパパパソソソソソコココココンンンンンへへへへへののののの取取取取取りりりりり込込込込込みみみみみ）））））

パソコンへの取り込みパソコンへの取り込みパソコンへの取り込みパソコンへの取り込みパソコンへの取り込み
ここでは、本機でミックスダウンしてトラック7/8にバウンスしたソング・
データを、パソコンへ取り込む方法について記載しています。

ソング・データをパソコンへ取り込むには、トラック7/8に録音したソング・
データをステレオWAVファイルに変換します。
変換されたWAVファイルは、本機 [USB] ポートを介してパソコンに取り込
まれ、パソコンのCD-R機能を使ってオーディオCDが作成できます。

＜＜＜＜＜USBUSBUSBUSBUSB接続についてのご注意＞接続についてのご注意＞接続についてのご注意＞接続についてのご注意＞接続についてのご注意＞
Macintoshパソコンとの接続は、“OS X以上”のOSを搭載しているパソコ
ンのみに対応しています。
“OS X以前”のパソコンに接続した場合、MR-8mkIIに記録されたソング・
データを破壊する恐れがありますので、“OS X以前”のパソコンには接続し
ないでください。
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MR-8mkII MR-8mkII MR-8mkII MR-8mkII MR-8mkII 　取扱説明書　取扱説明書　取扱説明書　取扱説明書　取扱説明書（（（（（パパパパパソソソソソコココココンンンンンへへへへへののののの取取取取取りりりりり込込込込込みみみみみ）））））

本機では、トラック7/8に録音したトラック・データ（L, RのモノWAVファイル）をステレオWAVファイ
ルに変換して、パソコンへ取り込むことが可能になります。ここでは、前述の「バウンス」でトラック7/8に
バウンスしたデータや、トラック7/8にステレオ録音したデータを、ステレオWAVファイルに変換する方法
について説明します。変換したWAVファイルをパソコンへ取り込むには、この後118ページを参照してくだ
さい。

ステレオWAVファイルへ変換するモードは、 [7/8 >
STEREO WAV FILE] キーで切り替えます。

11111））））） 停止している状態で停止している状態で停止している状態で停止している状態で停止している状態で [7/8 > STEREO WAV FILE]  [7/8 > STEREO WAV FILE]  [7/8 > STEREO WAV FILE]  [7/8 > STEREO WAV FILE]  [7/8 > STEREO WAV FILE] キーキーキーキーキー
を押して、を押して、を押して、を押して、を押して、変換モードをオンにします。変換モードをオンにします。変換モードをオンにします。変換モードをオンにします。変換モードをオンにします。
変換する範囲を選択する画面に変り、“““““ABS 0 - RecABS 0 - RecABS 0 - RecABS 0 - RecABS 0 - Rec
EndEndEndEndEnd”””””が反転します。

[7/8 > STEREO WAV FILE] キー

Track 7
(L ch)

Track 8
(R ch)

Stereo
(L, R)

トラック7/8に録音されたモノWAVファイルは、
下図のようなステレオWAVファイルに変換され
ます（注意注意注意注意注意：：：：：ステレオステレオステレオステレオステレオWAVWAVWAVWAVWAVファイルに変換できるファイルに変換できるファイルに変換できるファイルに変換できるファイルに変換できる
のは、のは、のは、のは、のは、トラックトラックトラックトラックトラック7/87/87/87/87/8に録音されたファイルのみでに録音されたファイルのみでに録音されたファイルのみでに録音されたファイルのみでに録音されたファイルのみで
すすすすす）。

また、ステレオWAVファイルに変換するトラック・
データの範囲は、ABS ZEROからREC ENDまでの
全データ、あるいは任意に指定することができま
す。

下記の操作は、変換したいトラック・データが録音され
ているソングが立ち上がっていることを前提にしてい
ます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：任意の範囲のみを変換したい場合
は、事前にLOCATE AポイントとLOCATE Bポ
イントを登録してください（☞51/56ページ）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：トラック7/8にWAVデータが存在
しないときは、変換を実行しようとしてもエラー
表示（“Track 7/8 Empty!”）が現れ、操作はキャ
ンセルされてしまいます。

“““““ABS 0 - Rec EndABS 0 - Rec EndABS 0 - Rec EndABS 0 - Rec EndABS 0 - Rec End”””””が点滅し、現在の設定以外に
“““““LOCATE A - LOCATE BLOCATE A - LOCATE BLOCATE A - LOCATE BLOCATE A - LOCATE BLOCATE A - LOCATE B”””””が選択可能になります。

トラック7/8の全データを変換するには“““““ABS 0 -ABS 0 -ABS 0 -ABS 0 -ABS 0 -
Rec EndRec EndRec EndRec EndRec End”””””を選択し、あらかじめ設定した範囲のみ
を変換するには“““““LOCATE A - LOCATE BLOCATE A - LOCATE BLOCATE A - LOCATE BLOCATE A - LOCATE BLOCATE A - LOCATE B”””””を選択
します。

22222））））） [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで変換範囲を選択した後、ダイヤルで変換範囲を選択した後、ダイヤルで変換範囲を選択した後、ダイヤルで変換範囲を選択した後、ダイヤルで変換範囲を選択した後、
[MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択した範囲が確定して、１つ前の画面に変りま
す。

現在表示されている“““““Name= *********Name= *********Name= *********Name= *********Name= *********”””””は変換元
のソング・ネームで、このまま変換を実行すると変
換するWAVファイルのファイル・ネームに変換元
のソング・ネームがコピーされることを示していま
す。

ここでは、例として変換元のネームをそのままコ
ピーしてWAVファイルの変換を実行しますが、任
意にネームをエディットするには、次ページの入力
方法を参照してください。

特に、同一ソング内のデータを何度もWAVファイ
ルに変換する場合には、ファイル・ネームを変更す
ることが大切です（次ページの＜注意＞をお読みく
ださい）。

変換モードのオン／オフ変換モードのオン／オフ変換モードのオン／オフ変換モードのオン／オフ変換モードのオン／オフ

WAVWAVWAVWAVWAVファイルの変換手順ファイルの変換手順ファイルの変換手順ファイルの変換手順ファイルの変換手順

WAVWAVWAVWAVWAVファイルの変換ファイルの変換ファイルの変換ファイルの変換ファイルの変換

GHI3DEF2ABC1

7/8 WAV FILE
STEREO1-4

1-6
NEW
SONG1-8

BOUNCE

5/6
7/8

点滅

変換モードから抜け出すには、 [STOP] キーを押します。
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55555））））） [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
変換モードから抜け出し、Home画面に変わりま
す。

＜ファイル＜ファイル＜ファイル＜ファイル＜ファイル・・・・・ネームの入力方法＞ネームの入力方法＞ネームの入力方法＞ネームの入力方法＞ネームの入力方法＞
以下の要領で、ファイル・ネームをエディットしま
す。

11111））））） 変換範囲の選択後、変換範囲の選択後、変換範囲の選択後、変換範囲の選択後、変換範囲の選択後、ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーダイヤルでカーダイヤルでカーダイヤルでカーダイヤルでカー
ソルをファイルソルをファイルソルをファイルソルをファイルソルをファイル・・・・・ネームネームネームネームネーム（（（（（NameNameNameNameName）））））に移動して、に移動して、に移動して、に移動して、に移動して、
[MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
変換元ソング・ネームの右端にあるカーソル
が点滅し、任意に入力可能な画面に変ります。

22222））））） 文字入力キーで希望のネームを入力します。文字入力キーで希望のネームを入力します。文字入力キーで希望のネームを入力します。文字入力キーで希望のネームを入力します。文字入力キーで希望のネームを入力します。
異なる文字入力キーを押すごとに、カーソル
は自動的に移動しますが、同一キーを連続使
用するときは、カーソル位置をジョグ・ダイ
ヤルで移動してください。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：先に変換したファイルと同一ネームのま
ま変換しようとすると、下記のような画面に変わり
ます。
この表示は、変換するファイル・ネームと同じWAV
ファイルが既に存在することを示しており、上書き
して変換するか、変換をキャンセルするかの選択を
促しています。

上書きしても構わないときは、ジョグ・ダイヤルで
カーソルを“““““[YES][YES][YES][YES][YES]”””””に移動して [MENU/ENTER]
キーを押してください。

上書きしたくないときは、カーソルを“““““[NO][NO][NO][NO][NO]”””””に移
動して [MENU/ENTER] キーを押してください。
ファイル・ネームをエディットする画面に変ります
ので、前述の要領で新たなファイル・ネームを入力し
てから再度実行してください。

なお、上記画面の状態から変換を中止するには、カー
ソルを“““““[NO][NO][NO][NO][NO]”””””に移動して [MENU/ENTER] キーを
押した後、 [STOP] キーを押して変換モードから抜け
出してください。

33333））））） ネーム入力後、ネーム入力後、ネーム入力後、ネーム入力後、ネーム入力後、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押しキーを押しキーを押しキーを押しキーを押し
ます。ます。ます。ます。ます。
入力したネームが確定し、一つ前の画面に変
ります。

この後この後この後この後この後 [RECORD]  [RECORD]  [RECORD]  [RECORD]  [RECORD] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [MENU/ [MENU/ [MENU/ [MENU/ [MENU/
ENTER] ENTER] ENTER] ENTER] ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、WAVWAVWAVWAVWAVファイルの変換を実行ファイルの変換を実行ファイルの変換を実行ファイルの変換を実行ファイルの変換を実行
します。します。します。します。します。

カーソルが点滅している状態で [UNDO/
REDO]/[DELETE] キーを押していくと、
現在表示されているネームが全てデリー
トできます。

変換が終了すると“Completed! ”が点灯します。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：作業を途中で終了しても、途中まで
変換していたファイルが残ることはありません。

44444））））） [RECORD] [RECORD] [RECORD] [RECORD] [RECORD] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER]
キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
変換が始まり、％の値がカウントアップして進行状
況を表示します。作業を途中で中止するには、
[STOP] キーを押してください。

点滅
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MR-8mkIIにはパソコンと接続するための [USB] ポートを装備していて、USB ケーブルで直接パソコンと接
続することができます。
これにより、ステレオWAVファイルに変換したデータをコンピュータへ取り込み、パソコンの音楽ソフトで再
生／編集したり、パソコンに接続されているCD-R/RWを使ってオリジナルのオーディオCDなどを作成する
ことができます。また、ソング・データを一時パソコンへ保存するときなどにも利用できます。

パソコンとの接続パソコンとの接続パソコンとの接続パソコンとの接続パソコンとの接続

パソコンとの接続は、上の図のようにMR-8mkII の
[USB] ポートとパソコンの [USB] ポートを、USBケー
ブルで直接接続します（USBケーブルは付属しており
ません）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：パソコンへの取り込みは、パソコンへの取り込みは、パソコンへの取り込みは、パソコンへの取り込みは、パソコンへの取り込みは、必ず前述の必ず前述の必ず前述の必ず前述の必ず前述の
「「「「「WAVWAVWAVWAVWAVファイルの変換」ファイルの変換」ファイルの変換」ファイルの変換」ファイルの変換」において、において、において、において、において、ステレオステレオステレオステレオステレオWAVWAVWAVWAVWAVファファファファファ
イルに変換したファイルのみを選択してください。イルに変換したファイルのみを選択してください。イルに変換したファイルのみを選択してください。イルに変換したファイルのみを選択してください。イルに変換したファイルのみを選択してください。
他のモノWAVファイルや、アンドウ用のファイルは
パソコンへ取り込まないでください。
取り込み可能なファイルについては、次ページをお読
みください。

Windows Me, 2000
またはXPを搭載したUSB対応のパソコン

USBケーブル

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：WAVファイルの取り込みに使用できるパ
ソコンは、Windows Me、2000、 XPおよびMac OS
X以上のOS（オペレーティング・システム）を搭載し
た、USB対応のパソコンのみに限られます。それ以外
のOSを搭載したパソコンでは実行できません。
あらかじめ、お使いのパソコンをご確認ください。

取り込みを実行する前の注意取り込みを実行する前の注意取り込みを実行する前の注意取り込みを実行する前の注意取り込みを実行する前の注意

＜バックアップ時の注意＞＜バックアップ時の注意＞＜バックアップ時の注意＞＜バックアップ時の注意＞＜バックアップ時の注意＞：：：：：カードに記録されてい
るソング・データを、単なるバックアップとしてパソ
コンに取り込むには、トラック単位ではなく、必ずソソソソソ
ングのフォルダーごとングのフォルダーごとングのフォルダーごとングのフォルダーごとングのフォルダーごと取り込んでください。ソング・
データのバックアップについては、121ページ「ソン
グのアーカイブ」を参照してください。

＜＜＜＜＜USBUSBUSBUSBUSB接続についてのご注意＞接続についてのご注意＞接続についてのご注意＞接続についてのご注意＞接続についてのご注意＞
Macintoshパソコンとの接続は、“OS X以上”のOS
を搭載しているパソコンのみに対応しています。
“OS X以前”のパソコンに接続した場合、MR-8mkII
に記録されたソング・データを破壊する恐れがありま
すので、“OS X以前”のパソコンには接続しないでく
ださい。

POWER USB FOOT SW

ONDC IN
LIGHTOFF

12V INPUT A SELECT

INT MIC
GUITAR

MIC/LINE

PC

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：パソコンと接続するときは、必ず [USB]
ポートをご使用ください。
[USB HOST] ポートは、パソコンと接続して使用する
端子ではありません。

＜カード＜カード＜カード＜カード＜カード・・・・・プロテクトの設定について＞プロテクトの設定について＞プロテクトの設定について＞プロテクトの設定について＞プロテクトの設定について＞
初期設定の状態では、USBモードの接続時に有効
な「カード・プロテクト」が“““““OnOnOnOnOn”””””に設定されて
おり、MR-8mkII からパソコンへの取り込みのみ
が可能で、パソコン側からMR-8mkIIへの取り込
みを禁止するための設定になっています。

これは、誤った操作でパソコン側からMR-8mkII
へファイルを取り込み、MR-8mkIIのソング・デー
タを破壊しないようCFカードを保護するための
設定です。

カード・プロテクトは用途に応じて解除すること
が可能ですが、通常はプロテクトがかかっている
状態でご使用いただくことをお薦めします。
なお、プロテクトを解除してご使用いただく場合
は、事前に必ず121ページに記載している「ソン
グのアーカイブ」をお読みください。プロテクト
の解除については120ページを参照してくださ
い。

パソコンへの取り込みパソコンへの取り込みパソコンへの取り込みパソコンへの取り込みパソコンへの取り込み

*本書に記載されている会社名および製品名などは、一般
的に各社の商標または登録商標となっています。

[USB] ポート
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3)3)3)3)3) ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソル位置をダイヤルでカーソル位置をダイヤルでカーソル位置をダイヤルでカーソル位置をダイヤルでカーソル位置を22222ページめのページめのページめのページめのページめの
“““““USBUSBUSBUSBUSB”””””へ移動して、へ移動して、へ移動して、へ移動して、へ移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押しキーを押しキーを押しキーを押しキーを押し
ます。ます。ます。ます。ます。
USBメニューを選択する画面に変ります。

1)1)1)1)1) パソコンおよびパソコンおよびパソコンおよびパソコンおよびパソコンおよびMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIの電源をオンにします。の電源をオンにします。の電源をオンにします。の電源をオンにします。の電源をオンにします。

2)2)2)2)2) [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードへ入モードへ入モードへ入モードへ入モードへ入
ります。ります。ります。ります。ります。
MENUを選択する1ページめの画面に変わり、
“<< Back”が反転します。

＜注意＜注意＜注意＜注意＜注意（（（（（重重重重重要要要要要ででででですすすすす！！！！！）））））＞＞＞＞＞
ステレオWAVファイルに
変換されたファイルは、下
の図にあるようにソング・
フォルダー内の“2M IX2M IX2M IX2M IX2M IX
フォルダーフォルダーフォルダーフォルダーフォルダー”に収納されて
います。そのため、パソコ
ンへは下記矢印部分の
“2MIX2MIX2MIX2MIX2MIXフォルダーフォルダーフォルダーフォルダーフォルダー”内にあ
る、ステレオWAVファイ
ルのみを取り込んでくだ
さい。

“““““2MIX2MIX2MIX2MIX2MIXフォルダー”フォルダー”フォルダー”フォルダー”フォルダー”以外の以外の以外の以外の以外の
WAVWAVWAVWAVWAVファイルを取り込んファイルを取り込んファイルを取り込んファイルを取り込んファイルを取り込ん
だりすると、だりすると、だりすると、だりすると、だりすると、正常に動作し正常に動作し正常に動作し正常に動作し正常に動作し
なくなる恐れがあります。なくなる恐れがあります。なくなる恐れがあります。なくなる恐れがあります。なくなる恐れがあります。
パソコンへ取り込む際にパソコンへ取り込む際にパソコンへ取り込む際にパソコンへ取り込む際にパソコンへ取り込む際に
は、は、は、は、は、充分ご注意ください。充分ご注意ください。充分ご注意ください。充分ご注意ください。充分ご注意ください。

WAVWAVWAVWAVWAVファイルの取り込み手順ファイルの取り込み手順ファイルの取り込み手順ファイルの取り込み手順ファイルの取り込み手順

ここでの操作は、例としてWindows MEを搭載したパ
ソコンに接続した場合の操作手順を記載しています。

#####001.wav

Song

#####002.wav

#####003.wav

#####008.wav

2 MIX

*********.wav

55555））））） USBUSBUSBUSBUSBケーブルでケーブルでケーブルでケーブルでケーブルでMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIとパソコンを接続します。とパソコンを接続します。とパソコンを接続します。とパソコンを接続します。とパソコンを接続します。

66666））））） パソコンのパソコンのパソコンのパソコンのパソコンの「「「「「マママママイイイイイ・・・・・コンピュータ」コンピュータ」コンピュータ」コンピュータ」コンピュータ」を開くと、を開くと、を開くと、を開くと、を開くと、パソパソパソパソパソ
コン上にコン上にコン上にコン上にコン上に「「「「「リリリリリムムムムムーーーーーバババババブブブブブルルルルル・・・・・ディスクディスクディスクディスクディスク・・・・・ドライブ」ドライブ」ドライブ」ドライブ」ドライブ」ががががが
追加されます。追加されます。追加されます。追加されます。追加されます。
初めてMR-8mkIIを接続した場合は、デバイス・ド
ライバーのインストールが行われます。

77777））））） 追加されたリムーバブル追加されたリムーバブル追加されたリムーバブル追加されたリムーバブル追加されたリムーバブル・・・・・ディスクディスクディスクディスクディスク・・・・・ドライブを開ドライブを開ドライブを開ドライブを開ドライブを開
き、き、き、き、き、目的のソング目的のソング目的のソング目的のソング目的のソング・・・・・フォルダーからステレオフォルダーからステレオフォルダーからステレオフォルダーからステレオフォルダーからステレオWAVWAVWAVWAVWAV
ファイルを選択してパソコンへコピーしまファイルを選択してパソコンへコピーしまファイルを選択してパソコンへコピーしまファイルを選択してパソコンへコピーしまファイルを選択してパソコンへコピーします。す。す。す。す。
追加された「リムーバブル・ディスク」を開くと、
MR-8mkIIにセットされているカードの内容が表示
され、現在カードに記録されているソング・フォル
ダーの一覧が確認できます。

必要なソング・フォルダーの“2 MIX2 MIX2 MIX2 MIX2 MIXフォルダーフォルダーフォルダーフォルダーフォルダー”
を開いて、フォルダー内にあるステレオWAVファ
イルを選択してパソコン上にコピーします。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：“USBUSBUSBUSBUSBモードモードモードモードモード”に入っているときは、
[STOP] キー以外すべてのキーは機能しません。
[STOP] キーを押すと“USBUSBUSBUSBUSBモードモードモードモードモード”から抜け出
すことができます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：フォルダーからWAVファイルをコ
ピーしたときは、カード上にある元のファイルは
残ったままです。しかし、「フォルダーへ移動」を
実行したときは、カード上のWAVファイルはなく
なってしまいますので、ご注意ください。

88888））））） データの取り込みが終ったら、データの取り込みが終ったら、データの取り込みが終ったら、データの取り込みが終ったら、データの取り込みが終ったら、パソコンからパソコンからパソコンからパソコンからパソコンからMR-MR-MR-MR-MR-
8mkII8mkII8mkII8mkII8mkII を外します。を外します。を外します。を外します。を外します。

4)4)4)4)4) ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソル位置をダイヤルでカーソル位置をダイヤルでカーソル位置をダイヤルでカーソル位置をダイヤルでカーソル位置を“““““USB DeviceUSB DeviceUSB DeviceUSB DeviceUSB Device
ModeModeModeModeMode”””””へ移動して、へ移動して、へ移動して、へ移動して、へ移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押しキーを押しキーを押しキーを押しキーを押し
ます。ます。ます。ます。ます。
USBデバイス・モードが設定されたことを示す画
面に変ります。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：初期設定では、カード・プロテクトが
“On”に設定されているため、USB接続を実行す
ると上記画面のように“<CARD PROTECTED>”
が点灯します。これは、MR-8mkIIからパソコンへ
の取り込みのみが可能で、パソコンからMR-8mkII
への取り込みを禁止していることを示しています。

99999））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：取り込み終了後、パソコンからMR-
8mkIIを取り外すには、必ずアクセス・ランプが消
灯していることを確認し、Windowsのハードウエ
アー取り外しを実行して、指示に従ってUSBケー
ブルを外してください。
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カード・プロテクトは、MR-8mkIIとパソコンを接続するUSBモードにおいてのみ有効で、MR-8mkIIにセット
されているコンパクトフラッシュ・カードをRead/Write可能にするか、Readのみ可能にすることができます。

前述118ページの＜注意＞にも記載しましたが、誤った操作でパソコンからMR-8mkIIへソング・データを取
り込んだりすると、MR-8mkII側のソング・データが破壊される恐れがあります。
そのため、ソング・データの破壊を防止するためにも、プロテクトをかけてご使用いただくことをお勧めしま
す。なお、必要に応じてプロテクトを解除するには、下記手順で行ってください。

11111））））） 停止している状態で停止している状態で停止している状態で停止している状態で停止している状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、
MENUMENUMENUMENUMENUモードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。
MENU項目を選択する画面に変ります。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルで22222ページめのページめのページめのページめのページめの“““““USB >USB >USB >USB >USB >”””””にカーにカーにカーにカーにカー
ソルを移動して、ソルを移動して、ソルを移動して、ソルを移動して、ソルを移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
USBメニューの選択画面に変り、“<<Back”が反転
します。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Card ProtectCard ProtectCard ProtectCard ProtectCard Protect”””””ににににに
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在設定されている項目（初期設定では“On”）が
点滅します。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルで“““““OffOffOffOffOff”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ [MENU/ [MENU/ [MENU/ [MENU/
ENTER] ENTER] ENTER] ENTER] ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
プロテクトがOffに設定され、“Card Protect = Off”
が反転する画面に変ります。

55555））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。
プロテクトをOnする場合も、同様の要領で設定し
直します。

Off
Read/Write可能（MR-8mkIIとパソコン
間で、ソング・データのやり取りが可能
です）。

On
Readのみ可能（MR-8mkIIからパソコン
へのみ、ソング・データの取り込みが可
能です（初期設定）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：カード・プロテクトを解除した状態
でUSB接続を実行したときは、下記画面が表示
されます。これは、MR-8mkIIとパソコン双方で
のRead/Writeが可能であることを示していま
す。

カードカードカードカードカード・・・・・プロテクトのプロテクトのプロテクトのプロテクトのプロテクトのON/OFFON/OFFON/OFFON/OFFON/OFF

点滅

点滅
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MR-8mkIIで記録したソング・データをアーカイブ（保存）するには、下記いずれかの方法があります。

（（（（（22222））））） ソングのフォルダーごとドラッグ＆ドロップでコピーする。ソングのフォルダーごとドラッグ＆ドロップでコピーする。ソングのフォルダーごとドラッグ＆ドロップでコピーする。ソングのフォルダーごとドラッグ＆ドロップでコピーする。ソングのフォルダーごとドラッグ＆ドロップでコピーする。
この方法では、作成途中のデータを含めすべてをそのままの状態で保存することができます。

（（（（（11111））））） フォステクスが供給しているフォステクスが供給しているフォステクスが供給しているフォステクスが供給しているフォステクスが供給している「「「「「WAV ManagerWAV ManagerWAV ManagerWAV ManagerWAV Manager（（（（（ワワワワワブブブブブ・・・・・マママママネネネネネーーーーージジジジジャャャャャーーーーー）））））」」」」」を使用する。を使用する。を使用する。を使用する。を使用する。
この方法では、すべてのトラック・データを単一のモノ・ファイルに変換するため、比較的最
小限の容量に圧縮されてパソコンへ保存できます。他のPCマルチレコーディングのアプリケー
ション・ソフトにインポートする場合に便利です。
「WAV Manager（ワブ・マネージャー）」の使用方法については、「WAV Manager（ワブ・マ
ネージャー）」に付属している取扱説明書を参照してください。なお、「WAV Manager（ワブ・
マネージャー）」は、弊社ホーム・ページからダウン・ロードできます（http: www.fostex.co.jp）。

●●●●●MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII へのロードへのロードへのロードへのロードへのロード：：：：：
パソコンからのロードは、MR-8mkIIのファイル・システムを破壊する恐れがあります。
特に、過度なファイルの削除や追加した場合は、FAT16のフラグ・メンテーションの増大を引
き起こし、パフォーマンスの低下による音飛びの原因ともなります。そのため、パソコンから
MR-8mkII へロードするには、必要なフォルダーを事前にパソコンに保存した後CFカードを
フォーマットしてから行ってください。

（（（（（11111））））） MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII のののののCFCFCFCFCFカードをフォーマットするカードをフォーマットするカードをフォーマットするカードをフォーマットするカードをフォーマットする（（（（（132132132132132ペペペペペーーーーージジジジジををををを参参参参参照照照照照）））））。。。。。

（（（（（22222））））） カードカードカードカードカード・・・・・プロテクトを解除プロテクトを解除プロテクトを解除プロテクトを解除プロテクトを解除（（（（（OffOffOffOffOff）））））するするするするする（（（（（120120120120120ペペペペペーーーーージジジジジ参参参参参照照照照照）））））。。。。。

（（（（（33333））））） MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII をををををUSBUSBUSBUSBUSB経由でパソコンと接続する経由でパソコンと接続する経由でパソコンと接続する経由でパソコンと接続する経由でパソコンと接続する（（（（（119119119119119ペペペペペーーーーージジジジジ参参参参参照照照照照）））））。。。。。

（（（（（44444））））） パソコン側のソングパソコン側のソングパソコン側のソングパソコン側のソングパソコン側のソング・・・・・フォルダーをフォルダーをフォルダーをフォルダーをフォルダーをMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIのルートのルートのルートのルートのルート・・・・・フォルダーにコピーフォルダーにコピーフォルダーにコピーフォルダーにコピーフォルダーにコピー
する。する。する。する。する。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞： 保存のときと同様、ムーブは実行しないでください。

（（（（（55555））））） 必要なソング必要なソング必要なソング必要なソング必要なソング・・・・・フォルダーを、フォルダーを、フォルダーを、フォルダーを、フォルダーを、繰り返しコピーする。繰り返しコピーする。繰り返しコピーする。繰り返しコピーする。繰り返しコピーする。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞： ソングの順番は通常コピー順となりますが、パソコンのOSによって
は、異なる場合があります。

（（（（（66666））））） 終了後、終了後、終了後、終了後、終了後、USBUSBUSBUSBUSBモードから抜け出す。モードから抜け出す。モードから抜け出す。モードから抜け出す。モードから抜け出す。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：パソコンへドラッグ＆ドロップするときは、必ず「コピー」を実行してく
ださい。「ムーブ」を実行すると、MR-8mkIIのCFカード上からソングが失われたり、
場合によっては目的以外のソングまで破壊することがあります。ドラッグ＆ドロップ
実行時は、充分にご注意ください。なお、事前にMR-8mkIIのカード・プロテクトを
“On”に設定しておくことをお薦めします。

●パソコンへ保存する場合●パソコンへ保存する場合●パソコンへ保存する場合●パソコンへ保存する場合●パソコンへ保存する場合：：：：：

（（（（（11111））））） MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII をををををUSBUSBUSBUSBUSB経由でパソコンと接続し、経由でパソコンと接続し、経由でパソコンと接続し、経由でパソコンと接続し、経由でパソコンと接続し、ルートルートルートルートルート・・・・・フォルダーを開く。フォルダーを開く。フォルダーを開く。フォルダーを開く。フォルダーを開く。
このルート・フォルダー内にある各ソング・フォルダーがコピーの対象となります。

（（（（（22222））））） ソングソングソングソングソング・・・・・フォルダーをドラッグ＆ドロップして、フォルダーをドラッグ＆ドロップして、フォルダーをドラッグ＆ドロップして、フォルダーをドラッグ＆ドロップして、フォルダーをドラッグ＆ドロップして、パソコン側へコピーする。パソコン側へコピーする。パソコン側へコピーする。パソコン側へコピーする。パソコン側へコピーする。

（（（（（33333））））） 終了後、終了後、終了後、終了後、終了後、USBUSBUSBUSBUSBモードから抜け出す。モードから抜け出す。モードから抜け出す。モードから抜け出す。モードから抜け出す。

ソングのアーカイブについてソングのアーカイブについてソングのアーカイブについてソングのアーカイブについてソングのアーカイブについて
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*CD-DA*CD-DA*CD-DA*CD-DA*CD-DA
Compact Disc Digital Audioの略で、一般的にオーディオ用として流通してい
るCDの正式名称です。CDの音声記録用アプリケーション規格で、フォーマッ
トは規格書“Red Book”で規定されています。
オーディオ信号はPCM符号化されたステレオ・デジタル信号で、サンプリング
周波数は44.1kHz、量子化ビット数は16ビットで記録されます。

オーディオオーディオオーディオオーディオオーディオCDCDCDCDCDの作成の作成の作成の作成の作成
ここでは、外部CD-R/RWドライブを使ってCD-DA＊フォーマットのオーディ
オCDの作成方法について記載します。
MR-8mkIIで録音したあなたのオリジナル曲を、CD-R/RWディスクへ記録し
てオーディオCDが作成できます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞
外部CD-R/RWドライブを使ってオーディオCDが作成できるのは、Normalモー
ド（44.1kHz/16bit）のソングに録音したソング・データのみです。
LPモード（22.05kHz/16bit）のソングに録音したソング・データで、オーディ
オCDは作成できません。
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外部CD-R/RWドライブを接続してCD-DAフォーマットのオーディオCDを作成するには、作業を開始する前
に、必ず下記事項をお読みください。

MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII に接続可能なに接続可能なに接続可能なに接続可能なに接続可能なCD-R/RWCD-R/RWCD-R/RWCD-R/RWCD-R/RWドライブについてドライブについてドライブについてドライブについてドライブについて（（（（（重重重重重要要要要要ででででですすすすす！！！！！）））））
[USB] ポートを装備し、ドライブの電源が単独で供給できるドライブであれば、バージョンアップ
したMR-8mkIIの [USB HOST] ポートに接続してご使用いただけます。MR-8mkIIは“USB BUS
POWER機能”（MR-8mkIIからUSBケーブルで電源をドライブ側へ供給する機能）を搭載していま
せんので、“USB BUS POWER”タイプのCD-R/RWドライブは使用できません。

なお、ドライブ・メーカーの事情で使用可能な機種が変更になることがあります。お手数でも、最
新の使用可能なドライブ情報を、弊社ホーム・ページ（http://www.fostex.co.jp）でご確認の上、お
買い求めください。

使用可能なディスクについて使用可能なディスクについて使用可能なディスクについて使用可能なディスクについて使用可能なディスクについて
MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII に接続するに接続するに接続するに接続するに接続するCD-R/RWCD-R/RWCD-R/RWCD-R/RWCD-R/RWドライブでは、ドライブでは、ドライブでは、ドライブでは、ドライブでは、下記マークの付いたディスクのみが使用可能です。下記マークの付いたディスクのみが使用可能です。下記マークの付いたディスクのみが使用可能です。下記マークの付いたディスクのみが使用可能です。下記マークの付いたディスクのみが使用可能です。

Recordable

ReWritable

＜＜＜＜＜CD-RCD-RCD-RCD-RCD-Rディスク＞ディスク＞ディスク＞ディスク＞ディスク＞：：：：：新品で、かつ記録可能な領域が十分なディスクであれば、
ファイナライズ処理するまで追記録が可能です。

＜＜＜＜＜CD-RWCD-RWCD-RWCD-RWCD-RWディスク＞ディスク＞ディスク＞ディスク＞ディスク＞：：：：：新品で、かつ記録可能な領域が十分なディスクであれ
ば、ファイナライズ処理するまで追記録が可能です。

＜＜＜＜＜CDCDCDCDCDディスク＞ディスク＞ディスク＞ディスク＞ディスク＞：：：：：市販のオーディオCDなど、このマークが付いたディスク
は、TOCのみ確認することができます。記録することはできません。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：MR-8mkIIに接続したCD-R/RWドライブでは、ステレオWAVファイルをCD-DAフォーマッ
トに変換して記録することのみが可能で、作成したオーディオCD（または市販のオーディオCD）を再生す
ることはできません。

ディスクの取り扱いについてディスクの取り扱いについてディスクの取り扱いについてディスクの取り扱いについてディスクの取り扱いについて
●CD-R/RWディスクを持つ場合は、信号面に指紋やホ
コリ、傷などが付かないよう気を付けてください。ディ
スクの両端をはさむように持つか、ディスク中央の穴と
端を挟んで持ってください。

ご使用前にお読みください！ご使用前にお読みください！ご使用前にお読みください！ご使用前にお読みください！ご使用前にお読みください！

●ディスクのレーベル面に、紙やシールを貼らないでください。特に、レー
ベル面に傷を付けないでください。傷が付くと記録／再生ができなくなるこ
とがあります。また、レーベル面には、市販のフェルト・ペン、またはそれ
と同等のペン以外は使用しないでください。先の硬いペン（ボールペン、エ
ンピツなど）などは、絶対に使用しないでください。ディスクを破損させて
しまいます。

●ヒビが入ったり、反っているディスクは、絶対に使用しないでください。ド
ライブの故障の原因となります。

●ディスクにホコリや指紋などの汚れが付いた場合には、柔らかく乾いた布、
またはエチルアルコールを含ませた布で、ディスクの内周から外周方向へ軽
く拭いてください。ディスクの円周方向へは拭かないでください。

●ご使用の際は、ディスクに付属している説明書を必ずお読みください。
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MIDI OUTUSB HOSTCOMPACTFLASH CARD

CD-R/RWCD-R/RWCD-R/RWCD-R/RWCD-R/RWディスクへ記録可能なソングディスクへ記録可能なソングディスクへ記録可能なソングディスクへ記録可能なソングディスクへ記録可能なソング・・・・・データについてデータについてデータについてデータについてデータについて
CD-DAフォーマットで記録できるのは、下記いずれかの方法でトラック7/8にバウンスしたデータ（完
パケした曲）を、ステレオWAVファイルに変換したデータです。

（（（（（11111））））） トラックトラックトラックトラックトラック11111～～～～～66666をトラックをトラックをトラックをトラックをトラック7/87/87/87/87/8にバウンスしたモノにバウンスしたモノにバウンスしたモノにバウンスしたモノにバウンスしたモノ・・・・・ファイルを、ファイルを、ファイルを、ファイルを、ファイルを、ステレオステレオステレオステレオステレオWAVWAVWAVWAVWAV
ファイルに変換したデータファイルに変換したデータファイルに変換したデータファイルに変換したデータファイルに変換したデータ

（（（（（22222））））） トラックトラックトラックトラックトラック11111～～～～～88888をををををNewNewNewNewNewソングのトラックソングのトラックソングのトラックソングのトラックソングのトラック7/87/87/87/87/8へバウンスしたモノへバウンスしたモノへバウンスしたモノへバウンスしたモノへバウンスしたモノ・・・・・ファイルを、ファイルを、ファイルを、ファイルを、ファイルを、
ステレオステレオステレオステレオステレオWAVWAVWAVWAVWAVファイルに変換したデータファイルに変換したデータファイルに変換したデータファイルに変換したデータファイルに変換したデータ

バウンスについての詳細は65～74ページを参照し、トラック7/8のデータをステレオWAVファイルに
変換する詳細は、116ページを参照してください。

外部外部外部外部外部CD-R/RWCD-R/RWCD-R/RWCD-R/RWCD-R/RWドライブの接続ドライブの接続ドライブの接続ドライブの接続ドライブの接続
CD-R/RWドライブは、専用のUSBケーブル（本機には付属しておりません）を使って、下記図の要領でMR-
8mkIIサイドパネル部にある [USB HOST] ポートへ接続します。

#####001.wav

Song

#####002.wav

#####003.wav

#####008.wav

2 MIX

*********.wav

MR-8mkII では、トラック7/8にバウンスした曲をステレオ
WAVファイルに変換すると、そのWAVファイルは変換元のソ
ング・フォルダー内にある“2MIXフォルダー”に収納されま
す（左記図を参照）。

外部CD-R/RWドライブを使ってCD-DAフォーマットのオー
ディオCDを作成するには、この“2MIXフォルダー”に収納さ
れているステレオWAVファイルのみがCD-R/RWディスクへ
記録できるようになっています。

そのため、希望のステレオWAVファイルを選択するには、あ
らかじめ収納されているソングを立ち上げておく必要がありま
す。オーディオCDを作成する前には、必ず次ページに記載さ
れている＜注意＞をお読みください。

USBケーブル
[USB HOST] ポート

USB 1.1 Aタイプ（標準）

CD-R/RWドライブ

CD-R/RWディスク

コンセント

Song01

2 MIX

Song01

2 MIX

Song02

2 MIX

Song03

2 MIX
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オーディオオーディオオーディオオーディオオーディオCDCDCDCDCDの作成手順の作成手順の作成手順の作成手順の作成手順

ここからの操作手順は、あらかじめ下記準備が整っていることを前提にして記載しています。

11111））））） CD-R/RWCD-R/RWCD-R/RWCD-R/RWCD-R/RWドライブに、ドライブに、ドライブに、ドライブに、ドライブに、CD-R/RWCD-R/RWCD-R/RWCD-R/RWCD-R/RWディスクをディスクをディスクをディスクをディスクを
セットします。セットします。セットします。セットします。セットします。
トレイの開閉は、ドライブ側で操作します。

22222））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、
MENUMENUMENUMENUMENUモードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。
MENU選択の1ページ目の画面に変り、初期設定
では“““““<<Back<<Back<<Back<<Back<<Back”””””が反転します。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルでMENUMENUMENUMENUMENU選択の選択の選択の選択の選択の22222ページページページページページ
目にある目にある目にある目にある目にある“““““USB HOST>USB HOST>USB HOST>USB HOST>USB HOST>”””””を選択して、を選択して、を選択して、を選択して、を選択して、
[MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
USB HOSTメニューの選択画面に変り、初期設
定では“““““<<Back<<Back<<Back<<Back<<Back”””””が反転します。

CD BurnCD BurnCD BurnCD BurnCD Burn

CD FinalizeCD FinalizeCD FinalizeCD FinalizeCD Finalize

2MIXフォルダーにあるステレオWAVファ
イルを、CD-DAフォーマットでCD-R/RW
ディスクへ記録するときに選択します。記
録終了後、CD Finalizeを実行してオーディ
オCDが完成します。複数の曲を記録すると
きは、CD Burnを繰り返し、最終曲を記録
した後、CD Finalizeを実行します。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：オーディオオーディオオーディオオーディオオーディオCDCDCDCDCDを作成するには、を作成するには、を作成するには、を作成するには、を作成するには、バウンスしたトラックバウンスしたトラックバウンスしたトラックバウンスしたトラックバウンスしたトラック7/87/87/87/87/8のデータをステレオのデータをステレオのデータをステレオのデータをステレオのデータをステレオWAVWAVWAVWAVWAVファイルにファイルにファイルにファイルにファイルに
変換したときのソングを立ち上げておくことが必要です変換したときのソングを立ち上げておくことが必要です変換したときのソングを立ち上げておくことが必要です変換したときのソングを立ち上げておくことが必要です変換したときのソングを立ち上げておくことが必要です（（（（（下下下下下記記記記記例例例例例ををををを参参参参参照照照照照）））））。。。。。

USB HOSTメニューには3つのメニューがあり、用途に
合わせて選択します（下記表を参照してください）。

CD TOCCD TOCCD TOCCD TOCCD TOC

CD-DAフォーマットでWAVファイルを記
録したディスクを、オーディオCDとして成
立させるとき選択します（注意注意注意注意注意：：：：：ファイナラファイナラファイナラファイナラファイナラ
イズすると、イズすると、イズすると、イズすると、イズすると、追記録はできなくなります追記録はできなくなります追記録はできなくなります追記録はできなくなります追記録はできなくなります）。

オーディオCD（市販のオーディオCDも含
む）のTOC（曲数／記録時間）を確認する
ときに選択します。TOCは、“CD Burn”ま
たは“CD Finalize”を実行した後でも確認
できます。

＜例＞＜例＞＜例＞＜例＞＜例＞：：：：： 5つのソング（01～05）がコンパクトフラッシュ・カードに記録されている状態で、記録
したいステレオWAVファイルがソング03の“2MIXフォルダー”に収納されている場合。

⬇
操作を開始する前に必ずソング操作を開始する前に必ずソング操作を開始する前に必ずソング操作を開始する前に必ずソング操作を開始する前に必ずソング0303030303を立ち上げておく。を立ち上げておく。を立ち上げておく。を立ち上げておく。を立ち上げておく。

オーディオCDを作成する場合の操作例

●●●●●11111曲のオーディオ曲のオーディオ曲のオーディオ曲のオーディオ曲のオーディオCDCDCDCDCDを作成する場合を作成する場合を作成する場合を作成する場合を作成する場合：：：：：

“CD Burn”を1回実行する
⬇

“CD Finalize”を実行する

●複数曲のオーディオ●複数曲のオーディオ●複数曲のオーディオ●複数曲のオーディオ●複数曲のオーディオCDCDCDCDCDを作成する場合を作成する場合を作成する場合を作成する場合を作成する場合：：：：：

“CD Burn”を複数回繰り返し実行する
⬇

最終曲の“CD Burn”が終了後、
“CD Finalize”を実行する。

特に、複数の異なったソングから一枚のディスクへ連続して記録する場合は、記録する前に希望のソングを
立ち上げてから作業することが大切です。

希望のソングを立ち上げるには、MENUモードの“Song”メニューにある“Select Song”で選択します。
“Select Song”の詳細は、90ページを参照してください。

● CD-R/RWディスクへ記録する、ステレオWAVファイルが収納されているソングが立ち上がってい
る。

● MR-8mkIIとCD-R/RWドライブがUSBケーブルで正しく接続され、双方の電源がオンになってい
る。
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＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：     操作中、下記例のように画面下に
“““““Not MountedNot MountedNot MountedNot MountedNot Mounted”””””が点灯するときは、MR-8mkII
とCD-R/RWドライブが正しく接続されていな
いことを示しています。

このような場合には、このような場合には、このような場合には、このような場合には、このような場合には、CD-R/RWCD-R/RWCD-R/RWCD-R/RWCD-R/RWドライブにドライブにドライブにドライブにドライブに
ディスクがセットされていることを確認して、ディスクがセットされていることを確認して、ディスクがセットされていることを確認して、ディスクがセットされていることを確認して、ディスクがセットされていることを確認して、
MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII のコンパクトフラッシュのコンパクトフラッシュのコンパクトフラッシュのコンパクトフラッシュのコンパクトフラッシュ・・・・・カードおカードおカードおカードおカードお
よびよびよびよびよびCD-R/RWCD-R/RWCD-R/RWCD-R/RWCD-R/RWドライブのアクセスが停止してドライブのアクセスが停止してドライブのアクセスが停止してドライブのアクセスが停止してドライブのアクセスが停止して
いる状態で、いる状態で、いる状態で、いる状態で、いる状態で、USBUSBUSBUSBUSBケーブルを抜き差ししてくだケーブルを抜き差ししてくだケーブルを抜き差ししてくだケーブルを抜き差ししてくだケーブルを抜き差ししてくだ
さい。さい。さい。さい。さい。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルで“““““CD Burn>CD Burn>CD Burn>CD Burn>CD Burn>”””””を選択して、を選択して、を選択して、を選択して、を選択して、
[MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
[MENU/ENTER] キーを押すと、現在立ち上がって
いるソングの“2MIXフォルダー”内にある「ステ
レオWAVファイル」を選択する画面に変ります。
下記例は、1つのステレオWAVファイルが存在す
ることを示しています。

55555））））） [MENU] [MENU] [MENU] [MENU] [MENU] ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルでWAVWAVWAVWAVWAVファイルを選択しファイルを選択しファイルを選択しファイルを選択しファイルを選択し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
CD-R/RWディスクへの書き込みが始まり、下記
画面に変ります。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：現在立ち上がっているソングの
“2MIXフォルダー”内に複数のステレオWAV
ファイルが存在する場合は、下記例のように各
ファイルが表示されます。

ディスクへの書き込み中は“““““Writing...Writing...Writing...Writing...Writing...”””””が点灯し、
カードのアクセスを示す“““““ACCACCACCACCACC”””””が点滅します。
また、CD-R/RWドライブのACCESS LEDも点滅
しますので、このような状態にあるときは、絶対に
電源を切ったり、ドライブのイジェクト・キーなど
を操作しないでください。
なお、データの書き込み中は、MR-8mkII の操作
キーは一切受け付けません。

ディスクへの書き込みが全て終了すると下記画面に
変り、アクセスも停止します。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：ご使用になるドライブによっては、
USB HOSTメニューの選択画面に入ると同時
に、下記ポップアップ表示が点灯することがあ
ります。

この表示は、MR-8mkIIとCD-R/RWドライブ
間で内部処理を実行していることを示し、約10
秒程度で消えます。そのため、ポップアップ表
示が消えるのを待ってから、USB HOST メ
ニューを選択してください。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：万一、LPモードのソングを立ち上
げて“CD Burn”を実行しようとすると、下記
ワーニング・メッセージが表示され、USB
HOSTメニューを選択する画面に戻ります。

LPLPLPLPLPモードのソングに記録されたステレオモードのソングに記録されたステレオモードのソングに記録されたステレオモードのソングに記録されたステレオモードのソングに記録されたステレオWAVWAVWAVWAVWAV
ファイルを選択しても、ファイルを選択しても、ファイルを選択しても、ファイルを選択しても、ファイルを選択しても、オーディオオーディオオーディオオーディオオーディオCDCDCDCDCDは作成は作成は作成は作成は作成
できません。できません。できません。できません。できません。MENUMENUMENUMENUMENUモードから一旦抜け出したモードから一旦抜け出したモードから一旦抜け出したモードから一旦抜け出したモードから一旦抜け出した
後、後、後、後、後、NormalNormalNormalNormalNormalモードのソングを選択し、モードのソングを選択し、モードのソングを選択し、モードのソングを選択し、モードのソングを選択し、初めから初めから初めから初めから初めから
作業をやり直してください。作業をやり直してください。作業をやり直してください。作業をやり直してください。作業をやり直してください。
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88888））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルで“““““[ENTER][ENTER][ENTER][ENTER][ENTER]”””””を選択して、を選択して、を選択して、を選択して、を選択して、
[MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ファイナライズの実行を示す画面に変ります。

その後、ファイナライズが終了すると同時に
“““““Completed!Completed!Completed!Completed!Completed!”””””が点灯し、CD-R/RWドライブから
自動的にディスクがイジェクトされます。

99999））））） 画面の指示に従って、画面の指示に従って、画面の指示に従って、画面の指示に従って、画面の指示に従って、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーをキーをキーをキーをキーを
押します。押します。押します。押します。押します。
USB HOSTメニューの選択画面に変り、“““““CDCDCDCDCD
Finalize>Finalize>Finalize>Finalize>Finalize>”””””が反転します。

ファイナライズ終了後TOCを確認するには、この
後「TOCの確認」を参照してください。

ファイナライズを実行するには“““““[ENTER][ENTER][ENTER][ENTER][ENTER]”””””を選択
し、中止するには“““““[CANCEL][CANCEL][CANCEL][CANCEL][CANCEL]”””””を選択してから
[MENU/ENTER] キーを押します。

1010101010））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押してキーを押してキーを押してキーを押してキーを押してMENUMENUMENUMENUMENUモードから抜モードから抜モードから抜モードから抜モードから抜
け出します。け出します。け出します。け出します。け出します。
画面上にある“<<Back”を選択して [MENU/
ENTER] キーを押す操作を繰り返すことでも、
MENUモードから抜け出すことができます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：ファイナライズしたディスクには
追記録できません。イジェクトされたディスク
をドライブに再ロードし、前述と同様他の
WAVファイルを追記録しようとしても、下記
警告メッセージが表示され、実行できません。

66666））））） [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
USB HOSTメニューを選択する画面に戻り、“““““CDCDCDCDCD
Burn>Burn>Burn>Burn>Burn>”””””が反転します。

複数のステレオWAVファイルを引き続き記録
する場合には、上記画面の状態から操作-4～6
を繰り返した後、操作-7のファイナライズを実
行します。

また、“CD Burn”を実行した後TOC情報を確
認することができます。次ページの「TOCの確
認」を参照してください。

77777））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルで“““““CD Finalize >CD Finalize >CD Finalize >CD Finalize >CD Finalize >”””””を選択を選択を選択を選択を選択
して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ファイナライズを実行するかどうかを選択する画
面に変り、“““““<<Back<<Back<<Back<<Back<<Back”””””が反転します。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：ディスクへ書き込み中、「書き込み
エラー」が発生すると下記のようなエラー・
メッセージが表示されることがあります。

このメッセージが書き込みの途中に表示され
た場合、現在使用しているディスクには正常
に書き込みできないことを示しています。
 そのため、 [MENU/ENTER] キーを押してこ
の画面から抜け出した後、他のディスクに交
換してやり直しするようにしてください。
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22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルで“““““CD TOC>CD TOC>CD TOC>CD TOC>CD TOC>”””””を選択して、を選択して、を選択して、を選択して、を選択して、
[MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“““““Please WaitPlease WaitPlease WaitPlease WaitPlease Wait”””””が点灯した後、前述の“CD Burn”
終了後のTOC確認と同様、TOCが表示されます。

11111））））） イジェクトされているイジェクトされているイジェクトされているイジェクトされているイジェクトされているCD-R/RWCD-R/RWCD-R/RWCD-R/RWCD-R/RWドライブのドライブのドライブのドライブのドライブの
トレイをクローズます。トレイをクローズます。トレイをクローズます。トレイをクローズます。トレイをクローズます。
ドライブ側のトレイ前方を軽く押すか、イジェク
ト・スイッチを押します。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：トレイをクローズすると、ドライ
ブがディスクを読み込むためアクセスLEDが
点滅します。そのため、ドライブのアクセスが
完全に停止し、アクセスLEDが消灯しているこ
とを確認してからつぎの操作を行ってくださ
い。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：複数のWAVファイルを連続して
“CD Burn”したディスクでは、下記例のように
TOC情報が表示され、リメインも確認できま
す。

●●●●●“““““CD FinalizeCD FinalizeCD FinalizeCD FinalizeCD Finalize”””””終了後終了後終了後終了後終了後TOCTOCTOCTOCTOCを確認するを確認するを確認するを確認するを確認する

22222））））） TOCTOCTOCTOCTOCの確認ができたら、の確認ができたら、の確認ができたら、の確認ができたら、の確認ができたら、ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルで
“““““<<Back<<Back<<Back<<Back<<Back”””””を選択してを選択してを選択してを選択してを選択して [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーキーキーキーキー
を押します。を押します。を押します。を押します。を押します。
USB HOSTメニューの選択画面に戻りますので、
“““““CD FinalizeCD FinalizeCD FinalizeCD FinalizeCD Finalize”””””を選択してファイナライズを実行し
ます。

TOC (Table of Contents) TOC (Table of Contents) TOC (Table of Contents) TOC (Table of Contents) TOC (Table of Contents) の確認の確認の確認の確認の確認

●●●●●“““““CD BurnCD BurnCD BurnCD BurnCD Burn”””””終了後終了後終了後終了後終了後TOCTOCTOCTOCTOCを確認するを確認するを確認するを確認するを確認する

TOCは、“CD Burn”の終了後、あるいは“CD Finalize”の終了後でも確認することができます。特に、複数
記録するときは、ディスクのリメイン（記録可能な時間）を確認しながら作業することをお勧めします。

11111））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルで“““““CDCDCDCDCD TOC>TOC>TOC>TOC>TOC>”””””を選択して、を選択して、を選択して、を選択して、を選択して、
[MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“““““Please Wait...Please Wait...Please Wait...Please Wait...Please Wait...”””””を表示した後、記録したトラック
（曲）と記録時間、さらにはリメインが表示されま
す。

＜＜＜＜＜TOCTOCTOCTOCTOC＞＞＞＞＞：：：：：Table of contentsの略で、音楽CDのトラック（曲）数や、演奏時間などを管理するデータ
領域を意味しています。

ファイナライズ終了後のTOC表示では、リメイン
が“““““0h 00m 00s0h 00m 00s0h 00m 00s0h 00m 00s0h 00m 00s”””””と表示されます。
これは、ファイナライズしたディスクにはこれ以上
追記録できないことを示しています。
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33333））））） TOCTOCTOCTOCTOCの確認ができたらの確認ができたらの確認ができたらの確認ができたらの確認ができたら [STOP]  [STOP]  [STOP]  [STOP]  [STOP] キーを押しキーを押しキーを押しキーを押しキーを押し
て、て、て、て、て、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。
Home画面に変ります。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：複数のWAV ファイルを記録して
ファイナライズしたときも、下記のようにリメイ
ンは“““““0h 00m 00s0h 00m 00s0h 00m 00s0h 00m 00s0h 00m 00s”””””を表示します。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：本機で作成したオーディオCD以外
に、市販のオーディオCDもTOCが確認できま
す。
CD-R/RWドライブにオーディオCDをロード
し、MENUモードの“USB HOST”メニューを
使って前述同様の操作を行ってください。
なお、本機で確認できるTOCはトラック数と記
録時間のみで、トラック（曲）のタイトルなどは
表示しません。
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その他の機能その他の機能その他の機能その他の機能その他の機能
ここでは、MR-8mkIIをご使用いただく上で必要な下記機能について記載して
あります。

（（（（（11111））））） コンパクトフラッシュコンパクトフラッシュコンパクトフラッシュコンパクトフラッシュコンパクトフラッシュ・・・・・カードのフォーマットカードのフォーマットカードのフォーマットカードのフォーマットカードのフォーマット

（（（（（22222））））） ピークピークピークピークピーク・・・・・ホールド時間の設定ホールド時間の設定ホールド時間の設定ホールド時間の設定ホールド時間の設定

（（（（（33333））））） プリロール／ポストロールの設定プリロール／ポストロールの設定プリロール／ポストロールの設定プリロール／ポストロールの設定プリロール／ポストロールの設定

（（（（（44444））））） Auto DeleteAuto DeleteAuto DeleteAuto DeleteAuto Delete機能の機能の機能の機能の機能のON/OFFON/OFFON/OFFON/OFFON/OFF設定設定設定設定設定

（（（（（55555））））） Bar/BeatBar/BeatBar/BeatBar/BeatBar/BeatリゾリューションのリゾリューションのリゾリューションのリゾリューションのリゾリューションのON/OFFON/OFFON/OFFON/OFFON/OFF設定設定設定設定設定

（（（（（66666））））） ファントム電源のファントム電源のファントム電源のファントム電源のファントム電源のON/OFFON/OFFON/OFFON/OFFON/OFF設定設定設定設定設定

（（（（（77777））））） MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII のイニシャライズのイニシャライズのイニシャライズのイニシャライズのイニシャライズ

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞
MENUモードの階層画面が表示されている状態では、下記の操作をすることで一つ前
の階層画面に戻したり、ダイレクトにMENUモードから抜け出すことができます。

（（（（（11111））））） MENUMENUMENUMENUMENU画面上にある画面上にある画面上にある画面上にある画面上にある     “““““<<Back<<Back<<Back<<Back<<Back”””””を選択してを選択してを選択してを選択してを選択して [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押す。キーを押す。キーを押す。キーを押す。キーを押す。
現在表示されている階層画面の一つ前に戻り、同じ操作を繰り返すと最終的に
はMENUモードから抜け出します。

（（（（（22222））））） [REWIND] [REWIND] [REWIND] [REWIND] [REWIND] キーを押す。キーを押す。キーを押す。キーを押す。キーを押す。
キーを押すごとに、現在表示されている階層画面の一つ前に戻り、最終的には
MENUモードから抜け出します。

（（（（（33333））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押す。キーを押す。キーを押す。キーを押す。キーを押す。
一気にMENUモードから抜け出し、Home画面に変ります。
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MR-8mkIIで使用するコンパクトフラッシュ・カード（以下CFカード）を、FAT16のファイル・システムで再
フォーマットします。CFカードを再フォーマットすると、カード上にある全てのソング・データが消去される
と同時にMENUモードなどの全データが初期化されます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞
CFカードのフォーマットは、実行すると元に戻すことができません。そのため、CFカード上に記録され
ている全てのソング・データが不要であることを確認してから実行してください。

11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードに入ります。モードに入ります。モードに入ります。モードに入ります。モードに入ります。
MENUを選択する1ページめの画面に変わり、初
期設定では“<< Back”が反転します。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““System >System >System >System >System >”””””に移に移に移に移に移
動して、動して、動して、動して、動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Systemメニューを選択する1ページめの画面に変
り、初期設定では“<< Back”が反転します。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを22222ページめにあるページめにあるページめにあるページめにあるページめにある
“““““Card Format >Card Format >Card Format >Card Format >Card Format >”””””に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER]
キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Are You Sure? ”が点滅する画面に変ります。

この画面は、フォーマットを実行すると現在CFカ
ード上にあるすべてのソングが削除され、フォー
マットはアンドウできないことを警告しています。

フォーマットを中止する場合は、 速やかに [STOP]
キーを押して、MENUモードから抜け出してくだ
さい。

44444））））） [RECORD] [RECORD] [RECORD] [RECORD] [RECORD] キーを押しながら、キーを押しながら、キーを押しながら、キーを押しながら、キーを押しながら、 [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER]
     キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
フォーマットが開始され、フォーマットが終了する
と同時にMenuモードの“Song”メニューへ進
み、Newソング（Song01）を作成する画面に変り
ます。

この後、23ページの「準備編」に記載されている
「Newソングの作成」を参照して、ソング・モード
（NormalまたはLP）とソング・ネームを設定して、
カード上にNewソングを作成してください。

コンパクトフラッシュコンパクトフラッシュコンパクトフラッシュコンパクトフラッシュコンパクトフラッシュ・・・・・カードのフォーマットカードのフォーマットカードのフォーマットカードのフォーマットカードのフォーマット

点滅

点滅
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MR-8mkII MR-8mkII MR-8mkII MR-8mkII MR-8mkII 　取扱説明書　取扱説明書　取扱説明書　取扱説明書　取扱説明書（（（（（そそそそそののののの他他他他他ののののの機機機機機能能能能能）））））

MR-8mkIIのディスプレイに表示されるレベル・メータには、ピーク値をホールドする機能が備わっていて、録
音時のピーク値を一定時間メータ上に点灯させることができます。
初期設定のピーク・ホールド値は3秒になっており、必要に応じてホールド機能をOFFにしたり、ホールド時
間を任意の値に設定することができます。

11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードモードモードモードモードに入ります。に入ります。に入ります。に入ります。に入ります。
MENUを選択する1ページめの画面に変わり、初
期設定では“<< Back”が反転します。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““System >System >System >System >System >”””””に移に移に移に移に移
動して、動して、動して、動して、動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Systemメニューを選択する1ページめの画面に変
り、初期設定では“<< Back”が反転します。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを22222ページめにあるページめにあるページめにあるページめにあるページめにある
“““““PeakHold TimePeakHold TimePeakHold TimePeakHold TimePeakHold Time”””””に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER]
キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在設定されているホールド時間が点滅する画面に
変り、任意に設定が可能になります（初期設定では
“3s”が点滅）。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで希望のホールド時間ダイヤルで希望のホールド時間ダイヤルで希望のホールド時間ダイヤルで希望のホールド時間ダイヤルで希望のホールド時間（（（（（まままままたたたたたははははは
OffOffOffOffOff）））））を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押しまキーを押しまキーを押しまキーを押しまキーを押しま
す。す。す。す。す。
選択した時間（またはOff）に設定され、一つ前の
画面に戻ります。

55555））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

設定されたホールド時間は、全てのソングに対して
有効となります。

ピーク・ホールド時間は、初期設定の“3秒”以外
に“1秒”、“2秒”、“4秒”、“5秒”、または“Off”
が選択できます。

“Off”に設定すると、ピーク値は一切ホールドされ
ません。

ピークピークピークピークピーク・・・・・ホールド表示ホールド表示ホールド表示ホールド表示ホールド表示
初期設定で約3 秒間点
灯します。

ピークピークピークピークピーク・・・・・ホールド時間の設定ホールド時間の設定ホールド時間の設定ホールド時間の設定ホールド時間の設定

点滅
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MR-8mkII MR-8mkII MR-8mkII MR-8mkII MR-8mkII 　取扱説明書　取扱説明書　取扱説明書　取扱説明書　取扱説明書（（（（（そそそそそののののの他他他他他ののののの機機機機機能能能能能）））））

ここでは、前述49ページで説明した「ループ・モード」と「オート・パンチイン／アウト」を併用する際、LOCATE
AおよびBポイントにおいて自動的に付加される「プリロール時間」と「ポストロール時間」の値を設定しま
す。

プレイ・モードを「ループ・モード」に選択した状態
でオート・パンチ・モードをオンすると、右の図のよ
うに登録されているLOCATE Aポイントには4秒の
プリロール時間、そしてLOCATE Bポイントには1秒
のポストロール時間が初期設定で自動的に付加される
ようになっています。

つまり、オート・パンチインを実行するLOCATE Aポ
イントの手前4秒がLoop Startポイントとなり、オー
ト・パンチアウトを実行するLOCATE Bポイントの
後1秒が、Loop Endポイントとして機能するように
なります。そのため、パンチインの前4秒から再生で
き、パンチアウト後1秒も再生することができます。

11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードに入ります。モードに入ります。モードに入ります。モードに入ります。モードに入ります。
MENUを選択する1ページめの画面に変わり、初
期設定では“<< Back”が反転します。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““System >System >System >System >System >”””””に移に移に移に移に移
動して、動して、動して、動して、動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Systemメニューを選択する1ページめの画面に変
り、初期設定では“<< Back”が反転します。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Pre Roll TimePre Roll TimePre Roll TimePre Roll TimePre Roll Time”””””ににににに
移動して、移動して、移動して、移動して、移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在設定されているプリロール時間が点滅する画面
に変り、任意に設定が可能になります（初期設定で
は“4.0s”が点滅）。
プリロール時間は、“0.1秒”から“10秒”の範囲
を、“0.1秒”単位で設定できます。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで希望のプリロール時間を選択しダイヤルで希望のプリロール時間を選択しダイヤルで希望のプリロール時間を選択しダイヤルで希望のプリロール時間を選択しダイヤルで希望のプリロール時間を選択し
て、て、て、て、て、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択したプリロール時間に設定され、一つ前の画面
に戻ります。引き続きポストロール時間を設定する
には、つぎの操作を続けます。

55555））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Post Roll TimePost Roll TimePost Roll TimePost Roll TimePost Roll Time”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在設定されているポストロール時間が点滅する画
面に変り、任意に設定が可能になります（初期設定
では“1.0s”が点滅）。
ポストロール時間も、“0.1秒”から“10秒”の範
囲を、“0.1秒”単位で設定できます。

66666））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルで希望のポストロール時間を選択ダイヤルで希望のポストロール時間を選択ダイヤルで希望のポストロール時間を選択ダイヤルで希望のポストロール時間を選択ダイヤルで希望のポストロール時間を選択
して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択したポストロール時間に設定され、一つ前の画
面に戻ります。

77777））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

プリロール／ポストロール時間の設定プリロール／ポストロール時間の設定プリロール／ポストロール時間の設定プリロール／ポストロール時間の設定プリロール／ポストロール時間の設定

点滅
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MR-8mkII MR-8mkII MR-8mkII MR-8mkII MR-8mkII 　取扱説明書　取扱説明書　取扱説明書　取扱説明書　取扱説明書（（（（（そそそそそののののの他他他他他ののののの機機機機機能能能能能）））））

「Auto Delete機能」とは、任意のソング内で“Track Edit”メニューにあるトラック・データの削除を実行し
たり、“Part Edit”メニューにあるパート・データの削除を実行すると同時に、自動的にソング内の不要になっ
たアンドウ用WAVファイルを削除する機能です。初期設定では“On”になっており、常にコンパクトフラッ
シュ・カードの記録可能な領域を最大限確保することが可能になっています。Auto Delete機能の設定は、カー
ド上にある全てのソングに有効です。

11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードに入ります。モードに入ります。モードに入ります。モードに入ります。モードに入ります。
MENUを選択する1ページめの画面に変わり、初
期設定では“<< Back”が反転します。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““System >System >System >System >System >”””””に移に移に移に移に移
動して、動して、動して、動して、動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Systemメニューを選択する1ページめの画面に変
り、初期設定では“<< Back”が反転します。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを22222ページめのページめのページめのページめのページめの
“““““Auto DeleteAuto DeleteAuto DeleteAuto DeleteAuto Delete”””””に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER]
キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在の設定が点滅する画面に変り、任意に選択が可
能になります（初期設定では“On”が点滅）。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルで“““““OffOffOffOffOff”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ [MENU/ [MENU/ [MENU/ [MENU/
ENTER] ENTER] ENTER] ENTER] ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Auto Delete”が“Off”に設定され、一つ前の画
面に変ります。設定内容は、本機Flash ROMに保
存され、カード上の全ソングを対象に機能するよう
になります。

Auto DeleteAuto DeleteAuto DeleteAuto DeleteAuto Delete機能の機能の機能の機能の機能のON/OFFON/OFFON/OFFON/OFFON/OFF設定設定設定設定設定

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞
●“Auto Delete”が初期設定（“On”)になっている状態では、トラック・データの削除（またはパート・デー
タの削除）は、アンドウすることができません。アンドウ／リドウを可能にするには、必要に応じて“Auto
Delete”を“Off”に設定してください。

●“Auto Delete”は、トラック・データの削除（またはパート・データの削除）を実行したときのみ、機能
します。そのため、トラック・データ（またはパート・データ）を削除しないソング内の不要なWAVファ
イルを削除するには、“Song”メニューにある“Delete Unused”を実行してください（☞94ページ）。

“Auto Delete”を再度“On”に設定するには、同
じ要領で行ってください。

55555））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードからモードからモードからモードからモードから抜け出抜け出抜け出抜け出抜け出
します。します。します。します。します。
Home画面に変ります。

点滅

点滅
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MR-8mkII MR-8mkII MR-8mkII MR-8mkII MR-8mkII 　取扱説明書　取扱説明書　取扱説明書　取扱説明書　取扱説明書（（（（（そそそそそののののの他他他他他ののののの機機機機機能能能能能）））））

Beatリゾリューション・モードの設定とは、Bar/Beat表示でLOCATE AおよびLOCATE Bポイントを登録
する際、自動的にリゾリューション（分解能）を「拍精度」に変換して登録するか、しないかを設定します。
つまり、Beatリゾリューション・モードをONに設定した状態でLOCATE AおよびLOCATE Bポイントを登
録すると、Bar/Beat表示のClk（クロック）が479以下であれば切り捨て、また480以上であれば切り上げし、
常にClkの値を“000”で登録することができます。

例として、ディスプレイ表示がBar/Beatの状態で、1bar 1  468clkの値をLOCATE Aポイン
トに登録、また12bar 4  485clkの値をLOCATE Bポイントに登録するとき、リゾリューショ
ン・モードをOnにしておくと、それぞれ以下のような値に登録されます。

1bar 11bar 11bar 11bar 11bar 1  468clk 468clk 468clk 468clk 468clk　　　　　➡　　　　　11111bbbbbaaaaarrrrr     11111      000000000000000ccccclllllkkkkk
（clk値468は切り捨てされます）

1111122222bbbbbaaaaarrrrr     44444      444448888855555ccccclllllkkkkk　　　　　➡　　　　　1111133333bbbbbaaaaarrrrr     11111      000000000000000ccccclllllkkkkk
（clk値485は切り上げされます）

11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードモードモードモードモードに入ります。に入ります。に入ります。に入ります。に入ります。
MENUを選択する1ページめの画面に変わり、初
期設定では“<< Back”が反転します。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““System >System >System >System >System >”””””に移に移に移に移に移
動して、動して、動して、動して、動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Systemメニューを選択する1ページめの画面に変
り、初期設定では“<< Back”が反転します。 44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルで“““““OnOnOnOnOn”””””（（（（（まままままたたたたたははははは“““““OffOffOffOffOff”””””）））））を選択を選択を選択を選択を選択

して、して、して、して、して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択した項目（OnまたはOff）に設定され、一つ
前の画面に変ります。

55555））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

BeatBeatBeatBeatBeat リゾリューションリゾリューションリゾリューションリゾリューションリゾリューション・・・・・モードの設定モードの設定モードの設定モードの設定モードの設定

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを22222ページめのページめのページめのページめのページめの
“““““      ResolutionResolutionResolutionResolutionResolution”””””に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーキーキーキーキー
を押します。を押します。を押します。を押します。を押します。
現在の設定が点滅する画面に変り、任意に選択が可
能になります（初期設定では“Off”が点滅）。

点滅
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MR-8mkII MR-8mkII MR-8mkII MR-8mkII MR-8mkII 　取扱説明書　取扱説明書　取扱説明書　取扱説明書　取扱説明書（（（（（そそそそそののののの他他他他他ののののの機機機機機能能能能能）））））

MR-8mkIIには、ファントム電源（+48V）を供給する機能が内蔵されており、ファントムを必要とするコンデ
ンサー・タイプのマイクを使用する場合に、ご利用いただけます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： ファントム電源は、 [INPUT A] と [INPUT B] のバランス入力（XLRコネクタ）に供給されます。
[PHONE] ジャックにプラグが差し込まれると同時に、ファントム電源は遮断されます。なお、ファントム電源
が“On”になっている状態で MR-8mkIIの電源をOFFすると、自動的に初期設定の“Off”に戻ります。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““Phantom PowerPhantom PowerPhantom PowerPhantom PowerPhantom Power”””””
に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在設定されているモードが点滅します（初期設定
では“Off”が点滅します）。

44444））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルで“““““OnOnOnOnOn”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ [MENU/ [MENU/ [MENU/ [MENU/
ENTER] ENTER] ENTER] ENTER] ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
数秒程度ワーニング・メッセージを表示した後、一
つ前の画面に変ります。

メッセージが表示されている間は全入力がミュート
され、画面が変ると同時にミュートは解除されま
す（“On”から“Off”に設定したときも、同様に
ワーニング・メッセージが表示され、全入力がミ
ュートされます）。

55555））））） 設定後設定後設定後設定後設定後 [STOP]  [STOP]  [STOP]  [STOP]  [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードからモードからモードからモードからモードから
抜け出します。抜け出します。抜け出します。抜け出します。抜け出します。
Home画面に変ります。
ファントム電源がONに設定された状態は、下記例

のようにHome画面上に“ ”が点灯します。

11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードに入ります。モードに入ります。モードに入ります。モードに入ります。モードに入ります。
MENUを選択する1ページめの画面に変わり、初
期設定では“<< Back”が反転します。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでダイヤルでダイヤルでダイヤルでダイヤルで22222ページめのページめのページめのページめのページめの“““““InputInputInputInputInput”””””にカーにカーにカーにカーにカー
ソルを移動して、ソルを移動して、ソルを移動して、ソルを移動して、ソルを移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Phantom Power”を選択する画面に変ります。

＜ファントム電源使用時の注意＞＜ファントム電源使用時の注意＞＜ファントム電源使用時の注意＞＜ファントム電源使用時の注意＞＜ファントム電源使用時の注意＞
● コンデンサー・マイクを接続するときは、ファントム電源が使える機種であるかを確認してください。
● ファントム電源は、マイクを接続してからOnに設定してください。
● ファントム電源のOn/Off、およびマイクを抜き差しするときは、 [MASTER] フェーダーを絞る・・・など、
必ず本機の出力をミュートしてください

ファントム電源のファントム電源のファントム電源のファントム電源のファントム電源のON/OFFON/OFFON/OFFON/OFFON/OFF設定設定設定設定設定

点滅
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MR-8mkIIをイニシャライズすると、すべてのソングに共通なMENUモードのSystem設定メニュー、および電
源投入後のタイム表示やディスプレイのコントラスト・レベルを、初期値に戻すことができます（イニシャラ
イズされる項目については、下記表を参照してください）。

11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードモードモードモードモードに入ります。に入ります。に入ります。に入ります。に入ります。
MENUを選択する1ページめの画面に変わり、初
期設定では“<< Back”が反転します。

22222））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを“““““System >System >System >System >System >”””””に移に移に移に移に移
動して、動して、動して、動して、動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Systemメニューを選択する1ページめの画面に変
り、初期設定では“<< Back”が反転します。

33333））））） ジョグジョグジョグジョグジョグ・・・・・ダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルをダイヤルでカーソルを22222ページめにあるページめにあるページめにあるページめにあるページめにある
“““““Init Memory >Init Memory >Init Memory >Init Memory >Init Memory >”””””に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーキーキーキーキー
を押します。を押します。を押します。を押します。を押します。

44444））））） [RECORD] [RECORD] [RECORD] [RECORD] [RECORD] キーを押しながら、キーを押しながら、キーを押しながら、キーを押しながら、キーを押しながら、 [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER]
キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
速やかにイニシャライズが行われ、終了と同時に
“Init Memory > ”が反転する画面に変ります。

イニシャライズの実行を確認する画面に変り、
“Are You Sure? ”が点滅します。
イニシャライズを実行するには [RECORD] キーを
押しながら [MENU/ENTER] キーを押します。
イニシャライズを中止するには、 [STOP] キーを押
します。

55555））））） [STOP] [STOP] [STOP] [STOP] [STOP] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、 MENU MENU MENU MENU MENUモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。

イニシャライズされる項目イニシャライズされる項目イニシャライズされる項目イニシャライズされる項目イニシャライズされる項目 イニシャライズ後の設定イニシャライズ後の設定イニシャライズ後の設定イニシャライズ後の設定イニシャライズ後の設定

プリロール時間の設定（Pre Roll Timeメニュー）

ポストロール時間の設定（Post Roll Timeメニュー）
ディレイ・タイプの設定（Delay Typeメニュー）
MIDI同期出力信号の設定（Midi Sync Outメニュー）
MTCフレーム・レートの設定（MTC Frame Rateメニュー）
ピーク・ホールド時間の設定（Peak Hold Timeメニュー）
Bar/Beatリゾリューションの設定（Resolutionメニュー）

電源投入後のタイム・ベース表示
ディスプレイのコントラスト・レベル

4秒

1秒
L-R（Stereoディレイ）

Off

25 (Frame)
3秒

Off

Bar/Beat表示

工場出荷時のコントラスト

MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII のイニシャライズのイニシャライズのイニシャライズのイニシャライズのイニシャライズ

Auto DeleteのON/OFF設定（Auto Deleteメニュー） On

ファントム電源の設定（Phantom Powerメニュー）
リズム・ガイドの設定（Rhythm Guideメニュー）

Off

工場出荷時の設定

カード・プロテクトの設定（Card Protectメニュー） On

点滅
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トラブルトラブルトラブルトラブルトラブル・・・・・シューティングシューティングシューティングシューティングシューティング
ついうっかりした操作ミスで、思うようにならない・・・という
ことがよくあります。
本機を操作中、「故障かな？」と思ったとき、修理を依頼する前に
お読みください。
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＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル77777＞＞＞＞＞：：：：：オーバーダビング時に、録音済みの
トラック音が聴こえてこない！

●●●●●録音済みトラックのフェーダーは上がっています録音済みトラックのフェーダーは上がっています録音済みトラックのフェーダーは上がっています録音済みトラックのフェーダーは上がっています録音済みトラックのフェーダーは上がっています
か？か？か？か？か？
録音するトラックと録音済みトラック両方のフェー
ダーが上がっていないと、録音済みトラックの音を
聞きながらオーバーダビングすることができません。

録音トラックと再生トラックの両方のフェーダーを、
適度な位置まで上げてご使用ください。

＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル33333＞＞＞＞＞：：：：：録音しようとしているチャンネルの
入力レベルが小さい。

●●●●●入力しているインプットの入力しているインプットの入力しているインプットの入力しているインプットの入力しているインプットの [TRIM]  [TRIM]  [TRIM]  [TRIM]  [TRIM] つまみは、つまみは、つまみは、つまみは、つまみは、正し正し正し正し正し
く調整されていますか？く調整されていますか？く調整されていますか？く調整されていますか？く調整されていますか？
各インプットの入力レベル（=録音レベル）を決め
るのは、 [TRIM] つまみの調整が大切です。PEAK
LEDが連続で点灯しないよう、調整してください。

＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル11111＞＞＞＞＞：：：：：[INPUT B] に接続した音源が、トラッ
ク1に録音できない

＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル55555＞＞＞＞＞：：：：：レベル・メータの振れが少なく、録
音レベルが小さい。

●●●●●モノモノモノモノモノ・・・・・トラックに録音するときは、トラックに録音するときは、トラックに録音するときは、トラックに録音するときは、トラックに録音するときは、 [INPUT A]  [INPUT A]  [INPUT A]  [INPUT A]  [INPUT A] 端子端子端子端子端子
のみが有効です。のみが有効です。のみが有効です。のみが有効です。のみが有効です。
[INPUT A] に音源を接続し直してください。

●●●●● [RECORD] [RECORD] [RECORD] [RECORD] [RECORD] キーのみを押して、キーのみを押して、キーのみを押して、キーのみを押して、キーのみを押して、録音スタンバイのト録音スタンバイのト録音スタンバイのト録音スタンバイのト録音スタンバイのト
ラックをインプットモニターにしていますか？ラックをインプットモニターにしていますか？ラックをインプットモニターにしていますか？ラックをインプットモニターにしていますか？ラックをインプットモニターにしていますか？
[RECORD] キーが点滅し、ディスプレイに
“ ”が点灯していることを確認してくださ
い。

●●●●●録音する楽器を接続しているインプットの録音する楽器を接続しているインプットの録音する楽器を接続しているインプットの録音する楽器を接続しているインプットの録音する楽器を接続しているインプットの [TRIM] [TRIM] [TRIM] [TRIM] [TRIM]
つまみは正しく調整されていますか？つまみは正しく調整されていますか？つまみは正しく調整されていますか？つまみは正しく調整されていますか？つまみは正しく調整されていますか？
[PEAK] LEDが点灯しない程度に [TRIM] つまみを
調整してください。

＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル66666＞＞＞＞＞：：：：：録音レベルは振れているのに、
[PHONES VOL] つまみを上げてもヘッドホンからモニ
ター音が聴こえてこない？

●●●●●録音しているトラックのフェーダーと、録音しているトラックのフェーダーと、録音しているトラックのフェーダーと、録音しているトラックのフェーダーと、録音しているトラックのフェーダーと、 [MASTER] [MASTER] [MASTER] [MASTER] [MASTER]
フェーダーは適度に上がっていますか？フェーダーは適度に上がっていますか？フェーダーは適度に上がっていますか？フェーダーは適度に上がっていますか？フェーダーは適度に上がっていますか？
録音時2つのフェーダーが上がっていないと、
[PHONES VOL] つまみだけを上げてもヘッドホン
からは何も聴こえてきません。
録音トラックのフェーダーと、 [MASTER] フェー
ダーを“ ”ポジションまで上げてご使用ください。

＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル22222＞＞＞＞＞：：：：：内蔵マイクで録音しようとしている
のに、入力レベルがディスプレイに表示されない。

●●●●●リアパネルにあるリアパネルにあるリアパネルにあるリアパネルにあるリアパネルにある [INPUT A SELECT]  [INPUT A SELECT]  [INPUT A SELECT]  [INPUT A SELECT]  [INPUT A SELECT] スイッチはスイッチはスイッチはスイッチはスイッチは
“““““INT MICINT MICINT MICINT MICINT MIC”””””ポジションになっていますか？ポジションになっていますか？ポジションになっていますか？ポジションになっていますか？ポジションになっていますか？
内蔵マイクで録音するには“INT MIC”ポジション
に設定してください。

●●●●● [INPUT A] [INPUT A] [INPUT A] [INPUT A] [INPUT A] ののののの [TRIM]  [TRIM]  [TRIM]  [TRIM]  [TRIM] つまみは適正なゲインが得らつまみは適正なゲインが得らつまみは適正なゲインが得らつまみは適正なゲインが得らつまみは適正なゲインが得ら
れるよう調整されていますか？れるよう調整されていますか？れるよう調整されていますか？れるよう調整されていますか？れるよう調整されていますか？
内蔵マイクに音源を近付け、最大音量のとき
[PEAK] LEDが点灯しないよう、調整してください。

●●●●● [RECORD] [RECORD] [RECORD] [RECORD] [RECORD] キーのみを押して、キーのみを押して、キーのみを押して、キーのみを押して、キーのみを押して、録音スタンバイのト録音スタンバイのト録音スタンバイのト録音スタンバイのト録音スタンバイのト
ラックをインプットラックをインプットラックをインプットラックをインプットラックをインプット・・・・・モニターにしていますか？モニターにしていますか？モニターにしていますか？モニターにしていますか？モニターにしていますか？
[RECORD] キーが点滅し、ディスプレイに
“ ”が点灯していることを確認してくださ
い。

＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル44444＞＞＞＞＞：：：：：[REC SELECT] キーをONにしてい
るのに、ヘッドホンで入力信号がモニターできない。

●●●●●  [RECORD]  [RECORD]  [RECORD]  [RECORD]  [RECORD] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、インプットモニターにしインプットモニターにしインプットモニターにしインプットモニターにしインプットモニターにし
ていますか？また、ていますか？また、ていますか？また、ていますか？また、ていますか？また、 [PHONES VOL]  [PHONES VOL]  [PHONES VOL]  [PHONES VOL]  [PHONES VOL] つまみは上がっつまみは上がっつまみは上がっつまみは上がっつまみは上がっ
ていますか？ていますか？ていますか？ていますか？ていますか？
入力信号をモニターするには、 [REC SELECT] キー
で選択されているトラックを、インプットモニター
にしないと聴こえません。また、インプットモニ
ターになっていても、 [PHONES VOL] つまみが
“MIN”になっていても聴こえません。

録音に関するトラブル録音に関するトラブル録音に関するトラブル録音に関するトラブル録音に関するトラブル

＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル88888＞＞＞＞＞：：：：：録音中、突然レコーダーが停止して
しまった。

●●●●●コンパクトフラッシュコンパクトフラッシュコンパクトフラッシュコンパクトフラッシュコンパクトフラッシュ・・・・・カードの記録可能な領域はカードの記録可能な領域はカードの記録可能な領域はカードの記録可能な領域はカードの記録可能な領域は
充分ですか？充分ですか？充分ですか？充分ですか？充分ですか？
めいっぱい録音したカードでは、新たな録音ができ
ません。新しいカードと交換するか、不要なソング・
データを削除して、録音し直してください。
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＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル99999＞＞＞＞＞：：：：：オート・パンチイン／アウトの操作
ができない！

●●●●●オートオートオートオートオート・・・・・パンチパンチパンチパンチパンチ・・・・・モードがモードがモードがモードがモードがONONONONONになっていますか？になっていますか？になっていますか？になっていますか？になっていますか？
ディスプレイに“ ”アイコンが点灯し
ていなければ、 [AUTO PUNCH] キーを押して、オー
ト・パンチ・モードをONにしてください。

●●●●●パンチインパンチインパンチインパンチインパンチイン・・・・・ポイントとパンチアウトポイントとパンチアウトポイントとパンチアウトポイントとパンチアウトポイントとパンチアウト・・・・・ポイントはポイントはポイントはポイントはポイントは
正しく登録されていますか？正しく登録されていますか？正しく登録されていますか？正しく登録されていますか？正しく登録されていますか？
各ポイントを確認するには、 [LOCATE A/IN] キー
／[LOCATE B/OUT] キーを押してください。
登録されているポイントへロケートすると同時に、
タイム・データが確認できます。

「パンチイン・ポイント＜パンチアウト・ポイント」
の関係で登録されていないときは、再度登録し直し
てからオート・パンチイン／アウトを実行してくだ
さい。

＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル11111＞＞＞＞＞：：：：：再生中、突然ロケートを実行してし
まった！

●●●●●プレイプレイプレイプレイプレイ・・・・・モードがモードがモードがモードがモードが“““““Auto RTN”””””またはまたはまたはまたはまたは“““““Loop”””””モーモーモーモーモー
ドに設定されていませんか？ドに設定されていませんか？ドに設定されていませんか？ドに設定されていませんか？ドに設定されていませんか？
ディスプレイに“ ”や“ ”の
アイコンが点灯していたら、 [PLAY MODE] キーを
押して、プレイ・モードをオフに設定してください。

＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル22222＞＞＞＞＞：：：：：再生音が聴こえてこない！

●●●●● [MASTER] [MASTER] [MASTER] [MASTER] [MASTER] フェーダーは適度な位置まで上がっていフェーダーは適度な位置まで上がっていフェーダーは適度な位置まで上がっていフェーダーは適度な位置まで上がっていフェーダーは適度な位置まで上がってい
ますか？ますか？ますか？ますか？ますか？
[MASTER] フェーダーが上がっていないと、トラッ
ク・フェーダーを上げてもヘッドホンや外部モニ
ターからは再生音が聴こえてきません。もちろん、
ヘッドホンでモニターしているときは [PHONES
VOL] つまみも上げてください。

＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル33333＞＞＞＞＞：：：：：[STOP] キーを押しながら [PLAY]
キーを押しても、LOCATE A-LOCATE B間の再生がで
きない！

●●●●● LOCATE ALOCATE ALOCATE ALOCATE ALOCATE AポイントとポイントとポイントとポイントとポイントとLOCATE BLOCATE BLOCATE BLOCATE BLOCATE Bポイントが正しポイントが正しポイントが正しポイントが正しポイントが正し
く登録されていますか？く登録されていますか？く登録されていますか？く登録されていますか？く登録されていますか？
初期設定の状態では、各ポイントは両方とも
“0m00s000ms”（または “-2bar 1  000clk”)になっ
ています。この状態では、A-B間の再生は実行でき
ません。
また、LOCATE Aポイント＜LOCATE Bポイント
の関係になるよう正しく登録されていないときも、
実行できません。

再生に関するトラブル再生に関するトラブル再生に関するトラブル再生に関するトラブル再生に関するトラブル

＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル11111＞＞＞＞＞：：：：：エフェクトがかからない！

●●●●●エフェクトをかけたいトラックのエフェクトをかけたいトラックのエフェクトをかけたいトラックのエフェクトをかけたいトラックのエフェクトをかけたいトラックの [EFFECT SEND] [EFFECT SEND] [EFFECT SEND] [EFFECT SEND] [EFFECT SEND]
つまみ、つまみ、つまみ、つまみ、つまみ、およびトラックおよびトラックおよびトラックおよびトラックおよびトラック・・・・・フェーダーは上がっていフェーダーは上がっていフェーダーは上がっていフェーダーは上がっていフェーダーは上がってい
ますか？ますか？ますか？ますか？ますか？

上記例のように、エフェクトをかけたいトラック（1
～4）の [EFFECT SEND] つまみを上げていき、内
蔵デジタル・エフェクトへ信号を送ってください。ま
た、エフェクトをかけるトラックのフェーダーが上
がっていることも確認してください。

0 10 EFFECT SEND100 100 100

＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル22222＞＞＞＞＞：：：：：マイク・シミュレーションが効いて
いない！

●●●●●リアパネルにあるリアパネルにあるリアパネルにあるリアパネルにあるリアパネルにある [INPUT A SEL]  [INPUT A SEL]  [INPUT A SEL]  [INPUT A SEL]  [INPUT A SEL] スイッチはスイッチはスイッチはスイッチはスイッチは
“““““MIC/LINEMIC/LINEMIC/LINEMIC/LINEMIC/LINE”””””ポジションになっていますか？ポジションになっていますか？ポジションになっていますか？ポジションになっていますか？ポジションになっていますか？

[INPUT A] にマイク・シミュレーションを効かせる
ためには、 [INPUT A SEL] スイッチを “MIC/LINE”
に切り替えなければなりません。正しいポジション
になっているか確認してください。
“GUITAR”のポジションでは、インサート・エフェ
クトはアンプ・シミュレーションが有効です。

INPUT A SELECT

INT MIC
GUITAR

MIC/LINE

エフェクトに関するトラブルエフェクトに関するトラブルエフェクトに関するトラブルエフェクトに関するトラブルエフェクトに関するトラブル
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＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル11111＞＞＞＞＞：：：：：突然レコーダーの電源が切れてし
まった！

●●●●● ACACACACACアダプタのプラグが抜けていませんか？アダプタのプラグが抜けていませんか？アダプタのプラグが抜けていませんか？アダプタのプラグが抜けていませんか？アダプタのプラグが抜けていませんか？
本体側およびコンセント側の接続を確認してくださ
い。また、電池で駆動しているときは、電池が消耗
していないか確認しましょう。

＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル11111＞＞＞＞＞：：：：：パソコンへWAVファイルを取り込
めない！

●●●●● USBUSBUSBUSBUSBケーブルは正しく接続されていますか？ケーブルは正しく接続されていますか？ケーブルは正しく接続されていますか？ケーブルは正しく接続されていますか？ケーブルは正しく接続されていますか？
また、また、また、また、また、ご使用になっているパソコンのご使用になっているパソコンのご使用になっているパソコンのご使用になっているパソコンのご使用になっているパソコンのOSOSOSOSOSは適合しは適合しは適合しは適合しは適合し
ていますか？ていますか？ていますか？ていますか？ていますか？
OSによっては、WAVファイルの取り込みは実行で
きません。下記のOSに対応しているかどうか、ご
確認ください。

WindowsWindowsWindowsWindowsWindows：：：：：Me/2000/XPMe/2000/XPMe/2000/XPMe/2000/XPMe/2000/XP
MacintoshMacintoshMacintoshMacintoshMacintosh：：：：：OS XOS XOS XOS XOS X以上以上以上以上以上

＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル22222＞＞＞＞＞：：：：：PC側にドライブ・アイコンが表示さ
れない！

●●●●●リムーバブルリムーバブルリムーバブルリムーバブルリムーバブル・・・・・ドライブが表示されるのに、ドライブが表示されるのに、ドライブが表示されるのに、ドライブが表示されるのに、ドライブが表示されるのに、多少時多少時多少時多少時多少時
間がかかることがあります。間がかかることがあります。間がかかることがあります。間がかかることがあります。間がかかることがあります。
ドライブ・データを読み込むまで時間がかかること
があります。ドライブ・アイコンが表示されるまで
お待ちください。

WindowsのPCでは「リムーバブル・ドライブ」が
表示され、MacintoshのPCでは「MR-8mkII」の
ドライブ名が表示されます。

＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル22222＞＞＞＞＞：：：：：[RHYTHM GUIDE] キーをONにして
いるのに、コンダクター・マップで作成したリズムガイ
ド音しか聞こえない！

●●●●●“““““Conductor MapConductor MapConductor MapConductor MapConductor Mapががががが“““““OnOnOnOnOn”””””になっていませんか？になっていませんか？になっていませんか？になっていませんか？になっていませんか？
下記画面にあるように、“Conductor Map”が
“On”になっていると、コンダクター・マップで作成
したリズムガイドが優先で出力されます。
つまり、下記画面で設定した“Signature”および
“Tempo”は“---”となり、無効になっていること
を示しています。

77ページを参照して、“Conductor Map”の設定
を“Off”に設定し直してください。

＜トラブル＜トラブル＜トラブル＜トラブル＜トラブル11111＞＞＞＞＞：：：：：リズムガイドの音が聴こえてこない！

●●●●● [RHYTHM GUIDE] [RHYTHM GUIDE] [RHYTHM GUIDE] [RHYTHM GUIDE] [RHYTHM GUIDE] キーはキーはキーはキーはキーはONONONONONになっていますか？になっていますか？になっていますか？になっていますか？になっていますか？
[RHYTHM GUIDE] キーがON（ランプ点灯）になっ
ていないと、リズムガイドの音は聴こえてきませ
ん。

●●●●●MENUMENUMENUMENUMENUモードのモードのモードのモードのモードの“““““Rhythm GuideRhythm GuideRhythm GuideRhythm GuideRhythm Guide”””””メニューにあるメニューにあるメニューにあるメニューにあるメニューにある
“““““Int Click LevelInt Click LevelInt Click LevelInt Click LevelInt Click Level”””””設定は、設定は、設定は、設定は、設定は、最適なレベルになってい最適なレベルになってい最適なレベルになってい最適なレベルになってい最適なレベルになってい
ますか？ますか？ますか？ますか？ますか？
“Int Click Level”の設定値が“00”になっていたり、
値が小さいと、リズムガイド音が聞こえません。

USBUSBUSBUSBUSB接続に関するトラブル接続に関するトラブル接続に関するトラブル接続に関するトラブル接続に関するトラブル

電源に関するトラブル電源に関するトラブル電源に関するトラブル電源に関するトラブル電源に関するトラブル

その他のトラブルその他のトラブルその他のトラブルその他のトラブルその他のトラブル
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製品の仕様製品の仕様製品の仕様製品の仕様製品の仕様
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[[[[[入出力端子入出力端子入出力端子入出力端子入出力端子]]]]]

0dBu=0.775Vrms, 0dBV=1.0Vrms

●アナログ●アナログ●アナログ●アナログ●アナログ・・・・・インプットインプットインプットインプットインプット（（（（（INPUT A/INPUT BINPUT A/INPUT BINPUT A/INPUT BINPUT A/INPUT BINPUT A/INPUT B）））））
コネクタ ：XLR-3-31タイプ（2番ホット）

：φ6mm PHONE
入力レベル ：-48dBu (MIC)～+4dBu (LINE)
入力インピーダンス ：1.5kΩ以上

：400kΩ以上 (INPUT A SELス
イッチ：“GUITAR”設定時の
INPUT Aのみ)

ファントム電源 ：P48V (MENUモードで設定）

●ステレオ●ステレオ●ステレオ●ステレオ●ステレオ・・・・・アウトプットアウトプットアウトプットアウトプットアウトプット（（（（（STEREO OUT L, RSTEREO OUT L, RSTEREO OUT L, RSTEREO OUT L, RSTEREO OUT L, R）））））
コネクタ ：φ6mm PHONE
基準出力レベル ：-10dBV (アンバランス）
適合負荷インピーダンス：10kΩ以上

●ヘッドホン●ヘッドホン●ヘッドホン●ヘッドホン●ヘッドホン（（（（（PHONES 1, 2PHONES 1, 2PHONES 1, 2PHONES 1, 2PHONES 1, 2）））））
コネクタ ：φ6mm Stereo PHONE
最大出力 ：30mW以上（32Ω時）
適合負荷インピーダンス：16Ω以上

●●●●●MIDIMIDIMIDIMIDIMIDIアウトアウトアウトアウトアウト（（（（（MIDI OUTMIDI OUTMIDI OUTMIDI OUTMIDI OUT）））））
コネクタ ：DIN 5ピン
フォーマット ：MIDI規格に準拠

●フットスイッチ●フットスイッチ●フットスイッチ●フットスイッチ●フットスイッチ（（（（（FOOT SWFOOT SWFOOT SWFOOT SWFOOT SW）））））
コネクタ ：φ6mm PHONE
レベル ：TTLレベル

●●●●●USBUSBUSBUSBUSBポートポートポートポートポート（（（（（USB 2.0 HI-SPEEDUSB 2.0 HI-SPEEDUSB 2.0 HI-SPEEDUSB 2.0 HI-SPEEDUSB 2.0 HI-SPEED）））））
コネクタ ：Bタイプ（標準）

●●●●●USB HOSTUSB HOSTUSB HOSTUSB HOSTUSB HOSTポートポートポートポートポート（（（（（USB 1.1USB 1.1USB 1.1USB 1.1USB 1.1）））））
コネクタ ：Aタイプ（標準）

●周波数特性 ：20Hz～20kHz、Normalモード

●ダイナミックレンジ ：87dB以上 (TYPICAL)
Normalモード

●全高調波歪率 ：0.05%以下 (TYPICAL)
Normalモード

1

3

2

[XLR[XLR[XLR[XLR[XLRコネクタのピンアサインコネクタのピンアサインコネクタのピンアサインコネクタのピンアサインコネクタのピンアサイン]]]]]

11111 グランドグランドグランドグランドグランド
22222 ホットホットホットホットホット
33333 コールドコールドコールドコールドコールド

[USB[USB[USB[USB[USBポートのピンアサインポートのピンアサインポートのピンアサインポートのピンアサインポートのピンアサイン]]]]]

11111 VBUSVBUSVBUSVBUSVBUS
22222 D-D-D-D-D-
33333 D+D+D+D+D+

[USB HOST[USB HOST[USB HOST[USB HOST[USB HOSTポートのピンアサインポートのピンアサインポートのピンアサインポートのピンアサインポートのピンアサイン]]]]]

44444 GNDGNDGNDGNDGND

11111 VBUSVBUSVBUSVBUSVBUS
22222 D-D-D-D-D-
33333 D+D+D+D+D+
44444 GNDGNDGNDGNDGND

12

3 4

1 2 3 4

[[[[[記録／再生記録／再生記録／再生記録／再生記録／再生]]]]]
●記録メディア ：コンパクトフラッシュ・カード

●サンプリング周波数 ：44.1kHz（Normalモード）
：22.05kHz（LPモード）

●量子化 ：16bitリニア（非圧縮）

●ファイルフォーマット：FAT16 (VFAT)

●トラック数 ：8トラック
*同時録音トラック数：最大2トラック

●ADC ：24bitΔΣ

●DAC ：24bitΔΣ

MR-8mkIIMR-8mkIIMR-8mkIIMR-8mkIIMR-8mkII の主な規格の主な規格の主な規格の主な規格の主な規格

[[[[[一　　般一　　般一　　般一　　般一　　般]]]]]
●本体質量 ：約1.6kg（付属品除く）

●ACアダプタ質量 ：約500g

●本体寸法（mm） ： 286 (W) x 220 (D) x 65 (H )

●電源／消費電流 ：DC12V、400mA
専用ACアダプタ、または単3
アルカリ電池（6本）を使用

●付属品 ：ACアダプタ、取扱説明書

* この製品の仕様および外観などは、改良のため将来予告
なく変更することがあります。

* CompactFlashTM（コンパクトフラッシュ）は、米国
SanDisk社の登録商標であり、CFA (CompactFlashTM

Association)へライセンスされています。

* ご使用いただくACアダプタの極性は、内側プラス (+)
／外側マイナス (-) になっています
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● この製品には、保証書が付属されています。
お買い上げの際に、販売店で所定の事項を記入して
お渡しします。記載内容をお確かめの上、大切に保
管してください。

● 保証期間は、お買い上げ日から1年です。
期間中は保証書の規定に基づいて、当社サービス部
門が修理いたします。詳細については、保証書裏の
「無償修理規定」をお読みください。

● 保証期間を過ぎてしまった場合、または保証書を紛
失した場合の修理については、お買い上げの販売
店、または当社営業窓口/サービス部門へご相談く
ださい。

国内営業窓口国内営業窓口国内営業窓口国内営業窓口国内営業窓口：：：：：
☎042-546-6355、 Fax. 042-546-6067
土・日・祝日および当社指定休日を除く
AM 10: 00～12: 00、 PM 1: 00～5: 00

サービス部門サービス部門サービス部門サービス部門サービス部門：：：：：
☎042-546-3151、 Fax. 042-546-3198
土・日・祝日および当社指定休日を除く
AM 10: 00～12: 00、 PM 1: 00～5: 00

● 保証期間を過ぎてしまった場合でも、修理によって
機能が維持できる場合には、お客様のご要望により
有料修理いたします。

● この製品の補修用性能部品（製品の機能を維持する
ために必要な部品）の最低保有期間は、製造打ち切
り後6年です。

● 当社営業窓口およびサービス部門の連絡先は、以下
のようになっています。お気軽にご相談ください。

286

22
0

65

外形寸法図外形寸法図外形寸法図外形寸法図外形寸法図

アフターサービスについてアフターサービスについてアフターサービスについてアフターサービスについてアフターサービスについて
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[[[[[バウンスモードバウンスモードバウンスモードバウンスモードバウンスモード（（（（（1-41-41-41-41-4＞＞＞＞＞5/65/65/65/65/6使用時使用時使用時使用時使用時]]]]]

[[[[[通常使用時通常使用時通常使用時通常使用時通常使用時]]]]]

ブロックブロックブロックブロックブロック・・・・・ダイヤグラムダイヤグラムダイヤグラムダイヤグラムダイヤグラム

DISTORTION

INPUT A

INPUT B

TRIM

TRIM

A/D

A/DBAL

BAL

IN7

IN8

OUT7

OUT8

IN5

IN6

OUT5

OUT6

IN4 OUT4

IN3 OUT3

IN2 OUT2

IN1 OUT1

RECORDER
REC

SELECT
TRK 1 FADER

TRK 2 FADER

TRK 3 FADER

TRK 4 FADER

TRK 5/6 FADER

TRK 7/8 FADER

TRK 4 EFF

TRK 3 EFF

TRK 2 EFF

TRK 1 EFF

TRK 1 PAN

TRK 2 PAN

TRK 3 PAN

TRK 4 PAN

TO STEREO BUSS
L R

EFF

REVERB / DELAY

REVERB / DELAY TIME

MASTER
FADER

MASTERING FX ST OUT L

ST OUT R

INT MIC

SIMULATION

IN7

IN8

OUT7

OUT8

IN5

IN6

OUT5

OUT6

IN4 OUT4

IN3 OUT3

IN2 OUT2

IN1 OUT1

RECORDER
REC

SELECT
TRK 1 FADER

TRK 2 FADER

TRK 3 FADER

TRK 4 FADER

TRK 5/6 FADER

TRK 7/8 FADER

TRK 4 EFF

TRK 3 EFF

TRK 2 EFF

TRK 1 EFF

TRK 1 PAN

TRK 2 PAN

TRK 3 PAN

TRK 4 PAN

TO STEREO BUSS
L R EFF

REVERB / DELAY

REVERB / DELAY TIME

MASTER
FADER

MASTERING FX

ST OUT L

ST OUT R

DISTORTION

INPUT A

INPUT B

TRIM

TRIM

A/D

A/DBAL

BAL

INT MIC

SIMULATION
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[[[[[バウンスモードバウンスモードバウンスモードバウンスモードバウンスモード（（（（（1-61-61-61-61-6＞＞＞＞＞7/87/87/87/87/8使用時使用時使用時使用時使用時]]]]]

[[[[[バウンスモードバウンスモードバウンスモードバウンスモードバウンスモード（（（（（1-81-81-81-81-8＞＞＞＞＞New SongNew SongNew SongNew SongNew Song使用時使用時使用時使用時使用時]]]]]
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OUT8

IN5

IN6

OUT5

OUT6

IN4 OUT4
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IN1 OUT1
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●あ●あ●あ●あ●あ（（（（（アアアアア）））））～お～お～お～お～お（（（（（オオオオオ）））））
アンドウ.............................................39、41、43、95、103

アンドウ用WAVファイル......................................94、135

アンプ・シミュレーション..................................................60

アフターサービス..................................................................145

アーカイブ...............................................................................121

インサート・エフェクト.......................................................60

インプット（INPUT）端子..................................................36

インプットAセレクトスイッチ.........................................37

インプットモニター....................................14、38、40、42

イレース.......................................................................96、105

イベントの変更........................................................................80

イベントの削除......................................................................80

イニシャライズ......................................................................138

エフェクト..................................................................................59

エフェクト・センド................................................................62

エーシー（AC）アダプター................................................20

オーバーダビング..................................................................42

オート・リターン...................................................................48

オート・プレイ.........................................................................48

オーディオCD.........................................................................123

オートデリート機能.............................................................135

●か●か●か●か●か（（（（（カカカカカ）））））～こ～こ～こ～こ～こ（（（（（コココココ）））））
カード・プロテクト................................................118、120

キューイング.............................................................................46

クリップ・ボード..................................................................108

クリック・レベル....................................................................77

クロック（CLK）.....................................................................87

ゲイン...........................................................................................15

コントラスト.............................................................................32

コンパクトフラッシュ・カード.............................18、132

コピー..............................................................97、106、108

コンダクター・マップ...........................................................78

●さ●さ●さ●さ●さ（（（（（サササササ）））））～そ～そ～そ～そ～そ（（（（（ソソソソソ）））））
再生..................................................................39、41、43、45

最終録音位置.............................................................................50

シミュレーション....................................................................60

シーケンサー.............................................................................86

CD-R/RWドライブ.............................................................123

シグネチュアー（Signature）マップ...............................78

ソング.................................................................................13、89

ソングの選択.............................................................................90

索　引索　引索　引索　引索　引
ソングの削除...........................................................................92

ソングにプロテクトをかける...........................................93

ソングの先頭...................................................................12、50
ソング・ネーム...............................................................24、91

ソングのアーカイブ.............................................................121

●た●た●た●た●た（（（（（タタタタタ）））））～と～と～と～と～と（（（（（トトトトト）））））
タイムベース...................................................................14、32

ディレイ......................................................................................61

ディストーション..........................................................36、38

テンポ（Tempo）マップ......................................................82

ディスプレイ............................................................................31

電源................................................................................................20

トラック.................................................................37、66、95

ツーミックス（2MIX）フォルダ.....................................119

トラック・データの削除....................................................96

トラック・データのコピー・ペースト..........................97

トラック・データのムーブ...............................................99

トラック・データの入れ替え...........................................101

トラブル・シューティング...............................................139

トリム....................................................15、36、39、41、43

トラック・フェーダー................................36、39、41、43

同期................................................................................................85

トック（TOC）......................................................................129

●な●な●な●な●な（（（（（ナナナナナ）））））～の～の～の～の～の（（（（（ノノノノノ）））））
ニュー・ソング.........................................................................23

ニュー・ソングへのバウンス..............................................72

任意の範囲をバウンス...........................................................74

●は●は●は●は●は（（（（（ハハハハハ）））））～ほ～ほ～ほ～ほ～ほ（（（（（ホホホホホ）））））
バウンス......................................................................................65

バー／ビート（Bar/Beat）......................14、32、75、136

バー（BAR）オフセット......................................................81

パワー・スイッチ...................................................................21

パソコン...................................................................................115

パート........................................................................................103

パンチイン／アウト................................................................53

パンチイン／アウト・ポイント.........................................56

拍精度........................................................................................136

ピークLED........................................................................15、36

ピーク・ホールド..................................................................133

拍子.....................................................................................76、78

プレイ・モード.........................................................................47

プリロール.....................................................................49、134
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フォーマット...........................................................................132

フットスイッチ.........................................................................55

ファントム電源..................................................36、40、137

プロテクト.....................................................................93、120

ブロック・ダイヤグラム....................................................146

ペースト..........................................................97、106、108

編集区間の再生............................................................46、104

編集ポイントの変更.............................................................104

変換モード...............................................................................116

ポストロール...............................................................49、134

●ま●ま●ま●ま●ま（（（（（マママママ）））））～も～も～も～も～も（（（（（モモモモモ）））））
マスター・レコーダー...........................................................44

マスタリング・エフェクト..................................................63

マイク・シミュレーション..................................................60

ミディ（MIDI）........................................................................85

ミディ（MIDI）インプリメント・チャート...................148

ミックスダウン.......................................................................44

ムーブ...........................................................................99、111

メトロノーム機能....................................................................75

文字入力キー..................................................................24、91

●や●や●や●や●や（（（（（ヤヤヤヤヤ）））））～よ～よ～よ～よ～よ（（（（（ヨヨヨヨヨ）））））
やり直し（アンドウ／リドウ）...39、41、43、95、103

ユー・エス・ビー（USB）........................................118、125

●ら●ら●ら●ら●ら（（（（（ラララララ）））））～ろ～ろ～ろ～ろ～ろ（（（（（ロロロロロ）））））
リバーブ......................................................................................61

リドウ.................................................39、41、43、95、103

リメイン................................................13、31、38、40、42

リハーサル.....................................................57、68、70、72

リプロモニター.........................................................................14

リゾリューション..................................................................136

リズム・ガイド.........................................................................75

ループ...........................................................................................48

レック・エンド（REC END）..............................................50

ロケート.....................................................................................50

ロケート・ポイント................................................................51

録音...................................................................................35～44

録音レベル..............................................................39、41、43

録音トラック............................................................................37

●わ●わ●わ●わ●わ（（（（（ワワワワワ）））））
WAV（ワブ）ファイル...............................................13、116

WAV（ワブ）ファイルの変換.........................................116

ワーニング..................................................................................33
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